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g he developers who set out to build Java Studio Creator had a very dif-
ficult task: to make the creation of sophisticated enterprise applications
easy.

The set of technologies that comprise Java2 Enterprise Edition (J2EE) is
huge. The good side is that J2EE is battle hardened and field proven to be an
excellent base for large scale mission critical applications. There are many
excellent books that cover all of the aspects of J2EE in great detail. But all of
this leads to the bad side of J2EE: it can be difficult and time-consuming to
learn and use. Tremendous effort goes into making J2EE as simple as possible,
but it remains daunting.

Java Studio Creator is a huge leap in the simplification of the process of
developing J2EE based web applications. Developers don't need to deal with
all of the gory details: Creator just handles them. Instead, developers can focus
on what their application does and looks like in a very simple and straightfor-
ward way. They weave together data sources through a simple drag-and-drop
interface. Very little knowledge of Java or J2EE is required to develop applica-
tions in Creator. Creator not only simplifies the process: it also accelerates it.

This book contains all that you need to know to generate enterprise applica-
tions using Creator. It doesn't require that you know anything about J2EE or
even Java: there are gentle introductory chapters that lead you through what
you need to know. This is a great entry point for developers from other plat-
forms (like Visual Basic!) to enter the world of large-scale, mission-critical
applications. It's fun. Take the plunge.

James Gosling
Sun Microsystems, Inc.
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ou’re about to embark on a journey that we hope will prove both
enjoyable and fruitful. Certainly the aim of any application develop-
ment tool is to help developers become efficient and allow them to
spend time on creative tasks while the tool silently generates the
drudgery for them. To that end, we hope this book will teach you the ins and
outs of Creator so that you can quickly begin to build web applications.

How This Book Is Organized

Creator2 has significant enhancements over the first version of Creator and
we've completely revamped (and grown!) this text to reflect the “new” Creator.
In a nutshell, you'll see an improved design time experience, with an advanced
page design editor and component style editor. Creator2 includes a complete
set of new (and more numerous) Ul components sporting an improved theme-
based look and intuitive property names. Data providers give you a consistent
interface with the persistence tier and NetBeans provides the underpinnings of
the IDE. Building portlet-based projects, consuming EJBs, and using AJAX-
enabled components round out the list of improvements. Enjoy!

Chapter 1 introduces the world of Java and its supporting technologies. Cre-
ator depends on these well-established Java technologies to do its job. With the
Java programming language and XML, JavaServer Faces component system,
and NetBeans tool building technology, Creator has tapped the available stan-
dards. Here we provide a gentle introduction to these topics, so you'll get the
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XXVi Preface

“big picture” of how Creator fits into the Java world. We also spend time on the
Java programming language since you will use Java often with Creator. If you
come from another programming environment, we want you to feel comfort-
able right away with Java-based web applications.

Chapter 2 introduces Creator, with the aim of getting you up to speed with
its various windows, the design canvas, and its editors. Knowing how to move
around in the IDE will quickly make you productive. You'll also build your
first project from scratch.

Chapter 3 is your “Components Catalog.” This reference chapter lets you
choose the best component for your application from Creator’s store of compo-
nents, validators, and data converters. We'll also point you to places in the
book where these components are used in complete projects.

Chapter 4 is all about working with the Java source editor, managing your
code with the Concurrent Versioning System (CVS), and performing project-
level tasks, such as refactoring. Creator is built on the NetBeans IDE, which
provides the backbone for these software management tasks.

Chapter 5 introduces Page Navigation in Creator. You'll learn how to specify
page flow in a web application and understand which components are suitable
for page navigation. We'll also discuss Creator’s navigation model and illus-
trate page navigation with several projects.

Chapter 6 discusses the anatomy of Creator projects. JavaBeans components
(beans) provide one of the key supporting technologies that Creator uses.
Developers who understand the advantages of JavaBeans components can
build robust applications with reusable components. The chapter also delves
into the JSF/Creator page request life cycle so that you can best leverage Cre-
ator’s life cycle callback methods.

Chapter 7 covers features that help you with web page design and layout.
Page fragments give your application a consistent look and several layout com-
ponents help you design your page layout. Creator’s Cascading Style Sheet
(CSS) editor lets you build page and component style rules.

Chapter 8 introduces data providers, a standard layer connecting your web
application’s components to a persistence tier, such as database, web service,
JavaBeans component, or Enterprise JavaBeans (EJB) component. We explore
the data provider interface and show you common ways to work with data
providers in your projects.

Chapter 9 shows you how to use a database with Creator. You'll build
projects with essential database operations, such as read, update, insert, and
delete. Creator’s data-aware components make linking to a database (via data
providers) easy and straightforward.

Chapter 10 shows you how to access a web service from a Creator-built
application. Creator bundles a selection of web services; you can also add addi-
tional web services to the IDE. In this chapter, you'll build an application that
uses the Google Search Web Service.
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Preface xxvii
e on the Enterprise JavaBeans (EJBs) provide a powerful model for distributed sys-
1. If you tems. Creator lets you build applications that consume EJBs, automatically
:omfort- enerating the code to invoke methods on deployed objects. Chapter 11 shows
you how to invoke EJB methods and manipulate returned data through stan-
ed with dard data providers.
to move With Creator, you can create a JSF portlet application that conforms to the
ild your Java Specification Request (JSR) 168 Portlet specification. Chapter 12 covers
ortlet application development, including examples on using web services,
lets you database access, and portlet Edit and Help modes.
compo- Chapter 13 shows you how to customize a web application with Creator.
s in the You'll learn how to localize/internationalize an application. We also show you
how to write and install custom validation methods. Anxious to use AJAX
ng your technology? We include several examples that use an auto-complete AJAX-
project- enabled text field.
, which Chapter 14 shows you how to use Creator’s debugger in your projects.
You'll learn how to set breakpoints, look at the server log file, respond to
specify exceptions, and use the NetBeans HTTP monitor.
suitable
o illus- About the Examples
>onents Java Studio Creator Field Guide, Second Edition is an example-driven book. All
T uses. example projects that we describe in these chapters are provided prebuilt in the
ats can example download bundle. The database chapter includes a sample Music
delves . database, which we also provide in the download bundle. The example code is
ge Cre- . available on the Sun Microsystem Creator2 web site.
layout.
It com- http://developers.sun.com/prodtech/javatools/
> Sheet jscreator/index.jsp
ur web You can also download the example code from the authors’ web site at
service, ;
>xplore http://www.asgteach.com
th data
) We recommend you visit both web sites to keep current with the latest Creator
] build : updates!
rt, and
ia data A A
Notational Conventions
r-built , . . ) )
{ addi- We've applied a rather “light hand” with font conventions in an attempt to
on that keep the page uncluttered. Here are the conventions we follow.
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xxviii

Preface

Element Font and Example

property name text property, cellpadding property

code comments // User event code here .
component name text field loanAmount
Creator components output text, text field, drop down list
filename colorl.properties, Pagel.jsp
Java class String, Object, Integer
Java code username.setValue ("ravedu")
JavaBeans components LoginBean, ColorBean, Pagel
JSF EL expressions #{Pagel.colorBean.redvValue}
JSP code, HTML code  <f:loadBundle>, <img>

press <Alt+Shift+]>; press <Enter>

View Pagel Java Class, Music > Tables

key combinations
menu selections
project name Loginl, Echo

user input Type the text Musicl, specify loginBean

About the Front Cover

L.M. Pei’s Glass Pyramid is an apt symbol for a book on Java Studio Creator.
The pyramid serves as the entrance to the Louvre Museum in Paris. Truly inter-
national, it was designed by a Chinese-American, who is both an engineer and
an artist. We were drawn to its elegant simplicity of glass and light, its multiple
facets, and the blending of a structure that is modern yet simultaneously repre-
sentative of Ancient Egypt.

Java Studio Creator is built on the same concept of layered architecture.
Based on JavaServer Faces technology, Creator leverages the existing Java 2
Platform Enterprise Edition (J2EE) architecture and of course, the solid founda-
tions of Java and its runtime environment. Likewise, the Glass Pyramid is an
extraordinary example of layered architecture whose backdrop is a traditional
Renaissance palace. The Louvre itself houses artistic treasures dating from
antiquity, perhaps none more famous than Leonardo da Vinci’s Mona Lisa.

Gail and Paul Anderson
Anderson Software Group, Inc.
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- ithout the help of others, not only would this text be lacking in

/ timeliness and accuracy, but its very existence is questionable.

Jim Inscore of Sun Microsystems blazed the path for this project,

taking care of both administration and coordinating technical help.
Without his desire to see this project a reality, the Second Edition would have
remained unrealized.

_— Many people from the Sun Microsystems Creator Team helped us directly

‘ and indirectly by answering technical questions, giving us insights into design

and architectural issues, providing updated “bits” so that we could always

work with a current system, and providing valuable feedback to early drafts.

We'd like to especially acknowledge Winston Prakash. He gave us crucial tech-

‘reator. nical support and answered many questions. He was our go-to guy and we
y inter- cannot praise his dedication to this project enough!

er .and Octavian Tanase and Sandip Chitale were also on the frontline for us, help-
wltiple ing with various technical questions throughout the entire writing process.
' repre-

Octavian also was central dispatch for our questions, feeding them to the right
Creator Team member. Thus, we'd also like to thank those who answered when
ecture. asked for help: David Botterill, David Folk, Chau Nguyen, Tor Norbye, Matt

Java 2 Bohm, Craig McClanahan, Chris Kutler, Edwin Goei, Dongmei Cao, Vaughn
011}1‘313' Spurlin, and Dusan Pavlica. Valerie Lipman was in on the early proposed con-
Cli Is an tent talks. Valuable feedback also came from one of our readers, Les Hawkins.
litional The Second Edition builds on the initial work of the First Edition. Greg
2 from Doench, our editor at Prentice Hall, made that possible. Vicky Hilpert of Viets-
isa.

bronn, Germany helped with the German translations and Blanca Lazaro
helped with the Spanish. Thanks also to our family (especially Sara and Kellen)
and friends for love and support.

Lastly, we'd like to thank James Gosling for giving us all Java.
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JAVA TECHNOLOGY
OVERVIEW

Topics in This Chapter

+ The Java Programming Language
+ JavaBeans Components

* NetBeans Software
~+ The XML Language
-« The J2EE Architecture
+ JavaServer Faces Technology
+ JDBC and Databases
+ Ant Build Tool
+ Web Services
+ EJBs and Portlets
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~ elcome to Creator! Creator is an IDE (Integrated Development
Environment) that helps you build web applications. While many
IDEs out in the world do that, Creator is unique in that it is built on
a layered technology anchored in Java. At the core of this technol-
ogy is the Java programming language. Java includes a compiler that produces
portable bytecode and a Java Virtual Machine (JVM) that runs this byte code on
any processor. Java is an important part of Creator because it makes your web
applications portable.

But Java is more than just a programming language. It is also a technology
platform. Many large systems have been developed that use Java as their core.
These systems are highly scalable and provide services and structure that
address some of the high-volume, distributed computing environments of
today.

1.1 Introduction

Creator depends on multiple technologies, so it's worthwhile touching on them
in this chapter. If you're new to Java, many of its parts and acronyms can be
daunting. Java technologies are divided into related packages containing
classes and interfaces. To build an application, you might need parts of one sys-
tem and parts of another. This chapter provides you with a road map of Java
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4 Chapter 1 Java Technology Overview

technologies and documentation sources to help you design your web applica-
tions with Creator.

We'll begin with an overview of the Java programming language. This will
help you get comfortable writing Java code to customize your Creator applica-
tions. But before we do that, we show you how to find the documentation for
Java classes and methods. This will help you use them with confidence in your
programs.

Most of the documentation for a Java Application Program Interface (APT)
can be accessed through Creator’s Help System, located under Help in the
main menu. Sometimes all you need is the name of the package or the system
to find out what API a class, interface, or method belongs to. Java consists of
the basic language (all packages under java) and Java extensions (all packages
under javax). Once you locate a package, you can explore the interfaces and
classes and learn about the methods they implement.

You can also access the Java documentation online. Here’s a good starting
point for the Java API documentation.

http://java.sun.com/docs/
This page contains links to the Java 2 Platform Standard Edition, which con-
tains the core APIs. It also has a link to all of the other Java APIs and technolo-
gies, found at

http://java.sun.com/reference/docs/index.html

Creator is also built on the technology of JavaServer Faces (JSF). You can
find the current JSF API documentation at

http://java.sun.com/j2ee/javaserverfaces/1.0/docs/api/
index.html

JSF is described as part of the J2EE Tutorial, which can be found at
http://java.sun.com/j2ee/1.4/docs/tutorial/doc/index.html

These are all important references for you. We've included them at the
beginning of this book so it’s easy to find them later (when you're deep in the
challenges of web application development). For now, let’s begin with Java as a
programming language. Then we’ll look at some of the other supporting tech-
nologies on which Creator is built.

Facebook's Exhibit No. 1003
Page 0036

Page 36 of 328 GOOGLE EXHIBIT 1003



) } ]
1.2 The Java Programming Language 5
pplica: 1.2 The Java Programming Language
his will
applica~ This cursory overview of the ]ava. progra_mming language is for readers w'ho
t}O“ for come from a non-Java programuning environment. It’s not meant to be an in-
n your depth reference, but a starting point. Much of Creator involves manipulating
components through the design canvas and the components’ property sheets.
ze (APT) However, there are times when you must add code to a Java page bean (the
> in the supporting Java code for your web application’s page) or use a JavaBeans com-
'+ system ponent in your application. You'll want a basic understanding of Java to more
1sists of casily use Creator.
ackages
ces and Object-Oriented Programming
starting Languages like C and Basic are procedure-oriented languages, which means
data and functions are separated. To write programs, you either pass data as
arguments to functions or make your data global to functions. This arrange-
ment can be problematic when you need to hide data like passwords, customer
identification codes, and network addresses. Procedure-oriented designs work
ich con- fine when you write simple programs but are often not suitable to more com-
achnolo- plex tasks like distributed programming and web applications. Function librar-
ies help, but error handling can be difficult and global variables may introduce
side effects during program maintenance.
Object-oriented programming, on the other hand, combines data and func-
tions into units called objects. Languages like Java hide private data (fields) from
You can user programs and expose only functions (methods) as a public interface. This
concept of encapsulation allows you to control how callers access your objects. It
allows you to break up applications into groups of objects that behave in a sim-
ilar way, a concept called abstraction. In Java, you implement an object with a
Java class and your object’s public interface becomes its outside view. Java has
inheritance to create new data types as extensions of existing types. Java also
has interfaces, which allow objects to implement required behaviors of certain
classes of objects. All of these concepts help separate an object’s implementa-
tion (inside view) from its interface (outside view).
All objects created from the same class have the same data type. Java is a
; strongly typed language, and all objects are implicitly derived from type
n at the Object (except the built-in primitive types of int, boolean, char, double,
ep in the long, etc.). You can convert an object from one type to another with a converter.
Javaasa Casting to a different type is only allowed if the conversion is known by the
ing tech- compiler. Creator’s Java editor helps you create well-formed statements with
dynamic syntax analysis and code completion choices. You'll see how this
works in Chapter 2,
Error handling has always been a tough problem to solve, but with web
applications error handling is even more difficult. Processing errors can occur
Facebook's Exhibit No. 1003
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Chapter 1 Java Technology Overview

on the server but need to propagate in a well-behaved way back to the user.
Java implements exception handling to handle errors as objects and recover
gracefully. The Java compiler forces programmers to use the built-in exception
handling mechanism.

And, Java forbids global variables, a restriction that helps program mainte-
nance.

Creating Objects

Operator new creates objects in Java. You don’t have to worry about destroying
them, because Java uses a garbage collection mechanism to automatically
destroy objects which are no longer used by your program.

Point p = new Point(); // create a Point at (0, 0)
Point g = new Point (10, 20); // create a Point at (10, 20)

Operator new creates an object at run time and returns its address in memory to
the caller. In Java, you use references (p and q) to store the addresses of objects so
that you can refer to them later. Every reference has a type (Point), and objects
can be built with arguments to initialize their data. In this example, we create
two Point objects with x and y coordinates, one with a default of (0, 0) and the
other one with (10, 20).

Once you create an object, you can call its methods with a reference.

p.move (30, 30); // move object p to (30, 30)

q.up(); // move object g up in y direction
p.right(); // move object p right in x direction
int xp = p.getX(); // get x coordinate of object p

int yp = p.getY(); // get y coordinate of object p
g.setX(5); // change x coordinate in object g
p.setY (25); // change y coordinate in object p

As you can see, you can do a lot of things with Point objects. It’s possible to
move a Point object to a new location, or make it go up or to the right, all of
which affect one or more of a Point object’s coordinates. We also have getter
methods to return the x and y coordinates separately and setter methods to
change them.

Why is this all this worthwhile? Because a Point object’s data (x and y coor-
dinates) are hidden. The only way you can manipulate a Point object is through
its public methods. This makes it easier to maintain the integrity of Point
objects.
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1.2 The Java Programming Language T

0 the user.
nd recover
L exception -

classes

va already has a Point class in its API, but for the purposes of this discussion,
{:t's roll our own. Here’s our Java Point class, which describes the functionality

im mainte- we've shown you.
Listing 1.1 Point class
// Point.java - Point class

destroying class Point {
omatically // Fields

private double x, y; // % and y coordinates
‘ // Constructors
>0 public Point (double x, double y) { move(x, v); }
0 public Point() { move(0, 0); }
nemory to // Instance Methods
objects so - public void move (double x, double y) {
nd objects this.x = x; this.y = y;
we create } ' .
O)andthe public vo}d up () { y++; }

public void down() { y--; }

public vold right () { x++; }
e public void left () { x--; }

// getters
ton public double getX() { return x; }
action public double getY() { return v}

// setters
) public void setX(double x) { this.x = x; '}
-4 . public void setY(double y) { this.y = v; }
- P )
Olsilbl ﬁ t?c The Point class is divided into three sections: Fields, Constructors, and
sht, a tto Instance Methods. Fields hold internal data, constructors initialize the fields,
l‘t]li gde fr and instance methods are called by you with references. Note that the fields for
=thods to x and y are private. This enforces data encapsulation in object-oriented pro-
d gramming, since users may not access these values directly. Everything else,
: ) ﬁ/ COO; however, is declared public, making it accessible to all clients.
’ f ;Ot}gt The Point class has two constructors to build Point objects. The first con-
Ol Poin Structor accepts two double arguments, and the second one is a default con-

structor with no arguments. Note that both constructors call the move ()
method to initialize the x and y fields. Method move () uses the Java this key-
‘ Facebook's Exhibit No. 1003
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8 Chapter 1 Java Technology Overview

word to distinguish local variable names in the method from class field name
in the object. The setX () and setY () methods use the same technique.

Most of the Point methods use void for their return type, which means th
method does not return anything. The ++ and -- operators increment or decre
ment their values by one, respectively. Each method has a signature, which is
another name for a function’s argument list. Note that a signature may be

empty.

Packages

The Point class definition lives in a file called Point.java. In Java, you must ‘
name a file with the same name as your class name. This makes it convenient
for the Java run-time interpreter to find class definitions when it’s time to
instantiate (create) objects. When all classes live in the same directory, it's easy
to compile and run Java programs.

In the real world, however, classes have to live in different places, so Java
has packages that allow you to group related classes. A package in Java is both a
directory and a library. This means a one-to-one correspondence exists between
a package hierarchy name and a file’s pathname in a directory structure.
Unique package names are typically formed by reversing Internet domain
names (com.nycompany). Java also provides access to packages from class paths
and JAR (Java Archive) files.

Suppose you want to store the Point class in a package called MyPack-
age .examples. Here's how you do it.

package MyPackage.examples;
class Point {

Package names with dot (.) delimiters map directly to path names, so
Point.java lives in the examples directory under the MyPackage directory. A
Java import statement makes it easy to use class names without fully qualifying
their package names. Import statements are also applicable to class names from
any Java APL

// BAnother Java program

import java.util.Date;

import javax.faces.context.*;
import MyPackage.examples.Point;

1. The this reference is not necessary if you use different names for the argu- ~ P
ments. !
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eld nameg
el

means the
t or decre-
, which is
‘e may be

The first import statement provides the Date class name to our Java program
from the java.util package. The second import uses a wildcard (*) to make
&[ class definitions available from javax.faces.context. The last import

brings out Point class into scope from package MyPackage . examples.

Exceptions

We mentioned earlier that one of the downfalls of procedure-oriented lan-
guages is that subroutine libraries don’t handle errors well. This is because
|ibraries can only detect problems, not fix them. Even with libraries that sup-

you must port elaborate error mechanisms, you cannot force someone to check a func-
onvenient tion’s return value or peek at a global error flag. For these and other reasons, it
's time to has been difficult to write distributed software that gracefully recovers from
y, it's easy erTorSs.

Object-oriented languages like Java have a built-in exception handling
8, 80 Java mechanism that lets you handle error conditions as objects. When an error
ais both a occurs inside a try block of critical code, an exception object can be thrown
s between from a library method back to a catch handler. Inside user code, these catch
structure. handlers may call methods in the exception object to do a range of different
t domain things, like display error messages, retry, or take other actions.

lass paths The exception handling mechanism is built around three Java keywords:
throw, catch, and try. Here’s a simple example to show you how it works.
MyPack~
class SomeClass {
public void doSomething(String input) {
int number;
try
number = Integer.parselnt (input);
}
catch (NumberFormatException e) {
lames, so .
String msg = e.getMessage();
PC?HY A // do something with msg
[ualifying }
mes from

Suppose a method called doSomething () needs to convert a string of char-
acters (input) to an integer value in memory (number). In Java, the call to Inte-
ger.parselnt () performs the necessary conversion for you, but what about
matformed string arguments? Fortunately, the parseInt () method throws a
NumberFormatException if the input string has illegal characters. All we do is
argu- ‘ place this call in a try block and use a catch handler to generate an error mes-
sage when the exception is caught.
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Chapter 1 Java Technology Overview

All that's left is to show you how the exception gets thrown. This is often
called a throw point.

class Integer {
public static int parselnt (String input)
throws NumberFormatException {

// input string has bad chars
throw new NumberFormatException('illegal chars");
}

The static parseInt() method? illustrates two important points about
exceptions. First, the throws clause in the method signature announces that
parselnt () throws an exception object of type NumberFormatException. The
throws clause allows the Java compiler to enforce error handling. To call the
parseInt () method, you must put the call inside a try block or in a method
that also has the same throws clause. Second, operator new calls the Number-
FormatException constructor to build an exception object. This exception
object is built with an error string argument and thrown to a catch handler
whose signature matches the type of the exception object (NumberFormat Excep-
tion).> As you have seen, a catch handler calls getMessage () with the excep-
tion object to access the error message.

Why are Java exceptions important? As you develop web applications with
Creator, you'll have to deal with thrown exceptions. Fortunately, Creator has a
built-in debugger that helps you monitor exceptions. In the Chapter 14, we
show you how to set breakpoints to track exceptions in your web application

(see “Detecting Exceptions” on page 669). . th
o d

Inheritance ; E
The concept of code reuse is a major goal of object-oriented programming. C
When designing a new class, you may derive it from an existing one. Inherit- of
ance, therefore, implements an “is a” relationship between classes. Inheritance hi
also makes it easy to hook into existing frameworks so that you can take on
1

d

2. Inside class Integer, the static keyword means you don’t have to instan-
tiate an Integer object to call parseInt (). Instead, you call the static
method with a class name rather than a reference.

3. The match doesn’t have to be exact. The exception thrown can match the
catch handler’s object exactly or any exception object derived from it by
inheritance. To catch any possible exception, you can use the superclass
Exception. We discuss inheritance in the next section.
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1.2 The Java Programming Language

is is often tionalities. With inheritance, you can retain the existing structure and

new func - o1 . . .
f an existing class and specialize certain aspects of it to suit your

behavior ©

s. . .
neelg Java, inheritance is implemented by extending classes. When you extend

e class from another, the public methods of the “parent” class become part of
?}?e public interface of the “child class.” The parent class is called a superclass
and the child class is called a subclass. Here are some examples.

class Pixel extends Point {

}

class NumberFormatException extends IllegalArgumentException {

nts about

mces that }

tion. The

lo call the In the first example, Point is a superclass and Pixel is a subclass. A Pixel

a method “is a” Point with, say, color. Inside the Pixel class, a color field with setter and

2 Number- getter methods can assist in manipulating colors. Pixel objects, however, are

exception Point objects, so you can move them up, down, left or right, and you can get or

h handler set their x and y coordinates. (You can also invoke any of Point’s public meth-

at Excep- ods with a reference to a Pixel object.) Note that you don’t have to write any

he excep- code in the Pixel class to do these things because they have been inherited
from the Point class. Likewise, in NumberFormatException, you may intro-

ions with duce new methods but inherit the functionality of IllegalArgumentExcep-

ator has a tion.

er 14, we Another point about inheritance. You can write your own version of a

oplication method in a subclass that has the same name and signature as the method in

the superclass. Suppose, for instance, we add a clear () method in our Point
class to reset Point objects back to (0, 0). In the Pixel class that extends from
Point, we may override the clear () method.? This new version could move a
Pixel object to (0, 0) and reset its color. Note that clear() in class Point is

ramming. called for Point objects, but clear () in class Pixel will be called for Pixel
2. Inherit- = objects. With a Point reference set to either type of object, different behaviors
theritance happen when you call this method.

n take on It's important to understand that these kinds of method calls in Java are

resolved at run time. This is called dynamic binding. In the object-oriented para-
digm, dynamic binding means that the resolution of method calls with objects

nstan-
ic

4. Creator uses this same feature by providing methods that are called at dif-
the ferent points in the JSF page request life cycle. You can override any of these
y methods and thus provide your own code, “hooking” into the page request
ss ‘ life cycle. We show you how to do this in Chapter 6 (see “The Creator-JSF

Life Cycle” on page 260).
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12 Chapter 1 Java Technology Overview

is delayed until you run a program. In web applications and other types of dis-
tributed software, dynamic binding plays a key role in how objects call meth-
ods from different machines across a network or from different processes in a
multitasking system.

Interfaces

In Java, a method with a signature and no code body is called an abstract
method. Abstract methods must be overridden in subclasses and help define
interfaces. A Java interface is like a class but has no fields and only abstract pub-
lic methods. Interfaces are important because they specify a contract. Any new
class that implements an interface must provide code for the interface’s meth-
ods.

Here’s an example of an interface.

interface Encryptable {
void encode(String key);
String decode();

}

class Password implements Encryptable {

voild encode (String key) { . . . }
String decode() { . . . }

The Encryptable interface contains only the abstract public methods
encode () and decode (). Class Password implements the Encryptable inter-
face and must provide implementations for these methods. Remember, inter-
faces are types, just like classes. This means you can implement the same
interface with other classes and treat them all as Encryptable types.

Java prohibits a class from inheriting from more than one superclass, but it
does allow classes to implement multiple interfaces. Interfaces, therefore, allow
arbitrary classes to “take on” the characteristics of any given interface. .

One of the most common interfaces implemented by classes in Java is the
Serializable interface. When an object implements Serializable, you can
use it in a networked environment or make it persistent (this means the state of
an object can be saved and restored by different clients). There are methods to
serialize the object (before sending it over the network or storing it) and to
deserialize it (after retrieving it from the network or reading it from storage).
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1.3 JavaBeans Components

ocesses in
A JavaBeans component is a Java clas§ with certain structure requirements. Jav-
abeans components define and manipulate properties, which are objects of a
ain type. A JavaBeans component must have a default constructor so that it

Cef: be instantiated when needed. Beans also have getter and setter methods
an abstrac f}iat manipulate a bean property and conform to a specific naming convention.
nelp defin These structural requirements make it possible for development tools and
'stract pub other programs to create JavaBeans components and manipulate their proper-
t. Any new ties.
ace’s meth- Here's a simple example of a JavaBeans component.

public class Book {
private String title;
private String author;

public Book() { setTitle(""); setAuthox(""); }
public void setTitle(String t) ({ title = t; }
public String getTitle() { return title; }
public void setAuthor (String a) { author = a; }

public String getAuthor() { return author; }

Why are JavaBeans components important? First and most important, they
are accessible to Creator. When you write a JavaBeans component that con-
forms to the specified design convention, you may use it with Creator and bind

methods JSE components to bean properties. Second, JavaBeans components can encap-

ble inter- sulate business logic. This helps separate your User Interface (UI) components

ber, inter- or presentation from the business data model.

the same In subsequent chapters, we show you several examples of JavaBeans compo-
, nents. We'll use a LoginBean to handle users that login with names and pass-

ass, but it words and show you a LoanBean that calculates mortgage payments for loans.

ore, allow The point class in Listing 1.1 on page 7 is another example of a JavaBeans com-

g ponent.

ava is the

. you can

esateof 1.4 NetBeans Software

ethods to

t)and to

orage). . NetBeans software is an open source IDE written in the Java programming lan-

guage. It also includes an API that supports building any type of application.
The IDE has support for Java, but its architecture is flexible and extensible,
making support for other languages possible.
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NetBeans is an Open Source project. You can view more information on its
history, structure, and relationship with Sun Microsystems at its web site

http://www.netbeans.org/

NetBeans and Creator are related because Creator is based on the NetBeans
platform. In building Creator, Sun is offering an IDE aimed specifically at cre-
ating web-based applications. Thus, the IDE integrates page design with gener-
ated JSP source and page bean components. NetBeans provides features such
as source code completion, workspace manipulation of windows, expandable
tree views of files and components, and debugging facilities. Because NetBeans
is extensible, the Creator architects included Java language features such as
inheritance to adapt components from NetBeans into Creator applications with
the necessary IDE functions.

1.5 The XML Language

XML is a metalanguage that dictates how to define custom languages and
describe data. The name is an acronym for Extensible Markup Language. XML
is not a programming language, however. In fact, it’s based on simple character
text in which the data are surrounded by text markup that documents data.
This means you can use XML to describe almost anything. Since XML is self-
describing, it’s easy to read with tools and other programs to decide what
actions to take. You can transport XML documents easily between systems or
across the Internet, and virtually any type of data can be expressed and vali-
dated in an XML document. Furthermore, XML is portable because it’s lan-
guage and system independent.

Creator uses XML to define several configuration files as well as the source
for the JSP web pages. Here’s an example XML file (managed-beans.xml) that
Creator generates for managing a JavaBeans component in a web application.

<faces-config>
<managed~bean>
<managed-bean-name>LoanBean</managed-bean-name>
<managed-bean-class>asg.bean examples.LoanBean
</managed-bean-class>
<managed-bean-scope>session</managed-bean-scope>
</managed-bean>
</faces-config>

Every XML file has opening tags (<tag>) and closing tags (</tag>) that
define self-describing information. Here, we specify a managed-bean element
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tion on its.

to tell Creator what it needs to know about the LoanBean component. This
. 0
' site

cludes  1ts name (LoanBean), class name and package (asg.bean-
mne Lqmples .LoanBean), and the scope of the bean (session). When you add your
gf\,‘{; JavaBeans Component.s to Creator as managed beans, Creator generates
this configuration information for you. . . .
Creator maintains and updates its XML files for you, but it'’s a good idea to
be familiar with XML syntax. This will allow you to customize the Creator

XML files if necessary.

‘NetBeans
ally at cre-
7ith gener-
tures such
xpandable |
‘NetBeans
s such as
tions with

1.6 The J2EE Architecture

The J2EE platform gives you a multitiered application model to develop dis-
tributed components. Although any number of tiers is possible, we’ll use a
three-tier architecture for the applications in this book. Figure 1-1 shows the
approach.

The client machine supports web browsers, applets, and stand-alone appli-
cations. A client application may be as simple as a command-line program run-
ning as an administrator client or a graphical user interface created from Java

1ages and Swing or Abstract Window Toolkit (AWT) components. Regardless, the J2EE

lage. XML L N . SR
» character specification encourages thin clients in the presentation tier. A thin client is a
ents data lightweight interface that does not perform database queries, implement busi-
AL is self-. ness logic, or connect to legacy code. These types of “heavyweight” operations
~ide what preferably belong to other tiers.
ystems or
and vali-
ie it’s lan-
he source Web
.x‘ml). that Presentation Tier Database
lication. Tier R — Tier
Business
Tier
Client J2EE Server Database
Machine Machine Server Machine
ag>) that Figure 1-1 Three-tier J2EE architecture
1 element
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16 Chapter 1 Java Technology Overview

The J2EE server machine is the center of the architecture. This middle tier
contains web components and business objects managed by the application
server. The web components dynamically process user requests and construct
responses to client applications. The business objects implement the logic of a
business domain. Both components are managed by a J2EE application server
that provides these components with important system services, such as secu-
rity, transaction management, naming and directory lookups, and remote con-
nectivity. By placing these services under control of the J2EE application server,
client components focus on either presentation logic or business logic. And,
business objects are easier for developers to write. Furthermore, the architec-
ture encourages the separation of business logic from presentation logic (or
model from view).

The database server machine handles the database back end. This includes
mainframe transactions, databases, Enterprise Resource Planning (ERP) sys-
tems, and legacy code. Another advantage of the three-tier architecture is that
older systems can take on a whole new “look” by using the J2EE platform. This
is the approach many businesses are taking as they integrate legacy systems
into a modern distributed computing environment and expose application ser-
vices and data to the web.

1.7 Java Servlet Technology

The Java Servlet component technology presents a request-response program-
ming model in the middle tier. Servlets let you define HTTP-specific servlet
classes that accept data from clients and pass them on to business objects for
processing. Servlets run under the control of the J2EE application server and
often extend applications hosted by web servers. Servlet code is written in Java
and compiled. It is particularly suited to server-side processing for web appli-
cations since each Servlet session is handled in its own thread.

1.8 JavaServer Pages Technology

A JavaServer Pages (JSP) page is a text-based document interspersed with Java
code. A JSP engine translates JSP text into Java Servlet code. It is then dynami-
cally compiled and executed. This component technology lets you create
dynamic web pages in the middle tier. JSP pages contain static template data
(HTML, WML, and XML) and JSP elements that determine how a page con-
structs dynamic content. The JSP API provides an efficient, thread-based mech-
anism to create dynamic page content.
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1.9 JDBC API and Database Access

Creator uses JavaServer Faces (JSF), which is built on both the servlet and
Sp technologies. However, by using Creator, you are shielded from much of
{hé details of not only JSP and servlet programming, but JSF details as well.

ion server

h as secu- 1.9 JDBC APl and Database Access

mote con- '

on server,

)gic. And, Java Data Base Connectivity (JDBC) is an API that lets you invoke SQL com-

» architec- mands from Java methods in the middle tier. Typically, you use the JDBC API
logic (or to access a database from servlets or JSP pages. The JDBC API has an applica-

5 includes

tion-level interface for database access and a service provider interface to
attach JDBC drivers to the J2EE platform. In support of JDBC, J2EE application

ERP) sys- servers manage a pool of database connections. This pool provides business
ire is that objects efficient access to database servers.

orm. This The JDBC CachedRowSet API is a newer technology that makes database
/ systems access more flexible. Creator accesses configured data sources using a Cached-
-ation ser- rRowSet object, a JavaBeans component that is scrollable, updatable, and serial-

izable. These components are disconnected from the database, caching its rows
into memory. When web applications modify data in the cached rowset object,
the result propagates back to the data source through a subsequent connection.
By default, Creator instantiates a cached rowset object in session scope.

The concept of data providers is also important because it produces a level of
abstraction for data flow within Creator’s application environment. Creator’s
data providers allow you to change the source of data (say, from a database

program-
ic servlet table to a web services call or an EJB method) by hooking the data provider to a
bjects for different data source.

rver and We introduce data providers in Chapter 8 and show how to use them with
:n in Java databases in Chapter 9.

'eb appli-

with Java

1.10 JavaServer Faces Technology

The JavaServer Faces (JSF) technology helps you develop web applications
using a server-side user interface (UI) component framework. The JSF API
gives you a rich set of Ul components and lets you handle events, validate and

dynami- convert user input, define page navigation, and support internationalization.
yu create JSF has custom tag libraries for connecting components to server-side objects.
late data We show you these components and tag libraries in Chapter 3.

lage con- JSF incorporates many of the lower level tasks that JSP developers are used
ed mech- to doing. Unlike JSP applications, however, applications developed with JSF

can map HTTP requests to component-specific event handlers and manage Ul
elements as stateful objects on the server. This means JSF offers a better separa-

Loy
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Chapter 1 Java Technology Overview

tion of model and presentation. The JSF API is also layered directly on top of
the Servlet API.

1.11 Ant Build Tool

Ant is a tool from the Apache Software Foundation (www.apache.org) that
helps you manage the “build” of a software application. The name is an acro-
nym for “Another Neat Tool” and is similar in concept to older build tools like
make under Unix and gmake under Linux. However, Ant is XML-based, it’s eas-
ier to use, and it’s platform independent.

Ant is written in Java and accepts instructions from XML documents. Ant is
well suited for performing complicated and repetitive tasks. Creator uses Ant
to compile and deploy your web applications. Ant gets its instructions for
building a system from the configuration file, build.xml. You won't have to
know too much about Ant to use Creator, but you should be aware that it’s
behind the scenes doing a lot of work for you.

1.12 Web Services

Web services are software APIs that are accessible over a network in a hetero-
geneous environment. Network accessibility is achieved by means of a set of
XML-based open standards such as the Web Services Description Language'
(WSDL), the Simple Object Access Protocol (SOAP), and Universal Description,
Discovery, and Integration (UDDI). Web service providers and clients use these
standards to define, publish, and access web services.

Creator’s application server (J2EE 1.4) provides support for web services. In
Creator, you can access methods of a web service by dragging its node onto the
design canvas. We show you web services with Creator in Chapter 10.

1.13 Enterprise JavaBeans (EJB)

EJB is a component technology that helps developers create business objects in
the middle tier. These business objects (enterprise beans) consist of fields and
methods that implement business logic. E]Bs are server-side components writ-
ten in Java that serve as building blocks for enterprise systems. They perform
specific tasks by themselves, or forward operations to other enterprise beans.
EJBs are under control of the J2EE application server. We show you how to
access EJBs from Creator applications in Chapter 11.
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1.14 Portlets

an application that runs on a web site managed by a server called a

tal. A portal server manages multiple portlet applications, displaying them
por ’1 e web page together. Each portlet consumes a fragment of the page and
o ;}1 os its own information and user interaction. Portlet application develop-
rer;: V:,ﬁl typically target portlets to run under portals provided by various por-

A portlet is

.org) that
is an acro-
1 tools like
2d, it's eas-

tal vendors. . :
You can use Creator to develop portlets. Creator builds JSF portlets. This

means your design-time experience in building portlet web application using
the visual, drag-and-drop features of Creator will be familiar. Most of the inter-
action with the IDE is exactly the same as it is for non-portlet JSF projects. We
ow you how to create portlets in Chapter 12.

nts. Ant is
r uses Ant
ictions for
't have to
re that it’s

shi

1.15 Key Point Summary

o Creator is an IDE built on layered Java technologies that helps you build

web applications.
« Procedure-oriented languages separate data and functions, whereas object-

oriented languages combine them.

ta hetero- + Encapsulation enforces data hiding and allows you to control access to your
of a set of objects.

Langu_age e TJava is a strongly typed object-oriented language with a large set of APIs
»scription, that help you develop portable web applications.

- use these

* InJava, operator new returns a reference to a newly created object so that
you can call methods with the reference.

¢ Java classes have fields, constructors, and instance methods. The private
keyword is used for encapsulation, and the public keyword grants access to
clients.

* Java packages allow you to store class files and retrieve them with import
statements in Java programs.

* Java uses try, catch, and throw to handle error conditions with a built-in
exception handling mechanism.

* Inheritance is a code reuse mechanism that implements an “is a”

arvices. In

e onto the
I,

f)bjeCtS in relationship between classes.

ields ar.ld * Dynamically bound method calls are resolved at run time in Java. Dynamic
ents writ- binding is essential with distributed web applications.

,' pebrform * An interface has no fields and only abstract public methods. A class that
ise beans.

implements an interface must provide code for the interface’s methods.
The J2EE architecture is a multitiered application model to develop
distributed components.

u how to
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* JavaServlets let you define HTTP-specific servlet classes that accept data
from clients and pass them on to business objects for processing.

* A]JSP page is a text-based document interspersed with Java code that allows
you to create dynamic web pages.

* JDBCis an API for database access from servlets, J]SP pages, or JSF. Creator
uses data providers to introduce a level of abstraction between Creator UI
components and sources of data.

* JavaServer Faces (JSF) helps you develop web applications using a server-
side user interface component framework. Creator generates and manages
all of the configuration files required by JSF.

* AJavaBeans component is a Java class with a default constructor and setter
and getter methods to manipulate its properties.

* NetBeans is a standards-based IDE and platform written in the Java
programming language. Java Studio Creator is based on the NetBeans
platform.

* XML is a self-describing, text-based language that documents data and
makes it easy to transport between systems.

* AntisaJava build tool that helps you compile and deploy web applications.

* Web services are software APIs that are accessible over a network in a
heterogeneous environment.

* EJBs are server-side components written in Java that implement business
logic and serve as building blocks for enterprise systems.

* Portlets are applications that consume a portion of a web page. They run on
web sites managed by a portal server and execute along with other portlets
on the page.

* Portlets help divide web pages into smaller, more manageable fragments.
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CREATOR BASICS

Topics in This Chapter

Creator Window Layout

Visual Design Editor
Components and Clips Palette
Source Editors/Code Completion
Page Navigation Editor

Outline Window

+ Projects Window

+ Servers and Resources
 Creator Help System
* Basic Project Building
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un Java Studio Creator makes it easy to work with web applications
from multiple points of view. This chapter explores some of Creator’s
basic capabilities, the different windows (views) and the way in which
you use them to build your application. We show you how to manipu-
late your application through the drag-and-drop mechanism for placing com-
ponents, configuring components in the Properties window, controlling page
flow with the Page Navigation editor, and selecting services from the Servers
window.

2.1 Examples Installation

We assume that you've successfully installed Creator. The best source of infor-

mation for installing Creator is Sun’s product information page at the following
URL.

http://developers.sun.com/prodtech/javatools/jscreator/

Creator runs on a variety of platforms and can be configured with different
application servers and JDBC database drivers. However, to run all our exam-
ples we've used the bundled application server (Sun Java System Application
Server 8.2) and the bundled database server (Derby). Once you’ve configured
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Creator for your system, the examples you build here should run the same on
your system.

Download Examples

You can download the examples for this book at the Sun Creator web site. The
examples are packed in a zip file. When you unzip the file, you'll see the
FieldGuide2/Examples directory and subdirectories for the various chapters
and projects. As each chapter references the examples, you will be instructed
on how to access the files.

You're now ready to start the tour of Creator.

2.2 Creator Views

Figure 2-1 shows Creator’s initial window layout in its default configuration.
When you first bring it up, no projects are open and Creator displays its Wel-
come window.

There are other windows besides those shown in the initial window layout.
As you'll see, you can hide and display windows, as well as move them
around. As we begin this tour of Creator, you’ll probably want to run Creator
while reading the text.

Welcome Window

The Welcome window lets you create new projects or work on existing ones.
Figure 2-2 shows the Welcome window in more detail. It lists the projects
you’ve worked on recently and offers selection buttons for opening existing
projects or creating new projects. If you hover with the mouse over a recently
opened project name, Creator displays the full pathname of the project in a
tooltip.

To demonstrate Creator, let's open a project that we’ve already built. The
project is included in the book’s download bundle, in directory FieldGuide2/
Examples/Navigation/Projects/Login1.

Creator Tip

We show you how to build this project from scratch in Chapter 5 (see
“Dynamic Navigation” on page 206). For our tour of the IDE, however, we'll
use the pre-built project from the examples download.
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. . ty Figure 2-1 Creator’s initial window layout
‘oject in a
ouilt. The 1. Select the Open Existing Project button and browse to the FieldGuide2/
dGuide2/ Examples/Navigation/Projects directory.
. 2. Select Login1 (look for the projects icon) and click Open Project Folder. This
opens the Login1 project in the Creator IDE.
3. Pagel should display in the visual editor, as shown in Figure 2-3. If Pagel
does not open in the design editor, find the Projects view (its default posi-
we'll : tion is on the right, under the Properties view).
j 4. In the Projects view, expand node Login1, then Web Pages. Double-click
Pagel.jsp. Pagel should now appear in the design editor.
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Welcome X |

. EJBGreeting2
ElfLresting

ﬁ Tutorials and Sample Applications

Jutorialsonthe Web Samples on the W

What's New Get Support § [

%

Figure 2-2 Creator’s Welcome window

Design Editor

Figure 2-3 shows a close-up of the design canvas (the visual design editor) of
Pagel. You see the design grid and the components we’ve placed on the can-
vas. The design editor lets you visually populate the page with components.

Pagel contains.a “virtual form.” Virtual forms are accessible on a page by
selecting the Show Virtual Forms icon on the editing toolbar, as shown in
Figure 2-3. Virtual forms let you assign different components to different
actions on the page. We show you how to use virtual forms in “Configure Vir-
tual Forms” on page 216 (for project Loginl in Chapter 5) and in “Virtual
Forms” on page 417 (for project MusicAdd in Chapter 9).

Select the text field component. The design canvas marks the component
with selection and resizing handles. Now move the text field component
around on the grid. You'll note that it snaps to the gird marks automatically
when you release the mouse. You can temporarily disable the snap to grid fea-
ture by moving the component and pressing the Shift key at the same time. You
can also select more than one component at a time (use <Shift+Cliclke) and Cre-
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Design Canvas

Figure 2-3 Creator’s design canvas showing project Loginl

ator provides options to align components. We cover the mechanics of page
design in Chapter 7 (see “Using the Visual Design Editor” on page 273).

Note that when you make modifications to a page, Creator indicates that
changes have been made to the project by appending an asterisk to the file
name tab. Once you save your project by clicking the Save All icon in the tool-
bar (or selecting File > Save All from the main menu), the Save All icon is dis-

dit f
f tfmorc)ag, abled and the asterisk is cleared from the file name tab.
bnents Typically applications consist of more than one page. You can have more
’ than one of your project’s pages open at a time (currently, there’s just one page
a page by . - .
shown in open). When you open other files, a file tab appears at the top of the editor
different pane. The file tab lets you select other files to display in the editor pane.
igure Vir- Creator lets you configure your display’s workspace to suit the tasks you're

working on. All the windows can be hidden when not needed (click the small x
in a window's title bar to close it) and moved (grab the window’s title bar and
move it to a new location). To view a hidden window, select View from the

v “Virtual

mponent . . .
)mponent menu bar and then the window name. Figure 2-4 shows the View menu with
)mfti I the various windows you can open, along with a key stroke shortcut for open-
S ori dC?an ing each window.

tigm e. You You can also dock Creator windows by selecting the pushpin in the window

' and Cre- title bar. This action minimizes the window along the left or right side of the
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Figure 2—4 Creator’s View Menu allows you to select specific views of your project

workspace. Make it visible again by moving the cursor over its docked posi-
tion. Toggling the pushpin icon undocks the window. Figure 2-5 shows the
Properties view with both the Projects and Files windows docked.

Properties

As you select individual components, their properties appear in the Properties
window. Select the text field component on the design canvas. This brings up
its Properties window, as shown in Figure 2-5.

Creator lets you configure the components you use by manipulating their
properties. When you change a component’s properties, Creator automatically
updates the underlying JSP source for you. Let’s look at several properties of
the text field component. If you hold the cursor over any property value, Cre-
ator displays its setting in a tooltip.

Components have many properties in common; other properties are unique
to the specific component type. The id property uniquely identifies the compo-
nent on the page. Creator generates the name for you, but you can change it (as
we have in this example) to more easily work with generated code. The label
property enables you to specify a textual label associated with the text field.
The red asterisk next to the label in the design view indicates that input is
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Figure 2-5 Properties window for text field component “userName”
Properties required for this component. Property text holds the text that the user sub-
brings up mits. You can use the style property to change a component’s appearance. The
style property’s position tag reflects the component’s position on the page.
iting their When you move the component in the design view, Creator updates this for
>matically you.
yperties of Property styleClass takes previously defined CSS style classes (you can
alue, Cre- = apply more than one). File stylesheet.css (under Web Pages > resources in the

Projects window) is the default style sheet for your projects. We cover style,
StyleClass and using Creator’s preconfigured Themes in Chapter 7.

re unique

e compo- Text field components can take a converter (specified in property con-
ingeit (as verter) and a validator (property validator). The validate and valueChange
Che label properties (under Events) expect method names and are used to provide cus-
text field. tom validation or to process input when the component’s text value changes.

t input is
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Click on the text field component (again) in the design canvas until Creator
displays a gray outline around the component. Now type in some text and fin-
ish editing with <Enter>. The text you type appears opposite property text in
the Properties window. To reset the property, click the customizer box opposite
property text. Creator pops up a Property Customizer dialog, as shown in
Figure 2-6. Select Unset Property. This is a handy way to return a property
value to its unset state.

CyUsebinding  (3) Use value

‘Th;s is some text‘]

g CK H Unset Property, H Cancel
b

Figure 2-6 Property customizer dialog for property text

Each property’s customizer is tailored to the specific property. For example,
select the Login button on the design canvas. In the Properties window, click
the property customizer box opposite property style. Creator pops up an
elaborate style editor. Experiment with some of the settings (change the font
style or color, for example) and see how the button changes in the design view.
You can also preview the look. Right-click inside the design view and select
Preview in Browser. Figure 2-7 shows a preview of Loginl with a different
appearance for the Login button.

Palette

Creator provides a rich set of basic components, as well as special-function
components such as Calendar, File Upload, Tab Set, and Tree. The palette is
divided into sections that can be expanded or collapsed. Figure 2-8 shows the
Basic Components palette, which includes all of the components on Pagel of
project Loginl. In Figure 2-8 you also see the Layout and Composite Compo-
nents palette.

The palette lets you drag and drop components on the page of your applica-
tion. Once a component is on a page, you can reposition it with the mouse or
configure it with the Properties window.

Figure 2-9 shows the Validators and Converters palette. Creator’s converters
and validators let you specify how to convert and validate input. Because con-
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Figure 2-7 Preview in Browser for Loginl
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Image
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Hidden Field
Calendar
File Upload

o Tree

Anchor
Message

Message Group

Code Clips
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Grid Panel
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-] Form

(%] Add Remave List
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Figure 2-8 Basic, Layout and Composite Components palette
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version and validation are built into the JSF application model, developers can
concentrate on providing event handling code for valid input.

‘Palette

& Basic

H Layout

+ Composite

= Walidators

<8 Dauble Range Validator

i Length Validator

fowg Long Rangs Validator

=i Converters :
B Big Decimal Converter

Boolean Converter

Byte Converter
Calendar Corwerter

&
b d

Character Converter

Date Time Converter
+ Dauble Carwerter
Float Converter

% Integer Converter

& Long Converter
Murnber Converter

¥ Shart Converter

Sql Timestarnp Convertar

e Clips | 4} Corponents

Figure 2-9 Creator Validators and Converters Components palette

You select converters and validators just like the UI components. When you
drag one to the canvas and drop it on top of a component, the validator or con-
verter binds to that component. To test this, select the Length Validator and
drop it on top of the userName text field component. You'll see a length valida-
tor lengthvalidatorl defined for the text field’s validator property in the
Properties window. ‘

Note that components, validators, and converters all have associated icons
in the palette. Creator uses these icons consistently so you can easily spot what"
kind of component you're working with. For example, select the Login button
component on the design canvas and examine the Outline view. You'll see that
the icon next to the button components (Login and Reset) matches component
Button in the Basic Components palette.

Outline

Figure 2-10 is the Pagel Outline view for project Login1. (Its default placement
is in the lower-left portion of the display.) The Outline window is handy for
showing both visual and nonvisual components for the page that's currently
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2lopers cap od in the design canvas. You can select the preconfigured managed

RequestBeanl, SessionBeanl and ApplicationBeanl. These JavaBeans

display

beans,

mponents hold your project’s data that belong in either request (page), ses-
;Oon or application scope, respectively. (We discuss scope issues for web appli-
cation objects in “Scope of Web Applications” on page 224.)
0 Iine” <t x
" pagel’
head!: Lagin 1
: buady1
(7] formi
flabel1: Members Login Text Field Component “userName”
TuserName
messagel
! password
message
; login: Login
: fg V) reset; Reset Length Validator “lengthValidator1”
Looof lengthvalidater 1 |
& RequestBean] e Managed Bean RequestBean1
& SessionBeant £ Managed Bean SessionBean1
& applicationEsant : ; ; > Managed Bean ApplicationBean1

Figure 2-10 Creator’s Outline window for project Loginl

Some components are composite components (they contain nested ele-
ments). The Outline window shows composite components as nodes that you
can expand and compress with ‘+ and - as needed. Suppose, for example, you
select grid panel for layout. When you add components to this grid panel, they
appear nested underneath the panel component in the Outline view.

The length validator component on the userName text field appears as com-
ponent lengthvalidatorl in the Outline view. Select the length validator and
examine it in the Properties view. Specify values for properties maximum (use
10) and minimun (use 3). This limits input for the userName text field compo-
nent to a string that is between 3 and 10 characters long.

gth valida-
erty in the .

jated icons -

"spot what Now let’s look at the Projects window.

igin button =

'l see that PrOjeCtS

:omponent
Figure 2-11 shows the Projects window for project Login1. Its default location
is in the lower-right corner. Whereas the Outline view displays components for -
individual pages and managed beans, the Projects window displays your

_ entire project, organized in a logical hierarchy. (Since Creator lets you open
placement more than one project at a time, the Projects window displays all currently
handy for Opened projects.) Project Login1 contains three JSP pages under the Web Pages

scurrently  node: Pagel.jsp, LoginGood.jsp, and LoginBad.jsp. Double-click any one of
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them to bring it up in the design canvas. When the page opens, Creator dis
plays a file name tab so you can easily switch among different open files in th,
design canvas.

‘projectg' . S R— 3 o

1 resources
-y stylesheet.css

Themes
Page Mavigation
Managed Bzans
Request Bean
Application Bean
Session Bean

ApplicationBeani.java
'_ Bundle. proparties

5 LoginBad.java

») LoginGood.java
Pagel.java
RequestBeani.java

H SessionBeanl java
-2 Ubraties

i@ Data Source References

Figure 2-11 Creator’s Project Navigator window for project Loginl

When you create your own projects, each page has its own Java componen
“page bean.” These are Java classes that conform to the JavaBeans structure w
mention in Chapter 1 (see “JavaBeans Components” on page 13). To see th
Java files in this project, expand the Source Packages node (click on the ‘+)
then the loginl folder. When you double-click on any of the Java files, Creato
brings it up in the Java source editor. (We’'ll examine the Java source edito
shortly.) Without going to the editor, you can also see Java classes, fields, con
structors, and methods by expanding the “+' next to each level of the Java file.

The Projects view displays Creator’s “scoped beans.” These are pre-config
ured JavaBeans components that store data for your project in different scopes
You can use request scope (Request Bean), application scope (Applicatio
Bean), or session scope (Session Bean). Many of the projects in this text ad
properties to these beans. We discuss JSF scoping issues in Chapter 6 (see “Pre
defined Creator Java Objects” on page 226).
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The Projects view also lists the resources node, which lives under the Web
. node. The resources node typically holds file stylesheet.css and any
.Pagcx) files. Creator uses the libraries listed in the Libraries node to display,
lmfﬁt and deploy your application. These class files (compiled Java classes) are
bu{tc/{“m special archive files called JAR (Java Archive) files. You can see the
Sto;ee a5 well as the contents (down to the field and method names) of any JAR
ET; b;, expanding the nodes under Libraries. We show you how to add a JAR
file to your project in Chapter 13 (see “Add the asg.jar Jar File” on page 595).

Files

The Projects window shows you a logical view of your project. Sometimes you
may need to access a configuration file that is not included in the Projects view.
In such a case, use the Files view, as shown in Figure 2-12.

"Files BPRPRE———— b=

3} faces-config.xml

)] managed-beans.xml
navigation. i

1) sun-web.xml

web, xml

[ resources

i LoginBad.jsp

: oginGoad. jsp
- (BjpPagel.jsp
o7 build, xenl

Figure 2-12 Files view for project Login1

The Files view shows all of the files in your project. For example, expand
node web > WEB-INF and double-click file web.xml. Creator brings up file

V\{eb.xml in a specialized Creator-configuration XML editor, as shown in
Figure 2-13,

35
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@} Welcome  x jig Pagel x e web.xml x|

%Genera\iSer\flets Fiters Pages XML @ General

1 General

Display Name: |

Description: | |

[ Distribut able

Session Timeouk: | } min.

@ Context Parameters

Bl Web Application Listeners

Listener Class Description

add...

Figure 2-13 Editing file web.xml

File web.xml lets you set various project-level configuration parameters, .
such as Session Timeout, Filters, or special error pages. Close this file by click
ing the small x in the web.xml file tab.

JSP Editor

As you drop components on the page and configure them with the Properties

window, Creator generates JSP source code for your application. You can view ’
the JSP representation of a page by clicking the JSP button in the editing tool-.
bar, as shown in Figure 2-14. ‘

Normally, you will not need to edit this page directly, but studying it is a
good way to understand how Creator Ul components work and how to man-
age their properties. You'll see a close correspondence between the JSP tags
and the components’ properties as shown in the Properties window. If you do
edit the JSP source directly, you can easily return to the design view. Creator
always keeps the design view synchronized with the JSP source.

Tags in the JSP source use a JSF Expression Language (EL) to refer to meth-
ods and properties in the Java page bean. For example, the login button’s
action property is set to #{Pagel.login_action}, which references method
login action() in class Pagel.java.

Creator also generates and maintains code for the “page bean,” the Java
backing code generated for each page. Let’s look at the Java source for
Pagel.java now.

Facebook's Exhibit No. 1003
Page 0068

Page 68 of 328

GOOGLE EXHIBIT 1003



2.2 Creator Views 37

Design | )P | ;
P ﬁ" encoding="UTF-5" 2>

JSP :
button h hinding="#{Pagal.pagel}” id="pagel“>
L} html binding="#{Pagel.htnll}” id="htall">
1 <ui:head binding="#{Pagel.headl}” id="headl” title="Login 1">
<ui:link binding="#{Pagel.linkl}"” 1d="1ink1l" url="/resources,.
- < fui :head- o
) <ui:body binding="#{Pagel.bodyl}” id="bodyl” style="-rave-layout:
: 1:‘:} <ui: form binding="#{Pagel.fornl}" id="forml” wirtualFormsConi:
Creator <ui:label hinding="#{Pagel.labell}” id="lahell” labellew:
Ul : <ui:textField hinding="#{Pagel.userlane}” id="userMName"” ] :
Componems : style="left: 48px; top: 7Zpx; position: absclute” :oc‘;
___;_____» <ui:message binding="#{Pagel.neszagel}” for="userName" isgh

<ui:passyordField binding="§)Pagel.passyord}”™ id="passwor’
style="left: S5dpx. top: 119px: positiom: abszolute” Lo
<ui:message bhinding="#{Pagel,nessage2}” for="password” i
<uihutton action="#{Pagel.login_action}” binding="§{FPags .
atyle="coloxr: gray; font-family: Georgia, 'Times New i
<ui:hutton action="§{Pagel.reset_action}” binding="#{Pagc.
<fui : foxm> .

- <fuithody>>
parameters, _thtml>
ile by click- re . B

T27:12 wsl

Figure 2-14 Pagel.jsp XML Editor

> Properties
o can view Java Source Editor
diting tool-
Click the Design button and return to the Pagel design view. As you build your

lying it is a application, not only does Creator generate JSP source that defines and config-

ow to man- ures your component, but it also maintains the page bean. For example, Cre-
he JSP tags ator makes it easy for you to code event handlers (methods that perform
~. If you do customized tasks when the user selects an option from a drop down list or

ew. Creator clicks a button). Double-click button Login in the design view. Creator gener-

ates a default event handler for this button and puts the cursor at the method in
the Java source editor. If this method was previously generated (as it was here),
Creator brings up the editor and puts the cursor at the method, as shown in
Figure 2-15. Here you see method 1ogin action() in file Pagel.java.

You can always bring up a page’s Java code by selecting the Java button in
the editing toolbar. This Java file is a bean (conforming to a JavaBeans struc-
ture) and its properties consist of the components you place on the page. Each

‘er to meth-
rin button’s
ces method

1,” the Java
source for
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Desigr - J5P

5 IR

private void _imit () throws Exception {
lengthValidatorl.setMaximun(10)
lengthValidatorl.setMinimum{3) ;

Java /

!
|
i
Button L

i
LOgIn private String myUserName = "ravedu”:
?;:/2?1? private String myPassword = “ravedu”;
Handler . ] . . .
&l public String login action{) {
i.t (nyUserlane. equals {useriane, getText (1] «s
nyPassvord. equals (password.getText (1)) {
: return "leginSuccess™;
Reset } else return "loginFail";
Button - }
Event ™~
Handler
R public String reset action(} {
/ forml.discardSubmitted¥alue {userName} ;
fornl.discardSubmittedValue [passwvord);
Code
Folding userNsne.setText (") ;
Handle pasavord.setText ("}
return null; :
L y :
3 :
2
£ G x
299:9 INS

Figure 2-15 Pagel.java in Java source editor

component corresponds to a private variable and has a getter and setter. Thi
allows the JSF EL expression to access properties of the page bean.

All of Creator’s editors are based on NetBeans. The Editor Module is a full
featured source editor and provides code completion (we show an example
shortly), a set of abbreviations, and fast import with <Alt+Shift+I>. The editor
also has several useful commands: Reformat Code (handy when pasting code
from an external source), Fix Imports (adds needed import statements as we
as removes unused ones), and Show Javadoc (displays documentation for:
classes and methods). There are more selections in the context menu (right-
click inside the editor to see the menu). Sections of the Creator-generated code
are folded by default to help keep the editing pane uncluttered. You can unfold
(select +) or fold (select ’-") sections as you work with the source code. You can
also view line numbers: place the mouse in the blue left-margin, right-click,
and select Show Line Numbers. ~

To see the set of abbreviations for the Java editor, select Tools > Options from
the main menu bar. The Options dialog pops up. Under Options, select Editing
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n, right-click,

Options from
select Editing

2.2 Creator Views

ings > Java Editor. On the right side of the display, click the small
next to Abbreviations. Creator pops up the window shown in

- Editor Sett
editing POX
Figure 2-16-

Expanded String Add...

public static final boolean ! Edit..
public static final int
bsfs public static final String
| fora for (int i = 0; i = | length; i++) {}
| fori for (Iterator | = |.iterator; i.hasMext();) { Object o = (Objec...
| psf private static final
& psfb private static final boolean
psfi private static final int
psfs private static final String
pst printStackTracel);
cerr System,err printin{"{");
sout System,out.printing"]");
tds Thread, dumpStack();
e trv { [} catch (Exception ex) { log{"Error Description”, ex);};
tref try 4 [F catch (Exception ex) {  log{"Error Description”, ex);...
trf try { |} finalte ¢
bn throw new
U bwne throw new Errar();
U bwni throw naw InternalError();
wh while () {+
E OK p\{}_] { Cancel } [ Help ]

Figure 2-16 Java source editor list of abbreviations

The window lists the abbreviations in effect for your Java editor. (You can

edit, add, or remove any item.) For example, to place a for loop in your Java

. source file, type the sequence fora (for array) followed by <Space>. The editor
generates

for

}

(int 1 = 0; 1 < .length; i++) {

and places the cursor in front of .length so that you can add an array name.
(- lengtnh refers to the length of the array object. This code snippet lets you eas-
ity loop through the elements of the array.)

The Java source editor also helps you with Java syntax and code completion.

All Java keywords are bold, and variables and literal Strings have unique col-
ors.
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When you add statements to your Java source code, the editor dynamicau}
marks syntax errors (in red, of course). The editor also pops up windows t,
help with code completion and package location for classes you need to refer,
ence (press <Ctrl+Space> to activate the code completion window). If available
code completion includes Javadoc help. For example, Figure 2-17 shows th
code completion mechanism as you highlight method equals() and pres
<Ctil+Space>.

4 B
=~
_ 'java.lang.String
FE puk
1N 3 public final boolsan equalsiObjact anObj=ct)

Compares this string to the specified object. The result is true if and only if the
argument is not mall andis a §tring object that represents the same sequence of
characters as this object.

" |Parameters:

7]
4 ou %

anfhject - the object ko compare this String against,

,' Returns:

]
]
1
11

trueif the String are equal; false otherwise,

See Also:

—

java, lang. String. compareTo (java. lang. String)

ava.lang, String, equalsIgnoreCaze(java, lang,

pri
private String nyPasswordiava.langString.equals®

& public String leogin actio; ® hoolean equalsIgnoreCase(String anotherString)
if (myUserName uzerName.getText ()) s
myPassword.equals {password.getText (1)) {
return "loginSucress™;
} else return “loginFail’;

i
299:30 (INS

Figure 2-17 Java source editor code completion

When you use the down-arrow to select the second method, equalsIgnore-
Case (), the help mechanism displays its Javadoc documentation. (To retrieve
Javadoc documentation on any class in your source file, select it and press
<Ctrl+Shift+Space>.) The Java Source editor is discussed in more detail in Chap
ter 4 (see “Using the Java Source Editor” on page 136).

When the Java source editor is active, Creator also activates the Navigato
window, as shown in Figure 2-18. The Navigator window lets you go to a
method or field within the Java source editor by clicking its name in the win-
dow. In Figure 2-18, the cursor hovers over method destroy (), displaying
help in a tooltip.
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dynamicany‘

If available,
7 shows the
) and pregg

Design  15P éJava

f o

g _init() A0

@ destyoy(} public void destroy ()
Tp getsbflicationBeantt
© getBody1()

Caflback method that is called after rendering is complated For this request, if
init () was called (regardiess of whether or nat this was the page that was

@ QEtFO"mIQ lckually rendered), Customize this methad to release resources acquired in the
getteadi) init(), preprocess(), or prerender () methods {or
@ getHtml1(} lcquired during execution of an event handler),

getlabell()

@ netlengthyalidator 1(
@ gettink1()

© getloging) L }
@ getMessagel()
@ getMessage2()
@ oetPacel(}

Overtides destroy in com, sun.rave, web.ui,appbasa. AbstractPageBaan
7 E

e e e T a==s

Eﬁ public 3tring reset action{) {

o ACY vt & b T FaT wn frrmmaeTTamn b o

i |

& :
297:5 NS

Figure 2-18 Navigator view and help for method destroy() displayed

Code Clips Palette

When the Java Source editor is displayed, Creator replaces the Components
palette with the Code Clips palette, as shown in Figure 2-19. Here we show
several sections, including the code clips for Application Data. Highlight clip
Store Value in Session in this section. If you hold the cursor over the clip name,
Creator displays a snippet window. You can drag and drop the clip directly
into your Java source file.

To view or edit a clip, select it, right-click, and choose Edit Code Clip.
Figure 2-20 shows the Store Value in Session code clip.

The Code Clips palette is divided into categories to show sample code for
different programming tasks. For example, if you click Application Data, you'll
see a listing of clips that let you access application data from different scopes in
your web application.

ilsIgnore
(To retrieve -
“and press
il in Chap-

- Navigator
ou go toa
in the win-
displaying
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' Palette @ X
s Samples

Database and Web Services
application Data :
3 Retrieve Yalue from Session

Retriave Yalue from Application
Stare Yahse in Application

} Retrieve Value from Request
<3 Store Value in Request

i= Web 8pp Functions

3 send Email

i Log Messages

i=Java Basics e
Get JavaBean Property
If-Then-Else

Swikch Statement

For Loop

Wwhila Loop

Atray Iterator

Try Catch Exception
Concatenate Strings
Compare Substrings

Convert Integer to String

Convert String to Integer
Enterprise Java Baans :
Java Script

<

V7 Code Clips |

Figure 2-19 Java Clips Palette

Save Changes J [ Cancel }

Figure 2-20 Code Clips Editor
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page Navigation Editor

the Java Source window and examine method login_action().

/] see that login_action () returns one of two Strings (either "loginFail"
YOL,: e - nsuccess") to the action event handler. The action event handler then
le(;qtlhe String on to the navigation handler to determine page flow. Let’s
e Navigation editor now.

Return tO

or
ass
look at the Pag
1. From the top of the Java source window, select the Design button. This
‘ returns you to the design canvas for this page.
2. Now right—click in the design canvas and select Page Navigation from the
" context menu. Creator brings up the Page Navigation editor for project
Login1, as shown in Figure 2-21.

cirome % | ) Pagel x| 9 = Page Mavigation x|

%Nawgation ! Source

LoginGood.jsp

Figure 2-21 Page navigation editor for project Login1

There are three pages in this project. The Page Navigation editor displays
each page and indicates page flow logic with labeled arrows. The two labels
originating from page Pagel.jsp correspond to the return Strings in action
method login action().

Chapter 5 shows you how to specify navigation in your applications (see
“Page Navigation” on page 188). The Page Navigation editor is also a handy
way to bring up any of the project’s pages: just double-click inside the page.
Once you've visited the Page Navigation editor, Creator displays a file tab
called Page Navigation so you can easily return to it.
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Before we explore our project any further, let’s have you deploy and run thy
application. From the menu bar, select Run > Run Main Project. (Or, click the
green Run arrow on the icon toolbar, which also builds and runs your project‘)

Output Window

Figure 2-22 shows the output window after building and deploying project
Loginl. Creator uses the Ant build tool to control project builds. This Ant builg
process requires compiling Java source files and assembling resources used b
the project into an archive file called a WAR (Web Archive) file. Ant reads its
instructions from a Creator-generated XML configuration file, called
build.xml, in the project’s directory structure.

a

LE X

:Output - ioginl frun)

compile:

compile-jsps:

pluto-hack-web-xml-run:

portlet-container-deploy:

jsCreatorDist:

run-deploy:

Incrementally deplofing Loginl_ localhost:Z4848_ zerver

Completed incremental distribution of Loginl

Incrementally redeploying Loginl localhost:Z4848 server

Start registering the project's server resources

Finished registering server resources

fwhile redeploying, trying to stop the application in target server completer
:Daploymenb of application Loginl completed successfully
run-dizplay-browser:

Erowsing: http:/Fflocalhost: 28080/ Loyinl/

T G
BUILD SUCCESSFUL (total time: § seconds) i

Figure 2-22 Output window after building and deploying project Loginl

If problems occur during the build process, Creator displays messages in the .
Output window. A compilation error with the Java source is the type of error .
that causes the build to fail. When a build succeeds (the window shows BUILD
SUCCESSFUL, as you see Figure 2-22), Creator tells the application server to
deploy the application. If the application server is not running, Creator starts it .
for you. If errors occur in this step, messages appear in the Qutline window -
from the application server. ‘

Finally, it'’s possible that the deployment is successful but a runtime error
occurs. In this situation, the system throws an exception and displays a stack .
trace on the browser’s web page. Likely sources for these errors are problems
with JSF tags on the JSP page, resources that are not available for the runtime
class loader, or objects that have not been properly initialized. ‘
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| the build/deployment process is complete, Creator brings up your
with the correct URL. (Here the status window displays “Browsing;:
Localhost:28080/Loginl/.”) To run project Loginl with the Sun
Application Server, Creator generates this web address.

Wher
prowser
nttpP : / /
pundled

rying project http: //1ocalhost :28080/Loginl/
You use localhost if you're running the application server on your own
Ant reads ; machine; otherwise, use the Intern‘et ad.dress or ho/st name where the server is
file, calle running. The port number 28080 is unique to Sun’s bundled J2EE application
2 v server. Other servers will use a different port number h_erg o
Note that the Context Root is /Loginl for this application. The application
server builds a directory structure for each deployed application; the context
root is the “base address” for all the resources that your application uses.
Figure 2-23 shows the Login1 project deployed and running in a browser.
The Password field’s tooltip is displayed. Both the User Name and Password
input fields have asterisks, indicating required input. Type in some values for
User Name and Password. If you leave the User Name field empty or type less
than 3 characters or more than 10, you'll get a validation error. (The minimum
and maximum number of characters only apply if you added a length validator
earlier.) The correct User Name and Password is “ravedu” for both fields.

ompleter

Go

isages in the

Bookmarks  Tools

Help

[} togin1

Cll

* User Hame:

Members Login

|ravedu

-+

Perxasn &
i

!

ype of error * password:
hows BUILD
mn server to
ator starts it
ne window

Please type in your password

ntime error
lays a stack
‘e problems
the runtime

Figure 2-23 Project Login1 running in a browsetr

If you supply the correct values and click the Login button, the program dis-
Plays page LoginGood.jsp. Incorrect values display LoginBad.jsp.
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It's time now to explore the Servers window, located in the upper-left por.
tion of your Creator display. Click the tab labeled Servers to see this window.

Servers

Figure 2-24 shows the Servers window after you've deployed project Login1,
Various categories of servers are listed here, including Data Sources, Enterprise
JavaBeans, Web Services, Deployment Server, Remote Deployment Servers,
and Bundled Database Server.

(Servers 4@ %
-G Data Sources

Enterprise Java Beans

7 Currency Converter

2 Helloworld Application
2 Jump Start Cycles
LoanElB

-f8 Travel Center

% Web Services

Ea Samples

S8 Jump Start Cycles
pheployment Server

[=R

g

Deployed Components
@ {DictionaryService
fLogini ~—————————— Deployed project Login1
_vs_ga Jhello-jaxrpe

1 30) flavaTravellerservice
Resources

E Remote Deployment Servers
v E3efundied Database Server

Figure 2-24 Servers window

The Data Sources node is a JDBC database connection. Creator bundles a
database server and the Data Sources node connects to the bundled database
by default. You can configure a different database. Creator comes configured
with several sample databases, which are visible if you expand the Data
Sources node.
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sper-left poy.

creator Tip
is window,

The Database Server must be running to inspect the sample database tables.
If the Bundled Database Server is not running, right-click node Bundled
Database Server and select Start Bundled Database.

oject Loginy.
s, Enterprige
lent Servers,

I

Let's expand the Travel > Tables node and view the database tables. As you
select different tables, Creator displays their properties in the Properties win-
{ow. Expand a table further to examine its database table field names, as
;hown in Figure 2-25. Here, we expand table PERSON, displaying field names
PERSONID, NAME, JOBTITLE, and FREQUENTFLYER.

‘Servers ax

U] Data Sources ~

FF CARRENTAL
FLIGHT

HH HoTEL

A WORELATION
~{H} PERSONID

@ MNAME

—F J0BTITLE

. t-F FREQUENTFLYER

b-f TRIP

HE TRIPTYPE

&£ VALIDATION_TABLE W

Figure 2-25 Inspecting the Travel Database tables (Person)

When you double-click a table name, Creator displays the data in the editor
pane with a default query, as shown in Figure 2-26. You can close the table
view by clicking the small x on the Query 1 tab. We discuss creating web appli-
cations that access databases in Chapter 9 (see “Accessing Databases” on
page 372).

The second resource in the Servers window is the Enterprise JavaBeans
node. Creator has a few sample E]Bs deployed on the bundled Application
Server, which you can access within your projects. Expand node Enterprise Jav-
aBeans > Travel Center > TravelEJB, as shown in Figure 2-27. The TravelE]B
provides some of the same data as the Travel database. With Creator, you can
bind data to components exactly the same with EJBs as you can with data
source tables. We show you how to use EJBs in Chapter 11.

T bundles a
ed database
i configured
d the Data
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@} Welcome x|

agel  x |4 o Page Navigation

Data Source: Travel, Last Run Feb 9, 2006 3:15:30 PM PST

o

PERSONID MAME JOBTITLE FREQUEN... E
1 sble, Tomy CED Lrie
2 Black, John  |CTO true
3 Kerit, Richard WP brine
4 Chen, Larvy  WRJCKO - 5G,,, fFalse
S Donaldsor, ... VP falsa
& rurrell, Tony  [¥P - SFE false

€ Row(s),

Figure 2-26 Display data from the Person table

i{Servers o ) @ x Servers @ %
-8 Enterprise Java Beans e ‘Web Services 2
&@ Currency Converker Samples
-8 Helloworld Application @ worldTime
& Jump Start Cycles } Kignitehews
% LoanEls ' KigniteStatistics
-F Travel Center @ UsWeather
=-dihy TravelEJR RigniteQuuates
€ getCarRental . GoogleSearch
- &y getDepartureFlight 2y doGetCachedPage
- @ getHotelReservation % doSpellingSuggestion
- @y getPersonByld - @, doGoogleSearch
b @y getPersons jé;i AmazonECommerce
- getReturnFlight Jump Skart Cycles
€y getTripFlights pPeplayment Server
y getTripsByPerson s 39 Deployed Components
&@, Resources
‘L:E] Remate Deployvment Servers
= pPundled Database Server

Figure 2-27 EJB and Web Services resources shown in the Servers window

Another server resource is Web Services, which provides access to remote -
APls from Creator applications. This requires the cooperation of several Java
technologies, which we discussed in Chapter 1. The Creator installation
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. Judes a client to access the Google Web Services. In Chapter 10 we show you
incitt to create an application with the Google web service APL. The Google
ho\A{ h web service methods are shown in Figure 2-27.

Se#ﬁe pundled Deployment Server allows you to deploy and run Creator
lications on your machine. The Deployed Components node shows you the
deployed components (including the Loginl application you just
deployed)' Erom the Deployment Server node, you can start and stop the
gerver, access the Administrative Console, or view the server’s log (right-click
Deployment Server to view the context menu with these options).

un Query

app
currently

creator Tip

P

The appl ication server must be running for access to the administration
console. Use user name admin and password adminadmin.

Debugging Windows

Creator has a debugger that lets you perform typical debugging tasks, such as
setting breakpoints, tracing the call stack, tracking local variables, and setting
watches. Use the View > Debugging menu to choose which debugging win-
dows to enable, as shown in Figure 2-28.

| < Local varisbles alt+shift+t

7 Watches Alt+shift+2
7 Call stack Ale+Shift+3
{4y Classes Alc+Shift+4
{1 Breakpoints Alt+5hifk+5
B Sessions Alb4+5hift+6
L Threads Alk45hift+7

on Sources Alt+Shift+8

\QHTTP Monitor  Ceri+Shift+5 3

Figure 2-28 View > Debugging Menu Choices

To run your application in “debug mode,” click on Run > Debug Main
Project from the menu bar. The application server has to stop and restart if it’s
not already in debug mode. In Chapter 14 we walk you through the debugger
options, setting breakpoints, stepping through code, and other debugging
activities,

v

5 to remote
everal Java
installation
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Creator Help System

The Creator Help System is probably the most useful window for readers ney
to Creator. This help system includes a Dynamic Help display, search capabi.
ity, contents, and an index. The easiest way to access the help system is to select
Help > Dynamic Help from the main menu. The selections displayed are con.
text sensitive. .

As an example, in the Pagel design view, select one of the Message compo. i
nents and choose Help > Dynamic Help. Creator displays a help window with
topics relating to the message component as shown in Figure 2-29.

{Dynamic Help o o T x

essage Group Component

Message Camponent Properties Window
Binding Component Properties

Warking 'With Components

Component Tasks: Quick Reference
Companent Web Tutorials

Abaut the Palette

Intraducing the IDE

Java Reference
1 JavaServer Faces (15F) Reference
1 5un Web UL Component: Reference F
Application Model Reference .
J5F Component Library (J5FCL) Reference
] Data Provider Reference
] RowSet Reference 2
1 Portlet Reference
Java studin Creator Tutaorials
4% JavaServer Faces Technology N
e dy? I5F Central ti
-4 Java Tutarial C
Figure 2-29 Dynamic Help window
C

When you double-click a selection, Creator displays the help information (see
Figure 2-30).
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2.3 Sample Application

Message Component
Ses Alsy Ilzﬁ‘_g[ﬁ

You can drad the Message cnmpnnent‘é*}from the Palette's Basic
categoty to the visual Designer to create a message relatedto a
single component. The bvo message corponents, Message and
Measadge Group, display error messages far component rendering
and validation. Message displays error messages far a specific
cornponent.

e Dragoing a message companent from the palette to the page
results in a message item with the suunary property setto true
and the detail property setto false.

@ Yoy can press Ctrl-Shift and drag the Message component to
another component to link the Ear praperty to the other
companent and display messages for that cormponent.

» iessages are automatically shown as the resultof a validation or
ather component related arrar.

You can send yaur own error text to a Message companent by calling
the corresponding Java object's info, error, fatal, orwarn

Figure 2-30 Creator Help system

2.3 Sample Application

Now that you're comfortable with Creator, let’s create a simple web applica-
tion. Even though this application is simplistic, it shows some of the power in

Creator. Figure 2-31 provides a preview of this web application.

Create a Project

Close project Login1 if it’s open.

1. From the Projects window, right-click the project node Loginl and select

Close Project from the context menu.

2. From Creator’s Welcome Page, select Create New Project. From the New
Project dialog, under Categories select Web and under Projects select JSF

Web Application. Click Next.
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IThe text vou enter here will be echoed below,

Hello, World Wide Web

Figure 2-31 Web application Echo running in a browser

3. In the New Web Application dialog, specify Echo for Project Name and click
Finish.

After creating the project, Creator comes up in the design view of the edito
pane. You can now set the title.

4. Select Title in the Properties window and type in the text Echo. Finish by
pressing <Enter>.

Add Components to the Page

Creator makes the Components palette visible after you create a project. Using
the design editor, you'll add three components to the page: a label, a text field
and a static text component. Figure 2-32 shows the design view with all the
components added to the page.

1. From the Basic Components palette, select Label and drag it over to the
design canvas. Drop it on the page, near the top on the left side.

2. The label remains selected after you drop it on the page. Supply the text
Type in some text. You may use <b> <i> for formatting. Finish by pressing
<Enter>. Creator sets the text property to this text (verify this in the Proper-
ties view) and displays the text on the page. The default font setting (prop-
erty labelLevel) for a label’s text is Medium(2), which can be changed in
the Properties window.
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g Welcome X (B

P Java i Ay iBD Any Siee E

Type in some text, You may use <h> <i> for formatting. .

Figure 2-32 Project Echo in the design view

3. From the Basic Components palette, select component Text Field and place it

on the design canvas underneath the label you just added.

4. Make sure the text field is selected. In the Properties window under Behav-
ior, change its toolTip property to The text you enter here will be echoed
below. Finish with <Enter>. This will appear as a tooltip when the user hov-
ers the mouse over the text field in the browser.

. From the Basic Components palette, select Static Text component and place
it under the text fietd. Resize it so that it is approximately 11 grids wide, as
shown in Figure 2-32.

6. Select the static text component. In the Properties window under Data,

uncheck property escape. This allows HTML formatting tags to pass through
unaltered to the browser.

w

. Finish by

roject. Usin, You've finished adding the components. Now you will use property binding

to bind the text field component text property to the static text component

with all th text property. Here’s how.
1. Select the static text component (staticTextl), right-click, and choose
T to the Property Bindings from the context menu. Creator brings up the Property
Bindings dialog as shown in Figure 2-33.
tht_? text 2. Under Select bindable property, choose text Object.
2ssing 3. Under Select binding target, expand Pagel > pagel > html1>body1 > form1 by
the Proper- clicking the ‘+ at each level.
ting (prop- 4. Select component textField1 (the text field component you added). Expand
1anged in the component by clicking '+ on textFieldl and select text Object. (The
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anbblClick String

onMouseDown  Shing
onMouseMove  String
onMousaOut  Shing

toolTip  String

visible  boofean

Select bindable property Select binding target:
F A
] praperty: rendererType
converter  Converter property: rendersChildren
escape  boofean property: required Soofedt
onClick Shring property: style String

property:
property:
; tablndex Intege

ropert:

onMouseOver  String property: toolTip String
onMouselp  String & property: trim  Boolean
style Shing i $ property: validator Metho
styleClass  String & property: value Object
%4 property: valueChangelListe

styleClass Siing. .
submittedvalue

property: visible Boofean

B A R

#i-1A] staticText1 StaticToxt ¥

" ddvanced (3 All

() Default

i

Current binding For text property:

,[ Clear l

i F\DDIYD\\i

| #{Pagel textFisld] text}

News binding expression:
| gel textField! bet}

Figure 2-33 Property Bindings dialog

5. Click the Apply button. (If you don't click the Apply button, Creator doesn't
set the property binding.) Under Current binding for text property, you
should see the following JSF EL expression

#{Pagel.textFieldl.text}

6. Click Close to finish

So, what did all this accomplish? You've just configured property binding on
the static text component (id staticText1). This means JSF gets the text prop-
erty (the text that is displayed on the page) for staticTextl from the text field’s
text property (component textFieldl). This, in turn, means that whatever
you type in for input will be echoed in the static text’s display when you press
<Enter>, Note that Creator and JSF made all this possible without you writing
any Java code!

Is a button necessary to submit the page? As it turns out, when you hit
<Enter> after entering text in the text field, the default action is to submit the
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2.4 Key Point Summary

This puts the JSF life cycle events in motion and the page is rendered

age- he new text displayed in the static text component. We discuss the JSF life
Wlthtivents in detail in Chapter 6 (see “The Creator-JSF Life Cycle” on
C);CI: 220). Because you unchecked the escape property, any formatting tags

unaltered by the component and passed directly through to the browser.
are Wi

peploy and Run

you've finished creating the application. Now it’s time to build, deploy, and
cun it. From the menu bar, select Run > Run Main Project (or select the Run
Main Project green arrow icon on the toolbar). Creator builds the application,
deploys it, and brings up a browser with the Echo web application running.

Figure 2-31 on page 52 shows what the browser window displays after you
type <b>Hello</b>, <i>World Wide Web inside the text field followed by <Enter>.
Note that bold tags mark the word Hello and italic marks the phrase World
Wide Web. The text field tooltip appears as the user hovers the mouse over the
text field component.

This completes our tour of Creator. The next chapter provides a detailed
description of the Creator Ul components, validators, and converters.

2.4 Key Point Summary

* Creator has multiple windows to give you different views of the project that
you're working on. The windows can be sized, docked and undocked, or
hidden.

¢ From the main menu, select View and the desired window name to enable
viewing,.

* Use the Welcome Window to select a Project to open or to create a new
project.

* The design canvas allows you to manipulate components on a page and
control their size and placement. Grid lines provide an easy way to align
components.

* Use the Components palette to drag and drop a component on the design

canvas.

Use the Converters and Validators sections in the palette to select data

converters and input validators for your project.

The Properties window allows you to inspect and edit a component’s

properties. Each component type displays a different list of properties.

A component’s text attribute typically contains text that is rendered on the

Page (such as labels on buttons, input text fields, and static text fields). Use

the toolTip property to create a tooltip for the component and the style

55
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property to change font characteristics. Property styleClass lets you apply
previously defined style definitions.

* You can apply Property Binding and “connect” the value of one component
to another or to a data object in request, session, or application scope.

¢ The Outline window shows all of the elements on a page, including
nonvisual components such as converters, validators, or EJB or Web Serviceg
clients.

* The Projects view gives you a logical view of your project, including Web
Pages, Source Packages, Libraries, the pre-configured beans, and Page
Navigation.

* The Files view lets you see all the files in your project.

* The JSP Source editor displays a page’s source. Most of the page includes JSF
tags for components and their properties. As you make changes to your
pages in the design canvas, Creator synchronizes the JSP and Java source.

* Creator’s editors are based on NetBeans and reflect a rich functionality for
editing Java source, JSP source, and XML files.

¢ The Java Source editor displays the Java source for each “page bean,” a
JavaBeans component that manipulates each page’s elements. You typically
place event handler code or custom initialization code in the Java page bean

* The Java Source editor includes a code completion mechanism that provides
pop-up windows with possible method names (use <Ctrl+Space> to invoke)
and Javadoc documentation for classes and objects in your program (use
<Ctrl+Shift+Space> to invoke). The Java editor also includes a dynamic
syntax analyzer to warn you about compilation errors before you compile.

¢ The Code Clips palette provides sample Java code to accomplish common
programming tasks. The Clips are organized into categories based on
function. You can select a clip and drop the code into your Java source.

¢ The Page Navigation editor lets you specify page flow. This editor generates
a navigation configuration file, navigation.xml.

* When you build your project, the Output window provides diagnostic
feedback and completion status.

¢ The Servers window displays Data Sources, Enterprise JavaBeans, Web
Services, Deployment Server, and Database Server nodes.

¢ The Deployment Server node lets you start and stop the application server
and undeploy running web applications.

* You can view database table data by expanding the Data Sources node and
selecting individual tables. Creator displays the data in the editor pane
when you right-click a table name and select View Data. :

¢ The Debugger Window displays several views that are helpful when you are
debugging your project. You can set breakpoints and monitor the call stack,
local variables, and watches with the debugger.

¢ The Creator Help system provides a table of contents, index, and search
mechanism to help you use Creator effectively. The help system is dynamic
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Topics in This Chapter

« JSF Overview
« Component Categories

» Basic Components
« Layout Components
e Composite Components

« Converters and Validators
+ Component Library Manager
» Importing a Component Library
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un Java Studio Creator’s design palette presents a wide variety of com-
ponents to choose from. These components include buttons, text fields,
checkboxes, listboxes, radio buttons, hyperlinks, images, tables, tree
nodes, grid panels, and so on—in short, anything you need to design a
web page. You can select a component, drag it to the design canvas, and drop it
at the location of your choice. In addition, you can choose validator compo-
nents to verify user input and converter components for data conversions. Cre-
ator maintains a design canvas with your web page layout and generates Java
code for you, along with JSP and XML statements to configure and deploy your
application.

In this chapter we present a catalog of Creator User Interface (UI) compo-
nents, validators, and converters. We also provide references to examples in
this book where they are used. The examples will help you understand how to
use the Creator Ul components in your projects.

3.1 JSF Overview

The Creator UI components work within a JSF web application environment.
With the JSF framework, these components let you handle events, validate and
convert user input, define page navigation, and support internationalization.
JSF also connects components to server side objects. Let’s start with the archi-
tecture of JSF to give you the “big picture” of what’s going on.
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JSF Architecture

Figure 3-1 shows the architecture used with JSF.

Web Container

Browser HTTP Request Page1.jsp

Access Page

Page2.jsp

HTTP Response
Render HTML

Page1.java

Figure 3-1 JSF architecture

Your browser interacts with the web container through one or more JS
pages (Pagel.jsp and Page2.jsp). These are JSP pages containing JSF tags. The
supporting page bean (Pagel.java) manages the objects referenced by the JS
pages. Note that the JSP pages handle HTTP requests when a page is accesse
whereas the Java files render HTML for the HTTP response.

The JSP Page

Suppose a web page has a static text component (staticTextl) that displays
“In what year were you born?”, a button to click (buttonl), and a text field
(textFieldl) for the year (restricted to the range 1900 to 1999). When these
components are moved from the palette to the design canvas, Creator gener-:
ates the component tags in the JSP file. Each Creator Ul component also.
becomes a property in the generated Java page bean. To understand how this
all works, let’s start with how the static text component is defined in Pagel.jsp.

<ui:staticText id="staticTextl"
binding="#{Pagel.staticTextl}"
style="font-size: 18pt; left: 96px; top: 96px;
position: absolute”
text="In what year were you born?"/>
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JJe is expressed in XML. Creator generates this file for you and
its nchronized with your page design. As you modify components with
keeps | }Il-ties window, Creator updates the JSP code as well as the Java code as
the Pfo?e Creator generates the required tags for your components in the JSP
necesssg}; can always access the JSP page by selecting the JSP label in the edit-
; age: olbar above the design canvas.
mgI tOthis example, the static text component displays “In what year were you
borxrnl” on the page. Its id property (unique page identification) is staticTextl
d its binding property (the corresponding property in the Pagel page bean)
an o staticTextl. The style property specifies its location on the page with
and top settings in pixels. This property also makes the text appear in

The JSP £

is als
the left :
18-point font size.

JSF Expression Language (EL)

JSF uses a specialized syntax to access JavaBeans components with its tags. For
example, the notation

#{Pagel.staticTextl}

references the staticTextl property in JavaBeans component Pagel. In the
JSP file (Pagel.jsp), the generated component tags reference properties in the
supporting page bean, as follows.

binding="#{Pagel.staticTextl}"

2is accessed,; :
Now let’s look at the generated tags for a button component in Pagel.jsp.

<ui:button id="buttonl"
binding="#{Pagel.buttonl}"
action="4#{Pagel.buttonl action}"
style="left: 72px; top: 168px; position: absolute”
text="Click for your age"/>

hat displays
| a text field
When these
eator gener-
ponent also
nd how this
n Pagel.jsp.

Elements binding and action are Ul component tag library properties whose
values are set with JSF EL. Element binding is the button component’s page
bean reference, and action references a special action event method
buttonl_action(), also in Pagel. Here, method buttonl action() is called
when the users clicks the button controlled by component button.
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Converters and Validators

What about the text field component? Recall that this component must read 5
year (in the range 1900 to 1999) from the user. Here’s how the input text figlg

component is configured in Pagel.jsp.

<ui:textfield id="textFieldl"
binding="#{Pagel.textFieldl}"
converter="#{Pagel.integerConverterl}"
style="left: 192px; top: 168px; position: absolute”
validator="#{Pagel.longRangeValidatorl.validate}"/>

Text field components display and accept text, but textFieldl must work with

integer numbers in this example. Consequently, a JSF conversion compone
(integerConverterl) is necessary to convert String input to integer value

Input is restricted to a specific range of numbers (1900 to 1999), so we'll need a

JSF validator (1ongRangevalidatorl) for the input, too.

converter="#{Pagel.integerConverterl}"”
validator="#{Pagel.longRangeValidatorl.validate}"

In both cases, JSF EL references the components that perform the conversio
and validation.

Event Handling

JSF uses a delegation event model to handle events generated by user actions

(clicking a button, changing a selection in a drop down list, pressing <Ente

after editing a text field, for example). It's helpful to have an understanding of

the pieces that work together to make responding to events a well-behaved sys-
tem

The Event Source is a component that is capable of generating an event. Dif-
ferent components generate different event types. Button components and
hyperlink components (for example) generate action events. Drop down list

components generate value change events.

Event Objects are generated by components (the Event Source). An Event
Object is basically a message that is passed from the Event Source to an Event

Listener. The Event Object contains information about the Event.

Event Listeners are specialized objects created by JSF that know what to do;
when an event is generated. Different types of listeners can respond to differ:

ent types of events. For example, ActionEventListeners respond to actio
events and ValueChangelListeners respond to value change events.

Using the “Publish-Subscribe” design pattern, Event Listener Registratio
keeps track of which objects “care about” an event occurring. Objects th
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» are those that register themselves through the Event Listener Registra-
vcare ;tel' registering with the Event Source, Event Listeners are notified when
tion. & 1 occurs. Notification means their special event method is called with
an adlo]t object as a parameter. Fortunately, Creator generates all the method
the eveelvent listeners, and event registration for you. Here is an example of the
Ztel}l;ilt value change method that JSF calls when a value change event is gener-

ated from a drop down list component.

ublic void dropDownl processValueChange (
P valueChangeEvent event) {
// TODO: Replace with your code

}

teger values.

Web application developers provide the specialized event-processing code
we'll need 3

(whatever actions your web application must perform in responding to the
value change event).

Action events are common with most applications and Creator generates the
action event handlers for you. Action events can be used to write processing
code in response to a button click. In addition, action events return String val-
ues to a navigation handler, which allow you to invoke a different web page.
Here is the default event handler Creator generates for a button (with property
id set to buttonl).

e conversion

public String buttonl action() {
// TODO: Process the button click action.
// Return value is a navigation
// case name where null will return to the same page.

return null;

Note that action events implement navigation by returning String values. A
null string means you stay on the same page. A different String ("Button-
Click", for example) instructs the navigation handler to go to a different page.

» to an Event

Java Page Bean

Now let’s show you the Java page bean file, Pagel.java. Creator generates Java
code in the Java page bean for the components you select from the design pal-
ette. Each component becomes a property of the supporting page bean, and the
cOmponent instance is bound to that property.

v what to do
nd to differ-
1d to action

Registration
Objects that
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Here’s the Pagel.java file for our simple web application with two text fielg
and a button. Again, Creator generates this file for you.

public class Pagel extends AbstractPageBean ({

private Button buttonl = new Button();
private TextField textFieldl = new TextField () ;
private TextField textField2 = new TextField () ;

private LongRangeValidator longRangeValidatorl =
new LongRangeValidator () ;

private IntegerConverter integerConverterl =
new IntegerConverter();

// getters and setters for components

public Pagel () {
}

// Creator-generated life cycle code omitted

public String buttonl action() {
// TODO: Process the button click action.
// Return value 1s a navigation
// case name where null will return to the same page.
return null;

Note that Pagel extends AbstractPageBean. The private fields are generate
for each UI component you place on the page and the getter and setter method
make them accessible as properties. Here are the getters and setters for tl
static text component.

public TextField getTextFieldl () {
return textFieldl;

}

public void setTextFieldl (TextField tf) {
this.textFieldl = tf;

In our example a public init () method calls a private _init () method
the Java page bean to set the minimum and maximum ranges for the JSF va
dator component (longRangeValidatorl). When you set these values for t
validator by using Creator’s Properties window, Creator generates the stat
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th two text fiq, private _init () method to configure the validator for you. This is

in the e e 1
ments 1 the managed components are initialized.

done before

Cte void init () throws Exception {
r1ViongRanqualidatorl.setMaximum(1999L);
1ongRangeva1idatorl .setMinimum (1900L) ;

}

ublic void init () |

P Super.init();

try |
_init Q7

}

catch (Exception e) {
log("Pagel Initialization Failure"”, e);
throw e instanceof FacesException ?

(FacesException)e : new FacesException(e);

}

// Perform application initialization that must complete
// *after* managed components are initialized
// TODO - add your own initialization code here

page.

3.2 Components

Creator allows you to select Ul components from a design palette for your
application. These components are implemented with a JSP custom tag library
for rendering components in HTML.

When you select a component and drag it to the design canvas, Creator gen-
erates code in the page’s JSP source as well as support code in the associated
Java page bean. Furthermore, Creator displays each component in the Outline
view, including any support components that may not be visible. Once you
place a component on the design canvas, you can modify its properties and
behavior through the Properties window, through the JSP code, or through
modifications to the Java page bean. In general, it’s preferable to edit properties
of a component with Creator’s Properties window. However, writing code to
handle action and value change events must be done in the Java page bean file.

Components Palette

The Components Palette is divided into three groups: Basic, Layout, and Com-

alues for the osi ' !
posite. Each component includes the component name and an icon that you

tes the state-
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Label

Static Text
 Text Field

Text Area

) Button
Hyparlink

Image Hyperlink
Drop Down List
2} Listhox
Checkbox

1 Checkbox Group
Radin Button
Radio Button Group
Irmage

Table

Password Field
Hidden Field
Calendar

4 File Upload

o Tres

anchor

¥ Message

Message Group

Figure 3-2 Component palette

Creator Tip

can drag and drop on the design canvas. Figure 3-2 shows you the compong,
groups and all of their components.

rid Panel

oup Pangl
Layout Panel

E Pane Separator
] Tab et

Pane Fragment Box
\) Page Alert

{#7] Property Sheet

L:l Farm

Add Remove Lisk
Ereaderumbs
. Lj Infine Help

Reference Implementatio

The Components palette also includes the Standard Components, the JSF
1 components bundled with the first version of
Creator. These are included for backward compatibility with imported

Creator1 projects only. For newly created projects, use the components in the
Basic, Layout, and Composite sections.

Component Properties

This chapter presents a catalog of Creator components so that you can easl
look up their behavior and use them in your applications. Many component
share common properties and code generation features, however. Let’s stalt
with the definitions of these properties so that you can see how they’re used.
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text
The text property stores a component’s main textual characteristics. Its mean-
.o depends on the component. For example, text stores the text of a button
i:bell the display text of a static text component, or the input for a text field.
The text property can also store the text for a password field and hidden field
components. . :

The text property is a Java Object type. Creator allows you to bind a com-

onent’s text property to a JavaBeans property, a data source, or even a local-

ized message in a properties file.

label

The label property is a text string that provides text labeling for a component
on a web page. Examples of components that have label properties are text
fields, checkboxes, radio buttons, and drop down lists.

The label property is a Java Object type. Creator allows you to bind a com-
ponent’s Label property to a JavaBeans property, a data source, or a localized
message in a properties file.

toolTip

The toolTip property is a text string for a component’s tooltip.

style

The style property holds Cascading Style Sheet (CSS) strings for properties
such as font family, font size, and position parameters. These determine the
type of font used, its point size, and placement on the design canvas. Creator
provides a sophisticated CSS style editor that helps you configure a compo-
nent’s style property. (For a detailed discussion of the style editor, see “Using
the Style Editor” on page 282.)

» JSF
tof
1

tsin the

styleClass

The styleClass property allows you to specify predefined CSS style classes.
You can place CSS style class definitions in the default style sheet,
stylesheet.css (found in the Projects window under Web Pages > resources).
We show you examples of property styleClass in Chapter 7 (see “Using Prop-
erty styleClass” on page 284).

id
components The id property is a page-unique string that identifies a component on the web

r. Let's sta pPage. Creator generates the component’s id for you, but you can use the Prop-
y're used. erties window to change it.

u can easily
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Creator Tip

We recommend renaming the default id when you have components on the
page with event handling methods (action or value change methods).
Providing meaningful names for the id property makes Creator generate
methods with meaningful names. This makes your Java code easier to read.

rendered

The rendered boolean property controls whether a component will be ren.
dered during the Render Response Phase of the JSF life cycle.

visible

The visible boolean property controls whether a rendered component will be
visible on the page.

action

The action property is important for Action and Link components, such as
buttons and hyperlinks. This property references a method in the page bean
that returns a String for JSF’s navigation handler. Chapter 5 discusses page nav-
igation in detail. The application writer may provide application-specific state-
ments in the action method, process information to determine page flow, or
both. To generate an action event handler, double-click the component in the
design canvas. Creator brings up the Java source editor and puts the cursor at
the first line of the action event handler.

binding
Creator sets the binding property for all components you place on the page. A
binding property binds the component instance to a property in the page bean
Since Creator maintains this property for you, there is no reason for you to
change it. For example, if you add a button component to a web application’

initial page (Pagel.jsp), the default binding property for the button compo
nent is

binding="#{Pagel.buttonl}"

This JSF EL expression references the buttonl property of managed bea
Pagel and binds the component instance to the bean property. Now you ca
write code in the Pagel.java page bean to access the button component an
dynamically control its properties.
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] qvaScript

on the ot allows client side processing activated with mouse events (for exam-
. JavaSC} lfmg a component, giving focus to a component, or moving the mouse
rate le, clic omponent). The browser executes the JavaScript on the client machine
o read. Chbel , Ct any server involvement. You can attach a mouse event to a component
e Wlthoeucifcyiﬂg a JavaScript element in the component’s Properties window for
by f}zvent. Not all Creator Ul components detect the same mouse events.
thaFor example, suppose you want to obtain a confirmation from the user
will be ren pefore activating a button’s Delete operation. In the design view, select the but-

on. In the Properties view under JavaScript, specify the following JavaScript
for property onClick.

return confirm('Are You Sure You Want To Delete?');

When the user clicks the button, a confirmation window appears, as shown
in Figure 3-3. If the user selects OK, the button’s action event handler method
is invoked. Otherwise, the button click is ignored.

ternet Explorer

Y ? fj Are You Sure You Want To Delete?
b

[ OK I\ ' [ Cancel }

R

Figure 3-3 JavaScript confirmation dialog defined for property onClick

t the page

¢ page bean Input Components

P for youto o ponents that collect i field d field

application ponents that collect input (text field, password field, text area, drop down

?ist, listbox, for example) share common properties to control and validate
nput. Let's look at some of these properties now.

validator

The validator property references a method that performs validation on its value.

naged bea ]SF. provides three standard validators: a length validator for strings, a long range
ow you ca validator for integral types, and a double range validator for floating types. You can
iponent an also write your own custom validation method. See “Add a Validation Method”

On page 617 (Chapter 13).
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Chapter 3 Creator Components

converter

The converter property references a converter component that builds the corre
type of object. Once the conversion has taken place, you can retrieve the object
casting it to the desired type.

maxlength

The maxlength property limits input to a specified number of characters. (This

not the same as length validation.) Setting maxlength causes a component to st

accepting input after the user has typed in the maximum characters allowed. N
error messages are produced.

required

The boolean required property specifies whether or not input is necessary f
the component. If the user leaves an input component’s field empty a
required is set, an error message is produced during the validation phase.

valueChange

A value change event occurs when an input component’s selection changes
its text changes. If you want to perform processing based on input chan
double-click the component in the design view. Creator generates a proces
ValueChange () event method for you in the Java page bean. You can add your
own processing code to this method. k

Auto-Submit on Change

The Auto-Submit on Change feature submits the page for processing when an
input component generates a value change event. To enable Auto-Submit on
Change, select the component in the design canvas, right-click, and choose
Auto-Submit on Change. This sets the onChange property to the following Java-
Script element, shown here for a Text Area component.

common_timeoutSubmitForm (this.form, 'textAreal');
The input component has id property textAreal. When the input value of the

text area changes, the page is submitted, allowing immediate processing
(instead of waiting for a button click or hyperlink selection).

Virtual Forms fi

Virtual Forms allow the application developer to build web pages that provide
more than one function (or use case). For example, a single web page migh
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o user to either login or create a new username. The login use case
a[low’"f o username and password before clicking the “Login” button. The cre-
requ”es;semame use case requires additional fields (perhaps a new password
ate nixst be entered twice, as well as a username). By grouping input compo-
that T to separate virtual forms, you avoid interference when a validator
input for a component that is not needed to fulfill another use case.
eral examples of virtual forms use shown in the text.

1s the COrregy
the object by

nents in
requires
Here are seV!
cters. (This ls

onent to stg Book Examples

#Configure Virtual Forms” on page 216 (Chapter 5). Uses virtual forms
allow a Reset button to clear input fields.

#yirtual Forms” on page 417 and “Configure Virtual Forms” on page 420
(Chapter 9). Uses virtual forms to provide add, update, and cancel use cases

on the same page.

Data-Aware Components

Creator offers a selection of data-aware components that can bind a data pro-
vider to a database table, a web services method, an EJB method, or a Java-
Beans component. The table component is particularly suited for displaying
data, but you can also choose from among the drop down list, checkbox, list-
box, or radio button components.

Creator automatically supplies a converter for non-String data fields when
you bind to a data provider with known data types. If there are any conversion
errors, you will only see error messages if you have placed message compo-
nents on the page.

Creator Tip

We recommiend placing a message group component on the page when youre
using the data-aware components (see “Message Group” on page 90).

Data Providers

A data provider is an abstraction for a data source. Creator has data providers
for database tables, web services, EJBs, maps, arrays, and lists. Data providers
are useful because they offer a common interface for accessing different
sources of data.

_ When you drop a database table on a data-aware component, Creator con-
flgures the appropriate data provider for you. Similarly, if you drop a web ser-
Vices method or EJB method on a component, Creator configures a data
Provider. You can also explicitly select data providers for arbitrary objects,
such as arrays or lists. Chapter 8 introduces data providers and Chapter 9 uses

s value of the
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data providers with database accesses. Chapter 10 shows you data provide
with web services and Chapter 11 shows you data providers with EJB methog

3.3 Basic Components

The following catalog of basic components describes each component ap
gives you common usage scenarios. To show you how a basic component cq
be useful in a Creator project, we also point you to relevant examples in oth
chapters of this book. The basic components are listed alphabetically for ea
lookup.

-8 Anchar Anchor

The anchor component helps position link targets within a page. Anchor co

ponents are non-visual and often used with hyperlinks to scroll pages.

default, an anchor is rendered in HTML as <a name=targetname></a>.
Figure 3-4 shows an anchor component dropped on the design canvas.

Figure 3-4 Anchor component

Suppose, for example, you place a hyperlink at the bottom of a page a
drop an anchor component called anchorTop at the top of the page. To jump
the top of the page, set the url property of the hyperlink to the following,

/faces/Pagel.jsp#anchorTop

It's also possible to link to anchor components in other pages.
Book Examples

» “Add Components to the Page” on page 298 (Chapter 7). Uses anchor
components with hyperlinks to control page scrolling.

9 eion - Brtton

The button component is an example of a “command component.” Buttons
perform an action when they are activated (clicked). This can happen during
server-side processing (a method that processes an action event) or with a nav
igational action that determines page flow. The button component is one of the
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3.3 Basic Components 73

often-used components in web design. By default, buttons are rendered
O;I;ML <input type=button> tags.
" Figure 3-5 shows a button component and tooltip in a web page with a
1

er. The message shown was set in the button’s toolTip property.
browst

[ install |

[Make sure the €D is in the drive]

Anchor com

oll pages. By

></a>, ;éjhona ! %4 Local intranet
1 canvas. .

Figure 3-5 Button component

Buttons can be used for “simple” or dynamic navigation between web
pages. With simple navigation, a button’s action method returns a String that
matches a case label in the navigation rules generated for the application. We
show you how to create this type of navigation in “Add Page Navigation” on
page 195. Dynamic navigation is useful when you need to figure out the next
page based on some sort of processing. In this case, the action method returns
a String based on the processing. See “Create New Web Pages” on page 212 for
an example of dynamic navigation.

In Creator, you connect the a button click (an action event) to an event pro-
cessing method by double-clicking the button component in the Creator design
canvas. This brings up the matching button action () method (where button
is the component’s id property) in the Java page bean so that you can add your
processing code.

The button’s text property is its label. You can bind this value to a property
0rto a value in a properties file.

llowing.

anchor

Book Examples

* "Add Button Components” on page 193 (Chapter 5). Uses a button to initiate
navigation.

* "Place Button, Label and Static Text Components” on page 257 (Chapter 6).
Uses a button to submit a page for processing.

ent.” Button
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Chapter 3 Creator Components

o “Add a Button Component” on page 452 (Chapter 10). Uses a button to
invoke an action event method.

e “Modify the Components for Localized Text” on page 599 (Chapter 13).
Configures a button for internationalization.

(5 Calendar Ca Iendar

The calendar component lets users enter dates on a page, either by typing iy

4 —
specific date or by selecting a date from a pop-up calendar. Figure 3-6 is 4,
example of a calendar component in the visual editor with a Enter Date labe]
th
i} Welcome x| 5p) Pagel x| i
ignl 5P dwa G B a
" Calendar . . Button le
RIONGAN T S -
v
[ ]
Figure 3-6 Calendar component
When you click the calendar icon, a pop-up window lets you select a dat T
from a drop down list of months and years. Otherwise, just type a specific dat C
into the component’s text field. : c
The calendar component automatically validates the input date. You contro o
the range by setting properties minDate and maxDate. The minimum dat s

defaults to the current date and the maximum defaults to today’s date fou
years from now. Most applications will need to customize these values. Here
an example that sets the minimum date to January 1, 1975 and the maximum
December 31, 2020. You typically add this initialization code to the page bean
init () method.

// Set minimum date to January 1, 1975

// Method getTime () returns java.util.Date €

calendarl.setMinDate ( T
new GregorianCalendar (1975, 0, 1).getTime()); v

// Set maximum date to December 31, 2020 W

calendarl.setMaxDate ( v,
new GregorianCalendar (2020, 11, 31) .getTime()); s
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wtton to Creator Tip

You cannot supply String ?allzes for thesg p.roperties in. the Propertz'es

window, but you can provz'del property bzndu'ig expressions (to objects of type

Date) or you cait set the minimum and maximum values as shown in the
age bean. Use a message group or message component to display validation

error 1essages o the page.

ipter 13),

oy typing
rure 3-6 is

/“-—_

The date format defaults to the default format for the locale, but you can use
the dateFormatPattern property to select different date format patterns.

Property selectDate holds the user-supplied date, which you can bind to
an object or a data provider. You can also right-click the calendar component
and select Edit Event Handler from the pop-up menu. The validate option
Jets you insert Java code that validates user input, and the processval-
ueChange option lets you insert Java code that executes when a component’s

AL value has changed.

Book Examples

Sl 1. o “Configure the Calendar Component” on page 355 (Chapter 8). Uses a
" calendar component and shows you how to configure its settings.

Checkbox 9] Checkbox

The checkbox component uses a boolean on/off setting as a choice for a user.
Checkboxes are often used as standalone components (that is, not part of a
checkbox group) on a page. Figure 3-7 shows part of a page with a checkbox
component. Here we set the label property to the text string shown and the
selected property to true, which displays a check mark.

Check here for email confirmation

Figure 3-7 Checkbox component

There are two important properties with checkboxes. The selected prop-
erty indicates whether or not a checkbox is selected and checked on the page.
The selectedvalue property allows you to store and retrieve an arbitrary data
value associated with the checkbox. A check box is considered to be selected
when the value of the selected property is equal to the value of the selected-
Value property. You can bind the selected property of a checkbox to an object,
such as a JavaBeans property or a data source object.

Use method isChecked () to determine if the component is selected.
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Book Examples

¢ “Configure Checkbox Components” on page 430 (Chapter 9). Uses
checkboxes in columns with table components.

o “Specify Property Bindings” on page 582 (Chapter 12). Uses standalone
checkbox components and binds them to SessionBean properties.

A cedbociew - Checkbox Group

Page 108 of 328

The checkbox group component groups a set of checkboxes. You can specif
their items with a dialog accessed from the Properties window or dynamica]|
fill them from a database or JavaBeans component. When you use a checkbg
group, users may select any number of checkbox options (including non
unless the required property is checked). Checkboxes are rendered as 3
HTML <table> element with rows and columns. Figure 3-8 shows a checkbg
group component when you drop it on the design canvas.

Citerm 1

(itern 2

S [Otern 3

Figure 3-8 Checkbox group component

A checkbox group component is appropriate when you want to give th
user a list of choices with the phrasing “please check all that apply.”l The sele
tion items may be hardcoded with the Properties window or generate
dynamically at run time. Creator automatically supplies a converter for no
String data fields when you fill the list from a database source. The checkbo
group component also accepts data binding. The selected property of t
checkbox group returns an array of Objects consisting of the checked sele
tions.

Adding a checkbox group component to your web page creates three el
ments: the checkbox group component, an embedded selection list, and
“default items” list used for initializing the selection choices. To specify t
choices, select checkboxGrouplDefaultOptions in the Outline view. In t
Properties window, click the editing box opposite property options. Creat
pops-up a dialog so that you can add, edit, or remove items. (This is the sar

1. If you'd like to limit the choice to only one from a list, use the radio button
group component (see “Radio Button Group” on page 93).
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Jog used to specify Display/Value pairs for the Listbox component. See
1o
dﬂure 3.20 on page 87.)

ses Fig
dal Example
\datone Figure 3-9 shows a Checkng group compqnent on a web page. The default lay-
S. gt for a checkbox group is a single vertical column, so we set the columns
ouo erty to the number of checkboxes (4) to get a horizontal layout. Note that a
Egef may select more than one choice (including none or all).
can specif
dynamicall select one or more side dishes Taast Bacon [ Mufin [ Ham
» a checkbg
uding non
dered as
3 a checkbg
Figure 3-9 Checkbox group component
Here is the Java code to display choices selected from the checkbox group
(whose id property is checkboxGroupl) in a static text component. Note that
we assign the selected values to a sides String array. Casting is necessary since
the getSelected () method returns an Object array. The for loop concate-
nates selected values with space delimiters. This code is placed in the button
event handler method.
public String buttonl action() {
String choices = "";
to give th String[] sides = (String{])checkboxGroupl.getSelected():
"1 The sele for (int i = 0; i < sides.length; i++) {
choices = choices + " " + sides[i1];

}
staticTextl.setValue (choices);
return null;

DrOp Down LiSt ] brop Down List

. list, and
specify th
siew. In th
ons. Creato
-is the sam

The drop down list component is an extremely versatile component, rendered
as an HTML <select> element (a drop down list). A drop down list allows a
user to select one item from a set of items, as shown in Figure 3-10.

The selection items may be hardcoded with a dialog accessed from the Prop-
erties window or generated dynamically at run time. Creator automatically
Supplies a converter for non-String data fields when you fill the list from a
rbutton
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© ltemt

Figure 3-10 Checkbox group component

database source. This component also accepts data binding. The selecteq
property determines the value of the currently selected item.

When a drop down list component is used with a data provider that wrap
pers a database data source, you typically bind the database table’s primary
key field with the Value field. You select an appropriate field from the data
table for the dropdown component’s Display field. Figure 3-11 shows the Bing
to Data dialog that lets you configure the drop down list and the data provider,
Here the Value field is the RECORDINGID field (the primary key) and the Dis-
play field is RECORDINGTITLE. Thus, the dropdown component’s getSe-
lected () method will return the primary key. This is useful for setting SQL
query parameters from a drop down list component’s selection value (see
Chapter 9, “Connect Dropdown List to Query” on page 408).

Current Items property setting
, #{Page1 recordingsDataProvider . options['RECORDINGS, RECORDIMGID, RECORDINGS RECORDINGTITLE' T

Bind ta Data E}ov

Bind to an‘ohjz‘actl N

Choose a Data Provider to bind to dropDowni:

%recordingsDataPruvider (Pagel) { Add Data Provider., )

Value field: Display field:
l<none>

<use valug figld >

/RECORDINGS.RECORDINGTITLE String
'RECORDINGS.RECORDINGARTISTID Integer
RECORDINGS.MUSICCATEGORYID  Integer
'RECORDINGS.RECORDINGLABEL  Skring
2RECURDINGS.FORMAT Skring
;RECURDINGS.NUMBERUFTRACKS Shovt
;RECURDINGS.NOTES Skring

RECORDINGS.RECORDINGARTISTID Integer |
RECORDINGS.MUSICCATEGORYID Integer
RECORDINGS.RECORDINGLABEL  Skring 1
RECORDINGS.FORMAT Skring ;
RECORDINGS.NUMBEROFTRACKS Short :
RECORDINGS.NOTES  Skring :

g ) OK& . f‘CanceI A‘ﬁelp

Figure 3-11 Bind to Data dialog with a drop down list

The nonvisual component dropDownlDefaultOptions supplies text for th
selections. To input text items, select the dropDownlDefaultOptions element in
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e view and click the options property in the Properties window. A
up that lets you type in Display/Value pairs for each selection item

dialog POP° 20 on page 87). To supply options for a drop down list using data
(see Figure 3= page 57

stored in ap

plication scope (for example), see “Add ApplicationBeanl Data” on

page ,the user selects a different item from a drop down list component, the

en ; .
wh es a value change event. To submit the page for immediate pro-

on a value change event, set the Auto-Submit on Change feature. To

covide event handling code for a value change event, double-click the drop

down list component on the design canvas. Creator generates a default pro-

svalueChange () method and brings up the Java source editor for you.

Book Examples

sadd a Drop Down List” on page 202 (Chapter 5). Uses a drop down list

with navigation.
#pdd a Data Source” on page 401 (Chapter 9). Fills the selection list from a

database data source.

« “Add ApplicationBeanl Data” on page 577 (Chapter 12). Shows how to

instantiate data in an Options[] array appropriate for a selection
component, such as drop down list or listbox.

o “Specify Property Bindings” on page 582 (Chapter 12). Uses a drop down

list to bind a SessionBean property.

¢ “Add Components to Pagel” on page 607 (Chapter 13). Uses a drop down

list to specify locale.

File Upload

[2 File Upload

The file upload component lets users locate a file on their system and upload it
to a server. You can upload text files, images, and other types of data files (.zip
or .jar files, even executables). This component is similar to an HTML <input
type="file"> element. Figure 3-12 shows a file upload component on the
design canvas.

. | [ Browse. ., E

Figure 3-12 File upload component

For security reasons, file upload components are not supported in portlet

Projects. You can upload files up to one megabyte in size by default. To upload
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larger files, modify the maxsize parameter for the UploadFilter entry in thy
web application’s web.xml file. ;

The read-only uploadedFile property provides a UploadedFile interfagg
with methods that let you read the file and write it to disk. There are also met,
ods to access the file’s name, size in bytes, and type (text/plain Or image)

jpeg).

Creator Tip

Be careful with file names that have spaces, they are not supported. It is also
not possible to nest a file upload component within a tab set component.

Example
Figure 3-13 shows you a web page with a file upload component. Note that th
file upload component has a built-in Browse button to let users locate a file ¢
their system. When the “Get File Now” button is clicked, the file contents ar
written to the server and displayed in the scrollable text area on the page.
message group component displays status.

Here is the Java code for the button handler that uploads the file, display
the file in the text area, and writes the data to the server.

public String filervaction() {
// read file from client
UploadedFile uploadedFile =
(UploadedFile)fileUploadl.getUploadedFile();
String uploadedFileName = uploadedFile.getOriginalName () ;
String FileName = uploadedFileName.substring
(uploadedFileName.lastIndexOf(File.separatorchar) + 1);
info ("Uploaded file from " + uploadedFileName +
", size is " + uploadedFile.qetSize() + " bytes");

// write data to text area component
textAreal.setText(uploadedFile.qetAsStrinq());

// save file contents to server on C:

try {
File file = new File("C:" + File.separatorChar + "Saved" +

File.separatorChar + FileName);
info("Saved file to " + file) ;
uploadedFile.write(file);

} catch (Exception ex) {
error ("Cannot upload file: " + FileName) ;

}

return null;
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I| Browse...

e eontextxml
[caTempicontext

Get File Mow

il version="1.0" encoding="UTF-§"?>
srootContext>
=context name="java:comp™>
zcontext name="eny"
<context name="jdbc™s
=ghject name="Order"
class="com.sun.rave.sql.0DesignTimeDataSource™
=arg class="java.lang.Boolean” value="true />
=arg class="java.lang.5tring” value="PBPUBLIC"/>
=3rg class="java lang Boolean” value="true"f=
«arg class="java.lang.5tring”
value="com.pointbase jdbc jdbcUniversalDriver=
=arg class="java.lang.5tring”
value="jdbcpointbase serverilocalhost29092/sample™=

System Messages

» Uploaded file from CATempicontextxml, size is 3279 bytes

n  Saved file to C\Savedicontextxmt

Figure 3-13 File upload component

Hidden Field £3 Hddon el
The hidden field component is a non-visual form field that is not displayed on
the design canvas or in a browser window. The hidden field component is gen-
erated as an HTML <input type="hidden"> element. Hidden field compo-
nents do not appear in the design view, but you can access their properties
from the Outline window.

Web developers typically use hidden field components to store data used by
]avascript on the page. Hidden field components are also handy for storing
page data, as an alternative to saving and restoring in session scope. The text
Property of a hidden field component holds the data that is sent to the server.

Note that anyone can examine an HTML document's source to locate a “hid-
den” field. Hidden fields, like password fields, are extended from the same
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component classes as text field and therefore have the same configurable prop.
erties.

B9 Hyperlink Hyperlink

Hyperlink components are action components that provide navigation to othe,
pages as well as to a location on a page (with the anchor component). A hyper.
link component is also useful when a page’s URL information is data drivep
and no processing is necessary (you set property url). Figure 3-14 shows 4
hyperlink for a home page in a browser window.

Hyperlin

4 Hyp Microsoft Internet Explo..
Fie Edit

View Favorites Tools Help
..... . \ »
% - Search
Home:Page
@htipyyp - & ocalintranet.

Figure 3-14 Hyperlink component

To add event handling code, select the hyperlink component in the design
canvas and double-click. This brings up the hyperlinkl action() method
(where hyperlinkl is the component’s id property) in the Java source editor.

Creator Tip

If you want the hyperlink to show an image rather than text, use the image
hyperlink component (see “Image Hyperlink” on page 84).

Book Examples

* “Add Components to Page LoginBad” on page 213 (Chapter 5). Uses a
hyperlink component with navigation.

¢ “Using Hyperlink with a Nested Static Text” on page 458 (Chapter 10). Uses
a hyperlink and a nested static text component (for formatting) to provide a
link to URLs returned from a Google web services search.
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; ify the Components for Localized Text” on page 599 (Chapter 13).
. #»Modity hyperlink component for localization.

: Coﬂfigul‘es a

Image
rigation to oy ‘ omponents display graphics from a file or a URL. The image compo-
ment). A hyp, Image © endered as an HTML <img> element. Figure 3-15 shows an image com-
1is data drjy,, nt lstrafter dropping it on the design canvas.

e3-14 ShOW

Figure 3-15 Image component

Once you place an image component on the design canvas, there are several
ways to set its image. The image may be a file (JPEG, GIF, PNG), a URL web
location, or a built-in theme. To set the image, right-click on the image compo-
nent and choose Set Image. The Image Customizer dialog appears with radio
buttons Choose File, Enter URL, and Set Theme Icon. Figure 3-16 shows the
Image Customizer dialog with the Set Theme Icon selected and
ALARM CRITICAL_MEDIUM set for the image.

Selecting Choose File in this dialog lets you navigate to an image file in your
file system and copy it to the resources node in your project. When you choose
this option, the image component’s url property is set to resources/
image_filename, where image_filename is the image file.

Creator Tip

You can also add an image by dragging its file node from the file explorer
dialog to your page.

The dialog also lets you enter a URL to a web location for the file. As before,
————— the url property of the image component will be set to the URL you enter.
Alternatively, you can select the url property in the Properties window and
select the Use Binding radio button. This allows you to bind the property to a
data object,

Book Examples

to provide a * “Add the Google Logo” on page 451 (Chapter 10). Puts an image on the

page.
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{7y Choose File () Enter URL (33 Set Theme Icon

Choose an icon from a list included in the theme, The theme icon may change depending
on what kheme is selected for the page:

Icon Identifier: .
ALARM_CRITICAL_SMALL
ALARM_DOWRN_MEDIUM
ALARM_DOWN_SMALL
ALARM_MAJOR _MEDIUM
ALARM_MAJOR_SMALL
ALARM_MASTHEAD_CRITICAL_DIMMED
ALARM_MASTHEAD _CRITICAL_MEDIUM
ALARM_MASTHEAD _DOWN_DIMMED
ALARM_MASTHEAD _DOWN_MEDIUM
ALARM_MASTHEAD_MAJOR_DIMMED
ALARM_MASTHEAD_MAJOR_MEDIUM
ALARM_MASTHEAD_MINOR_DIMMED
ALARM_MASTHEAD_MINOR _MEDIUM v

ﬁ i
ALARM_CRITICAL_MEDIUM v

! oK L}‘\'H Cancel ” Apply ][ Help }

Figure 3-16 Image customizer dialog

% 1mage Hyperiink Image Hyperlink

The image hyperlink component is similar to a hyperlink, except that it sup
ports images in addition to text. When you right-click an image hyperlink com
ponent, the Image Customizer dialog lets you set the image to a file (JPEG, GIF
PNG), a URL web location, or a built-in theme (see Figure 3-16).

The imageURL property specifies an image file or a URL on the web. Th
icon property holds the theme. Figure 3-17 shows an image hyperlink in
browser window.

As with hyperlinks, you can specify an action event handler. To add even
handling code, select the image hyperlink component in the design canvas an
double-click. Creator generates a default action event method and brings u
the page bean in the Java source editor. The cursor is set to th
imageHyperlinkl action() method (where imageHyperlinkl is the compo
nent’s id property).

Facebook's Exhibit No. 1003
Page 00116

Page 116 of 328 GOOGLE EXHIBIT 1003



3.3 Basic Components 85

Lﬁﬁ) Imagq.’_b)yperlink

: ’%g Local intranet

Figure 3-17 Image hyperlink component

Book Examples

o “Banner Page Fragment” on page 309 (Chapter 7). Uses an image hyperlink
. with a page fragment.

o “Add an Image Hyperlink Component” on page 481 (Chapter 10). Uses
image hyperlinks to page through Google search results.

o “Add Components to the Page” on page 562 (Chapter 12). Uses image
hyperlinks to page through Google search results.

Label s Label

The label component is typically used to associate text with input components,
such as text fields and checkboxes. Labels are rendered as HTML <label> ele-
ments when they are associated with components and as <span> elements
when they are not. Figure 318 shows a label on the design canvas.

.8 Do =
- OThisis aLabelo
.. B o o

Figure 3-18 Label component

A 1§bel’s for property associates the label with another component. When
you bind the for property of a label to a text field, for instance, the label com-
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ponent displays an asterisk if the text field’s required property is set to try
Furthermore, if invalid input is supplied to the server, the page will high}ig
the label component’s text in red. These behaviors make labels highly usefu]
pages where input components are heavily used.

Label components also have data binding. You can bind a label’s text prq
erty to a data source, a JavaBeans property, or text from a resource bundle.

Creator Tip

Input components have a dedicated 1abel property that you can
alternatively use for label text, but these labels cannot be easily resized or
aligned. Instead, use the label component for more flexibility with component
placement and style control.

Book Examples

¢ “Add a Label Component” on page 207 (Chapter 5). Uses a label to place a
heading on a page. ;

* “Modify the Components for Localized Text” on page 599 (Chapter 13). Sets
the label’s text from a localized .properties file.

+ “Add Components for Input” on page 620 (Chapter 13). Sets the label’s for
property to a text field component and sets the label’s text property froma
localized .properties file.

Listbox

The listbox component allows users to select items from a list of items. Th
selection items may be hardcoded with a dialog accessed from the Propertie
window or generated dynamically at run time. Figure 3-19 shows a listbo
component on the design canvas after configuring the options list.

Creator automatically supplies a converter for non-String data fields whe
you fill the list from a data provider source. The multiple property determine
whether the user may select one item or multiple items in the listbox. (Wit
multiple set, press <Ctrl+Click> to select more than one item.) The rows prop
erty controls the number of items to display.

When a listbox component’s data provider wraps a database data source
you typically bind the database table’s primary key field with the Value field
You select an appropriate field from the data table for the listbox component
Display field. Figure 3-11 on page 78 shows the (equivalent) Bind to Data dia
log for a drop down list that lets you configure the data provider.

The nonvisual component listboxlDefaultOptions supplies text for th
selections. To specify selection items, select the 1istboxlDefaultOptions ele
ment in the Outline view and click the options property in the Properties win
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Figure 3-19 Listbox component
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dow. A dialog pops up that lets you type in Display/Value pairs for each
selection item, as shown in Figure 3-20. Text in the Display column appears on
the page. The selected property (or method getSelected()) returns the cor-
responding text of the selected item from the Value column.

Mew

Hard Day's Might 2 Delete
Office Space 3 .
Best in Show M

Down

Click Mewe to create a new entry, Edit a value by clicking in the table cell,

| oK

N H Unset Property H

Cancel

¥

Figure 3-20 Dialog to select text items for listbox component

When the user selects a different item from a listbox component, the system

Page 119 of 328

generates a value change event. To submit the page for immediate processing
On a value change event, set the Auto-Submit on Change feature. To provide
event handling code for a value change event, double-click the listbox compo-
nent on the design canvas. Creator generates a default processvalueChange ()
method and brings up the Java source editor for you.
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Book Examples

” on page 400 (Chapter 9). Fills the selection lis
listbox for a master-detail database reaq
16 (Chapter 11). Fills the selectig

o “Add a Listbox Component
from a database data source. Uses

e “Add Components to the Page” on page 5
list from an EJB data source.

e “Add ApplicationBeanl Data” on page 577 (Chapter 12). Shows how to
instantiate data in an Options{] array appropriate for a selection

component, such as drop down list or listbox.

403 Message M essa g e

The message component displays error messages g€
nents. Typically, these messages are data conversion or input validation errors

When the validator or converter detects errors, it sends a message to the JS
context on behalf of the component. Message components can retrieve and dis
play these messages. Message components are particularly useful on a wel
page that contains multiple input components. When you associate a uniqu
message component with each input component, validation or conversio
error messages clearly indicate the source of the input error. By default, a me
sage component has its ShowSummary property set to true and its ShowDetail
property set to false. Figure 3-21 shows a message component initially

dropped on the design canvas.
Ctrlfsh‘rﬂ and drag to set “for* property.

Figure 3-21 Message component

To associate a message component to an input co
sage component, press <Ctrl+Shift>, and drag the arr
to the target component. This sets the for property to the id property of th
input component. Figure 3-22 is an example page with a submit button an
two message components associated with input text fields. Note that the names
of the text fields (textfieldl and textfield2) appear in the message text,
indicating that the for property has been set for each message component.

You can use the message component’s style property to format the appear
ance of your error messages.

You can also send your own message to a message component with the
info (), error (), fatal (), Or warn () methods. These methods are all rendered

using distinct styles. You must include the message component’s target compo
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1e selection list
database reaq.
Is the selectiqy,

fcategory

* *Number 1D

ws how to R _ S
—t 1 Message summary for textField2

ction

Figure 3-22 Message components with for property set

etrieve and dig ‘ nent id with the call, however. The following code shows the approach. Here,
inside the listbox’s value change event handler, we send a warning that the list-
box component’s value has changed. Note that component id listbox1 is the

ociate a uniqu
first parameter for method warn ().

or conversio
its ShowDetai public void listboxl_processValueChange (

onent initiall ValueChangeEvent event) |{
warn (listboxl, "Value changed!");

Creator Tip

The message component displays a single message only. If you need to display
multiple messages, or you don't want to specify a particular component, use
component Message Group instead.

select the mes Book Examples

ted by Creato
sroperty of th
nit button and

“Use Validators and Converters” on page 252 (Chapter 6). Uses a message
component to report data conversion errors for a text field component.
“Add a Message Component” on page 474 (Chapter 10). Uses a message
component to report validation errors for a text field component.

“Add Components to the Page” on page 562 (Chapter 12). Uses a message
component to report validation errors.

“Add Components for Input” on page 620 (Chapter 13). Uses a message
component to report validation errors from a custom validator method.

omponent.
nat the appear

ment with the
re all rendered
' target compo
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SF Message Graup Message Gro up

Message group components display run-time errors for page-level messages“
originating from multiple components or for system (global) messages. W;
message group components, you can limit the message group to display globy
errors only (that is, exclude component errors), or display errors for all compy,
nents on the page, including errors with the page itself.

Figure 3-23 is a page with a submit button, input text fields with associate(i
message components, and a message group component to report global errorg
The message group component’s showGlobalOnly property is set to true.

Teategory

; . Messaye suswnary for fextfield .

*Humber 1D : BT
H | Wessage sumimiary for texiFied2:

System Messages

s List of ylobal messade surmaries
Figure 3-23 Message group components

Set property showGlopbalOnly when one or more message component
appear on the page with a message group component. This prevents a compo
nent’s validation or conversion error message from appearing twice.

You can also use the message group style property to format the appea
ance of your error messages in the System Messages box.

Creator Tip

It's a good idea to routinely place a message group component on your pages,
especially when accessing a database, web service, or EJB. Recall that JSF
writes FacesException messages to the JSF context. You will only see these
nessages if a message group or message component is on the page.
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Book Examples

Message Group Component” on page 386 (Chapter 9). Uses a
npdd a roup component to report database access errors.
messa_gifand Message Group Components” on page 474 (Chapter 10). Uses
//Mess;oge group component to report system (global) errors.
g n:iiisccomPOnents to the Page” on page 502 (Chapter 11). Uses a message
?oup component to show all error messages when there is only one input

al) messages, Wi

p to display gloh
rors for all comp,

Component. } ) B
pdd the Google Web Service Client” on page 566 (Chapter 12). Uses a

| message group component to report system (global) errors.

is set to true.

. . H [+ Passward Field
 password Field -
rtextrietd] :kThe password field component allows users to input a single line of text. Ech-
R oed text is replaced by a single character, such as a black dot or an asterisk.
FextField? password field components are useful for handling sensitive data input, like

passwords and PIN numbers. The password field component is rendered as an
HTML <input type=password> element. When a password field is rendered,
its previous value is always cleared. Figure 3-24 shows a password field
dropped on the design canvas.

sage component Figure 3-24 Password field component

revents a compo
twice.
rmat the appeat

In all other respects, a password field component behaves just like a text
field. The input string is stored in the component’s password property. When
you change the text, a value change event is generated. The password field’s
getPassword () method reads the text and setPassword() sets it. You can also
bind the password property to an object or data provider.

Password field components can have validators. Length validators, required

H your pages, validators, and range validators are all possible to check input text. Note that

Z/ tilﬁt { :F value change events occur only if no validation errors are detected.

‘yE see these ~ When a password field component generates a value change event, the JSF
8¢ implementation invokes the value change event handler for that component.
S .

You can use the password field’s label property to set the label text on a page.
Its a good idea have message components associated with password fields to
Teport validation or conversion errors. To create a tooltip, set the password
field’s toolTip property.
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Book Examples

¢ “Create the Form’s Input Components” on page 208 (Chapter 5). Uses a
password field to gather input for a password field.

e “Bind Input Components” on page 237 (Chapter 6). Shows property bindjng
with the password field component.

* “Modify the Components for Localized Text” on page 599 (Chapter 13).
Shows how to localize an application that contains a password field (the
password component’s toolTip is bound to the properties file).

{&} Radio Button Radio Button

The radio button component uses a boolean on/off setting as a choice for a use;
Radio buttons can appear as standalone components on a page (not part of

radio button group). Figure 3-25 shows part of a page with two radio buttg
components. Here we set the label property to the text strings shown. You ca
treat two or more radio buttons as a group by setting each radio button’s nan
property to the same value. When radio buttons are part of the same group,
only one radio button can be selected (set to true).

CIHave an Agent Call Me

O 8ubscribe to Newsletter

Figure 3-25 Radio button component

There are two important properties with radio buttons. The selected prop
erty indicates that a radio button is selected and clicked on the page. Th
selectedValue property allows you to pass data values for the radio button
It’s also possible to bind the selected property of a radio button to an objec
such as a JavaBeans or a data source. A radio button is considered to b
selected when the value of the selected property is equal to the value of th
selectedValue property.

Use the isChecked () method to determine if the component is selected. Tt
use radio buttons in table component columns, set the name property to th
same value to group all the radio buttons in the column.
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Creator Tip

er 5). Uses a Radio buttors by themselves (not in a group) are used sparingly in web pages
pecause users cannot deselect a single radio button once it is selected. If you
want users to select and deselect their choices, use checkboxes (see
wCheckbox” on page 75).

Radio Button Group @ et

roperty bindip,

“hapter 13),
»rd field (the
ile).

The radio button group component lets you group radio buttons on a page.
: When a user selects a choice from a radio button group, each choice deselects
the previous one. This means only one button within the group is “on” at a
: time.2 Radio button groups are rendered as an HTML <table> element with
rows and columns. Figure 3-26 shows a radio button group component after
you drop it on to the design canvas.

‘he same groy
Crtem 1
S {Oem 2 -

C{OMmem3

Figure 3-26 Radio button group component

- The selection items can be hardcoded with the Properties window or
dynamically generated at run time. Creator automatically supplies a converter
for non-String data fields when you fill the list from a database source. This
component also accepts data binding. The selected property of the radio but-
ton group returns the selected item.

To specify the choices, select radioButtonGrouplDefaultItems in the Out-
line view. In the Properties window, click the editing box opposite property
options. Creator pops up a dialog so that you can add, edit, or remove items.
(This is the same dialog box used to specify Display/Value fields for the Listbox
component. See Figure 3-20 on page 87.)

Example

Figure 3-27 shows a radio button group component on a web page. The default
layout for a radio button group is a single vertical column, so we set the col-

2. If you need to select more than one item at a time, use the checkbox group
component (see “Checkbox Group” on page 76.)
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umns property to the number of radio buttons (3) to get a horizontal layOut
Note that a user may select only one choice.

Age Bracket () 21-24 &) 35-49 ) over 50

Your age is 35-49

Figure 3-27 Radio button group component

Here is the code in the button’s event handler that displays the user’s selg,
tion in a static text component. The code that accesses the radio button groy
component is bold.

public String buttonl action() {
String choice = (String)ageBracket.getSelected()
staticTextl.setText ("Your age is " + choice);
return null;

& sacet - Static Text

Of all the components, static text is probably used the most often in web pages
A static text component lets you display any kind of textual information, lik
instructions, titles, and headings. Static text components typically displa
String data, but you can bind them to objects, JavaBeans properties, and dat
providers. Figure 3-28 shows a static text component after dropping it on th
design canvas.

o s}
- offaic Texd
= B = B

Figure 3-28 Static text component

With data converters and formatters, static text components can displa
almost any type of data. An embedded static text component is the default for
table component. Static text components may be embedded in hyperlink com
ponents to allow embedded HTML in the hyperlink’s text display.

The text property of a static text component stores the text that is dis
played. From a user’s point of view, static text components are read-only. Th
setText () method sets its text and getText () reads it. You can resize stal
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rizontal layoy . o mponents on the design page, but Creator expands them if you leave
ex

t .
‘them UI’ISIZed'

gtatic text components are rendered as plain text, which may include HTML

. natting tags. This means you can build entire HTML pages by concatenat-
.fO; a string of HTML tags with text and assigning it to the component’s text

in

; pl'opel‘fy-

creator Tip

To enable correct rendering of HTML tags, make sure you set the escape
property to false in the Properties window. Also, avoid using static text as
labels for other components. Use either a separate label component or the label
property of the component.

he user’s sele¢
5> button group

e

Book Examples

“Place Button, Label and Static Text Components” on page 257 (Chapter 6).
Binds an output component to a JavaBeans property and applies a number
converter.

“Add Components to the Page” on page 298 (Chapter 7). Uses an embedded
static text component in a grid panel. Builds the static text component’s text
by concatenating HTML tags and unchecking the escape property.

“Using Hyperlink with a Nested Static Text” on page 458 (Chapter 10). Uses
an embedded static text component in a hyperlink to store HTML text.
“Configure the Table” on page 477 (Chapter 10). Uses an embedded static
text component to improve HTML formatting.

“Add Static Text Component to the Page” on page 586 (Chapter 12). Uses a
static text component for formatting text using HTML tags in a portlet.

Table [7] Table

The table component is a composite component with rows and columns. Tables
fypically have nested columns, which in turn contain other display compo-
nents (such as static text components, buttons, or text fields). Table components
render as HTML <table> elements.
A table node in the design palette has nested column and row group compo-
hents (see Figure 3-29). Dragging these components to a table in the design
anvas adds columns and row groups to the table. Figure 3-29 also shows a
table component initially dropped on the design canvas with the default of five
yperlink com: fows by three columns.

Figure 3-30 shows the Outline view for the default table component. Note
that each column in a table has a static text field to display data, but you can
feplace it with other components (checkboxes, hyperlinks, for instance). Every
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R Row Group

Tahle

i8] Column

column1

column2 2

SR

column3 .

.

row1_columni

rowl_colurnn2

row1_ecolumn3

row?Z_colurmn

raw2_column2

row?2_column3

raw3_calumni

row3_column2

row3_columns3

rowd_columni

rowd_column2

rowd_column3

rows_column2

rows_columna

raws_columni

Figure 3-29 Table component

table component also has a default data provider (defaultTableDataPrg
vider, a non-visual component).

lgoutline ‘ S

tableRowGroupl

] tableColurani
1A staticTextl
{81 tableColumn2
| A] staticText2
tableColumn3
@ staticText3
''''' & defaultTableDataProvider

Figure 3-30 Table component Outline view
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Creafor T'p
ovides an enhanced selection mechanism for composite

oonents, such as the table component. In the design canvas, click on any
comp? table colummn and look in the Outline view and Properties window to
o ”/1 iil’i component is selected. Now click again and you'll see the outer
f,ef;;gdz component’s properties. Successive clicks let you cycle through each

ing level of a component.

Creator P!

nest

Table components are typically filled dynamically with data from a data
vider attached to a data source (database table), web services method, EJB
p Othod or JavaBeans property. When you fill a table component with data
*?f‘(fm a ’data provider, Creator lets you control the layout, including the col-
amns to display, the number of headers and footers, and the component you
use in each column. You can also apply data converters to any field (column).
~ When you bind a data provider to a table component in the design canvas,
. Creator automatically fills the table with the data and generates the needed col-
umns. Creator also generates headers from the field names and applies the nec-

_ essary converters.

Example

Figure 3-31 shows Creator’s design canvas with a table component bound to
the TRACKS table from the Music Database in Chapter 9. This table has three
_columns (with headings from the database metadata). Creator shows the col-
umn’s data type as “123” for numeric data and “abc” for String data. For data
that is not text, Creator applies a converter for you.? In this table, an embedded
static text component is used for the display.

i
i

TRACKTITLE . * © TRACKLENGTH . ™

| aho abc
i

1123 ahc abc
; .

1123 . ahc abe

Figure 3-31 Binding table component with an external database table

3. For example, if a primary key field is integer data, Creator applies an Inte-
ger converter to the component. Creator performs this action for all the
data-aware components.
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Chapter 3 Creator Components

Creator automatically sizes the columns and dynamically generates the
rect number of rows. When you bind a table component to a database tab)
Creator generates a default query for you. You can modify this query by se|
ing the associated rowset from the nonvisual display. We show you hoy
work with database queries in Chapter 9 (see “Modify the SQL Query"é
page 405.)

Figure 3-32 shows Creator’s dialog for manipulating a table componey
layout. Select the table component in the Design or Outline view, right-cliy
and choose Table Layout. Here, the dialog shows the columns from
TRACKS database table. You can choose which columns to display, the heaq
and footer text, and the underlying component that holds the data.

Get Data From: gtracksDataProvider & 1 [ add Data Provider.. j i

avallable ) Selected

\RECORDINGID TRACKS, TRACKTITLE
TRACKS TRACKLENGTH

Column Details

Header Text: | TRACKNUMBER

Footer Text:

Component Type {Static Text

Yalue Exptession:

{currentRow, valus[ TRACKS, TRACKMUMBER]
Width: T
Horizontal Align:

Sortable

Figure 3-32 Table Layout dialog: specifying columns
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senerates the R

« 3-33 shows Creator’s dialog for specifying options for the table. Here
a database tab]

t the table’s title, description (summary), footer, and a message to

se
s query by selg, YU lcjnlf the table is submitted without data. The checkboxes let you enable
how you hoy,  dispie tions for the table component, including buttons to select all rows,

SQL Query” .

sorting, open or close the table’s sort panel, and enable pagination and a
ear 4

d mber. After making your selections, click Apply, then OK.

ble componey page size nu
view, right-clig
lumns from
splay, the head
data.

Title:

SUMMAry': H

Footer:

Empty Data Message: |

[] show Select &ll Rows Button
[7] show Deselect All Rows Button
{7] shaw Clear Sort Button

{7} shaw Sort Panel Toggle Buttorn

[[] Enable Pagination

{: oK %‘H Cancel H apply ]{ Help ]

Figure 3-33 Table Layout dialog: specifying options

Book Examples

“Configure the Table” on page 360 (Chapter 8). Uses a table component with
an object list data provider. Enables table pagination.

“Configure Table Component” on page 397 (Chapter 9). Uses a table
component with an SQL query parameter.

“Add a Table Component” on page 402 (Chapter 9). Builds a master-detail
relationship using data binding with a table component.

“Modify the Table Layout” on page 412 (Chapter 9). Uses a table component
with text field components for updating data.

“Add Components” on page 429 (Chapter 9). Uses a table component with
checkboxes.
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* “Add a Table Component” on page 477 (Chapter 10). Uses a table
component with an object array data provider and web services.

e “Configure Table Component” on page 556 (Chapter 12). Uses a table
component with portlets and database access.

Text Area

Text area components gather textual information for multiple lines. This co
ponent is similar to a text field, but you build it with rows and columns (s
Figure 3-34). Its standard look displays several lines, and a vertical scrollp
appears if the number of lines exceeds the number of rows. Text area com
nents let you specify their size, provide text for a tooltip, and bind their te
property to objects or data providers. Text area components are rendered as
HTML <textarea> element.

Please provide any additional information in the box below:

!When you select components,
§Creator generates code in the
Ipage's JSP source as well as
isuppon code in the associated
{Java page bean. Furthermore,

it places the componentin the

Outline Window where you can

]edit its properties and change s

| Confirm information

Figure 3-34 Text area component on a web page

Text area components are common with web applications that solicit free-
form text. Examples are composing letters, listing comments, sending email,
posting to guest books, filing bug reports, or reviewing products. .

The getText () method retrieves the text and setText () sets it. The text is
sent to the server when the page is submitted. Like the listbox component, text
areas work with value change events and the processvalueChange () even
handler. To configure this method, double-click the text area component in the
design view. Creator generates the event handler method in the Java page beall

for you.

Example
You can bind the text property to a session bean property to automatically
save submitted text in session scope. For example, here is the generated J5¢
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es a table
services.
- Uses a table

a text area component that binds its text property to session bean
erInfo (shown in bold).

e for
operty 1°
area binding="#{Pagel.textAreal}" id="textAreal"

s t
jitex nheight: 120px; left: 48px; top: 12px;

<

le=
: StZition: absolute”
intf'# (sessionBeanl.userInfo}"/>

ole lines. Thig e
s and columng
a vertical scrg]
. Text area cop,
nd bind their ¢
are rendered 5.

‘ Text Field T Text Field
;The ext field component enables users to input a single line of text. The input

ring i stored in the component’s text property, and a value change event is

S‘me%qted when you change the text. The component’s getText () method
'eandscthe text and setText () sets it. The text is sent to the server when the

I?a o is submitted. Text field components are rendered as an HTML <input

tygezntextb element. o .

Figure 3-35 shows a text field in a browser window that pr'ompts for a per-
son’s first name. The text field’s label and toolTip properties are set to the
strings shown. The boolean required property makes a red asterisk appear
with the label and alerts the user that input is mandatory.

Microsoft Internet Explorer

View Favorites  Tools  Help

w . *j‘j ;gj o

File Edit

Search 77 Favorites i

* First Name E[” 5
|Please enter your first namﬂ

» that solicit free
5, sending email
cts.

Zooe  SJiocalintranet

Figure 3-35 Text field component on a web page

With text fields, you can attach a length validator, a required validator, or
range validators (with converted numerical values). Value change events occur
only if no validation errors are detected. When a text field component gener-
ates a value change event, the JSF implementation invokes the value change
event handler for that component. Message components are handy for report-
Ing validation or conversion errors with text fields. (See “Message” on
Page 88.)

You can also attach a data converter to a text field. To do this, select the con-
vertor you want from the converter property in the Properties window under

0 automatically.
e generated JSP
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Data. When you apply a data converter, the type of the text property chap,
from String (the default) to the converted type. If you don’t want all inpyt o :
ponents on the page to be validated, use virtual forms (see “Configure Vjy
Forms” on page 216).

Text fields may be embedded in table components and you can bind them
data or other objects. Figure 3-36 shows the Property Bindings dialog boy f
binding a text field component to a JavaBeans property. Here, we bind toy
field username with the username property in the JavaBeans component logiy
Bean.

Ua

Select binding target:
# (Property not bound)

columns int
converter  Converter
disabled hoolean LoginGood
label String {2l paget
labellevel inf = "‘?‘3‘3‘
maxLength it
onBlur  Siting
anChange String
onClick String
onDbiClick  String
onFocus  String

# _ankewDa Strina..... 4 ApplicationBeani
» Default :

RequestBeanl

SessionBeanl

% loginBean LoginBean
4 property: loginGood Boofean
& property: password SHing '

R RN T

o
%

b
Current binding For text property:

. #{essionBean] .loginBean,username} I Clear }

Mew binding expression:
_ #{SessionBaant loginBean, username} ! 1 Apply ]

ey (7]

R

Figure 3-36 Property Bindings dialog with text field component

Book Examples

» “Configure Virtual Forms” on page 216 (Chapter 5). Excludes validation 0
text field components with virtual forms.

e “Bind Input Components” on page 237 (Chapter 6). Shows binding
properties with a text field.
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Xt property cf, 'm’s Input Components” o 2 250 (Cl '
‘want all inputaC Create the Form's Inp p n page 250 (Chapter 6). Shows text

s “Confi 1ds with converters and validators.
s v, ’;de Components to the Page” on page 298 (Chapter 7). Uses a text field in
~ i L.

sted gud pane ’
‘ g/‘hr,l[zdify the Table Layout” on page 412 (Chapter 9). Uses text fields with a
- table Compoﬂent. B
_updd Components™ on page 417 (Chapter 9). Uses text fields to gather input
for database TOW insert operations. Uses virtual forms.
ipdd a Text Field Component” on page 451 (Chapter 10). Shows validators.
., “Add Components for Input” on page 620 (Chapter 13). Uses text fields with
4 custom validator method.

Tree j Tres

 The tree component lets you render data in an expandable list with a hierarchi-
cal tree structure. In web applications, trees are useful for navigating through
 nested data, like file systems and categories. A tree component contains tree

nodes, which act like hyperlinks. In the design palette, a nested tree node com-
‘ ponent appears when you expand a tree node, as shown in Figure 3-37.

;(Jutﬁ,‘]EHW S e ¢ux

0 Tree Made

Tree

Y
7 L
T ree’NUdu 1 U treeNodel: Tree Mode 1

24l imaget

Figure 3-37 Tree component

Figure 3-37 also shows you the design canvas for a tree component and its
Outline view. Note that a tree node has an embedded image component. Once
you expand a tree component and drop it on the design page, you can drop
tree node components to build nested structures.

Initially, when you drop a tree component on a page, the root node is labeled
Tree and the subnode is labeled Tree Node 1. The text property lets you set the

validation of : SIrings to be rendered for these nodes, and the toolTip property gives users

more information about the node.

Facebook's Exhibit No. 1003
Page 00135

Page 135 of 328 GOOGLE EXHIBIT 1003




Page 136 of 328

Chapter 3 Creator Components

Creator Tip

When you drop tree node components on tree components, pay attention to
what Creator outlines in blue. If the entire tree component is blue, the tree
node will render as a sibling of the tree component. Otherwise, the tree node
will render as a nested node underneath the node outlined in blue.

There are several important properties with tree components. The url rop.
erty lets you navigate to another page or display data like a PDF or JPEG g;
Binding the action property to an action event handler makes the tree noq
automatically submit the current page. The clientSide boolean property con
trols whether a request to the server is made each time a user expands or ¢
lapses a node. ;

Example

Figure 3-38 shows a tree component called Download Site with tree nods
Home Page and Music. Underneath the Music node are the nested tree nodg
Jazz, Rock, and Country. f

. DownloadSte
[} Home Page

s [ Music

Jaz

Reck

ooo

g

Country

Figure 3-38 Example tree component

Note that the image for a tree node is a page icon if it is not nested. Othe
wise, a folder icon appears with an arrow if the node has children (neste
nodes). On a web page, users may expand or collapse the folder to see th
nested nodes by clicking the arrow icon.

Suppose a web application displays PDF files for the Jazz, Rock, and Cou
try music categories. When you select a tree node on the design page and clic
the url property customizer box, a dialog appears to set the property. Clickin
the Add File button Jets you browse for the location of the PDF file you want!
display. Figure 3-39 shows this dialog for the Jazz tree node.
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attention to
ue, the tree
the tree node

yusebinding (%) Use value

URL: JresourcesfJaz
) Pagsl
resources

B Country.pdf

! & Rock,pdF
| L.My stylesheet.css

g oK [\> l Gnsel: Properm L Cancel j F Help ‘I

Figure 3-39 Url dialog for tree node component

Creator Tip

At the time of this writin g,

tree node selection events do not work in portlet
projects.

3.4 Layout Components

The following catalog of layout com
gives you common usage scen
be useful in a Creator project,

chapters of this book.
lookup.

ponents describes each component and
arios. To show you how layout components can
we also point you to relevant examples in other
The layout components are listed alphabetically for easy

Form

The IDE makes sure that cevery new page that you create already has one form
‘omponent. If you want to add more forms, drag the form component from the
design palette and drop it on the page. This is usually not necessary in most
applications, but you may want to manage certain components in their own
forms, 1f you add a new form component to a page, it appears in the Outline

&) Form
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view along with forml, the default form (see Figure 3-40). New form Comp“

nents render as selected boxes in the design canvas.
‘Dutline o ax
Figure 3-40 Form component Outline view
Creator Tip
oy

If you need nested forms, use a virtual form (see “Virtual Forms” on

page 70). Although you can always delete form components that you add toa
page, it is not possible to delete the default form component, since every page
must have one.

[F Grid Panel Grid Panel

A grid panel component is a general-purpose container that groups other co
ponents and controls their layout. When you drop a grid panel on the desi
canvas, you can place other components inside of the grid panel. Creator fi
the grid panel with your components in a grid (rows and columns) layout. T
components appear on the grid panel in the order that you drop them. (Y
can rearrange components later by “re-dropping” them on the grid pane
Grid panels render as HTML <table> elements.

By default, grid panels have one column but you can modify the colum
property to add more columns. The grid panel displays its components left
right to fit the number of columns you specify. It also resizes the number
rows based on how many components you have in the grid panel. Figure 3
shows a grid panel (box of dashed lines) in the design canvas containing a b
ton, checkbox, and radio button. The grid panel on the left is a vertical layo
{one column, the default). Next to it is a grid panel with columns set to 3.

The grid panel is particularly useful when you don’'t know how much spa
a component will take up on the page. For example, if a static text componen
built dynamically and you want to place another component after it on t
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New form COmp‘f

S over 2t .

[Foverzt ~ @wmaie | Submit |

Fignre 3-41 Grid panel components

page, you can nest both components in a grid panel. The layout mechanism

s djusts the relative position of each component appropriately.

_ The grid panel component has other properties that control its appearance.

. These properties include bgcolor for background color, cellspacing and
;Vycellpaddi”g for cell width spacing, and border for the width of the grid

e —— panel’s border lines.

7

i on
‘you add to g
e every page

Creator Tip

Use the Qutline view rather than the design canvas to work with nested
components. It's much easier to place components on top of a desired target
with the Outline view. Rendering in the design view often obscures the
specific target component that you’re trying to drop onto.

Book Examples

“Add a Grid Panel Component” on page 193 (Chapter 5). Uses a grid panel
to hold button components.

“Add Components to the Page” on page 298 (Chapter 7). Uses nested grid
panels to help with component layout.

“Layout and Grouping with Grid Panel” on page 457 (Chapter 10). Uses a
grid panel to group different components and control their rendering.
“Add Components to the Page” on page 502 (Chapter 11). Uses a grid panel
and nested grid panel to help with layout. Uses static text components as
placeholders in grid panels.

“Add Components to the Page” on page 521 (Chapter 11). Uses a grid panel
with table components to help with layout.

“Using Grid Panel to Improve Page Layout” on page 597 (Chapter 13). Uses
agrid panel to handle layout for components rendered with text read from
properties files.

“Adding Components to the Page” on page 619 (Chapter 13). Uses a grid
panel to help with layout.

1el. Creator fil
ws) layout. Th
rop them. (Yo
he grid panel,

el. Figure 3-41
ntaining a but-
vertical layout
s set to 3.
w much space
t component i$
after it on the
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Chapter 3 Creator Components

Group Panel

A group panel is a general-purpose container that groups components ,
controls their layout. Whereas grid panels place components in a grid cong
ration (you specify the number of columns), a group panel component ygq
flow layout. Depending on the width of the panel, group panels arrange ¢q
ponents one after the other in a flow. When there’s not enough room in the f;
row, Creator continues with placement in a second row. Like grid panels,
order in which you drop components on a group panel is the same order ¢
they appear on the page.

A group panel component renders as an HTML <span> element and
page bean implements a group panel as a PanelGroup object. (If you set pr
erty block to true, a group panel renders as an HTML <div> eleme
Figure 3—42 shows a group panel (box of dashed lines) in the design canyg
containing a button, checkbox, and radio button.

Mlunder 21 ©Female

Figure 3-42 Group panel component

Creator Tip

Group panels are handy for grouping nested components. It’s possible, for
exantple, to place a group panel inside cells of a grid panel. This technique lets
you create interesting web pages by placing groips of components in each cell
of a grid panel. From the grid panel’s perspective, these nested comporents
are treated as a single cell.

The layout panel component is a container that groups components and le
you choose a layout mode. When you drag a layout panel component from &
component palette and drop it on the design canvas, the IDE gives you a Flo
Layout by default. As you drop components in the layout panel, the IDE alig
them from left to right on the top line, moving them to the next line if there
not enough room. This makes layout panels behave like group panels as !
add components.

If, on the other hand, you'd like to use the design canvas to position com
nents at arbitrary (absolute) places in the panel, change the panellayout pT
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Grid Layout (use the drop down list in the Properties window). Now
erty 10 onent will be positioned relative to the nearest grid lines. This makes
ch com ols behave like Creator’s design canvas (the default grid layout).
O.ut p 22,43 shows a layout panel (box of dashed lines) in flow layout mode
iﬁﬁf ng a'drOp down list, a listbox, and a button.
on

Components a
ina grid confj

lcofiee

T -
(Eggs ¥ L%ﬂ

: Figure3 _43 Layout panel component

Layout panel components are also the default for tab set components (see
© uTab Set” on page 114).

Book Examples

“Add Components to the Page” on page 289 (Chapter 7). Uses a layout panel
in Grid Layout mode to position components.

See TabSet3 project in the Creator download file (FieldGuide2/Examples/
WebPageDesign/Projects/TabSet3). Uses a tab set component with
embedded layout panels for each tab selection.

Page Alert 1) page Hert

The page alert component displays messages on a separate page. If you don’t
want to use a separate page, use an alert component from the Composite pal-
ette (see “Alert” on page 118). Page alerts are useful because they have recog-
N nizable icons and configurable messages. Figure 3-44 shows the page alert
component after you drop it on the design canvas.

isible, for
chnigue lets
vin each cell
Hiponents

nents and let:

Pége Aied .Sumnm. " .

Figure 3-44 Page alert component
ssition compo-
1Layout prop-
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w2 Page Fragrment Box Page Fragment BOX

Page 142 of 328

The type property in the Properties view contains a drop down list of icq
and alert types. There are four types of alerts: error, warning, informatigy,
question. The summary property displays a brief text message for the alert, C;
the detail property lets you display a longer, more detailed message. You
also right-click a page alert component and bind its properties to a Javabe
property or another object. :

Figure 3-45 shows two page alerts in a browser window. The left aler¢ d
plays a brief information message. The right alert shows an error alert Wit
brief reason for the alert followed by a detailed suggestion.

e W

Follow the Directions Below

Not allowed to access
contact wehsite administrator

Figure 3-45 Page alert components

Page fragments are separate, reusable components that you include in multi
web pages. The Page Fragment Box component generates a JSP directive
includes a JSP file fragment in your page. Page fragments let you build w
pages that have consistent form. You may, for instance, use page fragments
include the same graphic header in all pages of an application.

When you select a page fragment component and drop it on the design ¢
vas, Creator pops up a dialog that lets you create a new page fragment or sel
an existing one. Figure 3-46 shows the Select Page Fragment dialog.

Page fragment files show up in the Projects view Web Pages > resources
node as a .jspf file. In the Outline view, a page fragment box appears as a node
underneath an HTML <div> element. The name of this node has the format
directive.include:fragment_file.jspf, where fragment_file is the name of yout
page fragment file. Figure 3-47 shows the Outline view for the Fragment1.jspt
page fragment. k

Once you have a page fragment box, you can add visual elements to it
needed. A typical example is a page fragment consisting of a banner with &
company’s logo (an image component). As you create pages in your web ap
cation, drag a page fragment box component to the page, position it, and sp
ify the page fragment name.
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down list of ;
8 informaﬁOn
2 for the alery,
message. Yo,

: ; Fragment to include on the page.
ies to a IaVabe | colect apage frag

’~ page Fragment: Fragmentljspf

L_Ef‘itf Mew Page Fragment,., |

T11e left a]ertd
error alert With

‘Figlli’e 3-46 Select Page Fragment dialog
s -

istrator

“Outline ax
gel
pagel

¢ hitral1

ade in multip
? directive th
you build wi
e fragments

- Figure 3-47 Page fragment Qutline view

he design ca Creator Tip

'ment or sele

When adding components to page fragments, make sure the id of any new
component does not conflict with any component id names on the including
page. Also, virtual forms are not allowed within page fragments.

Book Examples

* “Banner Page Fragment” on page 309 (Chapter 7). Uses page fragment box
tomponents to create uniform looking pages.

* "Using Tab Sets and Page Fragments” on page 327 (Chapter 7). Uses a page
fragment box with tab set components.

nents to it as
anner with a
1r web appli-
it, and spec:
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iE] Page Separator Page Separator

The page separator component creates a horizontal line on your page. This
you separate other components for a better visual layout. Page separator ¢
ponents are rendered as HTML <hr> elements. You can change a page Separ,
tor’s width and appearance in the Properties view. In the page bean, a Pag,
separator component is a PageSeparator object. :

Figure 3-48 shows a page separator with a drop-down list, text field, an;
submit button.

Select Player

! Page Separator
i

Ve

Submit |

Figure 348 Page separator component

el meenysiest  Property Sheet

The property sheet component is a layout composite component. In the desigs
palette, property sheets contain nodes for nested property sheet section com:
ponents and property components (see Figure 3-49).

Le

| Praperty Sheet
5] Property Sheet Section
| Property

Figure 3-49 Property sheet component

When you drag a property sheet component to the design canvas, the initia
layout is one sheet section containing one property, as shown in Figure 3-49
It's possible to have multiple sheet sections on a page with header strings ini
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the sheet section’s label property. You can also have multiple

. ith . .
tlahzed w ponents within each sheet section.

5 operty com

page. Thig cty components are containers with labels, optional help text, and

separator ;Pwpefoz/matting' By default, the property component displays read-only

a page sep defautl)tut you can attach input components, such as calendars, drop-down lists,
ta,

ds. To add new properties, drop a property component on a property
ion, or right-click the property sheet section component and select
4 Property. After creating property components, the Outline view is helpful
Ad nput components on a selected property. Figure 3-50 shows a

ropping 1 . ;
foroit E/Ii)th one sheet section (sectionl) and four properties. Each property
a

has it

2 bean, 4 p

or text fiel

5 own input component.

Figure 3-50 Property sheet Outline view

There are several important properties for property sheet components. The
requiredFields property displays a required fields message (and red asterisk)
when set to true. A property sheet component also contains an anchor compo-
nent by default (see “Anchor” on page 72). If you set the jumpLinks property,
the property sheet displays links to its sections at the top of the property sheet.
Ifa property has an input component, you can set the optional required prop-
erty for that component to force data entry on the page.

Exumple

Property sheets are handy for creating data entry forms. Figure 3-51 shows an
entry form for a rental car reservation in a browser window.

Here, we have one property sheet set up with properties and input compo-
hents. Note that this property sheet has required fields for most of the input

15, the initi
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* |ndicates required field

21}

Rental Car Resgervation

R

" Pickep Clly ; e

i

Fpickuppate | |
mmiddinyyy

* Return Date ‘

mmddy

Figure 3-51 Property sheet example

components. The drop-down selection is not required for input and defaults
the initial string Sub Compact. The requiredFields property is set here to d
play the required fields message.

The tab set is a layout composite component. In the design palette, tab sets con
tain a nested tab component node (see Figure 3-52). Tab set components le
you click tabs to view alternate sets of components or navigate to differen
pages. Each tab in a tab set is a tab component with configurable properties. T
add a new tab, right-click the tab set component and choose Add Tab or drop
new tab component on a tab set (or another tab component for nested tabs). -

In the Outline view, tab components provide a default layout panel (se
Figure 3-52) to hold components that become visible when a user clicks a tab
Each layout panel’s panelLayout property is set to Grid Layout by default, bt
you can change it to Flow Layout in the Properties view. If you use tab sets t
navigate between pages, be sure to delete each tab component’s layout pane
The selected property of a tab set component determines which tab is initial
selected. Tab selections also change color when you select them.

You can create an event handler by double clicking any tab component of
tab set in the design view. It's also possible to bind a tab component’s text pro
erty to an object or data provider.
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layoutPanelt

igure 3-52 Tab set component

Creator Tip
et here to ¢ s

When you drop a tab component to the left or right of an existing tab in a tab
set, the tab component appears in the same row of tabs. Otherwise, the tab
component will be a child of the tab component that you drop it on. You can
have at most three levels of tabs in any tab set.

Figure 3-53 shows the design canvas for a tab set with three tab compo-

nents. In the Outline view, each tab component has its own layout panel.
oroperties. .

Tab or drop
sted tabs).
ut panel (see x
r clicks a ta o

y default, b ':
se tab sets

~ Figure 3-53 Design canvas and Outline view of tab set
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Book Examples

* “Using Separate Tab Sets” on page 324 (Chapter 7). Uses separate tab gq;
components to navigate among pages.

¢ “Add Tab Set and Tabs to CactusBanner” on page 329 (Chapter 7). Uses 5
set component with a page fragment for navigation.

* See TabSet3 project in the Creator download file (FieldGuide2/Exampleg
WebPageDesign/Projects/TabSet3). Uses a tab set component on one page
to display different sets of components. ;

ta]

3.5 Composite Components

The following catalog of composite components describes each component g,
gives you common usage scenarios. The composite components are list
alphabetically for easy lookup.

The add remove list component lets users select items from one list and add
remove them from another list. The component displays two listboxes and tw
buttons. One listbox displays available options and the other displays selecte
options. The buttons let you add or remove options from the two listboxes.

Figure 3-54 shows the layout after you drop the add remove list compone;
on the design canvas and fill in the selection items in the available listbox.

. Auvailable:’ 0 ool 0. Selected:
" First Narme
"iLastName
s iEmail
. IPhone Number
- hddress
CiCity
~Zipeode
~Country

Figure 3-54 Add remove list component
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3.5 Composite Components 117

Jection items can be set through the Properties window or dynami-
The ¢ .ated at run time. Creator automatically supplies a converter for non-
ally 88;etla fields when you fill the list from a data provider. The selected
string aof the add remove list returns the selected items. The items property
]prOPe.I‘tt s the component with a data provider.
associd icify the choices, select the non-visual addrRemovelist1DefaultItems
1o sPent in the Outline view. In the Properties window, click the editing box
com O,?e property options. Creator pops up a dialog so that you can add, edit,
0 Pg; ove items. (This is the same dialog box used to specify Display/Value
‘ qurC{S with the Listbox component. See Figure 3-20 on page 87.)
f@\(ou can also right-click the add remove list component and select Edit Event
Handler from the pop-up menu. The validate option lets you insert ]avq code
that validates user input, and the processvValueChange option lets you insert
ava code that executes when a component’s value has changed.

rate tab Set

r 7) USGS aty

;Oon one pa

Example
 Let’s add a submit button and a static text field to the sample page shown in

- Figure 3-54. In a browser window, the submit button determines which selec-

tions were made and the static text field displays them. Figure 3-55 shows the

_tesults of clicking the Submit button after adding an email, city, and country to
 the selected listbox. The static text field displays the selected string items.

slays select
listboxes. Available: Selected:
3t compone; First Name | Email
listbox. Last Mame City
Phone Number Country
Address
Zipcode

Idilbert@yahoo.comAnywhere|USA|

Figure 3-55 Add remove list component with selections
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118 Chapter 3 Creator Components

Here is the Java code for the Submit button event handler method tha y,
the selections from the add remove list component and displays the String
the static text component.

public String submit action() {
String selections = addRemovelListl.getSelectedValues();
staticTextl.setText (selections);
return null;

lal et Alert

The alert component lets you display messages on a page. Alerts have recg
nizable icons and configurable messages. When you drag an alert compong;
from the palette and drop it on to the design canvas, the default is an ery
alert, as shown in Figure 3-56.

! @Amn‘Summary '

Figure 3-56 Alert component

The type property in the Property view contains a drop down list of ico
and alert types. The are four types of alerts: success, error, warning, and inf
mation. The summary property displays a brief text message for the alert, a
the detail property lets you display a longer, more detailed message. If
summary property is empty, the component won't display on the page. You c
also right-click a page alert component and bind its properties to a Javabeans
property or another object. ’

Component alert includes an embedded hyperlink component, which you
access by setting property 1inkText. To specify an action event handler for the
hyperlink component, right-click the alert component and select Edit action
Event handler.

Example 1
Figure 3-57 shows a page with a success alert directing users to a second page
To show the check mark icon, we set the alert component’s type propertyt
success. The summary and detail properties are set to “Item in Stock” and “T
Process Your Order”, respectively. Users are directed to another page via th
1inkText property, set to the string “Click Here”.
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550 a &

Edt view Favorites  Tools Help uE

@ Item in Stock
To Process Your Order

» glick Here

igure 3-57 Success alert with page navigation

To implement page navigation, we use Creator’s page navigation editor to
 specify navigation. Figure 3-58 shows the page navigation editor connecting
the two JSP pages with string “alertOutcome”.

Pagel.jsp &

Pagr2.jsp
dleitOutcome .

Figure 3-58 Page navigation editor

The IDE generates an event handler when you double-click the alert compo-
‘hich you nent. Here is the Java code for the alert event handler method, which simply
erforthe = Teturns the same string used by the page navigator.

public String alertl action() ({
return "alertOutcome";

}

nd page

perty to Example 2

and “To You can use alert components in place of message or message group compo-
* via the nents. Figure 3-59 shows project Colorl (see “Custom Validation Method” on

Page 611) running in a browser. We replaced the three Iessage components

Facebook's Exhibit No. 1003
Page 00151

Page 151 of 328 GOOGLE EXHIBIT 1003



Page 152 of 328

Chapter 3 Creator Components

with alert components (with property id of redAlert, greenalert, and by,
Alert).

Fila  Edit Ve Favorites  Tools Help

Color Fun

@ 1t Hex

numbers must be
two digits exactly.

@ kk: Hex

characters must be
[0-8][A-F][a-f] oniy.

@ Validation Error:
Value is required.

Update Caler

Figure 3-59 Using alert instead of message to display validation errors

In the page bean method prerender (), we invoke helper method se
AlertMessage () to set the alert’s summary property with a component-specif
message from the FacesContext.

public void prerender () {
setAlertMessage (alertRed, redInput) ;
setAlertMessage (alertGreen, greenInput);
setAlertMessage (alertBlue, bluelnput);

Method setAlertMessage () obtains the FacesContext and any messages
associated with inComp, its argument’s component. FacesContext method get-
Messages () returns an Iterator of FacesMessages for the component§
clientId passed as an argument. Conveniently, the alert component does no

display if its summary property is empty.

private void setAlertMessage (Alert ac, UIComponent inComp) f{
FacesContext context = FacesContext.getCurrentInstance();
Tterator mi = context.getMessages(

inComp.getClientId(context));
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:rt, and b 1y

— m,
’

g newMessage =
(mi,hasNext()) {
((FacesMessage)mi.next ()) .getSummary ()+" ";

gtrin
while _
nenMessage

5 setSummary(newMessage);
4c.

Brea dcrumbs {iF} Breadcrumbs

1e preadcrumbs component is a default layout for hyperlinks. The name
os from an old hiker’s trick where you drop breadcrumbs on a trail to find
our way back and not get lost. With applications having many different web
ages, breadcrumbs typically show a user’s location by displaying the path
krough the page hierarchy to the current page.

. When you drag a breadcrumbs component from the palette and drop it on
the design canvas, the IDE includes a nested hyperlink component for every
ége in the application. Figure 3-60 shows the Design view and Outline view
for a breadcrumbs component with two pages.

Hex
must be
exactly.

. Paue 1>Page 2

; 5 hypetlinkl: Page 1
&% hyperfink2: Page 2

kFigure 3-60 Breadcrumbs component

In the Design view, the breadcrumbs component separates hyperlinks by
‘r.lght angle brackets (>). By default, the initial component has a single hyper-
link that points to the current page.
~ The url and action properties of each hyperlink are set the same way for
breadcrumb components (see “Hyperlink” on page 82). You populate a list of
 hyperlinks by setting the pages property of a breadcrumb component to point
to any array or list of HyperLink objects. You can also bind the pages property
t0.a JavaBeans component or data provider.

nComp) {
ance () ;
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Creator Tip

With portlets, the IDE does not provide a default hyperlink for breadcrunh
components. You must add the hyperlinks yourself. '

Example

Suppose an application has separate web pages to help users edit, comp;
debug, and test a program. On the test page, it may be important to refer to g,
previous pages for information that relate to testing. Figure 3-61 showsg
breadcrumbs component in a browser with links to the previous pages visite
by the user.

Favorites  Tools  Help

Test Page

Edit = Ciﬂgile » Debug > Test

Figure 3-61 Breadcrumbs Example

Property url of each hyperlink in the breadcrumbs component is set to
page that was previously visited.

] mireree  Inline HeIp

The inline help component is similar to a label. However, inline help comp
nents are restricted to displaying short help information for users on we
pages. Once you drop an inline help component on the design canvas, you ¢a
type text directly in the component box. You may resize the box and the te
wraps automatically. Figure 3-62 shows an inline help component on t
design canvas.

Facebook's Exhibit No. 1003

4

Page 154 of 328 GOOGLE EXHIBIT 1003



3.5 Composite Components - 123

eadcrump

This s Inline Help text

Figire 3-62 Inline help component

The inline help component has a type property which may be set to page
1o default) or field in the Properties view. Page view is a larger font that
he]‘es to a page, whereas field view is a smaller font to help describe individ-
al Clomponents. You can set the style property of an inline component using
he Style Editor and the styleClass property using the styleCIass'Property
ditor. The text property can also be bound to an object or data provider.

Example

Figure 3-63 shows a page in a web browser with an inl.ine help cpmponent at
the top with type property set to page. Below the Confirm Selectlon. button, a
second inline help component appears with its type property set to field.

File Edit Favorites Tools  Help

Inline Help
Step 2 Choose arecording ~<@——  (page)

Select a recording [ Confirm %‘ lection l

_ - Inline Help
% Click Confirm Selection —af—ij—— (field)

Figure 3-63 Inline help example
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3.6 Validators

Creator provides a set of standard objects that validate user input gathg,
through UI components. The JSF architecture builds validation into the
request life cycle process, making validation an easy task for the developer
specify. Figure 3-64 shows the available validators in the Creator Compone
palette.

&

' Palette

* Double Range Valxdator
¢ Length Yalidator
s Long Range Yalidator

Figure 3-64 Validators

Validation Model

In Creator, you attach a validator object to a component by selecting a validator
from the design palette and dropping it onto the component in the design can:
vas. You can also select a validator from the drop down list opposite property
validator in an input component’s Properties view. Validators have propertles
that you can manipulate to specify range limits (for example).

The JSF life cycle (see Figure 6-16 on page 262) includes a Process Valida-
tions phase. For components that have registered validators, JSF will validate
the component’s data. When validation errors occur, the affected component is
marked “invalid” and an error message is sent to the JSF context.

Validation errors affect the life cycle process. Validation errors cause the
page to proceed directly to the Render Response phase, skipping the Update
Model Values phase and Invoke Application phase. This means events such as
button clicks are not processed. When a page has multiple components with
registered validators, all input is validated. This is helpful to the user sinc
feedback (error messages) for the entire page can be displayed. Table3!
describes the validators in more detail.

There are three standard validators: a Double Range Validator for floating
types, a Length Validator for strings, and a Long Range Validator for integrd
values. You can also write your own custom validation method. Note that eacl
standard validator has properties for minimum and maximum values. The
Length validator works with String data, and the Double Range and Long
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3.4 JSF Validators

Description Example
put gat, Jame
nto the - e Range yalidator ~ Specify minimum and “Use Validators and Converters” on
devel ouble maximum values. page 252 (Chapter 6). Uses a Double
COmpo Range Validator with a text field to
Ney check the range of a double.

o th Validator Specify minimum and “Add a Validator” on page 472
eﬁg maximum values. Does (Chapter 10). Uses a Length
not detect empty input Validator with a text field.

fields (you use required
property of component).

ange Validator Specify minimum and “Place Interest Rate and Term

maximum values. Components” on page 254 (Chapter
6). Uses a Long Range Validator
with a text field to check the range of
an Integer value.

ong R

Custom Validate Method validate- “Add a Validation Method” on

: HexString () method page 617 (Chapter 13). Shows how
checks for a 2-digit hex to implement your own validation
string method.

PRI

Range validators are typically used with converters to convert a component’s
r a validatg data to the correct type.

design can . Table 3.1 also points you to examples in the book that show you how to use
te property the validators. This includes an example of a custom Validate Method called
2 properties validateHexString () that checks for a 2-digit hexadecimal string in a web
application.

mponentis . 3,7 Converters

the Update . [SF strives to separate presentation data (the data that users read and possibly

nts such as - modify) from internal data or model data. To accomplish this, you should use
nents with _ JavaBeans components, EJB components, JDBC cached rowsets, and other
user since application-specific structures to represent model data and behaviors. JSF also
. Table 3.1 . makes sure that any data conversions between the two views are consistent
; . and well-defined,

or floating Figure 3-65 shows the available converters in the Creator design palette.

or integral

e that each
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! palette o ax
imBasic G oA
Layout
Compasite

Walidators

Canverters S

4 Big Decimal Converter

Bonlean Converter
Byte Converter
Calendar Converter
Character Converter
Date Time Converter
» Double Converter
Float Converter
Integer Converter
Long Converter
MNumber Converter
Short Converter

Sql Timestamp Converter »

Figure 3-65 Converters

Conversion Model

A UI component (components for input such as text fields or components
output such as labels and static text components) can take a data converter
convert its data to a specific type. Typically (but not always), the compone
may be bound to a JavaBeans property of that type. For example, in proj
Paymentl (see “LoanBean” on page 242), we bind a text field compon
(LoanAmount) to the amount property of LoanBean. Property amount is a Do
ble, so we apply a Double converter to the text field component.

Like the validation process, JSF sets aside specific times to perform conv
sions. For an input component, conversion applies to the submitted inpt
before validation. When errors occur, the affected component is marked
“invalid” and conversion error messages are sent to the JSF context. JSE p
ceeds to the Render Response phase in this case.

Creator applies converters automatically to data-aware components whef
the source data type is not a String. Table 3.2 describes the converters available
on Creator’s palette.

Most of the converters are straightforward and provide a conversion that?
obvious from their name. Note that all converters use wrapper classes (sub
classed from Object) instead of the primitive types. This allows the text proP
erty (type Object) to accept all of these types. :
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~ 3.2 JSF Converters
Description/Example
D ;mal Converter Converts between String and java.math.BigDecimal.
eCLILe
Converts between String and Boolean.
Converter Converts between String and Byte.
Jendar Converter Converts between String and java.util.Calendar.
endid
acter Converter Converts between String and Character.
ard
te Time Converter “Configure the Table” on page 360 (Chapter 8). Converts
between String and java.util.Date.
Pouble Converter “Use Validators and Converters” on page 252 (Chapter 6).
Shows a double converter with an interest rate value and a
loan amount value.

foat Converter Converts between String and Float.
ﬁteger Converter “Place Interest Rate and Term Components” on page 254
: (Chapter 6). Shows an integer converter with a loan term

value.

ong Converter Converts between String and Long.

Number Converter “Place Button, Label and Static Text Components” on
page 257 (Chapter 6). Shows a number converter with a
currency value.

hort Converter Converts between String and Short.

Tponents for 5ql Timestamp Converter Converts between String and java.sql. Timestamp.

The Date time converter, Number converter, and 5ql Timestamp converter
quire a bit more explanation, however, so let’s do that now.

Date Time Converter

The Date Time Converter converts a component’s data to a java.util.Date.
When you apply a Date Time Converter to a text field, the textual input is con-
verted. The field on the page is updated with a standard format during the
J_Render Response phase. You can always configure a Date Time Converter’s
kformat if you need to. If you don’t specify a locale, the Date Time Converter
~ Uses the default locale (see “A Word About Locales” on page 593).

_ The Date Time Converter uses the format rules and patterns of the Date-
_Format class. See the tutorial at ht tp://java.sun.com/docs/books/
tutorial/il8n/format/dateFormat.html for more information on format-
. t.mg; see also the Javadoc for the DateFormat class at http://java.sun.com/

‘ 32se/1.4.2/d0cs /api/java/text/DateFormat.html.

The Date Time Converter uses a default pattern if you don’t configure it dif-
_rently. The data are assumed to be a date (as opposed to time) using the pat-
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tern MMM d, yyyy. Although full names for the month are accepted, the p,
Time Converter shortens it to three letters and rejects numerical valueg,
input, you must supply a comma. See “Configure the Table” on page 360 fq,
example of applying the Date Time Converter to a table column.

Of course, your choices for other formats are more flexible. Table 3.3 ghq
the results of applying the Date Time Converter to a specific date (Apy)
1985) in String format. The table shows several formatting patterns ang
effect of setting the dateStyle property to medium, long, and full.

Table 3.3 Date Time Converter

Property/Pattern Result

medium Apr 5, 1985

long April 5, 1985

full Friday April 5, 1985
MM-dd-yy 04-05-85

EEE, MMM d, "yy Fri, Apr5, ‘85

Number Converter

A Number Converter lets you manipulate numerical data using either a pa
tern, or specifying minimum and maximum digits and fraction digits. Sinc
numbers are sensitive to language and locale, a Number Converter can us
locale. ‘f

The Number Converter uses a pattern with separate properties for manipu
lating a format (such as currency symbol, integer digits, fraction digits, an
locale). We use a Number Converter to convert a double to a dollar (String
value here (see “Place Button, Label and Static Text Components” on page 257
Also see Figure 11-8 on page 505, which shows the Number Format dialog. W
use it in Figure 11-8 to convert a BigDecimal value to String for output, usin
pattern “USD #,44#4.00” for a currency amount in U.S. dollars.

Sql Timestamp Converter

The Sql timestamp converter converts data between String values a
java.sql.Timestamp data types. It is also useful for binding a component t0
database column of type TIMESTAMP. You can use to convert input data
type TIMESTAMP or display TIMESTAMP values on the web page.
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> accepted, the
merical Valyeg
"on page 36( ¢,
imn.

le. Table 33 sh
cific date (Apr
3 patterns and
d full.

8

~ AJAX Components

pronous jJavaScript Technology and XML (AJAX) is a web development

e for building interactive web applications. Its main purpose is to
nid! nchronous updates on a web page without refreshing the whole page
v 'atS}i,out performing a submit and postback. Creator provides a component

lthat includes experimental-technology AJAX components. To use these
o nents, install the Update Center’s most recent AJAX component library
add it to the Components palette. Figure 3-66 shows the BluePrints AJAX

s and Support Beans installed in the Components palette.

\Qh

e } - v
ePrints AJAX Comp -
gy Adto Complete Text Field

2 Map Viewer
o1 Progress Bar
" Select Value TextField

————————— Geocoding Service Object
. Gengraphic Point

“f"igure 3-66 BluePrints AJAX Components and Support Beans

- In this section, we’ll show you how to use the Component Library Manager
to add the AJAX component library to the palette. We show you how to use the
AJAX-enabled Auto Complete Text Field component in Chapter 13 (see “Using
AJAX-Enabled Components” on page 628 and “Using AJAX-Enabled Compo-
nents with Web Services” on page 638).

Creator Tip

Since the AJAX-enabled components are under development, yoir should
make sure you have installed the most recent component library from the
Update Center.

Ing values an
component to
rt input data t —
rage.

Importing a Component Library

The first step in using one of the AJAX-enabled components is to import the
target component library into Creator.
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1. From the Creator main menu, select Tools > Component Library Managg,
Creator brings up the Component Library Manager dialog, as shown 'ln‘
Figure 3-67. (Alternatively, right-click on one of the Component section
the Components palette and select Manage Component Libraries.)

Library Name:

* Compornent Libraries:

T Run Time Yersion: L

B Javadoc . -
Component Lisk: Default Palette Settings

@ Java Sources |
= Welb Resources | onpdette  fame T Categories

) Help Sources [ {€] Add Remove List Composite

| o Alert Composite

Anchor __ Basic

‘Basic Table Data Fiter Advanced Data Provi

Figure 3-67 Component Library Manager Dialog

. Click Import. Creator brings up the Import Component Library dialog.
. Click Browse and navigate to the directory samples/complib.
. Select ui.complib and click Open.

_ You'll see BluePrints AJAX Components and Support Beans in the text fi
under radio button Import into Palette Categories defined by Library, as
shown in Figure 3-68. Click OK.

6. The Component Library Manager dialog now shows the BluePrints AJA
Components listed under the Component Libraries. The Component List
includes the Auto Complete Text Field, Map Viewer, Progress Bar, and
Select Value TextField (and support beans) as shown in Figure 3-69. Click
Close to close the Component Library Manager dialog.

7. From the Components palette, open the BluePrints AJAX Components sec

tion to see these components added to the palette (as shown in Figure 3-66

U1 N

Creator Tip

More components will be included in the BluePrints AJAX Components
Library as they are developed.
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mpohgnt Library

Z\nB‘% . lisaf;{ples'\cumplib‘;ui. complib

§ EBrowse,,. 1

iy

ppart into palette Categories defined by Cormponent Library

ihfs F\JAX t‘omponents

A414% Suppott Beans

I o

K%_H Cancel H Help }

igur

ibraries:
brary dialog, e
lib. @ Sun Java Studic Creator Builk-ir /
& Design Tima
-~ Run Time
-5 Javadoc
- @ Java Sources
5 ‘Web Resources

%) Help Sources

18 in the text fie
by Library, as

luePrints AJAX
mponent List
ess Bar, and

ure 3-69. Click

! B Design Time
-3 Run Time
-9 Javadoc
{@ Java Sources
5 Web Resources
2) Help Sources

f 'Import..‘ | Remove %

omponents sec
vin Figure 3-66

¢ 3-68 Import Component Library Dialog

Library Name:

Identification URI:

Yersion:

Comporent List:

( EBluePrints AJAX Components

http: ffwww, sun, comfblueprintsfajax

o

Default Palette Settings

On Palette

MName Categories )
2 Auta Complete Tex... BluePrints AJAX Components )

{£ Geocoding Service ... BluePrints AJAX Suppart Bean

% Geographic Point BluePrints AJAX Suppart Beary

* Map Marker BluePrints AJAX Support Bean

EREREREE

3 Map Point BluePrints AJAX Support Beary
> Map Yiewer BluePrints AJAX Components
&5 Progress Bar BluePrints 414X Components
r,j] Select Value TextField BluePrints AJAX Somponents
: : i >

- E Closs[\gj
1ponents
- Figure 3-69 After importing the BluePrints AJAX component library

Page 163 of 328

Facebook's Exhibit No. 1003
Page 00163

GOOGLE EXHIBIT 1003




Chapter 3 Creator Components

3.9 Key Point Summary

Creator’s design palette contains components, validators, converters, anq
data providers.

Creator’s components are rendered in HTML.

Creator components share many properties in common, such as text,
toolTip, style, id, and binding.

Creator components that manipulate data can accept converters to convey
data to an from String form. You can also use converters to format data on
output.

Input components share common properties, such as validator,
maxlength, required, valueChangelistener, and onChange.

A value change event occurs when an input component’s selection change,
or its text changes.

Creator generates a processValueChange () method when you double-clic
an input component.

The Auto-Submit on Change feature submits a page when an input
component fires a value change event. Creator generates a JavaScript
element and configures the component’s onChange property to implement
this feature.

Table components (table and grid panel) have properties to control
appearance, such as bgcolor, border, cellspacing, cellpadding, and
columns.

Creator provides component binding with data providers that wrap data
sources, JavaBeans components, web services return objects, and EJB retu
objects. You can also apply property binding to arbitrary application data
This simplifies transferring data between the presentation view and the
model view. :
A table component is data aware and offers sophisticated layout choices. By
specifying headers, footers, and embedded component types for its '
columns, the page designer can build a custom page for displaying data.
You can enable paging controls with table components. This is useful for
database queries or other data that produce more than a single page of data
JSF has data converters that encourage the separation of model and '
presentation data. The Creator converters seamlessly convert presentation
data to and from model data.

The Creator validators validate user input before events are processed.
Validation and conversion errors short-circuit the normal life cycle request
mechanism and re-render the page with error messages.

Use a message or message group component to display validation or
conversion errors on a web page.

Use message group components to display system or global errors.
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| write your own custom validation method and hook it into the JSF
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Topics in This Chapter

+ Editing Java Code
» Refactoring

« Source Code Control with CVS als

« Creating Non-Web Projects mai
o
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un Java Studio Creator has an integrated development environment
(IDE) that greatly simplifies the “edit-compile-deploy” cycle of complex
web applications. Based on NetBeans, the IDE has code generation and
navigation features that make it easy and pleasurable to edit and com-
e programs. In addition to keyboard shortcuts and code completion, the IDE
iso provides code refactoring and CVS source code control. All of these fea-
res make up a development environment that helps you create, manage, and
maintain your web applications.

. This chapter shows you how to use the Source Editor to write Java code
effectively. You will learn how to customize the IDE to your tastes and create a
_comfortable environment to develop applications. We'll also show you how to
efactor your code when it becomes necessary to make large changes, like
hanging the name of a method or a heavily-used class. Because source code
Maintainability is so vital today with complex web projects, we’ll show you
Ow to put your code under CVS source code control. Along the way, there will
e plenty of examples to help you understand how to use these features! in
reator projects.

L. This chapter focuses only on editing, refactoring, and versioning in
the IDE. To learn more about Creator’s software development fea-
tures beyond these topics, consult the NetBeans documentation.

135
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Chapter 4 Software Development

4.1 Using the Java Source Editor

The Java source editor is where you'll spend a lot of your time in Creatoy =
section shows you useful features that make it easier to develop your appli;
tions.

Finding What You Need

Creator allows you to customize the Java editor to suit your individual taste
you select Tools > Options from the Creator toolbar and select Java Edit
under the Editing > Editor Settings node, you will see General and Expert
tings for the editor, as shown in Figure 4-1.

{# Basic (O Advanced
Options | i General ; :
~ ) General Settings Code Formatting Rule Java Indentation Engine
: B System Settings Abbreviations Abbreviations
3 web Bronsers Auta Popup Completion Window
2 Delay of Completion Window Auto Popug 500
; &P <Default System Browser>  ICase Sensitive Code Complstion ]
Logf Internet Explorer Auto Popup Javadoc Window =
%) Editing Code Folding ‘ Cada Folding
. N N =Experk 4 L i )
[& Edtor Sett”_jgs Code Completion Instant Substitution
: M CS5 Edior Insertion Point Blink Rate 300
oo [@ ML Editor Insertion Point Color M [0,0,0]
(& Plain Editor Overwrite Caret Calar N [0.0,0]
. g Insertion Point Yertical Bar
15P Editor Overwrite Caret Sofid Block
- 16] Properties Editor Fants and LU|‘0V5 Fonts & Colors
- Code Completion Matural Sork O
@ ML Editor Hiahlight Matching Bracket [
: -8 oD Editor Background Colar of Javadoc Popup Window: [ [247,247,255]
H @ Visual Designer Javadoc Preferred Size {500, 300]
Praject Settings Key Bindings Key Bindings
Line Height Carrection 1.0
Macros Macros
IMargin o, 0, 0,0]
Pair Character Completion &)
j Close

Figure 4-1 Java Editor Basic Options

Note that you can do basic things like change code formatting rules, a
new editor abbreviations, or modify code folding for imports and methods.
you are feeling like an expert, you can change fonts and colors, key bindin
and even the insertion blink rate (to save on your eyes). Take a few moments
click on the customizer boxes with several of the features here, and you W
learn a lot about what you can do to customize the editor. '
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4.1 Using the Java Source Editor

r ick the Advanced radio button in the Options dialog, you will see
Code Formatting Rule settings under the Editing > Code Formatting
) de. Figure 4-2 shows the list of configurable rules that affect code for-
me in Creat, ’

relop your apy

: {Expand Tabs tn‘Sbaces

ndividual taste 7 Bulding . Number of Spaces per Indent 4
&) Ant Settings  |Add Leading Star in Comment - [#]

5 Editing - iadd Newline Before Brace I}
27y KML | |Add Space Before Parenthesis [}
General Settings © . IStatement Continuation Indent 8

] Annotation Types
[& Editor Settings
Code Formatting Rules
55 Indentation Engine

Engine simple Code Formatting Rule
HTML Indentation Engine

Line Wrapping Code Formatting Rule

Java Code Formatting Rule

15P Cade Formatting Rule

%L Code Formatting Rule

& Beans Propetty

Java Sources

g gj Source Synchronization

[;-';1\ To Do Settings »

igure 4-2 Java Editor Advanced Options

Formatting Code

wa code is automatically formatted in Creator according to default rules.
Members of classes, for example, are indented four spaces, continued state-
_ ents are indented eight spaces, and any tabs that you enter are converted to
Paces. No spaces are placed before an opening parenthesis, and an opening
. Curly brace is put on the same line as a class or method declaration.

. Toreformat all the code in any file in Creator, type <Ctrl+Shift+F>. (Alterna-
fively, right-click inside the editor and select Reformat Code from the context
gizn.u.) This is very handy right after you paste a code fragment from another
<Ctri-r:{"0 your source code. To indent blocks of code manually, type <Tab> or

>, Typing <Shift+Tab> or <Ctil+D> reverses indents.

tting rules, add
and methods. If
5, key bindin,
ew moments
g, and you w
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138 Chapter 4 Software Development

You can change any of Creator’s default settings for code formatt,
accessing the Java Indentation Engine. This can be done directly with th,
Code Formatting Rule in the Advanced Options dialog (see Figure 4-2), o
clicking on the customizer box for Code Formatting Rule in the Basic Opti
dialog (see Figure 4-1).

Fonts and Colors

The Basic Options dialog (Figure 4-1) lets you configure font size and style
well as the foreground and background colors of the editor. Under Expert,
the customizer box for Fonts and Colors. Figure 4-3 shows the settings for
Method calls.

i

Synkax: Font
Default
Black Comment: | Monospaced 12 Bold
Character Literal :
Code Folding

Code Folding Bar

Errar In Sources

Glyph and Line Mumber Margin

7 Inherit

Foreground Color

Guarded Block

i 0,0,0
Highlight Insertion Paink Rows ¢ B [000]
Highlighted by Search ] Inherit

Incremental Search
Java Annotation
Java Identifier
Java Keyword

Sackgraund Color

| [ [255,255,255]

Java Operator ] Inherilé S
Matching Bracket
Mumeric Literal
Search Selection Breview
Search Wrapped
Selected Text
Single-line Comrent
Status Bar

String Literal
Whitespace

method()

Figure 4-3 Fonts and Colors Dialog

Clicking the customizer box for a Foreground or Background Color brin
up a color palette to choose a different RGB value. Likewise, clicking the cu
tomizer box for a Font allows you to change its style and point size. The Inhet
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4.1 Using the Java Source Editor 139

code formatﬁn . indicates whether or not a font or color should be inherited from the
H : [0,
lirectly with the : C :I)t syntax category.
! au

ee Figure 4-2) .
code Completion

in the Basjc Opﬁ

he handier features of the IDE is code completion, which lets you type
Java identifier and let the IDE finish the expression for you. To use this
activate a code completion box with one of the following:

e of £
rtofa
fure,
Type a few characters in an expression, then press <Ctrl+Space> or <Ctrl+\>.
Pause after you type a period (.) in an expression (this gives you a choice of

method names).
Type the import keyword followed by a space.

mt size and st
Under EXpert
the settings for

code completion box contains a list of choices to select from. After you
ose what you want, just press <Enter> to finish. To close the code completion
« without choosing anything, press the <Esc> key.

Figure 4-4 shows a code completion box and associated Javadoc popup win-
ow. Here we typed new List followed by <Ctrl+\> and selected ListDatabPro-
ider in the code completion box. Note that the Javadoc window provides the
ocumentation for this class. After you press <Enters, the IDE completes the
ass name and adds the import statement for the class to your code.

i

I

com.sun.data.provider.impl.ListDataProvider

public class ListDataProvider
extends AbstractTableDataProvidey

This TableDataProvider implemantation wraps the contents of a List. This DataProvider
ignores FisldKeys entirely, and maintains a single list of ohjects.

! iList®
Ceey ListCellRendersr

S ListDV feon, sur
=+ %o ListDataEverit

w4

public void prerel
ListbataProwi

size. The Inhe ‘ Figure 44 Code Completion and Javadoc popup
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Disabling Code Completion

You can disable the code completion box and Javadoc popups if you dony,,
them active. To do this, choose Tools > Options from the Creator meny, ext
the Editing > Editor Settings node, and select Java Editor. Under Genelal Se
from any of the following.

¢ To disable the code completion box - uncheck the checkbox for Auto Pop
Completion Window.

¢ To disable Javadoc popups - uncheck the checkbox for Auto Popup Jav,
Window.

¢ To change the code completion box display delay time - modify the def,
of 500 milliseconds for the Delay of Completion Window Auto Popup.

Note that changing these options disables only the automatic appearang
what the IDE does. Once disabled, you can still manually activate code com
tion with <Ctrl+Space> (or <Ctrl+\>). Likewise, typing <Ctrl+Shift+Spaces
ually activates Javadoc popups.

Show Line Numbers

You can toggle whether or not the Java source editor shows line numbers, P
the cursor in the blue left-margin area and right-click. Select Show Line N
bers from the context menu to enable line numbers. This is especially co
nient for identifying the source of an exception or debugging activities.

Code Folding

The Editor lets you collapse (or fold) certain sections of code to make room f
other lines. You may fold methods, inner classes, import blocks, and Javad
comments. Clicking a box icon in the left margin allows you to fold/unfo
code that is bracketed by a vertical line extending down from the icon. ;

It’s also possible to configure the IDE to fold code for you automatically.
do this, click Tools > Options from the toolbar and select Editing > Editor 5
tings > Java Editor. In the property window for Code Folding, click the custor
izer box (see Figure 4-1) and select the checkbox for any code element that y
would like folded by default. ~

To access the code folding commands, right-click in the editor window &
select Code Folds from the context menu. Or, select Window > Code Folds fro
the toolbar. Figure 4-5 shows the context menu for Code Folding and its sho
cuts. 3
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’
ind Usages Alt+F7 |
ow Javadoc .C\It+F1’ S :
. eformat Code ChrShift4F
: Fix Imparts AESHIRHE | Collapse Fald Ctrl+NumPad -
e Shift+F6 | Expand Fold Crh+NumPad + ]
pew Watch... Chrl+Shift+4 Collapse all Cerl+shift+iumpad - |

T gfeBr‘eakpuin§ Fa o Expanda

Fast Import (<Alt+Shift+I>) - lets you a.
for the currently selected identifier. Fi
Import Class dialog for the selected id
_ only one import shows up here, this

statement you want from a list in the dialog.
» Fix Imports (<AI&+Shift+F>) - lets you insert
for the entire file. Figure 4-7 shows the con
in the editor window and move the cursor
Code Completion - you can also generate i
completion.

box and an Import statement will be adde

Using Javadoc

Javadoc popup window appe
trl+Shift+Spaces. Press <Esc tor

a selected class within the IDE. Just right-
 Show Javadoc (

fowser windo

Chrl+Shift+NumPad +

| Collapse All Javadac
| Expand &l Javadoc

Pyisr

Crl+v Collapse All Java Code “
Expand All Java Code

dd an import statement to your code
gure 4-6, for example, shows an
entifier, ListDataProvider. Although
echnique lets you choose the import

any missing import statements
text menu when you right-click
to the Fix Imports selection,
mport statements with code
e with an open code completion
d to your code automatically.

Just type part of the class nam

ars for any selected class when you type
emove it. Additionally, you may open a web

click the class and choose
or <Alt+F1>) from the context menuy. You may close the internal

w by clicking the x in the Javadoc tab.
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Design

|

H

}
et I Matching Classes:
& !
T &3 Import Class
e & f "
s void prerender () {3 Impart Fackage
tDataProvider lp; {2 Fully Qualified Mame
- }
o o

nt handl

Figure 4-6 Fast Import using <Alt+Shift+I>

H&

public void prerender () |

ListhataProvider lp:
AR LEYAER

}

Select in
Find Usages

Show Javadac

Refactor

Reformat Code

Run File
Mew ‘Watch,..
Toagle Breakpoint

Paste
Code Folds

Ale+F1

Crly

Alb+F7

»

Ctrl+shife+F

shithee
Corbeshifeew |
F2 “

150:45 (INS

Figure 4-7 Fix Imports using <Alt+Shift+F>
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4.1 Using the Java Source Editor

~bb,«eviations

. has an internal list of abbreviations that generate commonly used

edito! . dentifiers, and code idioms. Just click on the Abbreviations custom-
wOfd,S’ lthe Basic Options dialog under General (see Figure 4-1). Figure 4-8
¢ boX 1’“ default list of abbreviations. Type the abbreviation, press the
W t:ld the editor fills in the expanded keywords or expressions for you.
,\ ceg{,;eviation is the same as the text you want to type, press <Shift+Space>
3n:p it from expan.ding. o ‘
The fora and fori abbrev1atlops are very handy for generating for loops
d the trc, trcf, and trf abbreviations for try/catch/finally can save a lot
typing time. Note that the Abbreviations dialog allows you to edit or remove
sbbreviation or add your own.

Expanded Stririg Add...

8l { s public static final bootean

public static finalint
public static final String Remove
far {inti=0; i < |.length; i++) {

for (Tterator i = |.iteratar; i.hasMext();) { Object o = (Objec...
private static final

private static final boolean

private static final int

private static final String

printstackTrace();

System.err.printin{"]");

Systern, out, printin{”|");

Thread. dumpStacke);

tey { |} catch (Exception ex) {  log{"Error Description”, ex);}
try { |} catch (Exception ex) { loa("Error Description”, ex):...
try { |} finally {}

: throw new
> itwne throw new Error();
] twni throw new InternalError();
while (|} {}

Lok [ cancel | ek |

Figure 4-8 Abbreviations Dialog

Generating Method's

The IDE helps you generate code when extending a class or implementing an
Interface. Let’s show you how to do this now.

Overriding Methods

When you extend a class, overriding multiple methods and getting everything
Tight can be a tedious process. Creator’s IDE has an Override and Implement
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144 Chapter 4 Software Development

Methods dialog to help you generate the code from a list of allowable meg,
for an extended class. Here are the steps.

1. Define your class and type extends ClassName.
2. Select Tools > Override Methods from the toolbar (or press <Ctl+D>).
3. Select the method(s) you want the IDE to override for your extended cJaq

Figure 4-9 shows the Override and Implements Methods dialog for 4
extended from ListProvider. Here we override the appendRow () and
InsertRow() methods. The Generate Super Calls checkbox makes the I
include calls to the super implementation of the method. Uncheck this bg
you don’t want this behavior.

© Override and Implement Methods
Select the methods to overtide or implernent. For h‘.ultiple selection use CTRL key.

[ show Superclasses and Interfaces - [ ] Show Ahsteact Methods Only

Available Supérclass and Interface Methods:

canRemoveRow(RowKey) @ boolean
clane() ! java.lang,Object

------ @ equals(Object) : boolean

g Finalize() : void

@ gekCursorIndex() | int

- @ getList() 1 java.util.List A

Generate Super Calls [] Copy Javadoc

E OK H Cancel H Help }

Figure 4-9 Override and Implement Methods Dialog

Implementing Interfaces

When you create a class that implements an interface, there can be many met
ods to implement. The IDE’s Synchronize feature helps you generate the nece
sary methods. Here are the steps.

1. Define your class and type implements InterfaceName.
2. Select Tools > Synchronize from the toolbar.
3. Select the method(s) you want the IDE to implement.
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have the IDE automatically prompt you to generate methods

»Wab]e meth
you create a class that implements an interface. Here are the steps.

‘, ; ject Tools > Options from the toolbar and click the Advanced radio button.
g;e and the Editing > Java Sources node and select Source Synchronization.
“ ); Jer General in the properties window, select the Synchronization

nabled checkbox.

Ctr1+I>)_
tended clag

ilog fOr a Clk
W () and ca
1akes the I
eck this boy

re 4-10 shows a Confirm Changes dialog when creating a class that imple-

ents the pataProvider interface.

‘: Changes recormended in fytestZ, anotherClass

es List

. Process All |

\add roethod ﬁllblic abstract com.sun.data.provider,Datalistener[] getDatalistenars(
indd method public abstract com.sun.data.provider Fieldkey getFieldKey(String) [from
‘ ?Add method public abstract cor.sun.data.provider Fieldkey[] qetFieldkeys() [from cor’
§Add methad public abstract java.lang. Class getType(FieldKey) [from com,sun.data.pre
§Add method public abstract java.Jang.Object getvalue(Fieldkey) [from com.sun.data.f-
? fAdd methad public abstract boolean isReadOnly(FieldKey) [from com.sun.data.provide
: %Add methad public abstract void removeDatalistener(Datalistener) [from com,sun.dat

~gynchronization Mode!

© {7y Do nat synchronize this object now (to do so explictly, use Tools | Synchronize)

: (3 Confirm all changes during synchronization

(s Perform synchronization without confirmatiorn

Close

L
 Figure 4-10 Confirm Changes Dialog for Implementing Interfaces

Generating Properties

With the IDE, it'’s easy to generate properties that conform to the JavaBeans
component model. Here are the steps.

- In the Projects window, expand your project node.

- Right-click on a bean pattern node (Session Bean, Application Bean, etc.)

- Choose Add > Property.

- In the New Property Pattern dialog, type in the name of your property and
select its type (String is the default). Under Mode, select Read/Write
(default), Read Only, or Write Only.

5. Choose the options you want for code generation of the property.

6. When you click OK, the IDE will generate a field for the property and the

getter and setter methods for the field.

nany meth-
* the neces-

F S R
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Figure 4-11 shows a New Property Pattern dialog for the status Property

~Property

Marne: | status |

Type: «ﬁtring

Mode: iRead § Wrike »
[ Bound

[ Constrained

~Options

Generate Return Skatement

Generate Set Statement

i‘ oK [\%H Canéel H Help ]

Figure 4-11 New Property Pattern Dialog

Searching and Replacing

The IDE has several find commands that help you search and replace in yo
code. These commands work with the current open file or with other proj
files. Let’s show you how to use these different find commands.

Find Command

Selecting Edit > Find from the toolbar (or typing <Ctrl+F>) lets you find speci
character combinations in your current open file. You can match case, look
whole words, search backwards, and use regular expressions in your sear
After you close a Find dialog, you can move to the next occurrence with <F3>ot
move to the previous occurrence with <Shift+F3>.

To search and replace, select Edit > Replace from the toolbar (or type
<Ctrl+H>) and fill in the fields for Find What and Replace With. Figure 4-1
shows a Find command that searches for isRowAvailable in the current opel

file.

Facebook's Exhibit No. 1003
Paoe 00178

Page 178 of 328 GOOGLE EXHIBIT 1003



4.1 Using the Java Source Editor 147

1EUS Propeyy,

y: Find

Skt jsRownvallable

] Match Case Wrap Around
[ whole Words o ST

[} Regular Expressions . [ ] Search Backwards [ Help l

[¥] Highlight Results [+] Incremental Search

iqure 4-12 Find command

ind Usages Command

e Find Usages command displays lines in your project according to what
ou specify. Just select Edit > Find Usages from the toolbar (or type <AIt+F7>).
ou may also bring up this command by right-clicking on a class, method, or
eld name and selecting Find Usages from the context menu. The Find Usages
mmand is case-insensitive and doesn’t match parts of words, but you can
ve it look for a variety of different things, such as:

Class, interface, method, or field declarations

Method declarations or variables of classes and interfaces

Specific occurrences, like new instances, imports, extending classes,
" implementing interfaces, casts, and throwing exceptions

Methods or fields of a specific type

o Getters and setters of a field

¢ Method invocation

Overriding methods

Comments that refer to an identifier

eplace in yo
1 other proje

The results of the Find Usages command appear in a separate Usages win-
 dow at the bottom of your screen (like the Output window). Figure 4-13 shows
_an example of a Usages window. Here we show the results of a Find Usages
command for the variable retvalue. Double-clicking on any of the retvalue
_ Occurrences takes you to the spot in the file where it’s used.

~ Find in Projects Command

. Figure 4-12

 The Find in Projects command lets you search project files for characters in a
current open

file, filename characters, file type, file modification dates, and version control

Status. Just select Edit > Find in Projects (or type <Cirl+Shift+F>) from the tool-

bar, or right-click a folder in the Files window and select Find from the context
menu. Figure 4-14 shows the Find in Projects dialog for the text SessionBean.
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mytest2
- & MyClass

e isRowhvailablel) ... return retvalue;

Figure 4-13 Find Usages command

Full Text *

Search for Text Containing;

[] Mateh Whele Wards Orily
[ tatch Case
D Regular Expression

Use This Criterion far Search

[ Save Jettings as...

| _search || Close |

Figure 4-14 Find in Projects command

The results of a Find in Projects command appear in a Search Results witt
dow at the bottom of your screen. With full-text searches, you can exparl
nodes to see which files contain your patterns. Double-clicking on any of th
occurrences takes you to the spot in the file where it is used. Figure 4-15 show
the Search Results window for the text SessionBean.
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4.1 Using the Java Source Editor 149

protected SessionBean! getSessionBean1() |

protected SessionBean1 getSessionBeani() {
return (SessionBean1)getBean{"5essionBean1");
return {(SessionBean!)getBean("SessionBean1");

@ RequestBeanl.java
@ SassionBeant,java
'@ managed beans.xml ¢
<managed-bean-name >SessionBean! <{managed-bean-name>

zmanaged-bean-class »mytest? SessionBean1 </managed-bean- cla>s>

O sortby Name {3 Do Mot Sort [ show alletals | [ Modify Search

Figure 4-15 Search Results window

Navigating Files

When you right-click in the editor window and select Go To, a context menu
lists ways to navigate from your current file to other places. You may navigate
_to the super implementation of a class, a specific line number, a declaration, or
to the source code for a class, method, or field. Figure 4-16 shows the context
~menu for Go To and its shortcuts.

Source alt+0O
Declaration alt+G

Select in

Find Usages AlL+F7 Super Implementation  Cerl+B
Show Javadoc  AlL+FI Lire... Ctri+G
Refactor p  Class...

Reformat Code Chri+Shift+F
Fix Imports Alr+9hnft+F
RunFle  shift+Fe
Mew Watch. ., Cerlshift+i
esults win- __ Toggle Breakpaint F9
o expand - e
any of the

~15 shows

| Chri+y
rodP Fo[d< )

P igure 4-16 Nav1gat10n with Go To

If you right-click in the editor window and choose Select in, you can navi-
8ate to other project files or to other files in the same package. These options
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are also available from the toolbar by clicking Window > Select Documg
Figure 4-17 shows the context menu for Select In and its shortcuts.

Projects  Ctri+Shift+1

Files ctrkshift+2

Alk+F1
Refactor o >
Reformak Code  Chrl+Shift+F
Fix Imports Alt+5hift+F
TRunFle  ShifteFs
Mew Watch... Chrl+Shift+w

Togale Breakpoint F9

Paste Chri+y
. Code Folds »

Figure 4-17 Navigation with Select in

Task Lists

During a hectic software development project, who wants to write notes
post-its to remind themselves to do something important? To help with th
the IDE supports task lists. Task lists provide a way to document and clean
any loose ends in your code. ~

Task lists manage special “tag” words that you mark in your code. Theset
words typically appear in comments, such as

// TODO: add your event handler here..
// PENDING: Gail will write this code

To see what tag words are available for your task list, click Tools > Opti
from the toolbar, click the Advanced radio button, and select the Editing >
Do Settings node. Click the Task tags customizer box to see the list of tags
their priorities. Figure 4-18 shows the Task Tags dialog.
Note that it’s possible to change or delete the default list of tags, and you ¢
add you own tag to the task list. You can also change a tag’s priority. The aval
able priorities are High, Medium-High, Medium, Medium-Low, and Low. B
default, all tags have Medium priority, except the <<<<<<<tag, which has Hig!
priority. ‘

To view the task list, setect View > To Do (or type <Ctrl+6>) from the toolba
This brings up the To Do window, which appears at the bottom of your screé
(tike the Output window). Inside the To Do window, you can view tasks for th
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ag List:
o Priority ] add
Medium AP ——,
Medium [ changs
MMMMMMM Medium
Delet:
redium [:E]
FNDING Medium
High

{ OK [\'J Cancel ]

qure 4-18 Task Tags dialog

crent file, all open files, or for a specific folder. If you right-click in the win-
w and select List Options, you can sort the task list by task, location, or pri-

ity. If you double-click any tag line in the task list, the editor highlights the
source code line in the file where the tag appears. Figure 4-19 shows an exam-
o of a task list in the To Do window for opened files.

le iOpened Files | Selected Folder ~ € Mo Filker !
I locaten I
2 ;',f fODO: Add your own initiéﬁzatiun code here {optionaly Pagel .]"ava:IGS {C1fDocuments and Settings/P 5
. [* J{ FIXME: figure this out later... Pagel.java:188  (C:/Documents and Settings/P.

F 1 TODO: Add your own initialization code here (optional) SessionBeant.java:40 (CifDacuments and Sett }1
<% 1} TODO: Add your own initialization code here (optional) RequestBeanl.javai4l  {Ci/Documents and Set e
} PENDIMG - Gail will write this code RequestBeant.java:sl  (CifDocuments and Setse

_ The To Do window also supports a handy feature called filters, which allow
you to limit what you see in this window. If you click on the filter icon (to the
eft of the combo box on the toolbar), the IDE brings up an Edit Filters dialog.
To create a new filter, click on the New button and type a filter name in the
me field. Below this, you may specify more than one criteria and match any
orall of the criteria. When you're done, your newly defined filter will appear in
he combo box on the toolbar of the To Do window.

; Figure 4-20 shows you how to create a filter for the PENDING tag. This
- Makes the To Do window display only the PENDING tag lines when you select
. PENDING in the Combo box.
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Mame: x PEMDING

7<) Mateh all of the following £ Match any of the follawing

*wz More ! Fewer
[t ]

Figure 4-20 Task Edit Filters dialog

4.2 Refactoring

Sometimes you need to make “global” changes to your project, like renamin
heavily-used class, field, or method. You might also have to add a new para
eter to a method or move a class to a different package. You could do th
things manually, but it would be tedious, error-prone, and well, a lot of wo
A better approach is to have the IDE help you. Making these kinds of modif
tions is called refactoring. In this section we’ll show you how to use the refac
ing features of the IDE. This knowledge can save you a lot of time, especiall
large projects with many files.

What is Refactoring?

Refactoring is transforming and restructuring source code so that the re
tored code behaves the same as the original source. In an object-oriented de
opment environment like Java, refactoring must apply to classes, fields,
methods. Some examples of refactoring are relatively simple, like renamin
class, field, or a method. Other types of refactoring are more complicated/ !
changing the signature of a method or moving a class to a different package

Here are several reasons why you would refactor your source code.

¢ You want to add a new feature to your code.
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need to remove unnecessary repetitions.
o You want to reduce complexity for better understanding.
1 . .
? }/OL want to make your code more maintainable for others.
. You

« explore how Creator’s IDE helps you refactor. We’ll show you how to use
s ef FC>toring features in the IDE and explain how to use them with existing

the 1€ ; As you will see, the IDE not only lets you preview the changes before

Proleriai(e them, but the IDE also gives you a chance to undo your refactoring

C’ﬁ:lnges if you make a mistake.

: ‘Here are the refactoring features in the IDE.

, Find Usages - determine where classes, fields, and methods are used in your
 source code.

. Renaming - change the name of a class, field, or method. Automatically
updates all the references to these elements in your source code.
Encapsulating Fields - generates getter and setter methods for fields.

- Optionally updates all references to a field using the getters and setters.
Change Method Signatures - add parameters to methods and change the
method’s visibility.

Move Classes - move a class to another package or inside another class.
Automatically updates your source code to reference the class from its new
location.

Refactoring Window

renaming

New param All the refactoring commands make use of a refactoring window, which
Ud do thes _ appears at the bottom of your screen in the IDE (in the same place as the output
lot of work - window). This window is created when you execute a refactoring command.

of modifica - The window provides a preview of files and class elements that are affected by
the refactqr  each refactoring command.
sspecially i Here’s what you can do in the Refactoring window.

Allow or disallow a refactoring change.
Open the file in the editor for the line(s) to be refactored.
Refresh the refactoring preview.

it the refac Exit without making any changes.
mted devel Apply the refactoring changes.
fields, and :
renaming . We'll show you how to use the refactoring window in the forthcoming exam-
licated, lik Ples.
package.

de.
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Payment Project

Let’s begin with an existing Creator project called Paymentl, a monthly
ment calculator. (Project Paymentl is in the download for this book ung
FieldGuide2/Examples/JavaBeans/Projects.) Open Project Payment]
deploy it by selecting Run Main Project on the Creator toolbar (or click the R
icon). When the web page comes up in your browser, you will see the payy
for a default loan amount, interest rate, and loan term. Try different values ¢
each parameter and click the Calculate button to see the recalculated loan Pa
ment.

We'll actually have you build this project from scratch in a later chapter, |,
let’s use it now to demonstrate refactoring. ~

Copy Project

This step is optional. If you don’t want to copy the project, simply skip this g
tion and make modifications to the Payment1 project.

1. Bring up project Paymentl in Creator, if it’s not already opened.
2. From the Projects window, right-click node Payment1 and select Save
Project As. Provide the new name PaymentRF.
3. Close project Paymentl. Right-click PaymentRF and select Set Main Proj
You'll make changes to the PaymentRF project.
. Expand PaymentRF > Web Pages and open Pagel.jsp in the design view.
5. Click anywhere in the background of the design canvas of the PaymentR
project. In the Properties window, change the page’s Title property toP
ment Calculator - Refactor.

IS

Find Usages

When it's time to refactor, the first thing you'll want to do is issue a Fin
Usages command. You already know how to determine where classes, field
and methods are used in your source code (see “Find Usages Command” 0
page 147), but let’s look at this technique again as it relates to refactoring.
The Payment Calculator project uses a LoanBean class to calculate paymen
from the input parameters supplied on the web page. Let’s use the Find Usag
command to determine where this LoanBean class is used in our source code

. Bring up the Projects view, if it is not already opened.

. Expand the Source Packages > asg.bean_examples node.
. Right-click LoanBean.java and select Find Usages in the context menu.
In the Find Usages dialog, click the Search in Comments checkbox, then
click the Next button.

O
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. [DE displays a Usages window. Click the Show Physical View icon in
5. Thebottom left margin of the window. The Usages window shows you all
the ~currences of the LoanBean class in the project (see Figure 4-21).

the ﬁ;le_click any of the LoanBean references in the window. This takes you
E,Ot:w appropriate line in LoanBean.java or SessionBeanl.java where these

statemems appear.

aymentRF
[& LoanBean.java
L3 Creates a mew instance of LoanBean
{{ ¥LpanBean.java
[& SessionBean.java
loanBean = new asg.bean_examples.LoanBean();
private asg.bean_examples.LoanBean loanBean;
putlic asg.bean_examples.LoanBean getLoanBean()
L.public void sel nanBean{asg.bean_examples.LoanBean loanBean)

ly skip this

Figure 4-21 Find Usages for LoanBean
red.

lect Save ~ .
;  Renaming Classes
t Main Proyect,k Let’s change the name of the LoanBean class in this project. The Find Usages
ommand shows the LoanBean object is instantiated in SessionBeanl.java. It
so lists the other places in this file where the LoanBean class is referenced.
Here are the refactoring steps to change the name of the LoanBean class and
_allits references in the project.

lesign view.
e PaymentRF
roperty to Pay-

oy

. Double-click LoanBean.java in the Projects view. This brings up this file in
the editor window.
- Find the LoanBean class declaration in LoanBean.java and right-click the
. LoanBean name. Select Refactor > Rename from the context menu.

- In the Rename dialog, type MyLoanBean in the New Name field and click
the Apply Rename on Comments checkbox.

is issue a Find
» classes, fields,
Command” on

factoring. - Make sure the Preview All Changes checkbox is checked in the Rename dia-
ulate payments  log,
he Find Usages - Click the Next button.

r source code. 0. The IDE displays a Refactoring window. Click the Show Physical View icon

in the bottom left margin of the window. Figure 4-22 shows seven occur-
_Tences (including comments) of the LoanBean class in the project.

 The Refactoring window lists all the occurrences of LoanBean in two files,
FoanBean.java and SessionBeanl.java. The checkboxes next to each refactor-
g line let you allow (checked) or disallow (unchecked) the refactoring. There
Arebuttons in the left margin of the window to refresh the refactoring data, col-

ext menu.
kbox, then
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I‘Usages ‘Refactoring g X
g;S Rename LoanBean to MyLoanBean [7 occurrences]

: ) Payment1RF

£ LoanBean.java

[#] P¥* Creates a new instance of LoanBean

/| *LoanBean.java

Rename file, class, and constructors to MyLoanBean

} SessionBeant.java

loanBean = new asg.bean_examples.LoanBean();

private asg.bean_examples.LoanBean loanBean;

] public asg.bean_examples.LoanBean getLoanBean()

public void setLoanBean{asg.bean_examples.LoanBean loanBean)

&

t [);Refactoring H Cancel J

Figure 4-22 Refactoring window

lapse the nodes in the tree, and show the logical and physical views of
refactoring lines. "
Let’s finish the class name refactoring now.

—

. Leave all the checkboxes checked in the Refactoring window.

. Click the Do Refactoring button.

3. Click the x in the top right corner of the Usages window to remove this wi
dow from the display. "

4. Verify that the file name MyLoanBean.java now appears in the Projects
view.

5. Right-click the MyLoanBean class name in MyLoanBean.java and select
Find Usages in the context menu. In the Find Usages dialog, make sure th
Search in Comments checkbox is still checked.

6. Click the Next button. In the Usages window, click the Show Physical Vie
icon in the bottom left margin of the window. You should see the newly
applied changes from the refactoring, including MyLoanBean as the new
class name (Figure 4-23).

7. Right-click the PaymentRF project in the Projects window and select Clea

and Build Project (this may take a few moments). Verify that your project

compiles without errors.

Undo and Redo

Everything should have worked fine here, but let’s show you the Undo a
Redo commands anyway. Select Refactor > Undo [Rename] from the Crea
toolbar (you can also right-click in the editor and select this from the cont
menu). You'll see all your refactoring changes restored back to their orig
values. This can be very valuable when you realize that a refactoring did not
exactly what you wanted.

N
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% %

AR R i

@ MyLnanBean,jav.a

LR Cregtes 2 new instance of Myl ganBean

Lf] ¥ MylLoanBean. javs

sessionBeant java

. lpanBean = new asg.bean_examples.MyLoanBean();

..private asg.bean_examples.MyLoanBean loanBean;

.public asg.bean_examples.MyLoanBean getloanBsan()

: public void setLoanBean{asg.bean_examples.MyLoanBean |zanBean)

re 4-23 Find Usages for MyLoanBean

After an undo command, it’s possible to redo refactoring changes by select-
Refactor > Redo [Rename] from the toolbar or from the context menu. Let’s
ve our changes undone for now and show you another way to refactor

Refactoring for Renamed Files

efactoring is also done when you rename class files in the Projects or Files
indow. This brings up the Refactor Code for Renamed File(s) dialog. Let’s
how you how to rename your LoanBean class with this technique.

Switch from the Projects view to the Files view.

. Under PaymentRF, open the src > asg > bean_examples node.

Right-click LoanBean.java and select Rename.

_In the Rename dialog, type MyLoanBean in the New Name field. Click OK.
The Refactor Code for Renamed File(s) dialog appears (see Figure 4-24).
Click Next.

_The IDE displays a Refactoring window. Click the Show Physical View icon
n the bottom left margin of the window. The refactoring changes should be
the same as what you did before (see Figure 4-22 on page 156).

Click Do Refactoring.

Verify that the file name MyLoanBean.java now appears in the Files view.
9. Right-click the PaymentRF project in the Projects window and select Clean
and Build Project (this may take a few moments). Verify that your project
compiles without errors.

Creator Tip

Make sure you use the IDE to renane class files. If you rename your files with
Windows explorer or other file system utilities, Creator won't be able to track
Your changes.
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Figure 4-24 Refactor code for renamed file

Renaming a class field or method is done the same way as renaming a clgs
Here are the steps.

1.

>

()Y

. Right-click the field or method and select Refactor > Rename from the cori}

. In the Rename dialog, type the New Name for the field or method.

. Click the Next button.
. In the Refactoring window, review the lines of code that will be refactored

. Click the Do Refactoring button to make the changes.
. Right-click on your project name in the Projects view and select Clean and

Mews Mame

V] Apply Rename on Comiments

[] Previaw all i Mext > H! Cancel 1 [ Help
)

Renaming Fields and Methods

Find the field or method you want to rename in the editor. In the Project
view, expand the source file nodes until you find the field or method yo
want.

text menu.

Clear any checkboxes for code that you do not want changed.

Build Project. Verify that your project compiles without errors.

Creator Tip

Be careful with refactoring fields and methods of JavaBeans components.
With JavaBeans, the setters and getters use naming conventions which could
be disrupted by an improper refactoring. Refactoring JavaBeans could also
adversely affect bindings and other assumptions made by the IDE.

Page 190 of 328

Refactoring lets you encapsulate fields, which insures that class fields can O%
be accessed by getter and setter methods. This type of encapsulation enfor

Encapsulating Fields
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iding and improves maintainability. Typically, a class field’s visibility is
3;111(611 to private, whereas the getter and setters for the field are marked as
;fcteOther visibility choices are possible (protected with inheritance access,
1C.

-e).
nsm;;ﬁ) supports the following refactoring features for Encapsulating
e

nerate getter and setter methods for fields,
Midify the visibility modifier for the fields and the getters and setters.
Replace references to field names with calls to the getters or setters,

Let's modify our Payment Calculator project and show you how to encapsu-
o a field and generate setters and getters for the field. Here are the steps.

Open MyLoanBean.java in the editor if it is not already open.

Add the following field declaration to your code, right below the MyLoan-
Bean constructor.

private String version = "Version 1.0";

; Select the version field. Choose Refactor > Encapsulate Fields from the tool-
‘bar (or right-click the version field and select this option from the context
menu).

Inthe Encapsulate Fields dialog, make sure the version field’s checkbox is
checked. Select protected in the combo boxes for both the Fields’ Visibility
and the Accessors’ Visibility (see Figure 4-25). Click Next.

The IDE displays a Refactoring window. Click the Show Physical View icon
inthe bottom left margin of the window. The Refactoring window shows the
changes that will be made to encapsulate the version field (Figure 4-26).

ethod.

be refactored

>ct Clean and tput -PaymentRF (dist) | 'Refactoring o s %

S. -+ Encapsulate fields in class asg.bean_examples.MyLoanBean [2 accurrences]
! (i PaymentRF
- [¥] [ MyloanBean.java
: Change modifier of field version to protected

et Create methad getVersion ;

o Create method setVersion °
vhich could %E
uld also ; g« Do Refactaring ;} 1 Cancel f ‘g,
e —— Figure 426 Refactoring window for Encapsulate Fields §

- Click Do Refactoring. Verify that the code for setter method setVersion ()
and getter method getVersion () now appear in MyLoanBean.java with
Protected visibility. The version field should be protected as well.
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Lisk. of Figlds Ta Encapsulate:

. Field | Getter Setter
[ lversion getVersion setversion
[ |}amount netAmount setamount
[ lrate getRate setRate

[ Hyears qetyears setfears
] payment getPayment setPayment
Fields' Yisibility:

Accessors' Visibility:

A

Use Accessars Even 'When Field Is Accessible

i Next » H Cancel ]rHelp J

Figure 4-25 Encapsulate Fields dialog

{¥] Preview All Changes

7. Right-click your project name in the Projects view and select Clean and
Build Project (this may take a few moments). Verify that your project com
piles without errors.

Changing Method Signatures

The design of class methods is crucial to the behaviors of object-orien
designs and reusable classes. During the early stages of development, it's e
to develop methods with several parameters and change them when you
to. But near the end of a large development cycle, changing the signature
heavily used class method can be a time-sink, because the change often pro
gates to a large number of invocations in source code. Refactoring can be a bj
help here, because the IDE can update all the method calls for you.

The IDE supports the following refactoring features for Changing Met
Signatures.

¢ Add parameters to a method’s signature.
o Reorder the parameters in a method’s signature.
s Change the visibility for a method.

Creator Tip .

Refactoring does not allow you to remove a parameter from a method’s
signature. You can’t refactor a method’s return type, either. If you need to do
these things in your project, you'll have to do it manually.
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nerate New Method

. we show you how to refactor a method’s signature, let’s add a new
d to the MyLoanBean class and call it from the Payment Calculator. Here
0

e Steps.

en MyLoanBean.java in the editor if it is not already open.
gdd the following method to your code, right below the setversion () and
éet\/ersion () methods.

plic String getInfo() { return version; }

Return to Pagel.java in the editor and click the Design button to bring up
he design view.

Double-click the Calculate button. This generates a calculate_action ()
method in Pagel.java. Add the following code before the return statement
new code is in bold).

]

plic String calculate action() {

// TODO: Process the button click action...
log (getSessionBeanl () .getLoanBean () .getInfo()) ;
return null;

Clean ang
I project com

. Click the Run icon on the toolbar to deploy the Payment Calculator applica-
_tion. Type input values on the page and click the Calculate button.

In the Servers window, right-click Deployment Server and select View
Server Log.

In the Output window, you should see the string “Version 1.0” appear in the
server log.

Add Method Parameter

Now let’s add a new parameter to our getInfo () method and refactor it in our
project. Here are the steps.

object-orienteq

;e often prop.
1g can be ab
u.

1ging Meth

L Select the getInfo () method in the editor. Select Refactor > Change Method
Parameters from the toolbar (or right-click the get Info () method and select
_ this option from the context menu).

. Inthe Change Method Parameters dialog, type who for Name, String for
Type, and “paul” for Default Value. To edit these, you'll need to double-
click each cell.

- Leave the Access Modifier public and make sure the Preview All Changes
checkbox is checked (see Figure 4-27). Click Next.

d’s
eed to do
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Parameters:

Add

{ Remova :

fype Default valus

Access Modifier:

Method Signature Preview:
public java.lang.String getInfo{String wha)

[#] Preview All Changes L Next > [ Cancel J Help |

Figure 4-27 Change Method Parameters dialog

4. The IDE displays a Refactoring window. Click the Show Physical View
in the bottom left margin of the window.The Refactoring window shows;
changes that will be made to refactor the getInfo () method (see Figur
28).

‘Dutput - locathost:24848 : {Refactoring .
@ ; g‘" Change parameters of getInfo method to public java.lang.String getInfo(String who) [2 occurren
PaymentRF

MyLoanBean. java

. [Z| Change methad paramaters of public String getInfo(}
Pagel.java

L. [} logigetSessionBean1().getLoanBean(). getInfo());

E Do Refactoring H Cancel l

Figure 4-28 Refactoring window for Changing a Method’s signature
5. Click Do Refactoring. Verify that a new parameter was added to the get

Info () method in MyLoanBean.java. Modify this code as follows (new
code is bold).

public String getInfo (String who) {
return version + "-" + who;

Facebook's Exhibit No. 1003

Paoce 001904

GOOGLE EXHIBIT 1003



‘ . that the call to getInfo () in Pagel.java was modified, too. Here’s
‘ hrli}’i t should look like (new code is bold).
wha

\\\
——
\

... string calculate_action() {

fblligf)& pProcess the button click action...
1/9 (getsessionBeanl () .getLoanBean () .getInfo(
el

"paul") );
ceturn null;

ow deploy, run, and test the project.

Right-c]ick your project name in the Proj
Build Project (this may take a few mome
piles without errors.

Click the Run icon on the toolbar to deploy the Payment Calculator applica-
tion. Type input values on the page and click the Calculate button.

In the Servers window, right-click Deployment Server and select View
Server Log.

n the Output window, you should see the strin
_in the server log.

ects view and select Clean and
nts). Verify that your project com-

g “Version 1.0-paul” appear

Reordering Parameters

eordering parameters in a method’s si

1who) [2 occurrenceq) parameter. Here are the steps.

gnature is done the same way as adding

Select the method you want in the edit
Parameters from the toolbar (or ri ght-c
from the context menu).

+:Select the parameter you want to move and click Move Up or Move Down.
This changes its position in the list, Click Next.

. In the Refactoring window, review the 1

~ Clear any checkboxes for code th

or. Select Refactor > Change Method
lick the method and select this option

w

nes of code that will be refactored.
at you do not want changed.

1 to the get- : 1glick Dg Refactoring to make ’Fhe chang.e& .
llows (new . Blg{;{t—chck your project name in the Projects view and select Clean and
ui

Project. Verify that your project compiles without errors,

Changing a Method’s Visibility
The refactoring comman

ds for a method’s visibility are very simil
8. Here are the steps.

ar to the oth-

L Select the method you want in the editor. Select Refactor > Ch
Parameters from the toolbar (or right-
from the context menu).

ange Method
click the method and select this option
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2. Select an Access Modifier for the method’s visibility from the combg b
(options are public, protected, private, or default). Click Next.

3. In the Refactoring window, review the lines of code that will be refaCtOr
Clear any checkboxes for code that you do not want changed. '

4. Click the Do Refactoring button to make the changes.

5. Right-click your project name in the Projects view and select Clean and
Build Project. Verify that your project compiles without errors.

Creator Tip

Note that the code for the getInfo () method refers to the version field
directly. By refactoring, you can make this method use the getter method for -
the field instead. To do this, select the version field and choose Refactor >
Encapsulate Fields. Make sure the checkbox is checked for Use Accessors

Even When Field is Accessible. Click Do Refactoring. You will see code in
getInfo () that now calls getVersion () to get the version field’s value,

Moving Classes to Different Packages

Another important refactoring feature is moving a class from one package
another. This kind of code change can certainly be a hassle to do manuall,
refactoring is a big help here.

There are two approaches for moving a class between packages, so
show you how to do both. Here are the steps for the first approach.

Moving Classes

J

. Bring up the Projects view, if it is not already opened.
2. Under PaymentRE, expand the Source Packages > asg.bean_examples no
Note that MyLoanBean.java is contained in this package (Figure 4-29).
3. Right-click MyLoanBean.java and select Refactor > Move Class from the
context menu.
4. In the Move Class dialog, select payment1 from the combo box for To Pa
age (see Figure 4-30).
. Make sure the Preview All Changes checkbox is checked. Click Next.
6. The IDE displays a Refactoring window. Click the Show Physical View i
in the bottom left margin of the window.The Refactoring window shows
refactoring statements that move the MyLoanBean class to the payment
package (Figure 4-31).
7. Click Do Refactoring to make the changes. Verify that MyLoanBean.jav
has been moved to the payment1 package in the Projects View (see
Figure 4-32).

21
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2thod for i i
actor > : § payment1
5S0Fs 1B Libraries
ode in i Data Source References
s valye.
jgure 4-29 Projects window before refactoring

dackage to
nanually,

Move class asg.bean_examples,MyLoanBeaan
ges, so le Project:

Lacation:

Ta Package
ples node,
4-29).
om the
r To Pack- Preview All Changes i Mext = N [ Cancel 1 [ Help ]
2xt.
- . Figure 4. i
View icon tigure 4-30 Move Class dialog
shows the . . . . . .
‘mentl 8. Right-click your project name in the Projects view and select Clean and

B}llld Project (this may take a few moments). Verify that your project com-
. piles without errors.

n.java

tion, Verify that everything works.
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’ 9. Click the Run icon on the toolbar to deploy the Payment Calculator applica-
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‘Refactoring

3&“3 Mave class asg.bean_examples.MyLoanBean to payment1 package [S occurrence,

rivate asg.bean_examples.MyLoanBean loarBean;

public asg.bean_examples.MyLoanBean gestLoanBean()

- [#] public void setLoanBean{asg.bean_examples.MyLoanBean loanBear)
[@ MylLoanBean.java

Mave source to package "payment1”

E Do Refackoring H Cancel ]

Figure 4-31 Refactoring window for Move Class

; Projecis ' X

PaymentRF Ll
(3 Web Pages
¢ Themes

)] Managed Beans
Page Mavigation
application Bean
Session Bean
Request Eean

Source Packages
-G asg.bean_examples
1 paymentl

{ﬁ] ApplicationBeant.java
£3 -@ Bundle, propetties

Pagel java
{BH) RequestBeani.java
@ SessionBeant.java i

Figure 4-32 Projects window after refactoring

Refactoring for Moved Files

Code for Moved Class dialog opens whenever you perform the follow!
actions:

¢ Cut and paste files in the Projects or Files window.
* Drag and drop files in the Projects or Files window.
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. new package name in the Projects window for a package node.
e

~ er name in the Files window for
els OCCUMTenCeg) e anew fold a folder node.

how you how to use this technique. Here are the steps.

fect Refactor> Undo [Move class] to put the MyLoanBean class back in the
jginal package.

the Projects view under PaymentRF, open the Source Packages >

be an_examples node.

. nt-click LoanBean.java and select Cut.

ght-diCk package payment1 and select Paste.

¢ Refactor Code for Moved Class dialog appears (Figure 4-33). Click

arkizan)

The IDE displays a Refactoring window. Click the Show Physical View icon
n the bottom left margin of the window. The refactoring changes should be

‘ th? same as what you did before (see Figure 4-31 on page 166).
Click Do Refactoring.

Verify that MyLoanBean.java has been moved to the paymentl package in

he Projects View (see Figure 4-32 on page 166).

ight-click the PaymentRF project in the Projects window and select Clean

and Build Project (this may take a few moments). Verify that your project

. The Refact ompiles without errors.

the followi
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4.3 Source Code Control with CVS

Version control allows developers to track the changes they make ¢,
source code. With version control, you can determine when a change wagq
and by whom. You can also use version control to track bugs and genera,
cific builds that might customize certain parts of your system. All this
for a single developer working on a project as well as a group working g
same project code.

Creator supports several Version Control Systems (VCS), but we’ll Showy
CVS (Concurrent Versioning System) which is very popular with develop*
You'll learn how to create CVS working directories and repositories, imp
source code into CVS, and check out modules. You'll also see how to cop,
editing changes to CVS, compare revisions, and examine log histories of @
changes. As before, we'll use our Payment Calculator project to show you |,
to use CVS with Creator. ‘

Q g

Copy Project

This step is optional. If you don’t want to copy the project, simply skip thiss
tion and make modifications to the Payment1 project. '

—_

. Bring up project Payment1 in Creator, if it’s not already opened.
2. From the Projects window, right-click node Payment1 and select Save
Project As. Provide the new name PaymentCVS.
3. Close project Payment1. Right-click PaymentCVS and select Set Main
Project. You'll make changes to the PaymentCVS project.
. Expand PaymentCVS > Web Pages and open Pagel.jsp in the design view
5. Click anywhere in the background of the design canvas of the PaymentC
project. In the Properties window, change the page’s Title property toP
ment Calculator - CVS.

Setting up CVS

The IDE provides two ways to work with CVS in Creator. You can use the b
in CVS client in Creator (written in Java) that helps you connect to CVS rep
tories on remote machines. Or, you can install CVS locally and have the I
work with CVS directly on your machine. This is the approach we’ll show
here.

Installing CVS

If you don't have CVS installed on your system already, it’s fairly easy to f
an open source version on the web for CVS. Download the appropriate vers

JISN
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4.3 Source Code Control with CVS 169

Jachine and install it. Make sure you can run the cvs command from
ma

our ompt window.

malﬁd pr

/5, you will need to setup two directories: a repository directory, which
Vo ¥ ioct’s full revision history, and a working directory to store the files

0
52 Pro) Here are the steps.

1p working i prOjeCt-

, 1o the IDE, create a directory or folder for your CVS repository. Make
1t we'll sho Qllzsiﬁiestis a safe place where accidental deletions are unlikefl)y (a tei,np
L:rrectory, for instance, would be a poor choice).

Outside the IDE, create a directory or folder for your CVS working directory.
You can skip this step if you already have a directory with source files and
Jou're willing to use this directory for version control.)

+rom the Creator toolbar, select Versioning > Versioning Manager. In the
ialog box, click the Add button.

1 the Add Versioned Directory dialog, select CVS for the System Profile.

il in the location of the CVS working directory you created in Step 2.

ot the Repository Path to the name of the CVS repository you created in

tep 1.

Iigk the Use Command-Line CVS Client radio button and make sure cvs is
et for your CVS executable.

ncheck the Perform Checkout checkbox and Click Finish (see Figure 4-34).
When you return to the Add Versioned Directory dialog, you should see
our working directory appear. Click Close to exit this dialog.

ply skip this

aned.
select Save

t Set Main

nitialize CVS Repository

ow that the CVS repository directory has been created, you need to initialize
ere are the steps.

. From the Creator toolbar, select Versioning > CVS > Init Local Repository.
This brings up the CVS Init dialog.

- Select your Repository Path in this dialog, click the Set As Default button to
remember these values, then click OK (see Figure 4-35).

‘Importing Files

ow that you've setup and initialized your CVS directories, the next step is to
port source files into the CVS repository. This is very straightforward, the

Ulglthing you have to watch are your own binary file types, like images and
I tiles.
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Steps Add Profile

ontrol S

1, Choose Template - Wersion tem Profie

2. Profile

lcvs

1 “1Documents and SettingsiCys Brows;

Working Directory:

CYS Server Type:

Repository Path:

{s) Use Command-Line C¥S Client

(Y5 Executable: :i s i | Brow

|

To get additional profiles, wisit

Figure 4-34 CVS Profile Dialog

Creator Tip

Version control works by storing your changes as textual diff statements. You
don’t want to import your own binary files (images, jar files, etc.) into the
repository, because textual diffs won’t work. The easiest thing to do is to

remove binary files from your project directory before you import. After you
checkout the files into your working directory, you can use the CVS§ > Add

command to put the binary files back in your project. (See “Creator Tip” on
page 180.)
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4.3 Source Code Control with CVS 171

| SetAsDefault | [ Get Default valuss |

yocuments and SettingstcVSRepositorQW? [ Browse, .. }

i

s[ Browse. .. ]

i, CK |“~:§H Cancel )

e 4-35 Initialize CVS Repository

Hére are the steps to import the Payment source files into the CVS reposi-

rom the Creator toolbar, select Versioning > CVS > Import. This brings up
he CVS Import dialog.

1 this dialog, set Directory to Import to the location of your source files to
import.

hoose local for the CVS Server Type.

Set the Repository Path to your CVS repository directory.

i Type PaymentCVS for your Repository directory.

Click the Use Command-Line CVS Client radio button and make sure cvs is
set for your CVS executable.

Fill in Logging Message, Vendor Tag, and Release Tag as shown, and
‘uncheck the Perform Checkout After Import checkbox.

Click the Set As Default button to store these values.

Click OK (see Figure 4-36). In the VCS Output window under Standard
Output, you should see a list of imported files in your repository.

Checking Out Files

ow that the files are residing in the CVS repository, you must check them out
to your CVS working directory. This directory is where you will make your
ements. You anges under version control. Here are the steps.

) into the

YN

From the Creator toolbar, select Versioning > CVS > Check Out. This brings

do is #
. A}ieri ou up the CVS Checkout dialog.
75> A £{ i 2. In this dialog, set the Working Directory to the name of your CVS working

directory.
3. Choose local for the CVS Server Type.
4 Set the Repository Path to your CVS repository directory.

or Tip” on
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fmik [ Set As Default J { Get Default Values }

Directory To Import: | My Dacuments\CreatariProjectsiPaymentCys | [ Browse.. |

G5 Server Type: local

L

Repository Path:

;C.'ytiocuments and Settings\CYSRepositary | [ Browse... J

Repository Directory: PaymentCVs

3 Use Command-Line CV5 Client

CYS Executable:

[ Brawse, ..,

Logging Message: initial
yendor Tag: g‘Vendor
Release Tag: | release

Checkout After Import

Figure 4-36 CVS Import Dialog

5. Click the Use Command-Line CVS Client radio button and make sure cvs

set for your CVS executable.

6. Click the Module(s) radio button and type in PaymentCVS.
7. Click OK (see Figure 4-37). In the VCS Output window under Standard
Output, you should see a list of checked-out files in your working director

Page 204 of 328

Updating Source Files

In this section we'll show you how to access files in your working directory:
edit their contents, then update them under CVS version control.
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| setaspefaut || Get Default values |

| workind Directory: ncuments and Settings\CYS i [(Browse... |

ol

{5 Server Type:

[S—

Repasitary path: | C:{Documents and SettingsiCYSRepository ‘ [ Browse.., j

() Use Command-Line CV3 Client
{2

s Executable: | X[ Browse... }

Ol

(3 Module{s): | PaymentCys e

Revision or Tag:

Date: i

{"] Force a Head Revision Match if Tag/Date nok found

Lok (el ]

Figure 4-37 CVS Checkout Dialog

nake sure cvs - Versioning Window
efore you make a change to your code, let’s open the Versioning window and
T Standard ee what the PaymentCVS project looks like. Here are the steps.

king director :
- From the Creator toolbar, Select View > Versioning > Versioning (or type
<Ctrl+8>),

- The Versioning window appears in the top left portion of the screen. Expand
the source nodes for src > asg > bean_examples > LoanBean.java, src >
paymentl > Pagel.java, and web > Pagel.jsp (see Figure 4-38).

i,N. te that all .java and .jsp files are listed as Up-to-date with 1.1.1.1 being the
Initial revision,
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Figure 4-38 CVS Versioning Window

Let’s modify our project code and test it. Here are the steps.

1.

\rersmnmg
& Vs CiDocuments and SettingsiCYs
) PaymentCys

build

3 conf

lib }
nbproject

bean_examples
:]/LuanBean,java i
-8 1.1 Initial revision
payment1

\j applicationBeanl java
[j,Bundle.pmperties {
} D,Pagel.java X
£ 1.1 Initial revision
[j,RequestBeanl Jjavai
: [_”]ySessirJnBeanl Jjava {1k

WEB-INF
) resources
[lvPaget.isp
g-£% 1,1 Initial revision
[j,build,xmlf £ 1

Editing Source Files

Bring up Pagel.jsp in the Design view. On the page for the Payment Cale
lator, double click the Calculate button. This generates a

calculate action() button handler code in Pagel.java.
. Let’s write to the log file for a button push. Add the following code befor:

the return statement (new code is in bold).

public String calculate_action() {
// TODO: Process the button click action...

log ("Version 1.1");
return null;
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4.3 Source Code Control with CVS l ‘: ' 175

k gave your changes. Note that Pagel.java and Pagel.jsp are marked as
"Locally Modified in the Versioning window.

Click the Run icon on the toolbar to deploy the Payment Calculator applica-

* tion. Type input values on the page and click the Calculate button.

[n the Servers window, right-click Deployment Server and select View

: Ser\/el' LOg- )
[n the Output window, you should see the string “Version 1.1” appear in the

~ gerver log.
Committing Source Files

Now that you've tested the code to make sure it works, let’s store your changes
under version control. Here are the steps.

1. In the Versioning window, right-click Pagel.java and select CVS > Update.
This ensures that your local copies of the files are up-to-date. You should see
a successful update appear in the VCS Output window under the Standard
Qutput tab.

Right-click Pagel.java again and choose CVS > Commit. This brings up a
CVS Commit dialog for Pagel.java.

3 In the window for Enter Reason, type log button push.

4, Follow these same steps for Pagel.jsp. Provide the same input log button
push for Enter Reason when you commit.

. The Versioning window should now mark the Pagel.java and Pagel.jsp
files Up-to-date as revision 1.2 (see Figure 4-39).

Comparing File Revisions

During a hectic software development cycle, it’s often necessary to compare file
revisions and track down what happens as code evolves. This helps everyone
understand what changes were made, by whom, and when.

At this point, you have revision 1.1 (initial) and revision 1.2 (log button
push) for both the Pagel.java and Pagel.jsp files. Let’s look at Pagel.java and
ow you how to see the changes you just made to the project for that file. Here
are the steps.

ayment Calcu

; code before
In the Versioning window, right-click on the 1.1 Initial revision under

_ Pageljava and select Diff Graphical.

A Pagel.java [VCS Diff] graphical visualizer window appears, showing
You the changes between revision 1.1 on the left and your working file (revi-
sion 1.2) on the right (see Figure 4-40).

€ Graphical Visualizer gives you a side-by-side view of the changes in the
4N window. You'll see changed lines highlighted in blue, lines added since
earlier revision highlighted in green, and lines removed highlighted in red.

Facebook's Exhibit No. 1003
Page 00207

Page 207 of 328 GOOGLE EXHIBIT 1003



176 Chapter 4 Software Development

EVersioﬁif;ﬁ h
C¥S Ct\Documents and SettingsiCys

#-£F 1.1 Initial revision
payraent1

[ ApplicationBeant . java
D,/Bundle.properties
E] wPagel java

&
B,RequestBeanl.java
w--D,/SessionBeanl Java it
3 web

WEB-INF
J resources

&-28 1.1 Initial revision
- build.xml

Figure 4-39 Commit CVS files

Try the Graphical Visualizer with Pagel.jsp to see the differences between
two revisions. You can also <Shift+Clicle revision nodes in the Versioning w
dow and right-click either of the nodes to select Diff Graphical.

Creator Tip

The Visualizer also lets you see the differences between revisions as text
differences. To see your changes in this format, click the Visualizer combo box
and select Textual Diff Viewer.

Viewing History

During software development, it’s important to track the changes that ha
made to a module and by whom. This sections shows you how to use the C
History command to get this information.
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S g
‘ void init{) throws Exception { private void _init() throws Exception { &
rivat:,bercmn_/ert,e rl.setMindntegerDigits (1) ; numberConverterl,setMinkntegerDigits (1}
mmberCcnverten .setMaxIntegerPigits (40) ; nunberConverterl.setMaxIntegerDigits (40) ;
:;mbe:Convennecl.setMn.xFractioyd)ig’itS {eh: mmberConverterl.setMaxFractiondigits (2)

public: String caJclLlate_actioM) {
£4.TODO: P[é;ess the buttaen click action. 1
/. case name whers null will-return:to.the
lng("‘n'e):sion ORELS
return null;

22
7 . = &
Working File

igure 4-40 CVS Graphical Visualizer

History Log

The CVS History Log command gives you a full list of a file’s revisions, tags,
and commit history. Let’s show you what this looks like for the changes we
made to Pagel.java. Here are the steps.

1. Right-click Pagel.java in the Versioning window.

2. Select CVS > History > Log.

3, A history log should appear in the IDE main window displaying the com-
_ plete revision history of Pagel.java (see Figure 4-41).

History Annotation

Another useful CVS history command is annotation. The CVS History Annota-
tion command displays information about each line in source file, including
when a line was changed and by whom. Let’s try this out with our Pagel.java
S file. Here are the steps.

's text

combo box 1. Right-click Pagel.java in the Versioning window.

2. Select CVS > History > Annotate.

3A history annotation should appear in the IDE main window displaying the
revision history of Pagel.java line-by-line. In Figure 4-42, we show you
which lines in the file were introduced for revision 1.2 and by whom.

1ges that have

0 use the CV
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@ Welcome x| g Pagel Le:n/ LoanBean.java X g Pagel.java[log] x|

Filename: | Pagel . java . locks:

Repository File:

Head Revision: Selected Revisions: OutOf: (3
Description: )
Symbolic Mames and Revision List:

Symbal... Revision |1 Revision - Author ~ Log Message . Date State  Lines .
release  1.1.4.1 11 [Paut &... [Intial revision  [2005{12/14 19:3... [Exp v
vendor 11,1 1111 [PaulA... finitial |2005(12/14 19:3.., [Exp  1+0-

Log Message:

i leg butten push

Figure 441 CVS History Log

LoanBean. java Sc";gPagel.iava[n.nnotate] %

.me | jpjPagel x

Filename: C:\Documents and SettingsiCYS\PaymentCYS{stc/payment 1 /Pagel .java
Fiter Revision:  |Equals & | <o Revision Select.,, %!
Filter by Author: | <No Author selected> v

lne .. Revi.. Author Date Line
4‘15,,,, 12 ”“‘Pau[/,qnd . 1506005 T R A
416 1.2 Paul and 15-Dec-05

Paul And 15-Dec-05 ! TODO: Process the button click
419 1.2 Paul And 15-Dec-05 {{ case name where null will return, .,
420 1.2 Paul and 15-Dec-05 log("version 1.1");
421 1.2 Paul and 15-Dec-DS rekurn nul;
422 1.2 Paul And 15-Dec-05 +
423 1.1 Paul And 14-Dec-05 +
424 f.1 Paul And 14-Dec-05

Figure 442 CVS History Annotation

Adding and Removing Files

After you import your source files and check them out, CVS allows you to ad
and remove source files from your CVS working directory. This section sho?
you how to use these commands.
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4.3 Source Code Control with CVS 179

ad Command

VS Add command lets you schedule a new file to be added to your work-
- ectory- The CVS status of a file must be set to Local, or the CVS Add
g 4 nd is not available for that file.

‘Lént’: create a new java file in our working directory and add it to the reposi-

_we'll also commit this file and put it under version control. Here are the
1y

ps-
In the Files window, right-click src > asg >bean_examples and select New >
Java Class. ’ _

Type DemoBean for the New Class Name in the New Java Class dialog.
Click the Finish button.

[n the Versioning window, the DemoBean.java file should appear under the
bean_examples node, marked as Local.

Right-click DemoBean.java and select CVS > Add. This brings up the CVS
Add dialog.

5, Type Demo Bean for the File Description and click the Textual radio button.
Check the Proceed with Commit If Add Succeeds checkbox. Click OK (see

_ Figure 4-43).

File Descriptisn: | Demo Bean

[} Proceed With Commit If Add Succeeds

File Type Flag:

{7 Auttodetect {extensions configured at server)

{73 Binary (no text diffs)

i OK [%J [ Cancel }

~ Figure 443 CVS Add Dialog

- In the VCS Output window, an Update tab will open and display status.
Since you clicked the commit radio button in the CVS Add dialog, CVS will
commit the file after the Add succeeds. In the CVS Commit dialog, type Ini-
tial revision in the window for Enter Reason.
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8. The Versioning window should now reflect the CVS status change of D

Figure 444 CVS Add New File

Bean.java to Up-to-date with revision 1.1 (see Figure 4-44).

‘:b‘ersiorﬁyng . . ey
) i 3
S conf
fib et
3 nbproject

u,/LoanBean.java i shibey :
Lo ~#% 1.1 Initial revision s
4 o Gimdmii RTINS, <

Creator Tip

Check the Textual radio button for text files and the Binary radio button for
binary files. Use the CVS > Add command to restore binary files (images and
jar files) that you removed during a CVS import. (See “Creator Tip” on
page 170.) If you do not check the commit checkbox in the Add dialog, your
file will not be added to CVS until you run the CVS > Commit command,

The CVS Remove command deletes your local copy and schedules the file!
removal from the CVS repository. To show you how this works, let's deletef
DemoBean.java file you just added. Here are the steps.

1.

N

Page 212 of 328

. Click Yes in the Question dialog. The CVS Remove dialog will appear.
. Check the Proceed with Commit If Remove Succeeds checkbox. Click OK

. In the VCS Output window, an Update tab will open and display status

. In the Versioning and Projects windows, the DemoBean.java will not

Remove Command

In the Versioning window, right-click DemoBean.java and select CV5>
Remove.

(see Figure 4-45). ~'

Since you clicked the commit radio button in the CVS Remove dialog, CV:
will commit the file after the Remove succeeds. In the CVS Commit dialof
type Not necessary in the window for Enter Reason. ‘

appear.
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change of Dmﬁ

Set As Default } [ Get Default Values !

7 Carmmit IF Remave Succeeds

Ft qure 445 CVS Remove File

configuring CVS Settings

The IDE lets you configure CVS with settings that apply to a single local work-
ing directory or globally for all projects under version control. Let’s show you
how to access these settings for CVS management.

) button for
(images and

~ Local Settings

Tip” on The IDE lets you view or change settings for your working directory. Here are
ialog, your the steps for the PaymentCVS project.
ommand.

1. From the Creator toolbar, select Versioning > Versioning Manager. In the

Versioning Manager dialog, select the working directory and click Edit. (Or,
right-click the working directory in the Versioning window and select Cus-
tomize.)

. The Customizer dialog has four tabs: Profile, Advanced, Environment, and
Properties. Figure 4-46 shows the settings under the Properties tab. Note
 that changes made in the Customizer apply only to the working directory

_ you select.

lules the file fo
5, let’s delete th

2lect CVS >
Global Settings
Il appear.
ox. Click OK Its also possible to view or modify global settings that apply to all CVS work-

ing directories and repositories. Here are the steps.

play status.
re dialog, CV3
ommit dialog

L From the Creator toolbar, select Tools > Options.

2. Click the Advanced radio button.

- Expand the Source Creation and Management node and Version Control

~ Settings node.

t. Click CVS. Figure 4-47 shows the General Properties window. Clicking any
customizer box here grants you access to a wide variety of different configu-
ration parameters that you can view or modify.

will not
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o Advanced | Enviranm

Genetal

Annatation Pattern ‘ ${fileName}$[? skatus] { [${stafus}-$[? revision,,,@*
Auto Refresh For Mewly Opened Falders i
Command Motification =)

Profile S

Print Cornmand Qutput
Advanced Options
Hidden

Offline Mode

Read Only

Cache 1D

Commands

Create Backup Files

Hide Shadow Files

Process All Files

Refresh Time For Local Filtes [ms]
Rernember Passviord

Variables Yariables

Figure 4-46 CVS Customizer for Working Directory

7} Basic Advanced

Options =i General
i y i X L
% Source Creation and Management ] ontext Commands Comrmiands
Templat Conditions Conditions
€% Templates
s Global Cormands Commands
Yersion Contraol Settings Variables yariables

&

seneric Y5 Profiles

@ Emply
LoLe@ s
L-FF ¥CS Groups S

z C!qse;v il Help

Figure 447 CVS Global Options
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,gvanced CVS Features

so implements more advanced features of CVS, such as branches
erging: A branch allows you to maintain different versions of a code base.
am be handy when a customer requires a different version of your code or
scalgd to build a demo program. After creating a branch, any committed
¥o es that you make apply only to that branch.
Chan\%; also supports code merging. This can be useful when it’s time to incor-
' the pranch code back into a code “trunk” or to merge file revisions. Merging
POEVS can be a bit tricky because merge conflicts are possible. This can happen
nhen more than one developer changes the same line of source code. The IDE
'Zl s you graphically resolve merge conflicts before committing the code to

ék; iDE al

{7 revisian,,,

orsion control.
 Branches and merging are beyond the scope of this book, but you should

w enough about CVS now to apply these advanced features if you need

4.4 Creating Non-Web Projects

ile Creator is a great IDE for creating and managing web applications, you
might also want to create non-web projects, such as stand-alone Java programs.
With general projects, the IDE generates an Ant script to build, run, and debug
your project. You can also add testing. In this section, you'll step through build-
ing a general project with a very useful goal: the project creates a sample data-
base that you'll use later on in this book to explore Creator’s database access
acilities.

The MusicBuild project consists of a single Java class, a library that you'll
dd through the Libraries node, and the default JDK that comes installed with
Creator. When you run the project, it generates sample database tables, table
onstraints, and records for a Music Library.

This project is included in the book’s download. If you don’t want to step
through the building process, you can bring up the project in the IDE. The
_ project is located at Field Guide2/Examples/Projects/MusicBuild.

SN

~ Create a General Project
Here are the steps to create the MusicBuild project.

L Close any projects that are open. From the Creator Welcome page, click the
Create New Project button.

2. In the New Project dialog, select General under Categories and Java Class

Library under Projects. Click Next.
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184 Chapter 4 Software Development

3. In the New Java Class Library dialog, specify project name as M“SiCBuil
4. Click Finish.

After creating the project, Creator builds the structure for your pyq
which you can inspect through the Projects window.

Add a Java Package

Here are the steps to add a Java package under the Source Packages node,

1. In the Projects window, expand the Source Packages node. You'll see tj,
Creator generates a default package node for you.
2. Right-click the Source Packages node and select New > Java Package, ¢y
ator displays the New Java Package dialog.
3. For Package Name, specify asg.databuild. Click Finish. Creator replaces
default package node with package asg.databuild.

Add a Java Class File

Here are the steps to add the main Java file to this project.

1. In the Projects window, select package asg.databuild. Right-click and s¢
New > Java Class.
2. In the New Java Class dialog, specify class name DerbyMusicDB. Creato
generates class file DerbyMusicDB.java.
3. Copy and paste the contents of DerbyMusicDB.java found in your Creato
book download at FieldGuide2/Examples/Database/utils. '
4. Go ahead and build the project (don’t run it yet, though). From the main
menu, select Build > Build Main Project. There should be no build errors in th
Output window.

Add a JAR/Folder

The DerbyMusicDB class uses Java’s JDBC package to connect to the bundl
database. In order for this program to work, you must make the databa
driver class available at runtime (found in jar file derbyclient.jar). You mu
also make sure that the bundled database server is running (before runningt
project).

Here are the steps to add the derbyclient JAR file to the project.

1. From the Projects window, select Libraries, right-click, and select AddIAR/
Folder from the context menu. Creator displays the Add JAR/Folder dialo
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4.4 Creating Non-Web Projects 185

2. Browse to the Creator installation directory and locate the derbyclient JAR
file, <Creator-Installation-Directory>/rave2.0/core/derbyclient.jar. Click

Open, as shown in Figure 4-48.

Look int

My Recent
Dacuments

jgraph.jar
naming. jar
rawset. jar

smbase. jar

L 1&] smdbz.jar
M«f ; éf_} sminformix, jar

My Documents |

) smaracle jar
tension-ide-launcher-upgrade. jal

SMresnurce. jar
SMSpy,jar
smslserver.jar
smsybase. jar

sqlx.jar

>
Filte narme: vd'érvbycii'er&,"jar o ‘ 1 Qpen ;
My Computer  Files of type: Classpath Entry (Folder, ZIP or JAR, ... & l Cancel

Figure 4-48 Add JAR/Folder dialog

After adding the derbyclient JAR file to your project, the Projects window
should display its name under Libraries, as shown in Figure 4-49.

EProiect's” R D%
MusicBuild

% Source Packages
asg.databuild

L_@j] DerbyMusicDB . java

3 Test Packages

Libraries

@ derbyclient.jar

L=l JDK 1.5 (Default)

Test Libraries

Figure 4-49 Projects view for project MusicBuild
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Build and Run Project

Now you are ready to build and run project MusicBuild. Click the green Run
Main Project icon from the icon toolbar or select Run > Run Main Project from
the main menu.

After running the program, the Output window should tell you the Music
database was created. Once you add the Music schema as a data source to Cre-
ator’s IDE, you can build web applications with design-time support for data-
aware components. We show you how to do this in Chapter 9. See “Configur-
ing the Bundled Database” on page 376.

4.5 Key Point Summary

* The IDE greatly simplifies the “edit-compile-deploy” cycle of complex web
applications.

* Keyboard shortcuts and code completion help make coding easier.

° The IDE lets you format your code, change fonts and colors, collapse (fold)
sections of code, generate import statements, and use abbreviations for
heavily used Java keywords and expressions.

* Javadoc popup windows make it easy to locate documentation for Java
classes.

* The IDE helps you generate code when extending a Java class or
implementing a Java interface.

* The IDE generates properties that conform to the JavaBeans component
model.

* Task lists provide a way to document and clean up loose ends in your code.

* Refactoring is transforming and restructuring source code so that the
refactored code behaves the same as the original source.

¢ With refactoring, you may rename a class, field, or method, generate getter
and setter methods for fields, change method signatures, and move classes
to another package.

* The IDE supports Undo/Redo for refactoring commands.

* Creator supports CVS (Concurrent Version System), one of several Version
Control Systems (VCS).

* With CVS, you may place source code under version control, generate
revisions, compare revisions, and examine log histories of code changes.

* A CVSrepository is a directory that stores a project’s full revision history.

* A CVS working directory stores the source code of your project.

* The IDE lets you setup CVS profiles and configure the CVS environment
when you work with project code under version control.

¢ Importing files in CVS is placing project source code under version control.

* Committing source files is storing your edited changes in CVS.
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4.5 Key Point Summary 187

The IDE has a Graphical Visualizer to help you compare different revisions
in CVS.

History logs in CVS help you document what source code lines were
changed in each revision and by whom.
After importing source code files into the repository and checking them out

to your working directory, you may add new files to your project or remove
them.

The IDE also lets you create non-web projects, such as stand-alone Java
programs.
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WEB PAGE DESIGN

Topics in This Chapter

« Component Style
+ Themes

. CSS Style Editor
+ Page Layout

« Page Fragments

+ Project Templates
~ + Navigation with Page Fragments
+ Tab Sets
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un Java Studio Creator provides layout components, visual design edi-
p tors, and style sheet editors to help you design visually pleasing pages
/ for a coherent, unified-looking web application. In this chapter we

explore some of the Creator tools and components available to you for
page design.

Once you've designed your pages, you'd like to reuse the components, style
settings, and logos and images on subsequent pages or in other projects. Cas-
cading style sheets, page fragments, and project templates help designers build
artifacts that can be reused. Although you will see some event handling code,
page initialization code, and property patterns in the upcoming examples, this
chapter concentrates on Creator’s visual page design.

7.1 Using the Visual Design Editor

Creator’s visual design editor runs in the main editor pane by default when
you create a new project. Its main purpose is to help you select components
and position them on the page using a page grid. You can also turn off the grid,
temporarily disable it, or change the grid size.
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Chapter 7 Web Page Design
Create a Project 5.
Let’s explore the main features of the design editor. To do this, yow'll build 4
simple project with three static text components. Figure 7-1 shows the project
in the design view with these components.
By
@ Welcome x | p Pagel x| po
D Java Q @; I;} %Any Size ne
S U USSP S S SRR N 1.
The quick brown fox. -
She sells ssashalls, .
S 2.
‘ Winter waves crashed againstthe cliffs. - - oo
Figure 7-1 Visual design editor in the editor pane 3.
1. From Creator’s Welcome Page, select button Create New Project. Creator
displays the New Project dialog. Under Categories, select Web. Under L
Projects, select JSF Web Application. Click Next. Te
2. In the New Web Application dialog under Project Name, specify Designl.
Click Finish. . 1]
After initializing the project, Creator comes up in the design view of the edi- 5
tor pane. You can now set the title. '
3. In the Properties window, select property Title and specify title Designl.

Finish by pressing <Enter>.

Add Components to the Page

Now let’s add the static text components and specify the text for each one.

1. From the Basic Component palette, select component Static Text and drop it
on the page. Don't worry about positioning yet.

2. The component is selected so that you can type in some text. Type in the text
The quick brown fox followed by <Enter>.

3. Select component Static Text again and add it to the page under the first
component.

4. Specify its text She sells sea shells.
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7.1 Using the Visual Design Editor 275

5. Add a third static text component and specify its text Winter waves crashed
against the cliffs.

da

ject Working with Components on the Page

By default, a project’s layout is in grid mode. This allows you to position com-
ponents on the page at an absolute location. The grid helps you with compo-
nent alignment.

1. Select the first static text component. Creator marks the component selected
and displays component resizing handles for you. With the component
selected, you can move it to a different location. You'll note that it automati-
cally snaps to the grid.

2. Select the same component a second time. The text area is selected (Creator
displays a blue background) and the component is enabled for text editing.
In this mode you can now issue typical editing short cuts, such <Ctrl+C> for
copy or <Cttl+V> for paste. You can also select a word, use the left and right
arrow keys, or type replacement text.

3. Sometimes you’ll want to move the component so that it doesn’t snap to the
grid lines. To temporarily turn off grid alignment, select the component,
hold the Shift key, and use the mouse to adjust the component on the page.

You can configure Creator to change the grid size or disable it using the
Tools menu.

1. In the main menu, select Tools > Options. In the Options dialog, select Visual
Designer. Creator displays the options for the Visual Design Editor, as

edi- shown in Figure 7-2.

2. After making changes, click Close.

The Show Grid option controls whether or not the grid is visible in the edi-
tor. This is true by default. When the Snap to Grid option is set to true, the com-
ponents align with the grid lines in the designer. The Grid Height and Grid
Width values control the grid size and the Target Browser Window controls the
size of the application’s window in the browser.

%

Component Alignment
Pt Each component has a context-sensitive menu that becomes visible when you
select a component and right-click the mouse. The Align menu option provides
component alignment criteria. While frequently you can align components by
simply using the default behavior of snapping to the grid lines, occasionally
you'll want to align components using other criteria. For example, here’s how
to center the three static text components.

text
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~

() Basic  { Advanced

QOptions

b
[ Plain Editor
-[& Java Editor

& 5P Editor
Properties Editor
XML Editor

DTD Editar

i Project Settings ;.'5

L iGereral
HTML Editar #

Shpw Grid ]
SNk ko Grid [+#]
Grilf True, gridis shown in the Yisual Designer. |

Grid Height

Target Browser Window

24
. Any Size e

Figure 7-2 Visual Designer Options dialog

1. Choose one static component and position it on the grid at the desired loca-
tion. Use the Shift key if you'd like to disable the snap to grid lines option.

2. You can select multiple components by selecting one, then selecting others
while holding the Shift key. Alternatively, you can draw a box around the
components you'd like to select, as shown in Figure 7-3. Click the mouse at a
spotabove and to the left of all the components. Drag the mouse towards the
lower-right until all the components are enclosed in the selection box. When
you release the mouse, all three components are selected.

Figure 7-3 Selecting multiple components
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7.2 Themes 277

3. Place the mouse over the component that you want to use as the alignment
reference, right-click, and select Align > Center. The three components will be
horizontally centered using the selected component as the alignment refer-
ence.

For horizontal alignment options, select Left, Center, or Right. For vertical
alignment options, select Top, Middle, or Bottom.

¥ Deploy and Run

After aligning the components, deploy and run the application. Figure 7-4
shows project Designl running in the browser. The components were centered
horizontally using the third component as the reference for the alignment.

A=

The quick brown fox.

She sells sea shells.
loca-

ion.
hers
the

seata

Winter waves crashed against the cliffs.

{s the S mera
Nhen

Figure 7-4 Project Design1 running in a browser

7.2 Themes

Creator gives web page designers a number of choices for specifying the look
of a web page. The components from the Basic, Layout, and Composite sec-
tions of the palette are rendered using themes. A theme is a bundled set of cas-
cading style sheets, JavaScript files, and images that apply to the components
and the web page. Creator currently ships with four configured themes. The
available themes for a project are listed in the Projects window under node
Themes, as shown in Figure 7-5. The currently selected theme is marked with a
triangle badge. To change the current theme, right-click a new theme selection
and select Set As Current Theme.
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‘Projects ™ % | Files

- Preconfigured Themes
iz Layoutl

‘Weh Pages /

3 resources

| Green Theme
: } Default Theme
g Gray Thame
~1@, Managed Beans
%CI Page Mavigation
{58) Request Bean
&)

5] Application Bean

Session Bean

£y Source Packages
=

V@ Data Source References

Libraries

Figure 7-5 Creator Themes available for projects

Creator Tip

To make a new theme take effect for deployment, first stop the application
server, then clean and rebuild the project.

The Default Theme provides a gradient blue color, giving the components a
unified look. The Gray and Green Themes provide color variations with the
same gradient appearance. The Gray Theme is useful when you want to give
the components a neutral look (for example, if your color scheme does not
mesh well with either blue or green). The Bike Theme is used with Jump Start
Cycles, one of Sun’s sample applications. Access sample applications at the fol-
lowing url:

http://developers.sun.com/prodtech/j avatools/jscreator/refer-
ence/code/sampleapps/index.html

Changing the Look with Themes

Let’s create a simple application, deploy it, and change its current theme. This
application won’t do much, but you'll see how several components are affected
by theme selection. Figure 7-6 shows the project running in a browser. The
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page contains a hyperlink component, text field, label, static text component,
and table. The application is built with the Default (blue) Theme.

& Tﬁeme:

Hyperlink

e

Label The rquick brown fox

& column2. s columng
row1_column2 row1_column3
row2_columni row2_columnz row2_column3
row3_column row3_column2 row3_rolumn3
rowd_colurmn row4_column2 rowd_column3
rows_columni row5_column?2 rows_column3

Figure 7-6 Project Themel running in a browser

1. From Creator’s Welcome Page, select button Create New Project. Creator
e displays the New Project dialog. Under Categories, select Web. Under
Projects, select JSE Web Application. Click Next.

sa 2. In the New Web Application dialog under Project Name, specify Themel.
the Click Finish.

ive :

10t After initializing the project, Creator comes up in the design view of the edi-
_aﬁt tor pane. You can now set the title.

ol

S RS
Q)

. In the Properties window, select property Title and specify title Themel.
Finish by pressing <Enter>.
4. In the Projects window, expand the Themes node and make sure that the
Default Theme is selected as the current theme (it should display a triangle
. badge).

S -

his Add Components to the Page
ed Using Figure 7-6 as a guide, add components to the page. Except for the static
text component, all will retain their default settings.

'he
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1. From the Basic Component palette, select component Hyperlink and drag it
to the top-left portion of the page.

2. Select component Button and place it to the right of the hyperlink compo-

nent.

. Select component Text Field and place it next to the button.

. Select component Label and place it under the hyperlink component.

5. Select component Static Text and place it to the right of the label component,
When you drop it on the design canvas, it remains selected and you can
begin typing. Type in some text (The quick brown fox) and finish with
<Enter>.

6. Finally, select component Table and place it on the page below the label com-
ponent. Creator generates a table with default rows, columns, and data. The
table component reflects the colors used by the different themes particularly
well.

7. Deploy and run the application by clicking the Run arrow on the toolbar.

> G

Change the Current Theme

Now let’s change the current theme for this project and redeploy the applica-
tion.

1. In the Projects window, expand the Themes node. Right-click Green Theme
and select Set As Current Theme. Creator reminds you that you must stop the
application server, then clean and rebuild the project before redeploying.

2. In the Projects window, expand the Libraries node and scroll down until you
find the JAR file associated with the Green Theme library.

3. Expand the Green Theme library. You’ll see the defaulttheme-green.css file
as well as the images, properties, and JavaScript files associated with this
theme. (You'll look at a cascading style sheet (.css) file shortly.)

4. In the Servers window, right-click Deployment Server and select Start/ Stop
Server. Click the Stop Server button.

5. Return to the Projects window, right-click the Themel project name, and
select Clean and Build Project. (This step is necessary to make the application
server use the correct JAR file for the selected theme.)

6. Deploy and run the application by clicking the Run arrow on the toolbar.
The application should now display green-colored components.

7. Repeat Steps 1-6 above to change the current theme to the Bike Theme.

Creator Tip

Instead of deploying the application each time, you can right-click inside the
visual design editor and select Preview in Browser for a quick look at a newly
selected theme.
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7.3 About Style 281

Modifying the Default Theme

The Default, Gray, and Green Themes are variations of the same theme. Is it
possible to modify themes for different colors or use a different theme alto-
gether? The style sheets and images that apply to components can theoretically
be modified. The theme JAR files are installed in the Creator2 directory (cur-
rently at rave2.0/modules/ext). You can unpack the JAR file, edit the CSS file
and images, and repackage them. Until Creator includes a theme-based editor,
however, this remains a non-trivial task. Still, there’s much you can do to con-
trol the appearance of your application. Let’s continue to explore web page
design options beginning with style.

7.3 About Style

You've probably noticed by now that each component has a style property
that allows you to change the appearance of various features such as font (size,
color, family, style), position, height, width, etc. Some components also contain
“pass-through” HTML attributes, such as border and cellpadding that apply to
table-type components. You specify style attributes by modifying the compo-
nent’s property sheet directly. This gives you control over the look of a specific
component. It is also a handy way to experiment with different styles until you
decide on an overall style for your application.
Property style accepts style declarations in the form

propertyl: valuel; property2: value2; . . . propertyN: valueN

Let’s look at an example.

Copy the Project

You'll make a copy of project Themel (call it Theme2) for this section. This step
is optional. If you don’t want to copy the project, simply skip this section and
continue making modifications to the Themel project.

1. Bring up project Themel in Creator, if it’s not already opened.

2. From the Projects window, right-click node Themel and select Save Project
As. Provide the new name Theme?2.

3. Close project Themel. Right-click Theme2 and select Set Main Project. You'll
make changes to the Theme2 project.

4. Expand Theme2 > Web Pages and open Pagel.jsp in the design view.
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5. Click anywhere in the background of the design canvas of the Theme?2
project. In the Properties window, change the pages’s Title property to
Theme2.

6. Select the table component, right-click, and select Delete from the context
menu to remove the component from the page (to simplify the page).

Using the Style Editor

9
Text Blo
Let’s use the style editor to manipulate a component’s look. Eg;?;
Positi
1. For project Theme?, restore the current theme to the Default Theme (blue- -
toned). Remember to stop the application server and clean and rebuild the
project before proceeding.
2. In the Design View, select component staticTextl.
3. In the Properties view, click the small editing box opposite property style. ; Prop
Creator pops up the Style Editor, as shown in Figure 7-7. o Sele

Creator provides a sophisticated Style Editor that lets you specify a compo-
nent’s style attributes. The Property Selection window lets you choose a prop-
erty to edit. Depending on this selection, the editor displays windows that let
you select values from a list or specify a custom value. When you change an
attribute, the Results Display Window applies the style to the component.

Use the Style Editor to modify the static text component’s style property.

—

. Select Font in the Property Selection window. ;
2. In the Font-Family selection window, select the list of font-family values Icss s
beginning with Verdana. |

3. In the Size window, select font size 18.
4. In the Style selection window, choose jtalic from the drop down menu. Note Actu
that the text in the Results Display windows reflects your selections.
5. Now select Background in the Property Selection window. The editor dis-
plays a different set of selection windows. Fioun
6. Select color yellow in the Background Color drop down menu. gure
7. Choose Border in the Property Selection window. 9 QL
8. In the All selection window for Style select solid, for Width select 1px, and
for Color select gray. De
Here is the new CSS Style setting for this component. Right

deplo
border: 1px solid gray:; background-color: yellow; |
font-family: Verdana,Arial,Helvetica,sans—serif;
font-size: 18px; font-style: italic; left: 120px; top: 72px;
position: absolute
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Figure 7-7 Using the Style Editor

9. Click OK. The page in the design view reflects the new style characteristics.

Deploy and Run

Right-click in the visual design editor and choose Preview in Browser, or
deploy and run the application to check its appearance.
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7.4 Cascading Style Sheets list-he
backgr
font-s
Using a component’s style property to control its look can be tedious. You font-w
must specify attributes for each component manually by editing its property , }
sheet. Furthermore, it’s difficult to employ a uniform look for a web page using '
only style property settings. There aj
Creator uses Cascading Style Sheets (CSS) to control the look of its compo- value #eeq
nents and pages. CSS is a standard that allows a web designer to specify style weight ha
characteristics. The style characteristics apply to a document in a cascading you define
fashion: that is, a style applies to a given level and subsequent styles can in turn names in a
apply on top of these “inherited” styles. If you don't specify a property for an ; You can
element, it generally inherits the property from its “parent.” For example, you (table heac
can specify that all text in a document is (color) navy. You can then specify that bal setting
text in a footer is a smaller text size. The footer text will be both navy and the color, and
smaller size since the footer-specific style inherits all properties specified for
the global style. 1. Seroll tc
You can read more about Cascading Style Sheets at the Cascading Styles '
Home Page: http://www.w3.org/style/css/. The web site also includes : /% Custc
tutorials about how to use style sheets. : |
2. Now ac
Using Property styleClass
/* Custg
All Creator components include property styleClass, which is a comma sepa-
rated list of style classes. You define and store a style class in a text file called a body |
style sheet. As stated earlier, using property styleClass helps web designers }
create a uniform look to all pages in a project. Creator provides a default style
sheet, stylesheet.css, that is included in each project you create. When you add 3. Put the
style classes to the style sheet, you can then reference them in the component’s up a pt
styleClass attribute. (Note that the bundled themes include a set of style rules | 4. Creato
that also apply to the components.) L down
A style sheet is a collection of style rules. Each rule consists of a selector and a 1 5. Creato
declarator. The selector identifies an HTML element(s) or style class name(s) to L 230, 23(
which the rule applies. The curly braces encompass the declarator, which is the . for pro
semi-colon separated list of property-value pairs. While the component’s style 6. Contin
attribute lists the property-value pairs for a given component, a rule is a collec- dows
tion of property-value pairs that is named. 1
Let’s examine the default style sheet, stylesheet.css, in the Style Sheet Editor. % f body {
In the Projects window for project Theme?2, select Web Pages > resources and I bac}
double-click file stylesheet.css. Creator brings up the style sheet in the Style L font

Sheet Editor and highlights the first rule, .1list-header.
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.list-header {
background-color: #eeeeee;
font-size: larger;
font-weight: bold;

}

There are three property-value pairs here: property background-color has
value #ecceece, property font-size has value larger, and property font-
weight has value bold. Rules that contain an initial dot are style classes. Once
you define them in the style sheet for your project, you can specify the class
names in a component’s styleClass attribute.

You can also define rules that apply to HTML elements such as <body>, <th>
(table heading), <td> (table data). The body style rule is a good place to list glo-
bal settings for your web application, such as basic font characteristics, text
color, and background color. Let’s do this now.

1. Scroll to the top and add the following comment.
/* Custom style rules */
2. Now add a rule for body followed by opening and closing braces.

/* Custom style rules */

body {

| | 3. Put the cursor after the open brace and hit <Enter>. You see that Creator pops
; . up a property selection dialog. Select background-color followed by <Enter>.
; 4. Creator now pops up a value selection dialog, as shown in Figure 7--8. Scroll
down to the bottom and choose more...and hit <Enter>.

1 5. Creator pops up a Choose Color dialog. Select tab RGB and specify values

) 230,230,200, as shown in Figure 7-9. Click OK. Creator fills in value #e6e6c8
for property background-color.

2 . 6. Continue editing style class body. You can also use the style selection win-

. dows below the editing pane. Here is the style to use for body:

body {
background-color: fe6e6c8;
font-family: Verdana,Arial,Helvetica,sans-serif
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Figure 7-8 Using the Style Sheet (CSS) Editor
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Figure 7-9 Choose Color dialog
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7.5 Page Layout

7. Add a style class called .headingStyle, as follows. Use the style selection
windows to specify font-size and font-weight (or just type them in).

.headingStyle {
font-size: XX-large;
font-weight: bold

}

8. Select the Save All icon on the toolbar to save the changes and close the Style
Sheet Editor (click the small x in the stylesheet.css tab).

The body rule applies to all HTML <body> elements, as well as any elements
declared inside of <body>. Thus, nested (“children”) elements inherit the prop-
erty-value settings from their enclosing (“parent”) elements.

Return to the Pagel design view. You'll see that the background color and
the font-family setting reflect the body style rule you defined. Now you’ll
apply the .headingStyle style class to the static text component.

1. In the design view, select the static text component (its text is “The quick
brown fox”).

2. Select the editing box opposite the style property. When the style editor
pops up, select Unset Property. Creator clears its style setting (including its
position value). The component is now in the upper-left corner.

3. Select it and move to its previous location (restoring its position values).

4. Make sure the component is still selected and type in the text headingStyle
for property styleClass (do not use the initial dot from the style sheet file)
followed by <Enter>. The static text component now has the extra large font
size and is bold.

Deploy and Run

Deploy and run the project. Figure 7-10 shows the application running in a
browser.

7.5 Page Layout

Creator provides several components that help you manipulate the layout of
your web page. In this section, we’ll examine components layout panel, grid
panel, and anchor (paired with hyperlink). We'll keep the projects simple in
order to concentrate on page layout issues.

287
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3. In

St

Figu

Label you

The quick brown fox

Figure 7-10 Project Theme2 running in a browser

Layout Panel

Creator’s palette includes several component containers that group or nest
embedded components. With containers, you can uniformly control the “chil-
dren” components’ appearance, including position, style, and rendering. The
layout panel component positions its components with either a flow layout,
placing each component directly after the previous one, or a grid layout, letting
you position components using the design editor. For this project, we'll also -
show you how to inspect the CSS style rules and HTML rendering that Creator ~ Figui
generates for you. Finally, we’ll show you how to center components on the =~
page, even when the user resizes the browser window.

1. Fr

Create a Project dr

10

In the following project, you’ll control components by grouping them together, 2. M

allowing the components to share common style, position, and rendering op

attributes. You'll see how the layout panel lets you position components using Th

the standard grid. ad

3. St

1. From Creator’s Welcome Page, select button Create New Project. Creator bo
displays the New Project dialog. Under Categories, select Web. Under

Projects, select JSF Web Application. Click Next. As

erty. !
attrib
used

2. In the New Web Application dialog under Project Name, specify Layoutl.
Click Finish.

After initializing the project, Creator comes up in the design view of the edi-
tor pane. You can now set the title.
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7.5 Page Layout 289

3. In the Properties window, select property Tit1e and specify title Layout and
Style. Finish by pressing <Enter>.

Add Components to the Page

Figure 7-11 shows the design view of project Layoutl. Use this as a guide as
you add components to the page.

s,

o f?'ﬁaf Q&éiﬁi o i“f)xzjzzmyéi}‘ piféf; ﬁ;eﬂéyé}ﬁ y«:waw dogs: )
"} Static / . g - Sheselts sea shells
JoTextt ool T
' \ P?zif@:‘f”fgﬁéﬁﬁiﬁke&?é ;)pc% éé‘;p}r:};s’éf,f ,ém;kpﬁk:ﬁ' R : o '
Test | i
hil- cfe L
The 4
out, T
ing .. LayoutPanel - ... ... .. .. ./ Button/ - ..o
Jso
ator Figure 7-11 Design view for project Layoutl |
the k ;
1. From the Layout section of the Component palette, select Layout Panel and

é drop it on the page. Enlarge it so that it is approximately 20 grids wide and

10 grids high.
her, 2. Make sure the layout panel component is selected. In the Properties window
ing . opposite property panellayout, select Grid Layout from the drop down list.
ing { This lets you use the design view’s grid to position components that you'll

§ add to the panel.

. 3. stillin the Properties window for the layout panel, click the small editing

: box opposite property style. Creator pops up the Style Editor.

As you've seen, there are several ways to modify a components’ style prop-

- erty. We'll step you through using the editor, but you can also type in the style

g attributes manually. Refer to Figure 7-7 on page 283 for the window labels

. 1 used here.

adi- P
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4. In the Property Selection window, select Font. In the center Font Family
Selection Window, choose Georgia, Times New Roman' times,serif. In the Size
Selection Window, choose 12. In the Style window, select italic from the drop
down list. In the Weight window, select bold from the drop down list. In the
Color window, select gray from the drop down list.

5. Now select Background in the Property Selection window. In the Back-
ground Color window, type the value rgb(255,255,204) followed by <Enter>,
The small color indicator on the right will change to a muted yellow.

6. Select property Border. In the top row labeled All, for Style select solid and
for Width select 2px. Select OK to close the Style Editor. The layout panel
now has a border and a new background color.

By changing the layout panel’s style settings, you'll see how the children
components are affected by the layout panel’s style. Some style attributes are
inherited (such as font characteristics); others are not (such as border). And
some settings are overridden by more specific settings. We’ll examine this in
more detail after you add components to the layout panel. L Figi

1. From the Basic Components palette, select Static Text and drop it on the lay-
out panel component. The static text component appears in the Pagel Out-
line view nested under the layout panel. i

2. Type in the text The quick brown fox jumped over the lazy yellow dogs fol- :

lowed by <Enter>.

. Change the static text id property to linel. ‘

4. Add two more static text components with text She sells sea shells and Peter e
Piper picked a peck of pickled peppers. Change the id properties to 1ine2 and !

@

line3. All three static text components will be nested under the layout panel E
in the Pagel Outline view, as shown in Figure 7-12. (The screen shot also . outs
shows two button components, which you'll add later.) - 1 F
Let’s position the three static text components so that they’re centered on the E
layout panel. 1 2. ¢
1. First, use the grid lines to evenly space the static text components vertically. 3 )
Leave some room at the bottom of the panel for a button component. 4' ¢
2. Select the first static text component. Use <Shift+Click> to select all three - B
static text components, as well as the layout panel. %
3. Position the cursor inside the layout panel (anywhere in the background) g
and right-click. Select Align> Center from the context menu. Creator centers i
all three text components horizontally, using the layout panel as the refer- 5
ence component. The components should now be centered, as shown in 6- Cf

Figure 7-11 on page 289.
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{A] line1: The quick brown fox jumped ..,
{A] line2: She sells sea shells

1A] line3: Peter Piper picked a peck ...
disappearButton: Click the Button
) restoreButton: Restore

5 , .

Figure 7-12 Pagel Outline view for project Layout1

Creator Tip

Note that the components are positioned relative to the layout panel
component. If you re-position the layout panel on the page, the nested
components retain their relative position inside the panel.

Now let’s add two button components: one inside the layout panel and one

outside.

1.

w

93]

From the Basic Component palette, select component Button and place it
inside the layout panel. Position it under the three text components off-cen-
ter to the right.

. Change its text label to Click the Button (note that the button’s font inherits

the font style from the panel).

. Change the button’s id property to disappearButton.
. From the Basic Component palette, select component Button again and

place it on the page, centered above the layout panel (outside of the panel).
The button component is not nested inside the panel component in the
Pagel Outline view. Its font characteristics are therefore independent of the
layout panel’s settings.

. Change its text label to Restore.
. Change the button’s id property restoreButton.
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The event handling code for the buttons will make the layout panel disap-
pear from the page (disappearButton) and then will restore it on the page
(restoreButton).

1. In the design view, double-click the first button (disappearButton). Creator
generates a default action event handler and brings up the Java source editor
so that you can add event handling code.

2. Add the following code to the disappearButton_action() event handler
(the added code is shown in bold).

public String disappearButton_action () {
layoutPanell.setRendered(false) ;
restoreButton.setRendered (true) ;
return null;

The event handler sets the rendered property of the layout panel to false, -
causing it (and all of its nested components) to disappear from the page. It ;
makes the Restore button appear on the page. .

1. Click label Design in the editing pane to return to the design view.

2. Double-click the Restore button, which brings up the action event handler in
the Java source editor.

3. Add the following code to the restoreButton_action() event handler. The
added code is bold. When the user clicks the button, the layout panel and all
of its nested components will be rendered on the page. At the same time, the ,
Restore button will disappear. '

public String restoreButton_action() {
layoutPanell.setRendered (true} ;
restoreButton.setRendered (false) ;
return null;

}

4. Click label Design in the editing pane to return to the design view.

5. Select the Restore button. In the Properties view under Advanced (scroll
down to see it), uncheck property rendered. The button disappears from the
design view.

Creator Tip

Even though the component no longer appears on the design view, you can
still select it in the Pagel Outline view. If you want to adjust it visually, turn
the rendered property back on, make adjustments, and then turn it off agair.

S

Facebook's Exhibit No. 1003
Page 00240

|-
Page 240 of 328 GOOGLE EXHIBIT 1003
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lisap- ~ Deploy and Run
page .
Deploy and run the application by selecting the green arrow in the icon toolbar.
Figure 7-13 shows project Layout] running in a browser. When you click the
2ator inside button, the layout panel disappears and the Restore button is rendered.
ditor Clicking the Restore button makes the layout panel reappear.
ler | ® Layout and Style - Netscape Browser
File-.  Edit ;‘fiew G0 Bookmarks' - Tools  Help
i layout and Style @ 2 ;f"f,”f'w
The guick brown fox jumped over the fazy yellow dogs E
Bhe sells ses shels !
false, ‘ ﬁ
ge. It Perer Piper picked a peck of piokied peopers ’
[ ciick) rEEB&EJn@
erin
. The ;
dall : Figure 7-13 Project Layoutl running in a browser
, the
% More CSS Style Issues
Although this project is very simple, there are subtle style issues illustrated
here. The style that a component finally acquires is an amalgamation from var-
lous sources, some of which may not be obvious. For example, the Creator
components acquire a basic style from the pre-configured Theme style sheets.
(This is why the button component has a gradient blue background image.)
When you nest components inside container components, the nested ones can
il inherit styles from the enclosing component. (Thus, the button and the text
1the components have a bold, italic font.) To help you figure out where style defini-
tions originate, Creator has a hidden Document Object Model (DOM) inspector
(hidden because it is not a formal part of the product). Let’s examine several
components in this project with the DOM inspector.
R

You access the DOM inspector by selecting a component with
<Ctrl+Alt+Click>. Creator displays a Layout Inspector window that contains a
tree of the page’s components. HTML components are shown in angle <>
brackets and the Creator component id appears (if there is one). The Properties
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window displays property values that can help you with various style
attributes.

For example, select the third static component and type <Ctrl+Alt+Clicks,
Depending on where you actually place the cursor, a word is highlighted in red
on the design view. Figure 7-14 shows the Layout Inspector (on the left) and
the corresponding Properties window (on the right).

:\Layout Inspector . BB :Properties
<form: Forml Seneral;
- ) edive JayoutPansl! (TBXU . @
7] <span linel istyles R
") <spans line2 Backaround L
<span fne3 Computed Styles i
) Linebox Group Local Styles m:
" Linebox Rules an
"% Peter Styles -
- space = Box Model E 1
g Border Widths [y
g 5P Childran %
-4 picked Positioning & o
-8 space Containing Block - :
% a Content Size o
@ space Extents Wh
4 peck Inline
- # space Margins ()
& of 3
-4 space Paci‘c{lng D
@ pickled Position G )
et space Pos Constraints e
- peppers
-4 <input> disappearButton
-4 <input> restoreButton

Figure 7-14 Creator DOM Inspector

Let’s say you want to determine exactly where the text is set to italic. In the
Properties window under Styles, there are several helpful windows. Com-
puted Styles tells you where a style setting originates. Local Styles are the style
rules set for this element (values not inherited), Rules are the CSS rules that
apply to this element, and Styles is the grand total of all the styles that apply to
this element.

In the Properties window, click the small box opposite property Local Styles.
In the property customizer, you'll see that this element contains only position-
ing styles. Click Close. Now select property Rules. These are the style rules that
apply to this element (found in file css_master.css). Click Close. Now select
property Computed Styles. Creator pops up the customizer shown in Figure 7-
15. Scroll up until you find the property setting for font-style (shown high-
lighted in the figure). You see that it’s set to italic and it references Line 12 in
Pagel.jsp. Click Close and select JSP in the editing pane to open Pagel in the
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JSP editor. Line 12 contains the component definition for <ui:panellayout>,
the layout panel that contains the text components. Thus, the text component
inherited its font-style property value from the layout panel.

direction: ity

display: inline css_master.Css: 766
Float: none ¢ss_master,css:757
#font-family: sans-serif css_rnaster.cssiil
Pfant-size: 12px css master.cssi12
Font-size-adjust: none €55, master £ss1 757

Font-variant: normat
Font-weight: 700.0
height: autc stylesheet css:5

Hline-height: 15.960001

!ist—style.»image: none css_master.css:757

fist-style-type: dis¢

margir-left: 0

margin-right; 0

margin-top: 0

margin-bottom: 0

Heft: 102px CiDocuments and Settings\GailiMy DocumentsiCreatoriFrojectsiLayout4iwebiPagel jspi14
right: auto styleshest.css:S

css_master.css: 701

Close |

Figure 7-15 Computed Styles property

Finally, return to the design view (click Design in the editing toolbar) and re-
select the text component with <Shift+Alt+Click>. Now select Styles (under
Styles) in the Properties window. You'll see all of the styles that apply to the
static text component.

Centering Components on a Page

Let’s continue our exploration of manipulating style attributes to center the
components in your browser window. You can apply centering horizontally,
vertically, or both. To center a component horizontally, you must know the
width of the target component. Likewise, to center a component vertically, you
must know its height. The convenience of using containers is that you can cen-
ter the container on the page, and then all of its children components retain
their relative positions in the centered container.

We're going to center the components on the page both horizontally and
vertically. You center the layout panel and separately center the Restore button
(you might want to enable rendering for the Restore button until you're done
modifying its style).

1. From the Pagel design view, select the layout panel. In the Properties win-
dow, select property style and bring up the style editor.

- 295

Facebook's Exhibit No. 1003
Page 00243

GOOGLE EXHIBIT 1003



K ;‘:2‘96 Chapter 7 Web Page Design

2. At the bottom on the window, you'll see the style settings for the compo-
nent. Note the property settings for width and height. It will be something e
similar to the following (depending on how you sized the layout panel).

height: 212px; width: 460px;
To center horizontally, use left: 50%. To center vertically, use top: 50%,

Unfortunately, these values will center the top-left corner of the layout panel.
To compensate for this calculation, you adjust using negative values for

margin-left and margin-top. The value should be half the size of the compo- r
nent’s width (for margin-left) and half the size of its height (for margin-top). i
Therefore, the new positioning values are as follows. ; R

sl

margin-left: -230px; margin~top: -106px; left: 50%; top: 50%;

3. Provide the above values for the layout panel’s positioning and click OK.
Creator will center the layout panel in the design view. - ‘

4. In the Pagel Outline view select the Restore button. In the Properties win-
dow under Advanced, enable rendering (check property rendered). The
button will appear on the design canvas.

5. In the Properties window, select property style and bring up the style edi-
tor.

Creator Tip

Note that there are no set values for a button’s height and width, because the
component automatically sizes itself according to the text label. To find out its
approximate size, you can resize it slightly and Creator will then make its size
static. Use these values for the centering calculations and then return the
component to automatic sizing by removing the static values for width and
height.

6. The position values for the Restore button are as follows. Provide the values
for the button in the Style editor and click OK.

S

margin-left: -33px; margin-top: -12px; left: 50%; top: 50%;

7. In the Restore button’s Properties window under Advanced, uncheck prop-
erty rendered.
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Creator Tip
) . ) "
Note that if you adjust the position of the layout component or the Restore
button in the design view, Creator replaces the percentage values you
supplied for left and top with absolute position values. You'll have to re-edit
the style property and supply the percentage settings.
3.
2l
. Deploy and Run
o Deploy and run project Layoutl. Resize the browser window and check that
the layout panel component remains centered. After you click the button, the :
Restore button appears. It should also be centered on the page. Figure 7-16
shows the component centered in the browser window.
oot a7
- L Stek e sureny, !
Dehe
- Figure 7-16 Project Layoutl with centered components
s

Grid Panel

Creator provides another container component called a grid panel. The grid
panel (as its name implies) provides a grid layout, whereby you specify the
number of columns if you require more than the default of one. Creator places
each component in the grid, positioning the component in the next available
cell. With a single column, a component goes into a cell in the next row.

The grid panel gives the page designer additional options for controlling the
page layout. For example, you can nest grid panels to achieve some advanced
layout designs. In this section, we’ll use the grid panel to control the page lay-
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out. We'll show you how to control component placement when you want to
position a component after a variable-sized component (such as a table that
contains an indeterminate number of rows).

o G 3 ks

Create a Project

In the following project, you'll control page layout by nesting components
inside grid panels. Project LayoutMadness displays a table of numbers and
their squares. The user specifies how many numbers should be displayed. To
keep everything simple, the event handling code will generate HTML tags on
the fly to build the table. This is a handy technique when you want to generate
your own HTML tags.

1. From Creator’s Welcome Page, select button Create New Project. Creator
displays the New Project dialog. Under Categories, select Web. Under |
Projects, select JSF Web Application. Click Next. .

2. In the New Web Application dialog under Project Name, specify Layout- Figure:
Madness. Click Finish.

After initializing the project, Creator comes up in the design view of the edi-
tor pane. You can now set the title.

3. In the Properties window, select property Title and specify title Layout
Madness. Finish by pressing <Enter>.

Add Components to the Page

You'll add a grid panel to help with page layout. Inside, you'll add a nested
grid panel that will hold a text field and button to gather and process the input.
A static text component will display (using generated HTML elements) the
table of squares and two hypertext/anchor component pairs will help with
page scrolling. Figure 7-17 shows the design view.

Creator Tip

Note that we assigned contrasting background colors to the grid panels. This @
is helpful when you want to see how the grid panel is rendered and how it lays =
out its nested components. When you'te satisfied with the layout, you can =

restore the grid panels’ default background colors.

Figure 7

Figure 7-18 shows the Pagel Outline view for this project. You might want
to consult it from time to time as you add the components to make sure that the
nesting levels for the components are correct.
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Figure 7-18 Pagel Outline view for project LayoutMadness
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Creator Tip

Creator lists the components nested in the grid panel in the order that you
place them on the page. If you need to rearrange the order, you can select a ~ 1.1
component, drag it up to its parent container, and re-drop it. This moves the !
component to the end of the list for that container. 1

2.
1. From the Basic Components palette, select Anchor and place it on the page i :
in the upper-left corner. o
2. In the Properties window, change its id to anchorTop. ]
3. From the Layout Components palette, select Grid Panel and place it on the 5
page. 6. :
4. In the Properties window for the grid panel, select property style and bring _ o
up the Style Editor.
5. In the Style Editor, select property Background. In the window for Back-
ground Color, provide the following RGB values.
gri
rgb (255, 255, 215) See rer
oz tex
6. Select property Text Block. For Horizontal Alignment, select center from the ida
drop down list.
7. Select property Position. Under Size, set Width to 400px. Click OK to close 1.

the Style Editor. The grid panel will have a muted yellow background in the
design view.

. In the Properties window, set property cellpaddingto3 and property ; 2.
cellspacing to 3. This will create space around the nested components. :

joe]

Now you’'ll add a second grid panel and nest it inside the first one.

—

. In the Layout Components palette, select a Grid Panel component and drop
it on top of the previous grid panel. - ne
2. In its Properties window, set property columns to 2, property cellpadding

to 6, and property cellspacing to 2. L
3. Click the editing box opposite property style and bring up the Style Editor ‘
for the nested grid panel.
4. In the Style Editor, select property Background. In the window for Back-
ground Color, provide the following RGB values. 5

rgb (232, 245, 202)

5. Select property Text Block. For Horizontal Alignment, select center from the
drop down list. Click OK to close the Style Editor.
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You'll place a button and a text field component inside the nested grid panel

(component gridPanel?).

From the Basic Components palette, select Button and drop it on the nested
grid panel. Make sure that the smaller, light-green panel is outlined in blue
before you release the mouse.

. The button’s label is selected. Change its label to Get Table.
. In the Properties window, change its id property to doTable.
. From the Basic Components palette, select Text Field and drop it on top of

the nested grid panel. Again, make sure that the panel is outlined in blue
before you release the cursor.

. In the Properties window for the text field, check property required.
. In the Properties window for the text field, set property label to Inputa

Number. Because the field is required, Creator prepends an asterisk to the
label.

The button and text fields components should be nested inside the second

grid panel. Since the nested grid panel has two columns, these components are
rendered side-by-side (each in its own cell in the same row). Let’s configure the
text field component now: you'll add an integer converter and a long range val-
idator.

1.

‘

1.

From the Converters Components palette, select Integer Converter and drop
it on top of the text field component. The converter property for the text
field is now set to integerConvert1.

. From the Validators Components palette, select Long Range Validator and

drop it on top of the text field component.

. In the Pagel Outline view, select longRangeValidatorl. In its Properties

window, set maximum to 200 and minimum to 1.

Now you’'ll add the rest of the components to the outer grid panel (compo-

nent gridPanell).

Since you've attached a validator and converter to the text field, you'll need
a message component to display error messages. From the Basic Compo-
nents palette, select Message and drop it on top of the outer grid panel.
{Check component selection if you use the design view. Alternatively, you
can drop the component on gridpanell in the Pagel Outline view.)

. In the design view, place the cursor inside the message component. Type

<Ctrl+Shift>, hold, and left-click the mouse, releasing the cursor when it’s
over the text field component. The message component now displays “Mes-
sage summary for textField1” on the design view.

. From the Basic Components palette, select Hyperlink and drop the compo-

nent on the outer grid panel.
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4. Its text is selected. Change its text property to Jump to End followed by L

<Enter>. Change its id property to jumpEnd. You’'ll

5. From the Basic Components palette, select Static Text and drop it on the
outer grid panel. In the Properties window, change its id property to
tableResult. Under Data, uncheck property escape. This allows HTML tags to 2.

be interpreted.

6. From the Basic Components palette, select a second Hyperlink component.

Drop it on the outer grid panel.

set its url property later.

=
D QL

—

7. Change its text to Top followed by <Enter>. Change its id property to jump- pul

Top.

8. From the Basic Components palette, select an Anchor component and drop
it on the outer grid panel. Change its id property to anchorBottom.

The Pagel Outline view should now match the one shown in Figure 7-18 on
page 299. Let’s configure the two hyperlinks and connect them to the anchor

components.

1. In the design view, select hyperlink component jumpEnd. In the Properties
window, click the editing box opposite property url. Creator pops up the

url property customizer, as shown in Figure 7-19.

{7 Use birnding

(2 lUse value

URL: ?‘Fac{g;]f‘qgel.jsp#anchorBottom

.o ( tef

107 resources
LMy stylesheet.css

i [ addFie The

1 OK |\J { Unset Praperty l [ Cancel § [

Help j

S5

Figure 7-19 Customizer for property url

2. Select anchorBottom and click OK. This sets property url to

/faces/Pagel.jsp#anchorBottom

3. Repeat steps 1 and 2 for the jumpTop hyperlink component and set its url

property to anchorTop.
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7.5 Page Layout 303

Let’s finally add the event handling code for the button component.

1. In the design view, double-click button Get Table. Creator generates the
default event handler and brings up Pagel.java in the Java source editor.

2. Supply the following code. Copy and paste from the Creator download file
FieldGuide2/Examples/WebPageDesign/snippets/
layout_doTable_action.txt. The added code is bold.

public String doTable action() {
String str = "<table border=\"2\"" +
" cellpadding=\"2\" width=\"400px\">";
int nrows = ((Integer)textFieldl.getValue()).intValue()

str = str + "<tr><th>Number</th><th>Square</th></tr>";
for (int i = 1; i < nrows+l; i++) {
str = str + "<tr><td>" + (i) +
ng/ed><td>" + (i*i) + "</td></tr>";
}

str = str + "</table><p>";

if (nrows > 0)
tableResult.setValue(str) ;

else tableResult.setValue(null);

return null;

Method doTable action() reads the value from the text field component
(textFieldl) and uses it to compute a table of squares for that many numbers.
The method generates the HTML code to dynamically build the table.

There’s a few layout and design decisions we made that affect this project.

» First, we used grid panel to hold the components because we can't tell ahead
of time how much space the static text (that holds the table of squares) will
consume. By using a grid panel, Creator places all the components after each
other in the next cell. If you tried to use absolute positioning you would not
be able for format cleanly any component that came after the static text
component.

* Second, we used anchor components since there is a possibility that the table
won't fit on the page. This way, the user can easily jump to the end to view
the bottom of the table. For the same reason, we added an anchor
component so that the user can jump back to the top of the page.

» We configured the nested grid panel to have two columns, which holds both
the button and the text field component in a single row. Then, the message
component (which can display rather long messages) is in the outer grid
panel in its own row.
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* You can optionally center the outer grid panel using the component
centering technique presented in the previous section. However, because the
height of the grid panel is unknown, you cannot center it vertically. To center
it horizontally, supply the following style positioning values for
gridPanell.

width: 400px; left: 50%; margin-left: -200px

Deploy and Run

Deploy and run project LayoutMadness. Figure 7-20 shows the project run-
ning in a browser (centered). The cursor is about to click the hyperlink compo-
nent to jump to the end of the page.

Fle Edit View Go Bookmarks Tools Help @

® nputa humber (15 S

Jum-“E?To End
—y

Number ; Square
1 ' | 1
2 ! 4
3 9
'4 16
5 . 25
5 3
7 49
8 64
9 81 @

http:/focalhost: 28080 Layout3/faces /Pagé l,jsp:anchoéso ttom

Figure 7-20 Project LayoutMadness running in a browser

7.6 Page Fragments

Page fragment components can be valuable to web page designers because
they define building blocks for web pages. You can place components inside
page fragments and then use the fragments within subsequent pages. Typi-
cally, page fragments hold parts of a web page that are standardized for a uni-
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7.6 Page Fragments

form look, such as images used as page headers, standard menus or navigation
links, or even footers that contain copyright notices.

A page fragment is a helpful mechanism for reuse, but it does have some
caveats. For one, page fragments are inserted inline into their containing docu-
ment on the server. This means that a page fragment can only contain elements
that are valid at the point of inclusion. As you work through the example in
this section, note that page fragments are embedded in a <div> element (gener-
ated by Creator) and do not contain elements such as <head> or <body>, which
already exist in the containing page.

To use page fragments in Creator, you first create a page fragment and then
place it on the page. As an example, let’s build a project for the hypothetical
company called Cactus Consortium. This project has three pages: a Home
(login) page, a Courses page, and a Books page. Figure 7-21 shows the layout
of the Home page. The header is a page fragment that contains an image
hyperlink component, the footer is a page fragment that contains a static text
component, and the left menu is a page fragment that consists of a grid panel
component holding navigation links (hyperlink components).

" CactusBanner Page Fragment = -

wctus Consorfivm

 Home Page <€——  StaticText = .

. Siatic Fext. . LTt

S pietpame. | ext Fleld Message sumrmary for
N s
LA Name Message summary for

. ; - i’ : 'ZS"IZWIE“ .
e mo

: ‘,'Me:ssage""'

CactusFooter Page Fragment

Figure 7-21 Page layout using page fragments
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This web application requires users to login with their first and last names, E—
. . . Listij
The names are stored in session scope and adorn the navigation menu on the
left. The user must login before navigating to subsequent pages. hea
The Books and Courses pages are prototype pages containing titles (and the ' F
page fragments for the uniform look). £
}
Create a New Project i
(ole)
1. From Creator’s Welcome Page, select button Create New Project. Creator .
displays the New Project dialog. Under Categories, select Web. Under 2
Projects, select JSF Web Application. Click Next. b
2. In the New Web Application dialog under Project Name, specify Cactusl. £
Click Finish. }
After initializing the project, Creator comes up in the design view of the edi- .ban
tor pane. You can now set the title. f
£
3. In the Properties window, select property Title and specify title Cactus Con- i

sulting. Finish by pressing <Enter>.

Modify Default Style Sheet ‘ td,
Now you’ll add some style rules to the default style sheet.

1. In the Project Navigator window, expand the resources node. You'll see the
default style sheet, stylesheet.css. P

2. Double click the stylesheet.css file name. Creator brings up this file in the ,
editor pane. -tak

3. Copy and paste the contents of file FieldGuide2/Examples/WebPageDe- ;
sign/snippets/stylerules.txt, adding the new style rules to the beginning of
the file. The new style rules are shown Listing 7.1.

Listing 7.1 New CSS Style Rules ; ; : }

/* Custom Style Rules for Cactus Consortium */ Yo

body { ap

background-color: rgb(230,230,200); 4 Sa'
color: olive; ’

} cl

Pa
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1es.
the

Listing 7.1 New CSS Style Rules (continued)

.headerStyle {
the font-family: Georgia, 'Times New Roman', times,serif;
font-size: 200%

}

.footerStyle {
font-family: Georgia, 'Times New Roman',times,serif;
border-top-color: olive;
border-top-style: solid;
border-top-width: lpx;
font-size: 75%

}

di- E .bannerStyle {

‘ font-family: Georgia,'Times New Roman', times,serif;
font-size: 24pt;

font-style: italic;

font-weight: bold

n-

td, th {
padding-left: .5em;
padding-top: lem;
padding-bottom: lem;
€ padding-right: lem;
}

.tableStyle {
font-family: Georgia, 'Times New Roman', times,serif;
o width: 200px;
border-left-color: olive;
border-left-style: solid;
— border-left-width: 1lpx;

You'll apply the style classes as you build the project. The body style rule
applies to the entire project, setting the background color and the font color.

4. Save the modified CSS file by selecting the Save All icon on the toolbar and
close file stylesheet.css (click the small x on the stylesheet.css tab). Note that
Pagel now has a new background color.
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Use the Gray Theme

The image and background colors for this application look better with the
more neutral gray theme components.

L. In the Projects view, expand the Themes node, right-click Gray Theme and
select Set as Current Theme.

2. After you restart the application server, Clean and Build the project to have
the new theme take effect.

Add SessionBean1 Properties

This application displays the user’s first and last names in different places
(both in the navigation panel and the home page display). It also keeps track of
whether the user is logged in or not. Since the application must save these val-
ues for each user session, you store all three variables in session scope. Pro-
gram data scope is covered in detail in Chapter 6 (see “Scope of Web
Applications” on page 224). Here’s how to add these three properties (first
name, last name, and login status) to SessionBean1, which puts the data in ses-
sion scope.

1. In the Projects window, right-click Session Bean and select Add > Property.
Creator pops up the New Property Pattern dialog.

2. For Name specity firstname, for Type specify String, and for Mode, specify
the default Read/Write, as shown in Figure 7-22.

3. Click OK.

. Repeat steps 1 through 3 and add property lastname to SessionBeanl.

5. Add property loggedin to SessionBeanl. For this property, specify Name
loggedIn, Type is Boolean (with an uppercase ‘B’), and Mode is Read/Write.
Click OK.

I

When you add properties to SessionBeanl, Creator generates code for the
data field, as well as the getters and setters you need to access the data. Now
you'll supply initialization code that you’ll add to the SessionBeanl () con-
structor.

L. In the Projects window, double-click Session Bean to bring
SessionBeanl.java up in the Java source editor.

2. Find the sessionBeanl () constructor and add the following code after the
comment, as shown. Copy and paste from the Creator download file
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the
~Propert
Mame: | firstname |
d Type: String e
Mode: 'Read [ Write i
ve [1Bound
] constrained
~Ciptions
Generate Field
ces Generate Return Statement
<of
sal- Generate Set Statement
'ro-
Veb
1rst [ ok r\} [ Cancel ] [ Help l
eSS~ i
Figure 7-22 New Property Pattern dialog
FieldGuide2/Examples/WebPageDesign/snippets/cactusl_session_init.txt.
v The added code is bold.

public SessionBeanl () {

// Creator-managed Component Initialization (folded)

// TODO: Add your own initialization code here (optional)
firstname = "";
lastname = "";
loggedIn = new Boolean(false);

2

}

Banner Page Fragment

Figure 7-21 on page 305 shows the general layout of the home page, Pagel.jsp.
The first step is to create the banner page fragment, CactusBanner.jspf, placed
across the top portion of the page.

1. Bring up Pagel in the design editor.

2. From the Layout Components palette, select Page Fragment Box and drag it
over to the top-left corner of the page. Creator pops up the Select Page Frag-
ment dialog.

3. Click Create New Page Fragment. Creator displays the Create Page Frag-
ment dialog.

309
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4. Specify Name CactusBanner and click OK. When you return to the Select
Page Fragment dialog, CactusBanner.jspf appears in the selection window,
as shown in Figure 7-23.

Select a page fragment to include on the page.

Page Fragment: :Cactusﬁanner Jspf s

[ Create New Page Fragment.., l

Figure 7-23 Select Page Fragment dialog

5. Click Close. Creator displays the (empty) CactusBanner page fragment in
the design view and adds a <div> component and include directive to the
Pagel Outline view.

Now you'll add components to the CactusBanner page fragment, as shown
in Figure 7-24.

- Cactus Conso ?ﬁi‘é’@gm SR LA

Page Fragment Box Image Hyperlink

Figure 7-24 CactusBanner Page Fragment

1. In the Pagel design view, double-click the CactusBanner page fragment to
bring up the design view for editing the page fragment.

2. Creator sets a page fragment’s default size to 400px (width) by 200px ;
(height). The white area in the design view indicates the page fragment’s i
boundary.

3. In the Properties view, change the Height to 130px and the Width to 700px.
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Place an image hyperlink on the page fragment.

1. From the Basic Components palette, select Image Hyperlink and place it in
the top-left of the design view. Its top and left position parameters should
both be zero. (Hold the mouse cursor over the style property in the Proper-
ties view to check its value.)

2. In the Properties window, click the editing box opposite property imageURL.
Creator pops up a custom property editor.

3. Click Add File, navigate to your Creator download directory, and select file
FieldGuide2/Examples/WebPageDesign/images/cactus_banner.JPG.

4. Select Add File. Creator copies the file to your project’s resources directory.
Make sure cactus_banner.JPG is selected and click OK. The image appears
in the design view.

5. In the Properties window, click the editing box opposite property text.
Click Unset Property in the property editor dialog. This removes the image
hyperlink’s default text from the design view.

6. In the Properties window under Behavior, set the toolTip to Return to Home
Page. (When the user clicks on the image, you'll navigate back to the home

page.)

Place a static text component on the page fragment.

1. From the Basic Components palette, select Static Text and place it inside the
page fragment under the image on the design canvas.

2. 1t will be selected. Type in the text Cactus Consortium followed by <Enter>.

3. In the Properties window opposite property styleClass, specify banner-
Style. (This is one of the styles rules you added earlier to the project’s style
sheet.) The text now appears in a larger italic font and its color is olive.

4. Select the Save All icon on the toolbar to save these changes to your project.

Navigation Page Fragment

; This project uses a grid panel to hold hyperlink components for navigation.
| Youw'll put this in a separate page fragment, NavigationPanel.jspf.

1. Return to the Pagel design view by selecting the Pagel tab above the editing
pane.

2. From the Layout Components palette, select Page Fragment Box and drag it
over to the left side of the page under the CactusBanner page fragment. Cre-
ator pops up the Select Page Fragment dialog.

3. Click Create New Page Fragment. Creator displays the Create Page Frag-
ment dialog.
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4. Specity Name NavigationPanel and click OK. When you return to the Select
Page Fragment dialog, NavigationPanel.jspf appears in the selection win-
dow.

5. Click Close. Creator displays the (empty) NavigationPanel page fragment in
the design view.

Now you'll add components to the NavigationPanel page fragment, ag
shown in Figure 7-25.

a1 Welcome  x L@“ MavigationPanel

Page Fragment Box

.E‘,D:{}I‘;v:;:.....: L

\ 4 Grid Panel
COUSES | g A

- Hyperlink

‘}-végmﬁi D / .

Lig dut

Figure 7-25 NavigationPanel Page Fragment

1. In the Pagel design view, double-click the NavigationPanel page fragment
to bring it up in the design view.
2. In the Properties view, change the Height to 250px and the Width to 200px.

Place a grid panel to hold the navigation links.
1. From the Layout Components palette, select Grid Panel and place it on the
page fragment in the top-left corner.

2. In the Properties view for property styleClass, specify tableStyle.

Add components to the grid panel.

1. From the Basic Components palette, select Static Text and drop it on the grid
panel component. Make sure that the grid panel component is outlined in
blue before you release the mouse.

2. The static text component is selected. Specify Menu for #{SessionBean1.first-
name} #{SessionBeanl.lastname} for the component’s text property. This con-
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slect catenates Session Bean property firstname and lastname with some text
in- ‘ for the menu’s heading.
ntin As you add components to the grid panel, you’ll see the effects of the style

class you applied to the grid panel. For example, Creator wraps the text onto
multiple lines instead of stretching the grid panel component because its width
it, as , is fixed at 200 pixels. Also, the grid panel’s cells have a generous margin
because of the style rules applied to HTML elements <th> and <td> (Creator’s
grid panel is rendered with an HTML <table> element). Finally, the grid panel
has a solid, 1px olive border on its left margin, which lengthens as you add
components.

1. In the Properties window for the static text component, change the id prop-
erty to leftHeader.

2. From the Basic Component palette, select Hyperlink and drop it on the grid
panel component. (Again, make sure the grid panel is outlined in blue.)

3. Specify Books for its text property.

. In the Properties window, change its id property to booksPage.

5. Repeat steps 4 through 6 to add a hyperlink component with text Courses
and id coursesPage.

6. Repeat steps 4 through 6 to add a hyperlink component with text Home
and id homePage.

7. Finally, add a hyperlink component with text Log Out and id logout.

8. Select the Save All icon on the toolbar to save these changes.

S

You’ll specify the navigation for this project after you’ve added the Books
and Courses pages.

ent
CactusFooter Page Fragment
pX.
Each page in this project has a footer with a copyright designation. This infor-
mation goes in its own page fragment, CactusFooter.jspf.
the 1. Return to the Pagel design view.

2. From the Layout Components palette, select Page Fragment Box and drag it
over to the bottom-left of the design view under the NavigationPanel page
fragment. Creator pops up the Select Page Fragment dialog.

3. Click Create New Page Fragment. Creator displays the Create Page Frag-

ment dialog.

. Specify Name CactusFooter and click OK. When you return to the Select Page

Fragment dialog, CactusFooter.jspf appears in the selection window.

. Click Close. Creator displays the (empty) CactusFooter page fragment in the

design view.
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Now you’ll configure the CactusFooter page fragment, as shown ip
Figure 7-26.

B
‘Q} Welcome x| Pagel ) CactusFooter | e
[Design| ISP lava Any Sze Page F tl
; . R ; age Fragment
Coapy ight Rooga0on Cac : X : . . . H Box n
1
Static Tex

Figure 7-26 CactusFooter Page Fragment

1. In the Pagel design view, double-click the CactusFooter page fragment to
bring it up in the design view.

2. In the Properties view, change the Height to 50px and leave the Width at the
default 400px.

3. From the Basic Components palette, select Static Text and drop it on the
page fragment. Place it in the top-left corner.

4. The static text component is selected. Specify Copyright 2005-2006 Cactus
Consulting Consortium for the component’s text property.

5. In the Properties window, specify footerStyle for property styleClass.
You'll see the font size shrink and a top border appear above the text.

6. Select the Save All icon on the toolbar to save the changes to your project
and select the Pagel tab to return to the Pagel design view.

Add Pages I

You've finished creating the page fragments. Now you’ll create two more
pages and add the page fragments to these pages as well.

Q2

1. Close the page fragments to keep the editor pane uncluttered. For each page
fragment, click the small "X’ on the tab.

2. In the Projects window, right-click the Web Pages node and select New >
Page. Creator displays the New Page dialog.

3. For File Name specify BooksPage and click Finish. Creator creates the new
page and brings it up in the design view. Note that it has the new default
background color you configured for this project.

4. Click anywhere in the background of the design view. In the Properties win-
dow for property Title, specify Cactus Consulting - Books.

5. Repeat Steps 1 through 3 and add another page with file name CoursesPage
and page property Title Cactus Consulting - Courses.

6. Select the Save All icon on the toolbar to save the changes to your project
and select the Pagel tab to return to the Pagel design view.
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7.6 Page Fragments

You have several ways to add the page fragments to CoursesPage and
BooksPage. The brute-force approach is to simply add the three page frag-
ments one at a time, positioning each one on the page at the same location. An
easier approach is to copy and paste the three page fragments as a group onto
the new pages. This second approach is more efficient and the one we’ll use
now.

1. Bring up Pagel in the design view. In the Pagel Outline view, use
<Shift+Click> to select all three div elements and their nested page frag-
ments, as shown in Figure 7-27. All three page fragments will also be
selected in the design view.

"4 x| :Navigator Use <Shift+Click>
S e " to select all three
__—divelements

Farm1

i

Figure 7-27 Selecting all three div elements and the nested page fragments

2. From the main menu, select Edit> Copy to copy the page fragments.

3. Now select the BooksPage tab on top of the editing pane to bring up Books-
Page in the design view. In the BooksPage Outline view, expand nodes
pagel > htmll > bodyl and select node forml. Right-click and select Paste
from the context menu. Creator copies all three page fragments to the
BooksPage, placing them in the equivalent positions on the page.

4. Select the CoursesPage tab and repeat the Paste operation on the forml com-
ponent in the CoursesPage Outline view.

Page-Specific Content for Page1

You’ve created three pages that all share the same content. Now you'll add the
page-specific components to each page. Let’s start with Pagel.

1. Select the Pagel tab above the editing panel to bring it up in the design view.
Figure 7-21 on page 305 shows the design view with the page fragment
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boxes and the page-specific components. Note that the page has a heading
text component, a second static text component, text field components to
provide login information, message components, and a button.

2. From the Basic Components palette, select Static Text and drop it on the

page to the right of the navigation panel.

. Specify the text Home Page.

. In the Properties window, set the id property to pageHeader.

5. In the Properties window, set the styleClass property to headerStyle. The
font-size and font-family now reflect the headerStyle style rule.

6. From the Basic Components palette, select Static Text and drop it on the
page under static text component pageHeader.

7. In the Properties window, set its id property to instructText.

W

You'll now add two text field components and message components to go
with them.

1. From the Basic Components palette, select Text Field and drop it on the page
under the static text components you added.

2. In the Properties window, set the component’s properties as follows. Set
property id to firstname, property label to First Name, property
labelLevel to Weak (3), and property required to true (it should be
checked). When you set the required property to true and provide label
text, Creator prepends an asterisk to the label text so that the user knows the
field is required.

3. In the design view, select the text field component, right-click, and select
Property Bindings. Creator pops up the Property Bindings dialog. Under
Select bindable property, click text Object. Under Select binding target,
expand SessionBean1 and select firstname. Click Apply and Close. This
binds the text field to the SessionBeanl firstname property,
#{SessionBeanl.firstname}.

4. From the Basic Components palette, select Text Field and drop it on the page
under the text field component you just added.

5. In the Properties window, set the component’s properties as follows. Set
property id to lastname, property label to Last Name, property labelLevel
to Weak (3), and property required to true (it should be checked).

6. In the design view, select the text field component, right-click, and select
Property Bindings. Creator pops up the Property Bindings dialog. Under
Select bindable property, click text Object. Under Select binding target,
expand SessionBean1 and select lastname. Click Apply and Close. This binds
the text field to the SessionBeanl lastname property,
#{SessionBeanl.lastname}.

You need a message component to display error messages if the user does
not provide input for the text components.
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7.6 Page Fragments 317

1. From the Basic Components palette, select Message and place it on the page
to the right of the firstname text field component.

2. Press and hold <Ctrl+Shift> and left-click the mouse inside the message com-
ponent. Drag the mouse and release it over the text field component. This
sets the message component’s for property to firstname, the id of the text
field component. This means that the message component will display mes-
sages from the Faces context that are designated for the text field compo-
nent. The message component’s display text now reads “Message summary
for firstname.”

3. Repeat Steps 1 and 2 and set the for property to the lastname text field
component.

You'll use a button component to submit the login information.

1. From the Basic Components palette, select Button and drop it on the page
below the text field components.
. Change the button’s text property to Login Now.
. Change the button’s id property to login.
4. In the design view, double-click the Login Now button. Creator generates a
default action handler and brings up Pagel.java in the Java source editor.
5. Add the following event handler code (add the code in bold).

[SSINS]

public String login_action() {
getSessionBeanl () . setLoggedIn (new Boolean (true)) ;
return null;

This appears to be a rather terse event handler. The code sets the session
bean property loggedIn to true. No special code is needed to check whether or
not the user provided login information (validation does that for you) or spe-
cifically set the firstname and lastname session bean properties (the text field
components property bindings do that for you). The only task left, then, is to
set the loggedIn property.

When the page is rendered, it should display the logged in values stored in
properties firstname and lastname. And, if the user has not logged in, it
should display an instruction line requesting the user to log in. You'll put this
logic in the predefined prerender () method.

1. Pagel.java should still be active in the Java source editor. Locate method
prerender ().

w
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318 Chapter 7 Web Page Design

2. Add the following code. Copy and paste from FieldGuide2/Examples/
WebPageDesign/snippets/cactusl_prerender.txt. The added code is bold.

public void prerender () {
// see if user is logged in
if (getSessionBeanl () .getLoggedIn().booleanValue()) {
instructText.setValue (
"Welcome, " + getSessionBeanl () .getFirstname() + " "
+ getSessionBeanl () .getLastname()) ;

} else
instructText.setValue (
"Please login using the form below.");

Page-Specific Content
Now let’s add the header text for the BooksPage and CoursesPage.

1. Select the BooksPage tab from the top of the editor pane to bring up Books-
Page in the design view.

2. From the Basic Components palette, select Static Text and place it on the
page at the same location as the Home Page static text component on Pagel.

3. Setits text property to Books Page, its id property to pageHeader, and its
styleClass property to headerStyle.

4. Repeat Steps 1 through 3 to add a static text component to CoursesPage. Use
the text Courses Page, id property pageHeader, and styleClass header-
Style.

5. Make sure that the pageHeader static text component is in the same location
for all three pages. You can check visually or hold the cursor over the style
property in the Properties window for the static text component and verify
that the position attributes for all three components are the same.

Page Fragments and Navigation

You'll now provide the navigation rules for this application. The page frag-
ment, NavigationPanel.jspf, contains the hyperlink components for naviga-
tion. Since this page fragment is on each page, you must specify navigation rules
for each page. You can certainly do this in the Navigation Editor. You’ll need
six cases: two navigation arrows originate from each page to specify the other
two pages. However, just a slight increase in the number of pages results in a
messy graph using the Page Navigation visual editor. Therefore, you're going
to cheat! Basically, you want three navigation cases (both the hyperlink compo-
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, nents for Home and Log Out should navigate to Pagel; the image hyperlink
1 component also navigates to Pagel), as follows.

1. Navigation label Books specifies page BooksPage.jsp.
2. Navigation label Courses specifies page CoursesPage.jsp.
3. Navigation label Home specifies page Pagel.jsp.

As it turns out, JSF provides a sophisticated navigation handler that allows
wildcard expressions. You'll define some basic rules and then modify the navi-
gation configuration in the source editor to provide the wildcard expression.

1. Bring up the Page Navigation. Right-click anywhere in the background of
any of the pages in the design editor and select Page Navigation from the
context menu. You'll see the three pages in the Page Navigation editor.

2. Select Pagel.jsp and when it enlarges, select the booksPage hyperlink and
drag a navigation arrow to BooksPage.jsp.

3. Creator displays a navigation arrow. Change the case label to Books.

4. Select Pagel.jsp and draw a navigation arrow from the coursesPage hyper-
link to CoursesPage.jsp.

s 5. Change the case label to Courses.

6. Now select CoursesPage.jsp and when it enlarges, select the image hyper-

link component and drag a navigation arrow to Pagel.jsp. Change the case

el. label to Home.
; 7. Starting with CoursesPages.jsp again, repeat this two more times, selecting
the hyperlink components logout and homePage. For both of these naviga-

Jse tion cases, change the case label to Home.

| Using the navigation editor, you’ve configured all of the components so that
on their action property contains the correct navigation case label. Now you just
le c have to generalize the cases so that the navigation handler goes to the correct
ty page from any starting page. You have one rule and three cases.

1. Click the Source button in the navigation editor’s toolbar to bring up naviga-

tion.xml in the source editor.

2. Modify the configuration file so that you have only one navigation rule with
ag- three navigation cases. Change the <from-view-id> element to /* (which
ga- matches arny page).
es
zed
her
na
ing
po-
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3. Here is the modified file. (You can copy and paste from file FieldGuide2/
Examples/WebPageDesign/snippets/cactusl_navigation.txt or provide the

modifications by hand.) Th
si
<faces-config> fr

<navigation-rule>
<from-view-id>/*</from-view-id>
<navigation-case> 2.
<from-outcome>Books</from-outcome>
<to-view-id>/BooksPage.jsp</to-view-id>
</navigation-case>

—

<navigation-case> : 3.
<from-outcome>Courses</from-outcome> :
<to-view-id>/CoursesPage.jsp</to-view-id>

</navigation-case>

<navigation-case> - ¥
<from-outcome>Home</from-outcome> .
<to-view-id>/Pagel.jsp</to-view-id>
</navigation-case>
</navigation-rule>
</faces-config>

4. Click the Save All icon on the toolbar and click the Navigation button to
return to the Navigation editor. Figure 7-28 shows the Navigation view
after you modify the navigation.xml source file. . L

agel X BooksPage x‘g_g CoursesPage 4;<W; 2. Page Navigation x

i Ty
{INavigation!  Source

BooksPage jsp o Cwmes-a P Paget.jsp

Figure 7-28 Navigation editor with source code wildcard expressions
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Logout Event Handler

The last task is to add the logout event handler code, which will reset the ses-
sion bean properties. The hyperlink logout is in the NavigationPanel page
fragment.

1. Bring up NavigationPanel.jspf page fragment in the design editor.

2. Double-click hyperlink component logout. Creator generates the hyper-
link’s event handler, logout_action (). Note that Creator transforms the
action property “Home” to the correct return String value in the event han-
dler.

3. The logout action () method will reset the values for the three session
bean properties. Copy and paste file FieldGuide2/Examples/WebPageDe-
sign/snippets/logout_action.txt. The added code is bold.

public String logout action() {
getSessionBeanl () .setFirstname("") ;
getSessionBeanl () .setLastname ("") ;
getSessionBeanl () .setLoggedIn(new Boolean (false)) ;
return "Home";

Deploy and Run

Deploy and run project Cactusl. Figure 7-29 shows project Cactus] running in
the browser displaying CoursesPage. The image hyperlink’s tooltip is visible.

Reuse with Project Templates

Once you have the look and feel of your application defined, Creator lets you
save the project as a template. Project templates promote reuse and uniformity
within an organization. When you create a new project, you can select a project
template as a starting point. Let’s create a template from project Cactusl.

1. In the Projects window, right-click the project node Cactus] and select Save
Project As. Creator pops up the Save Project As dialog.

2. For Project Name specify CactusTemplate. Click the Add Project to Template
List checkbox, as shown in Figure 7-30. Click OK.

Now when you create a project, you can select My Templates and view a list
of saved project templates for your new project. This is the approach we’ll take
with project Cactus2 (see “Using Tab Sets and Page Fragments” on page 327.)

321
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Figure 7-30 Adding a project to the Template List
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7.7 Introducing Tab Sets

As we continue exploring Creator’s components and configuration options for
web applications, let’s show you another useful layout component, the tab set.
Many applications use tab set components for navigation and complex page
management. With tab sets, you can display only those components that are
relevant to the task at hand.

The tab set is a composite component. You place a tab set component on a
page and then add tab components to the tab set. You have more than one way
to manage an application with tab sets, however.

The simplest way places a separate tab set component on each page. If your
application consists of three pages, for example, each page will hold its own
distinct tab set and each tab set holds three tab components. Furthermore, each
tab set has one tab that is always selected. The other two non-selected tabs act
as hyperlink components and provide navigation to the other two pages where
a different tab is always selected. This method is straightforward because you
never have to manage the state of the tab sets. You place the components on
each page with the visual design editor. Furthermore, you don't have to nest
the page’s components under the tab set.

A second approach is to put the tab set and tabs in a page fragment and
include the page fragment on each page. Again, you place the components for
each page directly on the page (you don’t nest them under the tab set compo-
nent). Because there is only one tab set component, you must maintain the state
of its selected tab, however. Like the first approach, the tabs are used to navi-
gate to the other pages. The advantage of using a page fragment for the tab set
is that any customizing for the tab set must only be specified once.

A third approach uses a single page: the tab set and its tabs all go on one
page. In this approach, you use the nested layout panel to hold the components
corresponding to each tab. When the user selects a tab, the tab set renders only
those components under the selected tab. Furthermore, the tab set automati-
cally marks the selected tab, so you don’t need to do anything to maintain its
state. The disadvantage of this approach is that it is more difficult to design the
page and the page is more complex.

We'll take you through building a project using the first approach. Then,
you'll implement a version of the Cactus project (Cactus2), incorporating both
a tab set and a navigation panel containing hyperlink components to perform
navigation. The Cactus2 project uses the page fragment method for the tab set
component. We illustrate the third approach in project TabSet3, which is
included in the Creator2 download directory under FieldGuide2/Examples/
WebPageDesign/Projects/TabSet3.
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Using Separate Tab Sets 3.
The first example uses a separate tab set on each page. For this project, you'l]
create three pages. Each page contains a tab set component with three tabs. The
tabs enable users to navigate to the other pages. 4,
Create a New Project

1. From Creator’s Welcome Page, select button Create New Project. Creator 5.
displays the New Project dialog. Under Categories, select Web. Under
Projects, select JSF Web Application. Click Next.

2. In the New Web Application dialog under Project Name, specify TabSetl.

S G UG e iy e S S o S = B = |

Click Finish. 6.
After initializing the project, Creator comes up in the design view of the edi- : 7.
tor pane. You can now set the title. ’
8. .
3. In the Properties window, select property Title and specify title TabSet1 - :
Pagel. Finish by pressing <Enter>.
9.
Add Components to Page1
Figure 7-31 shows the design view of Pagel. o
iy Welcome x| p) Pagel x|
Tab Set k

Figure 7-31 Pagel design view for project TabSet1

1. From the Layout Components palette, select Tab Set and drop it on the page-
Position it in the top-left corner.

2. When you add the tab set component, Creator preconfigures a single tab
nested in the tab set. Inside the tab component, Creator also preconfigures a
layout panel. The tab should be selected. Change its text property to First
Page, followed by <Enter>.
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. In the Pagel Outline view, select the nested layout panel, layoutPanell.

. In the Pagel Outline view, now select the tab set component. In the Proper-

. From the Layout Components palette, expand node Tab Set and select the

. Component tab2 should be selected. Change its text property to Second
. In the Pagel Outline view, delete the nested layout panel component (repeat

. From the Layout Components palette, select another Tab component and

7.7 Introducing Tab Sets 325

Right-click and select Delete from the context menu. Since you're placing a
separate tab set on each page, you don’t need the layout panel to hold the
page’s components.

ties window for the tab set component, add the property-value ; width: 100%
to the style property that is already configured. The background behind
the tabs will expand.

nested component Tab. Drop it on top of the tab set component that’s on the
page. Creator configures this as component tab2. In the Pagel Outline view,
make sure that component tab2 is at the same nesting level as tabl.

Page.

the step you followed to delete the nested layout panel in the first tab).

drop it on top of the tab set component. This is component tab3. Change its
text property to Third Page and delete its nested layout panel component.

. In the design view, click on component tabl (First Page) to make it selected.

Creator Tip

As you configure the tab set on each page, you specify the selected tab for that
page. Each page has a different tab selected. Figure 7-31 shows tabl selected
(the Pagel configuration).

. From the Basic Components palette, select component Label and drop it on

. Set its text property to Page 1.

. In the Projects view, right-click the Web Pages node and select New > Page.
. Specify File Name Page2 and click Finish. Creator brings up Page2 in the

. Set the Title property to TabSetl - Page 2.

Now you’ll add a label component to the page to hold a page header.

the page. (Drop it on the page, not on the tab set component.) In the Pagel
Outline view, the label component should be nested under forml, at the
same level as component tabSet1.

You'll now create a second and third page and copy and paste these compo-
nents to the new pages.

Creator pops up the New Page dialog.

design view.
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4. Repeat steps 1 through 3 to add a third page with file name Page3 and Title 5 N
TabSetl - Page 3. ta
ne

Since each page holds the same components (the tab set, three tabs, and a 6. Fil
label) it’s easier to copy and paste these components from Pagel and reconfig- o
ure them as needed for Page2 and Page3. fr
1

1. Select the Pagel tab above the editor pane to bring up Pagel in the design Z;

view.

2. In the Pagel Outline view, select component tabsetl and labell (use
<Shift+Clicle for multiple selection). The nested tabs will also be selected.

3. From the main menu bar, select Edit > Copy.

4. Now select the Page2 tab above the editor pane. In the Page2 Outline view,
expand pagel > htmll > bodyl and select component forml.

5. Right-click on forml and select Paste from the context menu. This copies the
Pagel components to Page2, maintaining the same position and other style
attributes.

6. Repeat Steps 4 and 5 with Page3, pasting the components on this page.

Now you’ll configure the tab set and label components for Page2 and Page3.

1. Select the Page2 tab above the editor pane to bring up Page2 in the design
view.
2. In the design view, click on component tab2 (Second Page) to make it
selected. The tab will turn white and the other two tabs will be blue.
. Select the label component and change its text property to Page 2.
4. Repeat Steps 1 through 3 for Page3. Make tab3 (Third Page) selected and
change the label’s text property to Page 3.

w

Figu.
Configure Navigation

The tab components behave like hyperlink components because you can define
action event handlers or action labels for navigation. You'll define six naviga-

|
L
tion cases: each page will have two cases that originate from a tab component E Dep
and terminate in one of the other two pages. P the ¢
1. In the design view, right-click anywhere in the background and select Page § U
Navigation from the context menu. Creator brings up the Navigation Editor. L
2. You see the three pages that you defined for this project. Select Pagel.jsp. | You’
When it enlarges, you'll see the three tab components. L Cact
3. Select tab2, click, and drag an arrow to Page2.jsp. Change the case label to the p
second. "
4. Select Pagel.jsp again, click tab3, and drag an arrow to Page3.jsp. Change 1. Fyf
the case label to third. ;
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e 5. Now repeat this sequence for Page2.jsp. Draw an arrow from component
tabl to Pagel.jsp. Use case label first. Draw a second arrow from compo-
; nent tab3 to Page3.jsp. Use case label third.

a 6. Finally, configure the navigation cases for Page3.jsp. Draw an arrow from
g~ component tabl to Pagel.jsp. Use case label first. Draw the second arrow
from component tab2 to Page2.jsp. Use case label second. Figure 7-32
shows the Navigation Editor with all of the cases configured and Page2.jsp
enlarged.

g welcome x ﬂfe Pagel x LQL Pagez x 'LaPageMNavigation x| i Fage3 x|

‘Nawgatlum Source
e | Pagel jsp S
Lodtab2
%—h =t ——_—BL
| second i first
Pagel jsp i Page3.jsp ¥
3. : L
glhild 3 - : N : “usewnd
Figure 7-32 Navigation Editor for project TabSetl
e
N Deploy and Run
u Deploy and run project TabSetl. Figure 7-33 shows Page2 in the browser and
the cursor is over the third tab.
N Using Tab Sets and Page Fragments

You'll now add a tab set to the CactusBanner page fragment from project
Cactusl. Instead of copying project Cactusl, you'll create a new project and use
the project template you saved earlier.

1. From the Welcome page, click Create New Project.

Facebook's Exhibit No. 1003
Page 00275

- - - - |
Page 275 of 328 GOOGLE EXHIBIT 1003




f;328; Chapter 7 Web Page Design

Page 2

[hpiffloc agetsmpr .

Figure 7-33 Page2 of project TabSet1 running in a browser

2.

Creator pops up the New Project dialog. In the Categories window, select
My Templates. Creator displays a list of available project templates.

. Select CactusTemplate and click Next.
. Creator displays the New JSF Web Application dialog. For Project Name

specify Cactus2 and click Finish.

. Creator brings up Pagel of project Cactus2 in the design view. Click any-
where in the background of the design canvas of the Cactus2 project. In the
Properties window, change the page’s Title property to Cactus Consulting 2.

Let’s add another style rule to stylesheet.css to make the tab set blend with
the pages better.

. In the Projects window, expand the Web Pages > resources node and double-

click stylesheet.css to bring it up in the Style Editor.

. Add the following style rule for TabGrp.

.TabGrp {
background-color: rgb(230,230,200);

Creator Tip

The standard Themes uses style rule TabGrp to apply styles to tab sets. By
customizing this rule, you can change the background color of the page
behind the tabs. The default color is a gradient gray for the Gray Theme.
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7.7 Introducing Tab Sets

Add Tab Set and Tabs to CactusBanner

First, let’s add components to the CactusBanner page fragment. Figure 7-34
shows the design view for the CactusBanner page fragment with the tab set
component added.

Cactus Consorfium

|
|
2“"\

\ Static Text

Selected Unselected Tab Set Image
Tab Tabs Hyperlink

Figure 7-34 Design view for CactusBanner.jspf

1. In the Projects window, double-click CactusBannet.jspf to bring up the
CactusBanner page fragment in the design view.

' 2. Click in the blue area to select the page fragment.

3. In the Properties view, change the page fragment’s height to 150px.

4. Select the Cactus Consortium static text component and move it over to the
right to make room for the tab set component.

5. From the Layout Components palette, select Tab Set and drop it on the page
fragment below the image hyperlink component.

6. The first tab is selected. Change its text to Home.

7. In the Outline view, select the nested layout panel, layoutPanell, right-
click and select Delete from the context menu.

8. In the Outline view, select the nested tab component, tabl. In the Properties
window for the tab, change its id property to homeTab.

Creator Tip

; The selected property of the tab set component takes the id (passed as a
- : String) of the tab that's selected. Renaming the component’s id with
meaningful names makes your code more readable.
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9. Now select component tabSet1 in the Outline view. In the Properties win-
dow for the tab set, check the property mini. This changes the appearance of
the tab set and makes the tabs smaller.

Add two more tabs to the tab set.

1. From the Layout Components palette, expand the Tab Set component and
select the nested Tab component. Drop it on top of the tab set you added.
(Make sure that the new tab is at the same nesting level as component
homeTab.)

. Change the tab’s text property to Books.

. Change the tab’s id property to booksTab.

. Delete the nested layout panel under tab booksTab.

. Repeat this and add another tab with text Courses and id coursesTab.
Delete the nested layout panel under tab coursesTab.

6. Reposition the tab set component so that it is within the page fragment
boundary (the white area) and that its left edge is flush with the fragment
boundary (the left style attribute should be 0).

7. In the CactusBanner Outline view, select the Cactus Consortium static text
component, drag it up to the £: subview component, and drop it on top of
the subview.

[©) R VI )

The static text component is now listed after the tab set component in the
CactusBanner Outline view. This makes the static text component render on top
of the tab set component. When you moved the component in the Outline view,
its style property was cleared. The component now appears in the design
view in the upper-left corner (on top of the image).

8. In the design view, move the static text component back (next to) the tab set
component, placing it to the right of the third tab.

Add style and styleClass attributes to the tab set component.

1. Select the tab set component. In the Properties view for property style, add
attribute ; width: 696px to the end. This aligns the width of the tab set compo-
nent with the jmage hyperlink component.

2. In the tab set Properties view for property styleClass, specify TabGrp.

3. In the tab set Properties view opposite property selected, click the check
mark for the drop down list corresponding to the tabs. Choose the first,
blank entry. Even though the property sheet will display Home (homeTab),
property selected should not appear in bold.
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Creator Tip

If the tab set’s selected property is bold, then Creator has generated a tag in

the JSP file to set it. Because you'll set the tab set’s selected property in

each enclosing page’s prerender () method, you must not generate the
corresponding JSP tag. The JSP code executes after the prerender ()

1 ' method, rendering the method ineffective.

4. Select the Save All icon on the toolbar to save these changes.

Setting the Currently Selected Tab

As you've seen from working with the tab set component in the first tab set

example, the tab set displays tabs and renders them as either “selected” or “not

selected.” A selected tab (there can only be one selected tab) has a contrasting

color and its link is inactive. It is the current tab. A non-selected tab has an

active link. In this example, the action associated with clicking a non-selected

¢ tab causes page navigation. When the new page is rendered, the tab set must
reflect the newly selected tab.

The most straightforward way to maintain the state of the currently selected

tab is to set it in the enclosing page’s prerender () method. Setting the selected

he tab in each page ensures that the correct tab is selected even when navigation
top to a new page happens through the hyperlink components in the Navigation-
w, Panel page fragment or the image hyperlink.

gn As mentioned in the previous page’s Creator Tip, the only caveat is you

must ensure that Creator does not generate JSP code to set the tab set’s
selected property, since this will take precedence over the prerender () code.

et
1. In the Projects window under Web Pages, double-click Pagel.jsp to bring it
up in the design view.
2. Select the Java button in the editing toolbar to edit the Java source.
3. Add the following code to method prerender (). Copy and paste from
id FieldGuide2/Examples/WebPageDesign/snippets/
Y0- cactus2_pagel_tabset.txt. The added code is bold.

public void prerender () {
CactusBanner cactusBanner = (CactusBanner)getBean (
"CactusBanner") ;
) cactusBanner.getTabSetl () .setSelected ("homeTab") ;
// see if user is logged in
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You'll add the same code to the prerender () methods in Courses.java (with 5. R
String "coursesTab") and Books.java (with String "booksTab"). c

1. Bring up Courses.java in the Java source editor. Add the same code to the
prerender () method.

2. Change the tab set’s setSelected() argument to "coursesTab" .

3. Bring up Books.java in the Java source editor. Add the same code to the }
prerender () method and change the tab set’s setSelected () argument to

"booksTab". 6. N
4. Select the Save All icon on the toolbar to save these changes. v
€l
Configure Action Method for Tabs 7. C
The navigation rules have already been configured for this project. Because (
you used navigation wildcard notation in project Cactusl, these rules will
apply to the tab set component as well. You do not need to make any adjust- Che
ments to the navigation rules. However, you do need to specify the return you
string for each tab’s action method. To do this, you'll generate action methods ‘
through the IDE and provide the code for the action event handler.
1. Bring up CactusBanner in the design view.
2. Double-click tab component homeTab. Creator generates the default
homeTab_action () event handler and brings up CactusBanner.java in the
Java source editor.
3. Replace the return null with return "Home" as shown.
public String homeTab_action() {
// TODO: Replace with your code
return "Home"; ; -
}
V
4, Return to the design view (click Design in the editor toolbar) and repeat gi_ ref]
steps 2 and 3 for tab component booksTab. Replace the return null with T net
return "Books". s Ca
public String booksTab action() { b
// TODO: Replace with your code : 7
return "Books";
}
Th
ers
°
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7.8 Key Point Summary

5. Return to the design view and repeat steps 2 and 3 for tab component
coursesTab. Replace the return null with return "Courses"

public String coursesTab _action() {
// TODO: Replace with your code
return "Courses";

6. Make sure that the tab set’s selected property is not set in the Properties
view. If it’s bold, select the first (blank) entry in the drop down list for prop-
erty selected. The property name should no longer be bold.

7. Click the Save All icon on the toolbar to save these changes.

Check Pages with Modified CactusBanner

Check and adjust the placement of the page fragments on each page. Once
you’'ve done this, deploy and run the application.

Creator Tip

Since the grid panel contains a vertical line on the left border, align this
border with the first tab’s left edge. This creates a pleasing visual connection
between the grid panel component and the tab set component. The easiest way
to adjust the page is to simultaneously select the NavigationPanel and
CactusFooter page fragments. Then, while holding down the Shift key, move
the fragments down and to the left to make the alignment with the tab set
component. By moving both fragments together, you keep their relative
position constant.

When you run the application, check to make sure the tab set component
reflects the correct page navigation, whether you use the hyperlink compo-
nents or the tab set component for navigation. Figure 7-35 shows project
Cactus? running in a browser with page BooksPage rendered.

7.8 Key Point Summary

This chapter explores some of Creator’s tools and components that web design-
ers use to compose web pages and visually organize their projects.

o Creator’s visual editor helps you compose web pages by providing
component dragging, dropping, and page positioning.

333
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Figure 7-35 Project Cactus2 running in a browser

* By default the visual editor displays a grid that helps you align components.
You can turn off the grid or change its size using the Tools > Options > Visual
Designer menu. You can temporarily disable grid alignment by
repositioning the component while holding down the Shift key.

¢ You can select multiple components by dragging a mouse around the target
components, enclosing them in a box. You can also use <Shift+Click> to add
components to those that are already selected.

e To align components with one another, select the target components,
position the mouse over the reference component, right-click, and select
Align. This brings up the Align context menu with choices for alignment.

¢ Tor horizontal alignment options, select Left, Center, or Right. For vertical
alignment options, select Top, Middle, Bottom.

e Creator’s Basic, Layout, and Composite components are rendered using
themes. A theme is a bundled set of cascading style sheets, JavaScript files,
and images that apply to the components and page. The available themes
are listed in the Projects window under node Themes.

¢ To change the current theme, right-click a new theme selection in the
Projects window and select Set As Current Theme. To make the new theme
take effect for deployment, stop the application server and clean and rebuild
the project.

e You can control the look of a component by modifying its style property.
Property style accepts property-value pairs to control style attributes such
as color, background color, font characteristics and page position.
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7.8 Key Point Summary

Creator provides a style editor to manipulate a component’s style property.
To use the style editor, click the editing box opposite property style.

In addition to the style property, Creator also uses Cascading Style Sheets
(CSS) to control the look of its components and pages. You can add style
classes to a project’s default style sheet, stylesheet.css. You can also provide
your own style sheet.

To edit the default style sheet, double-click file stylesheet.css in the Projects
window under Web Pages > resources. Creator brings up the style sheet in
the Style Sheet Editor.

Apply one or more style classes to a component by specifying them ina
comma separated list for the component’s styleClass property.

Using a style sheet with the styleClass property is easier than configuring
a component’s style property to achieve a uniform look.

Creator provides several components that provide grouping and layout
capabilities. The layout panel component provides the option of using a grid
layout which lets you use the design view to easily position nested
components.

The grid panel component provides a cell for each nested component.
Creator places each component in the next available cell. The default
number of columns is one, but you can change this value in the grid panel’s
Properties window. The grid panel is especially useful when you want to
include one or more components after a component with indeterminate
sizing (such as a table that can have any number of rows).

The anchor and hyperlink components control page scrolling. The hyperlink
component jumps to a spot on the page marked by the anchor component.
Jumping to an anchor does not perform a page request.

Page Fragments are page building blocks for web applications. Typically,
you use page fragments to hold parts of your web page that you'd like to
standardize for a uniform look, such as page headers, standard menus, or
footers.

You can save a project as a template. When you create a new project, you can
then select a saved template as a starting point.

You can use wildcards in page navigation rules. Select the Source button in
the Page Navigation editor and modify the navigation.xml source file
directly. Wildcards simplify navigation rules by reducing the number of
navigation cases you define.

The tab set is a composite component that contains nested tabs. Under each
nested tab is a layout panel component. Tabs are similar to hyperlinks in that
you can specify action event handling code as well as navigation strings.
You can use tab sets with page fragments or put a tab set and its nested tabs
all on one page. You may also put a separate tab set on its own page.

A tab set’s selected property holds the component 1d (as a String) of the tab
that is currently selected.
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" eb services are software APIs that are accessible over a network in a
heterogeneous environment. This network accessibility is achieved
with a set of XML-based open standards such as the Web Services
Description Language (WSDL), the Simple Object Access Protocol
(SOAP), and Universal Description, Discovery, and Integration (UDDI). Both
web service providers and clients use these standards to define, publish, and
access web services.

Creator’s default application server provides support for web services. Pre-
installed with Creator is a Google Web Service client, which appears in the
Servers window under node Web Services > Samples > GoogleSearch. The
Google Web Service APIs provide a SOAP interface to search Google’s index,
accessing information and web pages from its cache. With SOAP and WSDL,
Google enables clients to access these services in a variety of programming
environments (including, of course, Java).

This chapter shows you how to create an application that uses the Google
Web Service API. Then, you’ll enhance it. After creating a project that uses web
services, you'll (hopefully) exclaim, “Is that all?” because the steps are fairly
simple. And that’s the way technology should be when industry-wide stan-
dards are adopted. You'll see that once we drag and drop the web service onto
the design canvas in Creator, we spend most of our time showing you elabo-
rate ways to manipulate and display the data that Google returns.
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Chapter 10 Accessing Web Services

10.1 Google Web Services

We've divided this example into several projects that incrementally build on
features of the previous project. With each increment, you’'ll start with the
project you previously built. Alternatively, you can pull up any of the projects
from the Creator download and make changes to these projects.

Note

You must register with Google before using their web service. You'll also -
want to download the Google Web APIs developer’s kit since it has additional
documentation. Registration is free and painless. Once you register, Google
will email you a key, which is requtired for access to their service. The Google
Web Service URL is at http://www.google.com/apis/.

Let’s look at a summary of the projects you'll be building. In this first ver-
sion, you'll submit a search query to Google’s search service and display just
the first result that’s returned. This is equivalent to the “I'm Feeling Lucky”
submit button on the Google web site. In subsequent versions, you'll add vali-
dation for the query text field and display (up to) all ten results returned.
Finally, you’ll add pagination so that you can obtain and display subsequent
groups of results.

Figure 10-1 shows Creator’s design canvas with the components you’ll add
for project Googlel. The image component holds Google’s recognizable logo, a
button component initiates the search, and a text field holds the search string.
For the results display, static text component timeCount displays the search
time and results count, the hyperlink component and an embedded static text
component display the target URL, and static text component snippet dis-
plays the URL’s “snippet” description. You’'ll bind these components to the var-
ious properties of the result object and you'll nest them inside a grid panel
container to more easily manipulate them as a group.

Create a New Project

1. From Creator’s Welcome Page, select button Create New Project. From the
New Project dialog, under Categories select Web and under Projects select
JSF Web Application. Click Next.

2. In the New Web Application dialog, specify Google1 for Project Name and
click Finish.

After creating the project, Creator comes up in the design view of the editor
pane. You can now set the title.
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Figure 10-1 Creator’s design canvas view showing project Googlel’s components

3. Select Title in the Properties window and type in the text Google Search 1.
Finish by pressing <Enter>.

Add the Google Logo

It’s a nice touch to include the Google logo when building a web application
with Google’s search service. To add an image on the page you simply drop the
image’s file directly on the design canvas.

* Using a file utility program (such as Windows Explorer), drag file
FieldGuide2/Examples/WebServices/images/Logo_40wht.gif to the Design
view and drop it on the canvas (consult Figure 10-1 for positioning).

This places the Google logo on the page (using the image component) and
copies the file into your project’s resources directory. You can see this in the
Projects window (select Googlel > Web Pages > resources).

Add a Text Field Component

You'll need a text field component to obtain the user’s search query.

1. In the Basic Components palette, select component Text Field and drag it
onto the design canvas. Place it below the Google logo.
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2. Make sure it is selected and stretch it so that it's approximately 15 grid units
wide.
. In the Properties window, change its id property to searchString,
4. To provide a tooltip for this text field, type the text Type in a search string fol-
lowed by <Enter> for the toolTip property (under Behavior).

W

Add a Button Component

In this application, a button component initiates a search using Google’s Web
Service AP

1. In the Basic Components palette, select Button and drag it onto the design
canvas. Place it to the right of the Google logo.

2. Make sure the button s still selected. Type in the text Google Search fol-
lowed by <Enter>. Creator resizes the button to accommodate the longer text
string, which now appears inside the button on the design canvas. This sets
the button’s text property.

3. In the Properties window, change the button’s 14 attribute to search.

4. To provide a tooltip for the button, edit its toolTip property in the Proper-
ties window (under Behavior). Type in the text Search Google for the Search
String followed by <Enter>.

5. Align the Google logo with the button. Select the button component in the
design canvas. While pressing <Shift>, move the mouse to the Google logo
and left-click, which simultaneously selects the logo.

6. With both components selected, make sure the mouse is over the logo and
right-click. Select option Align > Middle from the context menu. The button
will move so that it is centered vertically in relation to the logo.

Creator Tip

Creator provides several ways to help you place components on the canvas.
By default, components “snap to the grid lines.” To adjust components
without regard to the grid lines, hold the Shift key as you move the
component on the canvas. You can select mul tiple components using the Shift
key while you left-click with the mouse. Then it is possible to move the
selected components as a group. Finally, make adjustments between
components by selecting them and right-clickin < the mouse inside the
“anchor” component, as described above. The Align menu selection has
several options that you can use to manipulate the selected components.
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Add the Google Web Services

Since the Google Web Service client is preinstalled for you, you can simply
drag and drop this component to add it to your project.

1. In the Servers window, expand the Web Services > Samples > Google-
Search nodes.

2. Drag the doGoogleSearch node and drop it anywhere on the editor pane.
Nothing appears in the design canvas; however, you will see
googleSearchClient1 and googleSearchDoGoogleSearchl in the Outline view
for Pagel, as shown in Figure 10-5 on page 460.

Adding a Web Service to the IDE

The Creator installation process configures the Google web service as well as
other web services listed under the Web Services > Samples node in the Serv-
ers window. Creator also provides a way to add a web service to the Services
view. For example, here are the steps to load the Google web service client into
Creator manually.

Creator Tip

Since the GoogleSearch web service client is included with Creator, you do
not need to follow these steps to access it from a Creator project. We include
this procedure in case you'd like to add a web service that has not been pre-
configured with Creator.

Before you can add a web service, you must provide the location (URL) of its
Web Services Description Language (WSDL) page. This is the information that
describes the particular web service’s APL

We're going to step through the process to add the Google Search to Creator
as an example. Once you've determined the Web Service URL, you can use
these steps to add any web service.

. Go to the Servers view.

. Right-click on Web Services.

. Select Add Web Service. Creator pops up the Add Web Service dialog.

. In the URL field at the top, supply the URL of the WSDL file of the target
web service. Here is the URL for Google’s WSDL file.

> W N =

http://api.google.com/GoogleSearch.wsdl
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This is the location of the WSDI, (Web Services Description Language) file
for the Google Search Service,

5. Click Get Web Service Information. The Google web service APl appears in
the Web Service Information window, as shown in F igure 10-2.

Select Web Service Source

% URL:
{5 Local File:

Check Ws-1 Basic Profile 1.0 compliance

[#] Generate SOAP Headers

ﬁet Web Service Infarmatian l

Web Service Information:

| Service  GoogleSearchService &
| Name in
I WSDL:
- Client | pebservice gaoglessar 1

Package

Name:

Port {urn:Goog!eSearch}GoogleSearchPort ;
L Namer S b
el e
Start http://api.anogle.com/GoagleSearch.wsdi
08/01 /2005 18:01:44: Parsing WSDL, Please wait . WSDL -
5http:ffapi.google.com/GDogleSeareh.wsdl

08/01 /2005 18:01:44: Parsing WSDL results:

g‘ Addw[%[ LCancel ]L Helpj

Figure 10-2 Add Web Service dialog

6. Scroll through the information in the Web Service Information window. Cre-
ator displays detailed information about the web service, including its
name, the package name, port name, port display name, port address, and
the methods. Information on the methods inctude the method names, the
parameters and their types, and the return type. We’ll examine the search
method doGoogleSearch () in more detail later in this chapter.

7. Click Add. The name GoogleSearch appears under the Web Services node in

the Servers window. ‘
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Once a web service is listed in the Servers view, you can select it and add it
to your Creator project (as you did with GoogleSearch).

Add Search Result Properties to Page1

The trick to easily manipulating the results of the Google search web service is %
make the return object accessible through the IDE. The search web service

returns an object (GoogleSearchResult) that contains information that you’ll

access. Object GoogleSearchResult also includes an object array (result-

Elements) that contains specific information on the search result sites. You'll

make both of these objects properties, then add an object array data provider to

bind to the components on the page.

1. In the Projects window, expand the Sources Packages > googlel nodes.
2. Right-click on Pagel.java and select Add > Property. Creator pops up the
New Property Pattern dialog, as shown in Figure 10-3.

'~Pr0per{y

Name: | mySearchResut |

Type: iGoogIeSearthResult S
Mode: Read Only v
7] Bound
[] Constrained
"Options‘
- [#] Generate Field

Generate Return Statement

Figure 10-3 Adding property mySearchResult to Pagel.java

3. For Name, specify mySearchResult, for Type, use GoogleSearchResult, and
for Mode select Read Only. Name and Type are case sensitive, so be sure to
match the capitalizations. Click OK.
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4. Add a second property to Pagel. For Name, specify resultArray, for Type
specify ResultElement]], and for Mode select Read Only.

Creator Tip

Make sure that property resultArray is NOT an indexed property, but that
Type includes the array notation (1.

5. Select the Java label in the editing toolbar to bring up Pagel.java in the Java
source editor.

6. Scroll to the end of the file where you'll see the generated code that added
properties mySearchResult and resultArray. You'll see syntax errors. Fix
these using the shortcut <Alt+Shift+F> (fix imports), or <Alt+Shift+I> (import
shortcut). (You must put the cursor anywhere inside GoogleSearchResult
and ResultElement[] before using the <Alt+Shift+I> import shortcut.)

7. Add the following initialization statement to the end of method init () in
Pagel.java, as shown (the added code is bold). This allows you to control
the visibility of the grid panel container component by binding its rendered
property to whether or not property mySearchResult is null.

public void init () |
super.init ();

// Creator-managed Component Initialization

mySearchResult = null;
}

8. Save the project files by clicking the Save All icon on the toolbar.

Add a Data Provider

Using an object array data provider will make the types contained in Result-
Element visible through the IDE. This, in turn, will make component binding
easy.

1. Select Design in the editing toolbar to return to the design view.

2. Expand the Data Providers node in the Components palette.

3. From the Data Providers Components palette, select Object Array Data Pro-
vider and drop it on the design view.You'll see component objectArray-
DataProviderl in the Pagel Outline view.

4. In the Properties window, change the object array data provider’s id prop-
erty to myResultObject.
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5. Still in the Properties window, select the drop down opposite property
array and select resultArray. This connects the data provider to the array
returned in the GoogleSearchObject.

Layout and Grouping with Grid Panel

You'll now add the components that will display the results of the Google
Search. Because you want to control these components as a group, you'll use a
Grid Panel component as a container for the display components.

1. From the Components palette, expand the Layout node, if necessary.

2. From the Layout Components palette, select Grid Panel and place it on the
page below the text field component.

3. In the Properties window under Advanced, uncheck property rendered. This
sets the rendered property to false and causes the grid panel to disappear
from the design view.

4. Select the JSP label in the editing toolbar to bring up Pagel.jsp in the editor
pane.

5. Scroll down to the grid panel tag and locate the rendered property. Change
its setting from false to the following.

rendered="#{not empty Pagel.mySearchResult}"

This means that the grid panel (and all of its sub-components) will be ren-
dered (displayed) if Pagel.mySearchResult is not empty (null).

Creator Tip

By nesting the display components (static text and hyperlink components)
inside a grid panel, we can control the rendering of all of these components by
specifying the rendered property of the container component (the grid panel).

6. Return to the design view by selecting the Design label in the editing tool-
bar. The grid panel should reappear on the design canvas.

7. Check the setting for property rendered. In the Properties window, locate
property rendered and hold the mouse pointer over the cell. Creator dis-
plays a tooltip with the current setting for this property, as shown in
Figure 10-4.

Add a Static Text Component

Next, let's add a static text component to display some of the search results
from Google. You'll add this component to the grid panel container.
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Figure 10~4 Showing the grid panel’s rendered property binding expression

1. From the Basic Components palette, select Static Text. Place it on top of the
grid panel. You can make it a sub-component of grid panel by dropping it
on top of the grid panel component in the Outline view, or dropping it on
the grid panel in the design view.

2. In the Properties window, change its id property to timeCount.

The static text component timeCount will display the amount of time in sec-
onds that the search request took on Google’s server, as well as the estimated
number of search results found. Although Google’s search returns at most ten
results, this number is the estimated total (anywhere from zero to thousands).

Using Hyperlink with a Nested Static Text

The hyperlink component allows application writers to submit a form, navi-
gate to an external URL, or navigate to an anchor within the same page. You'll
use it to hold the URL returned in the Google search results. Normally, the
text property of the hyperlink component is sufficient to display descriptive
text for its URL. However, in this situation, the text will contain embedded
HTML code supplied by the Google search web service. To correctly render
this, use a nested static text component and uncheck its escape property.

1. In the Basic Components palette, select Hyperlink and drop it onto the grid
panel in the Pagel Outline view. It should appear nested under the grid
panel at the same level as the timeCount static text component you already
added. The id property of this component is hyperlinkl.

2. In the Basic Components palette, select Static Text and drop it directly on top
of the hyperlink component you just added. (You can drop it on top of the
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component on the design canvas, or you can drop it on top of the hyperlink
displayed in the Pagel Outline view.)

Creator Tip

When you drop it on top of the hyperlink component in the design view, make
sure that the hyperlink component is outlined in blue. This is an indication
that you have selected it for placement and that the static text component will
be nested. If you drop it onto the hyperlink component in the Outline view,
the hyperlink component should be selected (white text in a blue background),
making the static text component nested.

3. Make sure that the nested static text component is selected. In the Properties
window, change its id property to nestedText.

4. Under Data in the Properties window, uncheck the escape property. This
allows correct rendering of HTML tags embedded within the text.

5. Add another static text component and drop it on top of the grid panel in
the Outline view. This second static text component will display the “snip-
pet” returned by the Google search.

6. In the Properties window, change the id property to snippet.

7. The snippet that Google returns will also contain embedded HTML tags. To
display the HTML formatting correctly, uncheck the escape property in the
static text’s Properties window.

Add a Message Group to Display Errors

When you access an external web service, there is always a possibility that the
access could fail. The server that provides the web service could be inaccessi-
ble, the machine that runs the web application could fail, or the access key may
be incorrect. In any case, you want to know that the web services call has failed
and why.

We'll show you the code that guards against any type of failure later in this
section. For now, you'll use a Message Group component to display messages
for this web application.

¢ From the Basic Components palette, select Message Group component and
drop it onto the design canvas. Place it to the right of the text field.

The Message Group component renders messages that are tied to any com-
ponent, as well as messages generated by the message routines, info(),
warn (), error (), and fatal (). You can use these routines to report infor-
mation back to the user from any bean (Java class) that extends class Faces-
Bean.
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You've finished adding the components to the page. Compare the compo-
nents you have placed on the page with those shown in Figure 10-5, the Out-

line view for Pagel.
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Figure 10-5 Pagel Outline view of project Googlel

Deploy and Run

Creator Tip

miich).

Although you haven’t added the calls to the Google Web Service yet, let’s
build and run the web application anyway. When the application runs, the
page is redisplayed when you click the Search Google button (admittedly, not

To run the project, click the green arrow in the toolbar or select Run > Run
Main Project from the main menu. The page should display the Google logo in
the upper-left corner, as well as the text field and button. The grid panel and all
of its nested components will not be visible since property mySearchResult is
empty (null). You can type in a test search string, but clicking the button does
not (yet) access the Google web service. It does, however, redisplay the page.

Now it’s time to look at the methods in the Google web service APL
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Inspect the Web Service

The Google web service is already included in your application, so let's use
Creator to learn more about it.

When you added the Google web service to your page, Creator modified the
Java page bean file (Pagel.java) to import the Google web service package, as
shown here.

import webservice.googlesearchservice.googlesearch.
GoogleSearchClient;

import webservice.googlesearchservice.googlesearch.
GoogleSearchDoGoogleSearch;

In the Navigator window Creator displays the Pagel methods (orange circle
icon), the constructor (yellow diamond icon), and private variables (blue rect-
angle icon). Find the blue rectangle next to variable googleSearchClientl and
double-click. In the Creator-managed code, youll see private variable
googleSearchDoGoogleSearchl defined as follows.

private GoogleSearchDoGoogleSearch googleSearchDoGoogleSearchl
= new GoogleSearchDoGoogleSearch();

This is the object that you use to make calls to Google’s web service AP, as
follows.

mySearchResult = (GoogleSearchResult)
googleSearchDoGoogleSearchl.getResultObject () ;

Creator Tip

At this point, you will undoubtedly find Google’s documentation to be
helpful. A detailed description of the methods and their parameters can be
found on the Google Web Site: http://www.google.com/apis/
reference.html

Table 10.1 contains a list of the parameters for initiating a search with the
googleSearchDoGoogleSearch object. The search returns a GoogleSearch-
Result object.
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Table 10.1 doGooglesearch () parameters

Name

key

q
start

maxResults

filter

restricts

safeSearch
1r
ie

oe

Type

String
String
int

int
boolean

String

boolean

String

String
String

Description

Key provided to you by Google. A key is
required for access to the Google service.

Search query.
Zero-based index of the first desired result.

Number of results desired per query. This
is at most 10.

Specifies whether or not you want filtering,
which helps eliminate very similar results.

Limits the search to a subset of the Google
Web index.

Enables filtering of adult content.

Language Restrict-limits the search to
documents with the specified languages.

Input Encoding-deprecated.
Output Encoding-deprecated.

Table 10.2 contains some of the methods for return object GoogleSearch-
Result. Note that these methods are the getter form of JavaBeans object prop-
erties. Therefore you can call the getter method, or access the property using a
JSF EL expression, such as the following.

#{Pagel.mySearchResult . startIndex}

which evaluates to the starting index of the returned results.
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Table 10.2 Googlesearchresult public methods

Name Return Type Description

getDirectoryCategories Array Array of the Directory
Category items
corresponding to the
ODP? directory matches
for this search.

getEndIndex int Index (1-based) of the last
search result in the
ResultElements array.

getEstimatedTotalResultsCount int Estimates of the total
number of results for the
query.
getResultElements ResultElement [] Array containing the
results.
getSearchComments String Search comments.
getSearchQuery String Search query you
provided.
getSearchTime double Time it took the Google
server to compute the
results.
getSearchTips String Tips for searching.
getStartIndex int Index (1-based) of the first

search result in the
ResultElements array.

isDocmentFiltering boolean True if document filtering
is enabled.

isEstimateIsExact boolean True if the total results
estimate is exact.

a. “The Open Directory Project is the largest, most comprehensive human-edited direc-
tory of the Web. It is constructed and maintained by a vast, global community of volunteer
editors.” (See About the Open Directory Project, http://dmoz.org.)

Finally, each response includes an array of ResultElement objects. Some of
the methods you use to access a ResultElement object are listed in Table 10.3.
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Table 10.3 ResultElement public methods

Name Return Type Description

getCachedSize String Size of the cached
document.

getDirectoryCategory DirectoryCategory Name of the ODP

category in which the
result occurs.

getDirectoryTitle String Name of the result as it
appears in the Open
Directory.

getHostName String Hostname of the result.

getSnippet String Short description of the

result page.

getSummary String Description of the
result as it appears in
the Open Directory.

getTitle String Page title of the result.

getURL String URL of the result page.

isRelatedInformationPresent boolean True if there are related
documents to this
result.

Testing the Google Web Service

Creator provides a web services testing mechanism. This is a quick way to
study the method, provide parameters, and look at the results. Here’s how.

1. In the Servers window under Web Services > Samples > GoogleSearch,
right-click method doGooglesearch () and select Test Method. Creator pops
up the Test Web Service Method dialog.

2. Fillin the dialog as shown in Figure 10-6. For key, provide your key (sent to
you by Google after you register at their web site), for g, provide a query
string (we used “I M Pei Louvre”), and for maxResults, use 1. You can use
default values for all of the other parameters.

3. Click Submit. A successful test displays the results in the Results window.
Expand GoogleSearchResult > ResultElement][] > ResultElement to see the
results.

4. Click Close to finish.
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Test Web Service Method: doGoogleSearch
Enter the values for the parameters and press the "Subimit’ hutton.

; ‘_,465

ResultElement{]

Type . . Name Value .
% javalang.String key Your Key Goes Here
€ java.lang,String q 11 Pei Louvre
% int start 0
# int maxResults 1
4 boolean filker False
£ java.lana.String restrict
# boolean safeSearch false
# java.lang.String Ir

B NV PO - AU UUURUE
| Submit |
Results:
Type. s Value.
% boolean |false

I[Lwebservice.googlesearchservice, ResultElement; @1

§ java.lang.String Phatos and descriptive information from the Digital Ar

#% javalang.String http:ffwaw.be.edufbc_orgfavpfcasffartffaze7fpeih... I\
% java.lang,String Pyramid, <b>Louvre=fb> addition, Paris, 1983-89, <...

& java.lang.5tring zbzIMafb> <bsPei<fb>

€ java.lang,String 21k

# boolean true

Figure 10-6 Testing Web Service Method doGoogleSearch

Configure Web Service Call

Instead of supplying method parameters in the event handling code, you can
configure the web service through the Properties window, as follows.

1. Select googleSearchDoGoogleSearchl in the Pagel Outline view.

2. In the Properties window, the method’s arguments are all listed under the
General heading. For property key, provide your key (the one Google sent to
you) and for maxResults, use 10. These are the only properties that you need

to set.
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Creator Tip

Make sure you include your Google Web API’s License Key for property key.
Otherwise, your application will return an exception. You'll configure the
search query (property o) later.

Add Event Handling Code for Button

You'll now add the Java code to access Google’s search method. You'll put the
code in the action method associated with the Google Search button on the
page.

L. Make sure the Pagel design view is active in the editor pane.

2. Double-click the Google Search button, Creator generates default code for
the button’s action method, search_action() and brings up Pagel.java in
the Java source editor.

3. Add the following code to the search_action () method. From your Cre-
ator book download, copy and paste the file FieldGuide2/Examples/Web-
Services/snippets/google1_search.txt into the search_action() event
handler. The added code is bold.

%
% Listing 10.1 Method search_action ()
.
% public String search_action() {
.
mySearchResult = (GoogleSearchResult)
googleSearchDoGoogleSearchl.getResultObject();
resultArray = mySearchResult.getResultElements();
myResultobject.setArray(
(java.lang.Object[])getValue("#{Pagel.resultArray}”));
} catch (Exception e) {
log("Remote Connect Failure: ", e);
mySearchResult = null;
error ("Remote Site Failure: " + e.getMessage()) ;
}
return null;
}
h Handling Exceptions and Error Messages
5
Let’s examine the search button’s action event code.
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Because method doGoogleSearch () (which you invoke through the client
googleSearchDoGoogleSearchl) throws RemoteException, you should
include its call inside a try block. In this case, the accompanying catch handler
will catch any exception, including RemoteException. The catch handler per-
forms several tasks. First, it logs the error with the application server’s log. You
can view the log by selecting Deployment Server in the Servers window.
Right-click and select View Server Log. Creator displays the log in the Output
window (by default this is below the editor pane) under the tab for the applica-
tion server host machine and port (ours is localhost:24848).

The next line sets the Pagel property mySearchResult to null. Recall that
you bound the rendered property of the grid panel to whether or not this
property is empty. Since there is nothing to display when an exception occurs,
it makes sense to make sure the screen is not cluttered with a previous call’s
results.

The last line of the catch handler is a call to method error (). Method
error () posts a message to the FacesContext. This message is not associated
with a particular component, but is a generic user message. Generic messages
will be displayed by a message group component if there is one on the page.
(This is why you placed a message group component on the page.) Along with
method error (), Creator provides methods info (), warn(), and fatal () for
reporting messages back to the user. These message reporting methods render
differently on the page, depending on their severity level.

; If the call to googleSearchDoGoogleSearchl succeeds, you store the results

in variable mySearchResult (a property), making the results accessible to the

rest of the web application. You also set property resultArray and the data
provider’s array property. In the next section, youw'll bind the components
using these Pagel components.

Specify Binding for the Display Components

The static text and hyperlink components that you nested inside the grid panel
display portions of the result returned from the call to Google’s search method.
Instead of setting these components’ properties inside the event handler, you
can specify the bindings through the Properties window. Let’s provide the
bindings now. (You may want to refer to Table 10.3 on page 464, which lists the
properties for the returned result object.)

Design Note

Because taking small steps is always better than attempting a giant leap, let's
display only the first result on your web page. In a later section, we'll have
you display all of the returned results (a maximum of ten).
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1

. Click the Design label in the editing toolbar to return to the design view.

2. Select the static text component timeCount. In the Properties window for

property text, type in the following binding expression. (Note that this
expression combines literal text with expressions.) Type in the complete text
on a single line and finish with <Enter>. The text will appear on the design
canvas.

Search Time: #{Pagel.mySearchResult.searchTime}; Approx.

Results: #{Pagel.mySearchResult.estimatedTotalResultsCount)

This will display the search time and the estimated total number of results
returned from the search.

Creator Tip

If you hold the mouse over the text property in the Properties window, the
value is displayed in a tooltip. Use this to check that you entered the
expressions and literal text correctly.

Now you'll bind the display components to the object array data provider,

myResultObject

1.

‘Page 304 of 328

Select the hyperlink component (use the Outline view). In the Properties
window, select the editing box opposite property text. Creator pops up a
property customizer. Click button Unset Property to remove the default text,
Hyperlink.

2. The hyperlink component holds the URL property of the result returned

from the Google search. In the Properties window, select the editing box
opposite property url. Creator displays the url property customizer.

. Select radio button Use binding and tab Bind to Data Provider. Make sure that
data provider myResultObject is selected, as shown in Figure 10-7. Select
property URL in the Data field window. Click OK.

Creator generates the following binding expression for the hyperlink’s url
property.

#{Pagel.myResultObject.value['URL']}

4. Select the nested static text component nestedText. This component will

display the title of the returned search result. In the Properties window for
property text, click the editing box to bring up the text property customer.
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{o Usebinding {3 Use value

Current: URL property setting
| #{Paget myResultObject walue[ URL']}

:, Bind to Data Provider Bind ko an Objectg

: Choose a Data Providar to bind to hyperlinkl:
. imyResultObject {fage?) w1 [ AddData Provider..

. Data field:
<LNONE

cachedSize Sking
directoryCategory DiectoryCabegory
directoryTitle Sking

hostName String
relatedInformationPresent boclear
snippet  Sking

summary String

title String

t QK %}[ Cancel ” Help ]

Figure 10-7 Bind url property to the object array data provider myResultObject

5. Select radio button Use binding, tab Bind to Data Provider, Data Provider
myResultObject, and Data field title. Select OK. Creator generates the follow-
ing expression.

#{Pagel.myResultObject.value('title']}

6. Make sure that the escape property for this static text component is
unchecked (set to false). This allows the embedded HTML elements that Goo-
gle supplies to be rendered correctly on the page.

7. Select the static text component snippet. This components displays a short
description of the returned URL. In the Properties window, bring up the cus-
tomizer for property text.

8. Select radio button Use binding, tab Bind to Data Provider, Data Provider
myResultObject, and Data field snippet. Select OK. Creator generates the fol-
lowing expression.

#{Pagel.myResultObject.value['snippet']}
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9. Make sure that the escape property for this static text component is also

unchecked (set to false).

Finally, youw'll bind the text field searchString to
the googleSearchDoGoogleSearchi object.

the query parameter q in

L. In the Design view, select text field component searchString. In the Proper-

ties window, bring up the customizer for property text.

2. Select radio button Use binding and tab Bind to an Object.

3. In the Select binding target window, expand googleSearchDoGoogleSearch1
node and select property g, as shown in Figure 10-8. Click OK.

(%) Use binding

{7 Use value

Current Text property setting

#{Page!,g00gleSearchDoGaogleSearchi .qF

| 6ind to Data Provider | Bind to an Object |

Select binding target:
Pow @ pagel Page

{

¢y googleSearchDoGoogleSearchl GoogleSearchDoGoogleSearch

property:
property:
property:
property:
property:

property:
property!
property:

¢
$
4
- e property:
4
4
¢

praperty:

/@ property: dataClassInstance GoogleSearchlant

: refrs

dataListeners Datalistensr[]
dataMethod Method
dataMethodArguments Object]]
fieldKeys Fialdey[]
filter Boolean
googleSearchClient GoogleSearchtlient
ie Shing
key Sting
Ir String
maxResults Intoger
oe String

Hog

IeDataListeners RefreshableDatalistencr[] ™ ?

Cancel

i OK ]\1 { Uriset Pmpertyj [
5

Figure 10-8 Bind searchString text property to propetty q (query)

Deploy and Run

You're ready to test this initial version of the Google search web application.

Facebook's Exhibit No. 1003
Page 00306

*

Page 306 of 328

GOOGLE EXHIBIT 1003



IR

10.2 Validation - Project Google2

¢ From the main menu bar, select Run >Run Main Project or select the green
arrow on the icon bar. You can test the Google Search API by typing in
various search queries. Click on the URL (displayed as the title) and go to
that web page. Figure 10-9 shows a screen shot of the application.

File Edit

Hep @

View . Go

Goc

{11 Pej Louvre

gle

Search Time: 0.089023; Approx. Results: 5440
HnPei
P¥tnid, Louvre addition, Paris, 1983-89. 1M Pei, architect. Pyramid, Louvre

addition, Paris, 1933-89. IM Pei, architect. Pyramid, Louvre addition, Paris, ...

http:ifwww.bc.adu;bc_or@iavp}casjﬁuarfﬁa2§7jpei.htmi

Figure 10-9 First version of the Google Web Search application

10.2 Validation - Project Google2

You have created a simple web application that uses a published web service.
Now you're going to build on this example and enhance it in the following

ways.

¢ Provide validation for the text field component and require that the user
provide something. That is, you want to prevent a zero-length string and
require a minimum length for the search string (three characters).

¢ Place a message component on the page to report validation errors

associated with the text field component.

¢ Configure the message group component so that it displays global messages

only.
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Copy the Project

To avoid starting from scratch, make a copy of the Google1 project. This step is
optional. If you don’t want to copy the project, simply skip this section and
continue making modifications to Googlel.

L. Bring up project Google1 in Creator, if it's not already opened.

2. Trom the Projects window, right-click node Google1 and select Save Project
As. Provide the new name Google2.

3. Close project Googlel. Right-click Google2 and select Set Main Project.
You'll make changes to the Google2 project.

4. Expand Google2 > Web Pages and open Pagel.jsp in the design view.

5. Click anywhere in the background of the design canvas of the Google2
project. In the Properties window, change the page’s Title property to Goo-
gle Search 2.

Add a Validator

It’s always a good idea to validate user input. Included in the components pal-
ette are a set of validators to help with this task. With text strings, two valida-
tors are of interest. First, a length validator can control a String’s length. You
can specify a maximum and a minimum for the number of characters input.
Interestingly enough, if you want to prevent a zero-length string, you cannot
use the length validator (and set the minimum to 1). Instead, you must use the
component’s required property. The required property is set in the Properties
window for each text field component. If you check it (set it to true) and the
component’s value is a String, then its length must be greater than zero.

Validation in this application is important for two reasons. First, the web
application developer has better control over user input and can give feedback
to increase program usability. Secondly, by requiring valid input at the applica-
tion’s server site, you prevent access to Google’s web site with an invalid search
request.

For this example, let’s prevent a zero-length string and set a length mini-
mum of three characters and a maximum of 2,048 characters (this is the maxi-
mum search query allowed by Google).
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Creator Tip

For testing, you’ll set the length minimum to 3 and its maximum to 25.
Coupled with the required validator, you should get the following behavior. If
the user leaves the text field empty, you'll get a message from the required
validator saying that a value is required. If you type in a 1- or 2-character text
value, you'll get feedback from the length validator saying that it was less
than the minimum of 3. Likewise, if you type in more than 25 characters, the
length validator will complain that the string was more than the maxinum.
Note that a zero-length string does not trigger the length validator even if the
minimum is set to 1. You must use the required property of the component!

Let’s add validation to the application now.

1. Make sure Pagel is active in the design canvas.

2. Select the text field component, searchString.

3. In the Properties window, click the checkbox for the required attribute. This
means the text field component cannot be empty.

4. From the Components palette, expand the Validators node, select Length
Validator, and drop it on top of the searchString text field component. Cre-
ator sets the validator attribute for searchString to lengthvalidatorl.
Component lengthValidatorl appears in the Pagel Outline view.

You've instantiated a length validator for the text field component. Now you
have to give it length boundaries: the minimum and maximum allowable.

5. Select lengthvalidatorl in the Outline view. In its corresponding Proper-
ties window, change attribute maximum to 25 and minimum to 3.

These values are probably not the limits you'd want to use in your produc-
tion application, but they're good values for testing. Once you're convinced
that the application is working the way you want, set the maximum to 2048,
which is the maximum imposed by Google. The advantage of using the valida-
tor instead of letting Google complain is that you save a trip to the Google
server.

Note also that the private init () method in the Java page bean has been
modified to include the minimum and maximum settings you defined in the
Properties window, as follows. (Unfold the Creator-managed Component Defi-
nition block to see the init () method.)

lengthValidatorl.setMaximum(25) ;
lengthValidatorl.setMinimum{3) ;

473
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Add a Message Component

You've already placed a message group component on the page. And, if you
run the web application now, the message group component will display error
messages detected during validation. However, the look of the message group
component is not really what you want, since validation messages aren’t really
“System Messages.” For validation error reporting, use the message compo-
nent. Like the message group component, the message component retrieves
messages from the JSF context. The difference is that the message component is
associated with a single component. That way, the web application designer
can control exactly where on the page the error message for a specific input
component appears. This is particularly useful for pages that contain many
input components (such as a form that submits a whole page of personal infor-
mation). Thus, when the validator sends an error message to the JSF context, it
identifies the component whose input is marked invalid. A message compo-
nent tied to this input component will pick up the error message and display it
on the page.

1. Return to the Design view.

2. From the Basic Components palette, select Message component and drop it
onto the design canvas. Place it in between the text field and the grid panel.

3. When you place the message component on the canvas, you can associate it
with the text field using the mouse. Press and hold <Ctrl+Shifts, left-click the
mouse, and drag the cursor to the searchString text field. This sets the
message component’s for property. In the design view, the message compo-
nent now displays the text Message summary for searchString,

Message and Message Group Components

Go ahead and run the web application (select Run > Run Main Project from the
main menu). Either leave the input field blank or type in less than three charac-
ters and press the Google Search button. You'll see that the application displays
the error message twice: both the message component (which is tied to the text
field) and the message group component (which displays all messages) display
the validation error.

By default, a message group component displays all messages associated
with a page, both messages tied to a specific component (such as the validation
eITor message you just saw) and system messages (such as a problem with
your Google authorization key). But when you also use message components
specific to an input component, it's better to restrict a message group compo-
nent to display global messages only. Global messages are those that are not
tied to a specific component.

1. Make sure that Pagel is active in the design view.
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2. Select the message group component.
3. In the Properties window, check property showGlobalonly (set it to true).

1 The message group component now displays the text “List of global mes-

r sage summaries.”

) 4. Rerun the application and check its behavior for reporting validation errors
7 as well as system errors. To simulate a system error, temporarily disconnect
N your test machine from the internet or use an incorrect access key. The Goo-
3 gle web services call will fail. Figure 10-10 shows the application running

5 with a validation error message (from the length validator).

r

t

7

£

L {‘J@ Google Search

2 ab
Yaligation Erron Value is less than allowable minimum of '3

5 A OF F DocumentDove.. R Sl ] g
A S N e

Figure 10-10 Google Web Search with input validation

Creator Tip

, During testing, note that when you complete a successful search and follow
this with invalid input, the previous results are cleared from the page. You get
this behavior because you reset property mySearchResult to null during the
Pagel method init (). JSF calls method init () with each page access,
assuring that the page will only render results from a new, valid call to
doGoogleSearch () method.

10.3 Displaying Multiple Result
Elements

The previous version of the application displays only the first result element
returned from a Google search. Most of the time, the Google search returns an

Facebook's Exhibit No. 1003 ;
Page 00311 j

e — ——
Page 311 of 328 GOOGLE EXHIBIT 1003




476 Chapter 10 Accessing Web Services

array of ten results. You get the first ten results of the query if parameter start
is set to zero and maxResults is set to 10. To get the next set of ten results, set
start to 10 (instead of 0). For the third set of ten results, set start to 20, and so
on.

Google returns the total result count with method getEstimatedTotalRe-
sultsCount (); you can easily determine the number of results returned by get-
ting the length attribute of the ResultElement array. This will be at most ten.
Furthermore, Google imposes a 1,000 count limit, so even if the query returns
30,000 hits, Google will give you at most 1,000 (in ten-count page increments).

In this version of our Google search application, you're going to display all
(up to ten) elements of the ResultElement array (that is, the first page). You'll
use Creator’s Table component and the object array data provider you already
configured.

Our approach is not so different from the project you just built: you use a
hyperlink component to hold the ResultElement’s URL, a nested static text
holds the result’s title, and a second static text component holds the result’s
snippet. To make sure that the snippet information starts on its own line in the
table, you'll use a static text component to hold the HTML <br/> tag, which
forces a line break in the table cell.

Here are the enhancements that you're going to make to this project.

* Use a Table component to format and display the results from a Google
search web service call.

¢ Use an Object Array Data Provider (component myResultObject) to map
the ResultElements[] array into the table component.

* Specify binding expressions for the table title, column title, as well as each
component that you'll add to the table column.

Copy the Project

To avoid starting from scratch, make a copy of the Google2 project. This step is
optional. If you don’t want to copy the project, simply skip this section and
continue making modifications to Google2.

1. Bring up project Google2 in Creator, if it's not already opened.

2. From the Projects window, right-click node Google2 and select Save Project
As. Provide the new name Google3.

3. Close project Google2. Right-click Google3 and select Set Main Project.

You'll make changes to the Google3 project.

- Expand Google3 > Web Pages and open Pagel.jsp in the design view.

5. Click anywhere in the background of the design canvas of the Google3
project. In the Properties window, change the page’s Title property to Goo-
gle Search 3.

>
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Add a Table Component

The table component is a convenient way to present tabular data, such as an
array of objects. You'll be using a single column (to mimic the display you see
from Google’s web site). In each cell, you'll display the result web site’s title fol-
lowed by the snippet. The title is the text for the hyperlink to the result’s site.

1. Make sure that Pagel is active in the design view. Close the Output window
to give yourself more room to work in the design editor.

2. From the Basic Components palette, select Table and drag it to the canvas.
Place it below the grid panel component that’s already on the page. (You'll
delete the grid panel component later. For now, leave it on the page.) You'll
see a default table rendered on the design canvas and the default table data
provider, defaultTableDataProviderl, appears in the Outline view.

3. When you place the table component on the canvas, the table’s title is
selected so that you can provide your own title.

4. Type in the following text to set the title.

Search Results (#{Pagel.mySearchResult.startIndex} to
#{Pagel.mySearchResult.endIndex})

Type the text all on a single line and finish with <Enter>. The title text will
appear in the table’s title area.

Configure the Table

When you place the table component on the page, creator configures it with a
default data provider. You'll use the object array data provider you configured
earlier instead.

1. Select the table component, right-click, and choose Table Layout from the
context menu.

2. In the drop down menu for Get Data From, choose myResultObject. Creator
displays the data fields in the Selected window.

3. Use the < (left arrow) to remove all fields except URL, snippet, and title.
Click Apply.

4. Select column URL and change the component type to Hyperlink. Click
Apply and OK to close the dialog.

Creator binds each of these columns to the URL, snippet, and title fields of
the data provider for you. You'll need a bit more customizing to get a look
that’s similar to the page the Google web site builds. Look at the Pagel Outline
view. You'll see the table component (tablel), a nested table row group, and
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three table column components with headings URL, snippet, and title. You'll
now rearrange these components a bit.

1.

From the Pagel Outline view, select the static text component under the col-
umn entitled title and drop it on top of the hyperlink component under the
URL column. (This should nest component staticText3 under component
hyperlink2.)

. In the Properties window for staticText3, change its id property to nested-

Text and uncheck its escape property.

. In the Properties window, hold the cursor over the text property and verify

that its binding is set to the following.

#{currentRow.value[’'title’]}

4. Now select the hyperlink component (hyperlink?2). In the Properties win-

dow, set property url to the following. (By default, Creator binds the text
property instead.)

#{currentRow.value{’url’]}

. In the Properties window for the hyperlink component, select the editing

box opposite property text to bring up the property customizer and select
Unset Property.

. From the Basic Components palette, select Static Text and drop it on compo-

nent tableColumnl in the Pagel Outline view. The static text should appear
at the same level as the hyperlink component.

. In the Properties window, uncheck its escape property and set its text prop-

erty to <br/>. (This will provide a line break in the table cell and improve the
formatting.)

. From the Pagel Outline view, select the static text component under the col-

umn entitled snippet and drop it on top of component tableColumnl.

. In the Properties window, change its id property to snippet and uncheck its

escape property. Now hold the cursor over the text property and verify
that its binding is set to the following.

#{currentRow.value{’snippet’]}

You'll now make final configuration changes to the table component.

. In the Pagel Outline view, remove components tableColumn? and

tableColumn3 (there shouldn’t be any nested components in these unused
columns).

. Select the table component. In the Properties view, set property width to 500.
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3. In the Pagel Outline view, select static text component timeCount and bring
up the property customizer for property text. Copy it using <Cttl+C> and

click OK.

4. Now select component tableColumnl and bring up the property customizer
for property headerText. Paste (use <Cttl+V>) the value from timeCount’s
text property. Click OK. The column’s header shows the new value.

dered. The table disappears from the design view.
6. Click button JSP to bring the the JSP source editor.

#{not empty Pagel.mySearchResult}

nested components).

component, as shown in Figure 10-11.

5. Select the table component. In the Properties view, uncheck property ren-

7. Change the table’s rendered property to the following. (You might want to
copy and paste from the grid panel’s rendered property.)

8. Return to the design view. Delete the grid panel component (and all of its

9. Move the table component up so that it is directly underneath the message

By Welcome x| p; Pagel x|

iDesigng 5P . Java “ 7

System Messages

= List of global inessage summaries

#{Page1 mySearchResult estrmatedl‘otalResultsCuurrt}
) ?T\lo items found.

?;earcl\ Time: #{Page1.mySearchResult.searchTime}; Approx. Results:

SRR R R R i S R RS R

Figure 10-11 Google Search application using Data Provider and Table components
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Deploy and Run

* Deploy and run the Google application. Depending on the input you
provide for the search query, you should see up to ten results displayed on
the page. Figure 10-12 shows an example screen shot.

l M Pei Louvre o h

. Search Results {1 to 10}
{ Search Time: 0.074927; Approx. Results: 5370 *
13 Pei

Pyramid, Louvre addition. Paris, 1983-39. IM Pei, architect. Pyramid, Louvre

addition. Paris, 1983-89. IM Pei, ar hitect. Pyramid, Louvre addition, Paris, ..
Pyramide du Lowvre - 1M Pej - Buildings Cniing

Pyramide du Louvre by IR Pei architect, at Paris, France, 1989, in the Great

Buildings Online.

im pel /the grand Wyre paniz

im pei. the chineseorn american architect iech ming pei is one ofthe most

prq]i’ﬁ’c architects of our times.

archite
http:/fwwvess designboom, com/portrait/pei_jouvre. htmi

the chinese-horn smer! ieoh ming pel “

Figure 10-12 Google Web Search application using HTML to build a results table

10.4 Displaying Multiple Pages

Each Google request displays up to ten results. It's time to add controls that
move forward to retrieve additional results or move backward to display ear-
lier results. You've seen how to use a button component to initiate an action.
Now you’ll use two image hyperlink components. The images will be forward
and backward pointing arrows. Since a hyperlink component is a command
component, you can configure an action method that will be invoked when the
hyperlink (that is, the arrow image) is clicked.
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The image files you'll use are in your Creator book’s Field Guide2 download
bundle (FieldGuide2/Examples/WebServices/images), but if you'd like to use
arrow graphics of your own, simply substitute the appropriate .gif or .jpg file.

The modifications for this project include adding two new image hyperlink
components and image files for their display. You'll also install action event
methods for the hyperlink components to page forward or backward through
the Google search results. These additions are straightforward. What's a bit
tricky is that you have to keep track of some of the parameters across page
requests when you call Google. That means you can’t use local variables with
request scope inside Pagel.java, since the Pagel bean is instantiated with each
page request. Therefore, you'll need to save and restore these control variables
in session scope using the Pagel methods destroy () and init (). (Ironically,
destroy () refers to the destruction of Pagel but is used to save session state
before said destruction. To review the different types of scope for web applica-
tion objects, see “Scope of Web Applications” on page 224.)

Although Creator’s table component has sophisticated paging controls,
these are used to page through a large data set. In this application, the maxi-
mum array size is ten. In order to access the subsequent results, you must sub-
mit a new call to the Google web service search method with a different
starting index and obtain a new result array.

Copy the Project

To avoid starting from scratch, make a copy of the Google3 project. This step is
optional. If you don’t want to copy the project, simply skip this section and
continue making modifications to Google3.

1. Bring up project Google3 in Creator, if it’s not already opened.

2. From the Projects window, right-click node Google3 and select Save Project
As. Provide the new name Google4.

3. Close project Google3. Right-click Google4 and select Set Main Project.
You'll make changes to the Google4 project.

4. Expand Google4 > Web Pages and open Pagel.jsp in the design view.

5. Click anywhere in the background of the design canvas of the Google4
project. In the Properties window, change the page’s Title property to Goo-

t gle Search 4.

Add an Image Hyperlink Component

Before you add components to project Google4, look at Figure 10-13, the
design canvas for this project. You can see the placement of the image hyper-
link components (the two arrows).

M e e T

Facebook's Exhibit No. 1003
Page 00317

A E—

Page 317 of 328 GOOGLE EXHIBIT 1003



‘482 Chapter 10 Accessing Web Services

Image Hyperlink
Components

k - System Messages
) 4 . } . B {jst of glohal
e S P message

T — e L summaries
Message summary for searchBiring - T

 Search Results (#{Pagel.mySearchResult.startindex} t

Search Time: #{Page1.mySearchResult.searchTime}; Number of Resuits
Returned: #{Page1.mySearchResult.estimatedTotalResultsCount}

"1 Mo iterns found.

Figure 10-13 Design canvas showing component layout for project Google4

1. From the Basic Components palette, select Image Hyperlink and drop it
onto the design canvas under the Google Search button.
2. In the Properties window, change its id property to previous.

Creator Tip

You're changing the standard id that Creator uses because it's easier to keep
track of the components in the Java page bean file. By using meaningful id
names (such as previous and next), the associated action methods that
Creator generates will have meaningful names, too.

3. In the Properties window under Behavior, set property toolTip to View the
previous set of results.

4. Make sure that the image hyperlink component is selected, right-click, and
select Set Image from the context menu. Creator pops up an Image Custom-
izer dialog that allows you to specify the URL, File, or Theme Icon for the
image.

5. In the dialog, select radio button Choose File, browse to the Creator book
download, and specify directory FieldGuide2/Examples/WebServices/
images for the field labeled “Look in:”, as shown in Figure 10-14.
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{_3Set Theme Icon

My Recent

i nav_previous, gif
DivcUmets

|

7

i

v File name: [ nav_previous.gf
My Documents

- Files of type: ,éAII Image Files (.gif, .jpa, .prg, .ipe,

e

4

Creator2iFieldGuide2\ExamplesiWebSarvicestimagesinav previous,qif ;?’f
< G bR

[ oK [}H Cancel ][ Apply ][ Help }

Figure 10-14 Image Customizer dialog for image component

6. Select file nav_previous.gif. Click Apply. Creator displays the arrow in the
dialog’s Preview window and the image appears on the design canvas.
= 7. Click OK. Creator copies the image file to the project’s Web Pages >
resources directory.
8. In the Properties window for the image hyperlink, click the editing box
opposite property text and select Unset Property in the customizer dialog.

A Second Image Hyperlink Component

Follow the same procedure to add a second image hyperlink component and a
second image to the page.

1. From the Basic Components palette, select Image Hyperlink and drop it
onto the design canvas under the Google Search button.

2. In the Properties window, change its id property to next.

3. In the Properties window under Behavior, set property toolTip to View the
next set of results.
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4. Make sure that the image hyperlink component is selected, right-click, and
select Set Image from the context menu.

5. In the dialog, select radio button Choose File, browse to the Creator book
download, and specify directory Field Guide2/Examples/WebServices/
images for the field labeled “Look in:”. Select file nav_next.gif. Click OK.
Creator copies the image file to the resources folder and the right-arrow
image should now appear on the design canvas.

6. In the Properties window for the image hyperlink, click the editing box
opposite property text and select Unset Property in the customizer dialog.

7. Adjust the image hyperlink components so that they're aligned vertically to
each other. Select the hyperlink component next, press and hold the Shift
key, and then select the hyperlink component previous. With both compo-
nents selected, right-click and select Align>Middle from the context menu.

Deploy and Run

You might want to experiment with the placement of these newly added
graphic components. Right-click and select Preview in Browser. Check the
placement of the components and adjust them if necessary. Now deploy and
run project Googled. (The arrow buttons won't do anything useful, but you
should be able to display the ten results as before.)

Creator Tip

The arrow buttons erase the table (why?). To see the search results again, click
the Google Search button. The table is cleared because clicking an arrow
button generates an action event, which initiates the JSF page life cycle
process. You haven't specified any action, but the system proceeds through the
different life cycle phases anyway. When JSF instantiates the Pagel page
bean, it invokes Page.init (), which sets mySearchResult fo null and
the table component is not rendered.

Add SessionBean1 Properties

You will soon add control variables to the Pagel.java file. These values keep
track of the current index and other controls you need for displaying more than
the first page of results. To maintain these values across page requests, you add
them to the SessionBeanl managed bean as properties. This automatically puts
them in session scope. The following properties are all type Integer and mode
Read/Write:

* startIndex - index of the first result (parameter start)
* currentCount - length of the ResultElements (] array
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* totalCount - estimated total number of results for the query; used to test
end conditions

Here are the steps to add properties to SessionBeanl.

1. From the Projects window, select Session Bean, right-click and select Add >
Property.

2. Creator pops up the New Property Pattern dialog.

3. For Name, specify startIndex, for Type, specify Integer, and for Mode, select
the default Read/Write. Click OK.

4. Repeat these steps for currentCount and totalCount. Specify Type Integer and
Mode Read/Write for both.

5. In the Projects window, double-click node Session Bean. This brings up file
SessionBeanl.java in the Java source editor.

6. Add the following code to the end of method init () to initialize the three
properties. Copy and paste from file FieldGuide2/Examples/WebServices/
snippets/google4_session_init.txt. The added code is bold.

public void init() {

startIndex = new Integer(0);
currentCount = new Integer (0);
totalCount = new Integer(0);

i

Specify the Action Code

When a user clicks the right-arrow hyperlink, the web application should dis-
play the next ten results from the Google search. Conversely, clicking the left-
arrow hyperlink displays the previous ten results. Because you’ll make similar
calls to the Google search API, you should place this code in its own method.
Once you determine the correct start index, you can call this method from the
action event handlers for the search button and from both hyperlinks.

1. To return to the design view for Pagel, select the tab labeled Pagel.jsp at the
top of the editor pane.

2. Inthe design canvas, select the right-arrow hyperlink next and double-click.

3. Creator brings up the Java page bean file, Pagel.java, and displays the gen-
erated event handler, next_action().

4. To keep track of the index variables and the result count information that
Google returns, you’ll need integer control variables. Place these declara-
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tions above method next_action (). Copy and paste file FieldGuide2/Exam-
ples/WebServices/snippets/googled_variables.txt.

private int startIndex = 0;
private int prevIindex = 0;
private int currentCount = 0;

private

int totalCount = 0;

The startIndex, currentCount, and totalCount integer variables are
saved and restored in session scope for the action handlers. To do this, you'll
use the Pagel methods destroy() and init() to save and restore the
SessionBeanl properties. Recall that method init () is invoked after the page
is constructed and method destroy () is invoked after the page is rendered.
(Table 6.6 on page 266 describes these life cycle methods.)

1. Add the following code to method destroy (). Copy and paste from
FieldGuide2/Examples/WebServices/snippets/google4_destroy.txt. This

code calls setters to store startIndex, currentCount, and totalCount as

equivalently named properties in the SessionBean1 object. The added code
is bold.

Listing 10.2 Method destroy ()

private void destroy() {
getSessionBeanl () .setStartIndex (new Integer (startIndex));
getSessionBeanl () . setCurrentCount (

new Integer (currentCount)) ;

getSessionBeanl () .setTotalCount (new Integer (totalCount)) ;

}

2. Next, add the following code to the end of method init (). Copy and paste
from Field Guide2/Examples/WebServices/snippets/google4_init.txt. The
added code is bold.

Listing 10.3 Method init ()

private void init() {

mySearchResult = null;
startIndex = getSessionBeanl () .getStartIndex().intValue();
currentCount =

getSessionBeanl () .getCurrentCount() .intvalue() ;
totalCount = getSessionBeanl () .getTotalCount() .intValue() ;
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Most of the code that resides in the search_action () event handler can be
pulled out and placed in a method that all three action event handlers will call.
Let’s call this new method doSearch (). The difference is that the start index,
which was previously hard-coded to zero, has been parameterized (int
start). The second difference is that we're saving the total search count
(totalCount) and the length of the ResultElements|[] array (currentCount).

3. To create the doSearch () method, use FieldGuide2/Examples/WebServices/
snippets/google4_doSearch.ixt and place it directly before the
search _action() method (near the end of the Java page bean file). Note
that this method sets the starting index value by calling method set-
Start (). It also sets totalCount and currentCount from the
mySearchResult object.

Listing 10.4~Meth‘od dosearch ()

public void doSearch(int start) {
try {
googleSearchDoGoogleSearchl.setStart (start);
mySearchResult = (GoogleSearchResult)
googleSearchDoGoogleSearchl.getResultObject () ;

resultArray = mySearchResult.getResultElements();

myResultObject.setArray(
(java.lang.Object[])getValue
("#{Pagel.resultArray}"));

totalCount =
mySearchResult.getEstimatedTotalResultsCount () ;

currentCount =
mySearchResult.getResultElements () .length;

} catch (Exception e) {
log ("Remote Connect Failure: ", e);
mySearchResult = null;
error ("Remote Site Failure: " + e.getMessage()):

4. The search_action () method is now simpler, since all that’s required is to
reset the index control variables and call doSearch (). Copy and paste from
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file FieldGuide2/Examples/WebServices/snippets/google4_search_action.txt to
modify this method. Here’s the new code.

Listing 10.5 Method search_action()

public String search action() ({
startIndex = 0;
previndex = 0;
doSearch (startIndex) ;
return null;

Clicking the right-arrow hyperlink returns the next set of results from Goo-
gle. To effect this return, update the start parameter (see Table 10.1 on
page 462) of the doGoogleSearch () method. Also note that the code in the
action handler next action() is similar to the code in the above
search_action (). You just need to check for upper limits in the index control
variables.

5. Add code to the next_action () event handler. Copy and paste from file
FieldGuide2/Examples/WebServices/snippets/googled_next_action.txt. Note
that the index variables from the session object are automatically restored
and saved through methods init () and destroy (). (The added code is
bold.)

Listing 10.6 Method next action ()

public String next action() {
previndex = startIndex;
startIndex = startIndex + currentCount;

if (startIndex >= totalCount| |startIndex>= 1000) ({
startIndex = prevIndex;
prevIndex -= currentCount;

}

doSearch (startIndex) ;
return null;

Now let’s add a previous action () method to handle action events associ-
ated with the left-arrow hyperlink.

6. Return to the design canvas by selecting Design from the editing toolbar. ; {
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7. Select the left arrow hyperlink previous and double-click. This creates the
event handler method in the Java page bean for you and places the cursor at
- the beginning of the method.
8. Add the following code to the default previous_action () method. Copy
- and paste from file FieldGuide2/Examples/WebServices/snippets/
googled_previous_action.txt. The added code is bold.

L‘isting 10.7 Method previous action()

public String prevl action() {
prevIindex = startIndex -~ currentCount;
startIndex = prevIndex;

if (startIndex <= 0) {
startIndex = 0;
previndex = 0;

}

doSearch (startIndex) ;
return null;

You'll note that the structure of previous action() is similar to the
next action() method.

Deploy and Run

Deploy and run the project. You should be able to page through multiple result
sets by using the arrow graphics “right” and “left.” Figure 10-15 shows the
fourth page of a result set.

10.5 Key Point Summary

Creator provides an easy drag and drop feature for accessing a web service
through your project. You can add a web service so that it is accessible through
the Servers window, test a web service method, and view the returned results.

¢ Web services provide a standard way to access services over a network in a
heterogeneous environment.

* You can add a web service client to Creator by supplying the URL of its Web
Service Description Language (WSDL) page.
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) Google Search 4 Mozilla Firefox
Fle Edit ¥ew Go Bookmarks Tools Help o

So0gle Search.

4 »

i i !
|1 M Pei Louvre [ View the next set of results| |

Gouogle

| Search Time: 0.026716; Approx. Results: 5260

Gabion: Arcadian idyll: IM Pei’s only English building is an ...

Arcadian idyll: i1 Pei's only English building is an ambitious rural pavition.

- At one point Pei sent aver one of his men from the Louvre to check up on ...
%D Savant Review: 11 Pei

A DVD review by Glenn Erickson (DVD Savant) of the films i# Pei: First Person
.. One of the main focuses is the Louvre project, a maze of bureaucratic ...

Le Grand Louvre

Le Grand Louvre. Paris, France IM Pei, architect. Location. History. 18 Pei's Le
Grand Louvre is an underground extension of gallery space sewving France's ...

hittp: jﬁo;glhost;28080]60091@4;‘@;65{?39& Ljsp#

Figure 10-15 The Google Web Search application displaying the third page of results

* You can test a web service by selecting one of its methods, right-clicking on
the method, and selecting Test Method. Creator displays a Test Web Service
Method dialog in which you supply parameter values, submit the call, and
examine the results.

* You can access methods of a web service by dragging its node onto the
design canvas. Web services appear in the Outline view for the page.

¢ The Google web service API provides a SOAP interface to search Google’s
index of pages.

¢ Initiate a search of the Google engine by dragging the doGoogleSearch web
service onto your page.

¢ Web service methods should be invoked within a try block.

¢ Use image components to add graphics to your web pages.

¢ Use a static text component to display read-only text. Setting its escape
attribute to false allows correct rendering of HTML tags. JSF dynamically
sizes the output text component for you.

¢ Use a hyperlink component to submit a form, navigate to an external URL,
or navigate to an anchor within the same page.

* Use an image hyperlink component to render an action component using an
image.
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* You can nest a static component within a hyperlink component and use it to
display the text for the hyperlink. This allows you to render HTML tags
correctly by unchecking the escape property.

e You can control whether or not a component is displayed through its
rendered property.

* You can nest components inside a grid panel or other layout component.
This allows you to easily control the rendering on these components as a
group through the parent component’s rendered property.

o The length validator makes sure that input is within a certain range for
length. It does not check for empty fields.

 The required attribute makes sure the field is not empty.

e Validators write error messages to the JSF context. Use a message
component to display error messages generated by a specific component.

e Use the message group component to display generic user messages. Set its
showGlobalOnly property to true to suppress error messages that are
already displayed through component-specific message components.

* You can generate user messages using one of info (), warn (), error (), and
fatal () from within any FacesBean object.

o Pagel lives in request scope. You can maintain information you need to access
across page requests as properties in SessionBean1, which is defined in
session scope.

* Use page bean method destroy () to save session state in SessionBean1. Use
page bean method init () to restore session state from SessionBeanT.
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